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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert

symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

/\DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.

/\WARNING
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Qualified Personnel
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in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Proper use of Siemens products
Note the following:

/\WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this

publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability
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Siemens AG Copyright © Siemens AG 2009.
Industry Sector ® 06/2009 Technical data subject to change
Postfach 48 48

90026 NURNBERG
GERMANY




Preface

Scope and standards

This document is part of the Engineering System Handling documentation package.

Scope of validity

This manual applies to SIMOTION SCOUT in association with the SIMOTION CamTool
option package for product version V4.1 SP4.

Sections in this manual

The following is a list of chapters included in this manual along with a description of the
information presented in each chapter.
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Overview
This chapter contains an overview of the SIMOTION SCOUT Engineering System.
Installing software

This chapter contains the system requirements for SIMOTION SCOUT, describes the
procedure for installing and uninstalling it, and provides important information on the
communications link to the SIMOTION device.

Functions

This chapter describes the basic steps for operating SIMOTION SCOUT. The SIMOTION
SCOUT workbench and HW Config are explained.

An important tool is provided in the form of the SIMOTION SCOUT online help, for
example. This chapter contains basic information about this topic. Additional functions
such as the licensing of the runtime components and the replacement of the SIMOTION
device are also described.

Product combinations

This chapter describes topics such as compatibility and storage media as well as STEP
7, NetPro, Drive ES, HMI, and other interfaces.

Diagnostics

It also contains information about which diagnostic functions are available and how these
are operated.

FAQs

This chapter contains handling recommendations for service with SCOUT V4.1. It
explains how projects are created and edited.

The process of inserting and commissioning drives is described. It contains general
information and special applications.

Index

Index
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SIMOTION Documentation

An overview of the SIMOTION documentation can be found in a separate list of references.

This documentation is included as electronic documentation with the supplied SIMOTION
SCOUT.

The SIMOTION documentation consists of 9 documentation packages containing
approximately 80 SIMOTION documents and documents on related systems (e.g.
SINAMICS).

The following documentation packages are available for SIMOTION V4.1 SP4:

SIMOTION Engineering System

SIMOTION System and Function Descriptions
SIMOTION Service and Diagnostics
SIMOTION Programming

SIMOTION Programming - References
SIMOTION C

SIMOTION P350

SIMOTION D4xx

SIMOTION Supplementary Documentation

Hotline and Internet addresses

Siemens Internet address

The latest information about SIMOTION products, product support, and FAQs can be found
on the Internet at:

Additional support

General information:
— http://Iwww.siemens.de/simotion (German)
— http://www.siemens.com/simotion (international)

Downloading documentation
Further links for downloading files from Service & Support.
http://support.automation.siemens.com/WW/view/en/10805436

Individually compiling documentation on the basis of Siemens contents with the My
Documentation Manager (MDM), refer to http://www.siemens.com/mdm

My Documentation Manager provides you with a range of features for creating your own
documentation.

FAQs
You can find information on FAQs (frequently asked questions) by clicking
http://support.automation.siemens.com/WW/view/en/10805436/133000.

We also offer introductory courses to help you familiarize yourself with SIMOTION.

SIMOTION SCOUT
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For more information, please contact your regional Training Center or the main Training
Center in 90027 Nuremberg, Germany.

Information about training courses on offer can be found at:

www.sitrain.com

Technical support
If you have any technical questions, please contact our hotline:

Europe / Africa
Phone +49 180 5050 222 (subject to charge)
Fax +49 180 5050 223
€0.14/min from German wire-line network, mobile phone prices may differ.
Internet http://www.siemens.com/automation/support-request
Americas
Phone +1 423 262 2522
Fax +1 423 262 2200
E-mail mailto:techsupport.sea@siemens.com
Asia / Pacific
Phone +86 1064 757575
Fax +86 1064 747474
E-mail mailto:support.asia.automation@siemens.com
Note

Country-specific telephone numbers for technical support are provided under the following
Internet address:

http://www.automation.siemens.com/partner

Questions about this documentation

If you have any questions (suggestions, corrections) regarding this documentation, please
fax or e-mail us at:

Fax +49 9131- 98 2176
E-mail mailto:docu.motioncontrol@siemens.com

SIMOTION SCOUT
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Description 1

1.1 Description

The SIMOTION SCOUT Configuration Manual is a general description of the software. Not
all available software functions are described in this document. All detailed, subject-specific
information can be found in the context-sensitive online help and the corresponding
documentation.

Important notes and information on the SIMOTION Motion Control system are contained in
the following catalog:

e SIMOTION, SINAMICS S120 and Motors for Production Machines, PM 21 Catalog

1.2 SIMOTION SCOUT Engineering System general

Introduction

SIMOTION SCOUT

While the Motion Control system SIMOTION provides a wide variety of preprogrammed
functions, it is also parameterizable and programmable for individual requirements. High-
performance tools, which provide optimum support and ease of use for the necessary
engineering steps, are required for this.

The SIMOTION SCOUT Engineering System is the environment for the uniform automation
of production machines with SIMOTION and integrates into the SIMATIC environment in
accordance with TIA (Totally Integrated Automation).

SCOUT provides a uniform, function-oriented view for your automation task and at the same
time is very easy to use.

The possible SIMOTION applications range from simple, parameterizable, speed-controlled
single axes through to complex, mechatronically-coupled and programmable multi-axis
machines. Therefore, SIMOTION SCOUT provides views adapted to the task and can be
expanded with additional tools (e.g. tool for the graphic creation of cams).

SIMOTION SCOUT is the engineering system for SIMOTION. It is integrated into STEP 7
and provides all the required tools for the following functionalities:

e Configuration

® Parameterization
® Programming

® Testing

e Diagnostics.
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1.2 SIMOTION SCOUT Engineering System general

The following tasks are graphically supported with operator guidance:
® Creation of the hardware and network configuration

e Creation, configuration and parameter assignment of technology objects
such as axes, output cams and cams.

SIMOTION P350

SIMOTION C

RT code

Engineering system Technology packages Hardware platforms
SIMOTION SCOUT

Figure 1-1 SIMOTION system overview

The automation topology is defined in the first engineering steps. The hardware and network
configuration is created by parameterizing the required components and networks.

SIMOTION SCOUT
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1.3 Procedure for creating the project

1.3 Procedure for creating the project

Steps to create a project
Machine automation is implemented step by step as the project is created:

First create a new project.
Create the device (SIMOTION D, SIMOTION C, SIMOTION P).

Then, you create the system configuration that describes the structure of the automation
topology:

— Which hardware components (drives, SIMOTION hardware platform, 1/O) are you
going to use?

— How are they interconnected?

The basic parameterization of the hardware components and networks is then performed.
SIMOTION SCOUT does this using two field-proven STEP 7 programs: HW Config and
NetPro.

In the next step, the technology objects are configured, supported by wizards.
Select the programming language (MCC, ST, LAD/FBD or DCC).
The download to the SIMOTION device is performed and

test the machine application.

1.4 Workbench

What is the SIMOTION SCOUT workbench?

The workbench is the SIMOTION user interface and is, therefore, the common framework for
all other tools in the Engineering System. The workbench is also the navigation center for the
individual engineering steps. It is used to create and manage SIMOTION projects and
provides a uniform and integrated view of all data and programs.

Workbench features

The workbench is:

An integrated and intuitively operated engineering system
Enables central data and program management, even for distributed systems
A function-oriented, technological project structure with filterable views

Enables quick access to individual engineering tools, such as configuration,
programming, and commissioning.

You will find further information on the workbench at: Getting to know the workbench
(Page 35)

SIMOTION SCOUT
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1.5 Technology packages and fechnology objects

1.5 Technology packages and technology objects

Technology packages in SIMOTION SCOUT

Technology packages combine software functions which are required for automation in
mechanical engineering in various sectors.

The following standard technology packages are available for SIMOTION:

e TP CAM
contains the basic Motion Control technologies, such as drive axis, position axis,
following axis, synchronous object, cam, output cam, cam track, and measuring input

e TP PATH
also contains the path interpolation technology

e TP CAM_EXT
contains additional objects for preparing technological data on the system level, e.g.
addition object, formula object

e TControl
contains the temperature controller technology.

e DCC
contains interconnectable modules for drive-related controller functions

® More sector-specific technology packages are also available as separate products.

Access to the technology package functions is carried out via additional language
commands and system variables. Programming of motional sequences is therefore simple
and integrated.

The Motion Control Basic, Position and Gear technology packages were available for earlier
versions.

As from SIMOTION SCOUT Version V3.2, they are contained in the Cam technology
package.

Once the basic project structure has been created by the system configuration, the next step
is to define the technology objects (axes, output cams, cams, etc.) required for the
automation task. This defines the volume of project data that must be assigned parameters
for the purpose of commissioning.

Technology objects in SIMOTION SCOUT

The technology objects (TOs) are inserted directly into the folders provided in the project
navigator. These are completed with the associated parameterization tool or commissioning
tool.

The next step is to program the SIMOTION devices. The SIMOTION SCOUT engineering
system provides user-friendly and efficient programming languages to describe the individual
functions of the machine process.

SIMOTION SCOUT
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1.6 Programming languages

Additional references
Please refer to the following documents on these subjects

Function Manual: SIMOTION Basic Functions

SIMOTION Motion Control, Basic Functions, Description of Functions for modular
machines

Function Manual: SIMOTION Motion Control, TO Axis, Electric/Hydraulic, TO External
Encoder

Function Manual: SIMOTION Motion Control, Synchronous Operation TO, TO Cam
SIMOTION Motion Control Output Cams and Measuring Inputs, Function Manual
Function Manual: SIMOTION Motion Control, Path Interpolation TO

System Manual: SIMOTION Communication

Function Manual: SIMOTION Motion Control, Supplementary Technology Objects
Configuration Manual: SIMOTION CamTool

and the online help.

1.6 Programming languages

1.6.1 Programming languages in SIMOTION SCOUT

Access to the technology packages and functions is carried out in the same way as access
to the SIMOTION Kernel via language commands from the user program.

The programming languages in SCOUT provide all of the language commands required to
implement the functions simply and quickly. The SIMOTION runtime system also supports
cyclic, sequential, time-controlled, and event-driven programming.

The programming languages are:

SIMOTION SCOUT

Motion Control Chart (MCC)
If you want to program graphically, you can use MCC for sequential flowchart-oriented
programming.

Ladder Logic/Function Block Diagram (LAD/FBD)

The familiar programming methods using LAD/FBD are also available in the SCOUT
Engineering System for user-friendly logic programming, supplemented with

motion control functions via PLCopen function blocks.

Structured Text (ST)
If you prefer a high-level language for your automation task, ST is available as an efficient
and IEC 61131-3-compliant text-based language.

Drive Control Chart (DCC)

Many applications require a combinatorial logic that combines several states (e.g. access
control, plant states) to form a control signal (e.g. ON command) for controlling the drive
system.

In addition to the logical operations, arithmetic operations and storing elements are
increasingly required in drive systems.

This functionality is available as Drive Control Chart (DCC) on drive objects of the
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1.6 Programming languages

1.6.2

SINAMICS drive system and the SIMOTION control system.

The Drive Control Chart Editor (DCC Editor), based on CFC, can be used to graphically
configure SIMOTION controllers and SINAMICS drives.

For further information, see the chapter titted DCC Programming System (Page 100)

A variety of programming languages can be combined in a single project.

The user program is executed in various tasks. A task is a job which is executed in a certain
chronological sequence. The advantage of the task system is that processes hung in the
appropriate task levels can run in parallel.

The SIMOTION motion control system uses high-performance CPUs on which a realtime
operating system suitable for fast control processes is implemented. Each task is allocated a
slice of the computing time. The organization of the task sequences is performed by the
operating system. A differentiation is made between user and system tasks that are
independent of one another.

Various debug functions are possible in the programming languages. Please refer to the
appropriate programming manuals for more detailed information.

Graphics-based flowchart programming with MCC

Motion Control Chart

18

The idea behind MCC is to formulate the process sequences in the machine using simple
and logical expressions. The result is one or more flowcharts showing the chronological
sequence of the individual actions. As production machines are primarily concerned with
controlling the motion of a large number of individual axes, MCC particularly supports the
simple description of these motion sequences with powerful Motion Control commands.

To control the machine, commands are available for awaiting the fulfillment of conditions and
for formulating computations, as well as for executing various control structures, such as
polling (IF), case determination (CASE), and loops (FOR, WHILE, UNTIL). Several MCC
programs may be created to describe different process situations. For example, you can
create one MCC program to bring the machine to a defined initial state when it is switched
on, a second MCC program for the normal production sequence, and a third MCC program
to specify what the machine is to do in the event of a fault.

All commands are available in toolbars, sorted according to command groups. Clicking a
command in the toolbar automatically incorporates it at the position marked in the flow chart.
Double-clicking a command in the flow chart opens a specific dialog box for assigning
parameters to this command.

Performance features:

e FEasy-to-use due to graphics-based representation in flowcharts.

® Hierarchical command library for Motion Control, PLC, and technology functions.
® Control structures (IF, WHILE, CASE, etc.)

® Conditions can be created in different languages. The chart can then be displayed in an
arbitrary language. Plain text can be created in an MCC with the ST zoom.

SIMOTION SCOUT
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1.6 Programming languages

® Structuring based on command modules, i.e. combination of command sequences to
create a command module. Clicking the command module invokes the corresponding
command sequence.

e FEasy-to-use debug functions for online testing and diagnostics: E.g. single-step or
program status mode for easier troubleshooting (debugging).

Additional references
Please refer to the following document on this subject
e SIMOTION MCC Motion Control Chart Programming and Operating Manual

and the online help.

1.6.3 Graphics-based programming language with LAD/FBD

Ladder Logic / Function Block Diagram

LAD/FBD stand for ladder logic and function block diagram. LAD/FBD are graphics-based
programming languages. The statement syntax corresponds to a circuit diagram. LAD/FBD
enable simple tracking of the signal flow between power rails via inputs, outputs, and
operations. LAD/FBD statements consist of elements and boxes, which are graphically
connected to networks. LAD/FBD operations follow the rules of Boolean logic.

The programming language provides all the elements required for the creation of a complete
user program. LAD/FBD features an extensive command set. This includes the various basic
operations with a comprehensive range of operands and how to address them. The design
of the functions and function blocks enables you to clearly structure the LAD/FBD program.

The LAD/FBD programming package is an integral part of the basic SIMOTION software.

Easy-to-use debug functions for online testing and diagnostics are available: E.g. monitoring
of the variable values, program status and stopping points.

Additional references
Please refer to the following document on this subject
e SIMOTION LAD/FBD Programming and Operating Manual

and the online help.

SIMOTION SCOUT
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1.6 Programming languages

1.6.4 High-level language programming in ST

Structured Text

ST is a high-level, PASCAL-based programming language. This language is based on the
IEC 61131-3 standard, which standardizes programming languages for programmable
controllers (PLC).

The basic command scope is sufficient for the implementation of everything related to data
management, arithmetic functions, control structures, and 1/0 access. The addition of
technology packages for Motion Control expands the scope of commands by further
comprehensive, extremely flexible Motion Control commands (e.g.: _pos(..) for axis
positioning).

In addition, applications can be subdivided into any number of sections. Such a section
might be a program allocated to a runtime level, an instantiatable function block with its own
memory, or a function without its own memory. In this case, the function blocks and functions
are not allocated to a runtime level, but are instead called in programs.

® Motion control, PLC and technology functions in a single language
e Well structured programs with comment capability
® High-performance editor functions, such as

— Syntax coloring

— Automatic indenting

— Automatic completion

— Bookmarks

— Fold (show and hide blocks)

— Display pairs of brackets

— Select text, e.g. by column

— Using the command library

e FEasy-to-use debug functions for online testing and diagnostics: e.g. display of up-to-date
variable content of the code sequence selected in the editor (program status) and
stopping points.

Additional references
Please refer to the following document on this subject
e SIMOTION ST Structured Text Programming and Operating Manual

and the online help.

SIMOTION SCOUT
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1.7 CamEdit cam edlitor

1.7 CamEdit cam editor

CamEdit can be used to describe curves by means of either interpolation points or
segments. A combination is not possible. If the curve is to be created from segments using
polynomials, SIMOTION SCOUT provides the VDI wizard to assist in creation of the curve.
Cam geometries are created in offline mode.

Information on the graphical creation of cams can be found in the CamTool (Page 100)
section.

SIMOTION SCOUT
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2.1

211

System requirements

Installing the interface card

Installing the interface card in the PG/PC

An interface card must be installed in the PG/PC so that the SIMOTION device can

communicate with the PG/PC. This applies only to PROFIBUS.
To use Ethernet, an Ethernet connection must be present on the PC.
The PG/PC is used for the configuration, parameterization and testing.

e |nstall the interface card in the PG/PC according to the installation guide provided.

e |nstall the appropriate drivers on the PG/PC.

e Connect the interface card to the interface of the SIMOTION device indicated below using

a suitable cable.

Table 2- 1 Interface assignment for SIMOTION devices
SIMOTION device Interface As delivered
SIMOTION C2xx X8 DP1 PROFIBUS address 2, baud rate 1.5 Mbit/s
X9 DP2/MPI PROFIBUS address 2, baud rate 1.5 Mbit/s
X7 (Ethernet) IP address: 169.254.11.22
Subnet: 255.255.0.0
SIMOTION C240 PN X8 DP1 PROFIBUS address 2, baud rate 1.5 Mbit/s
X9 DP2/MPI PROFIBUS address 2, baud rate 1.5 Mbit/s
X7 (Ethernet) IP address: 169.254.11.22
Subnet: 255.255.0.0
X11 (1 PROFINET interface with | Supplied without IP address and subnet.
3 ports)
SIMOTION P350 X101 DP1 PROFIBUS address 2, baud rate 1.5 Mbit/s

X102 DP2/MPI

Ethernet

PROFIBUS address 2, baud rate 1.5 Mbit/s

IP address: 169.254.11.22

SIMOTION P350-3 PB X101 DP1

X102 DP2/MPI

Ethernet SS1

Ethernet SS2

PROFIBUS address 2, baud rate 1.5 Mbit/s
PROFIBUS address 2, baud rate 1.5 Mbit/s

IP address: 169.254.11.22
Subnet: 255.255.0.0

IP address: 192.168.214.1
Subnet: 255.255.255.0

SIMOTION SCOUT
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SIMOTION device Interface

As delivered

SIMOTION P350-3 PN X21 MCI-PN (1 PROFINET
interface with 4 ports)

Supplied without IP address and subnet.

X130 IE2/NET
(Ethernet)

X1400 (1 PROFINET interface

With optionally inserted CBE30:

Ethernet SS1 IP address: 169.254.11.22
Subnet: 255.255.0.0
Ethernet SS2 IP address: 192.168.214.1
Subnet: 255.255.255.0
SIMOTION D4x5 X126 DP1, PROFIBUS address 2, baud rate 1.5 Mbit/s
X136 DP2/MPI PROFIBUS address 2, baud rate 1.5 Mbit/s
X120 IE1/OP IP address: 192.168.214.1
(Ethernet) Subnet: 255.255.255.0

IP address: 169.254.11.22
Subnet: 255.255.0.0

Supplied without IP address and subnet.

with 4 ports)
SIMOTION D410 DP X21 DP PROFIBUS address 2, baud rate 1.5 Mbit/s
SIMOTION D410 PN X200 and X201 Supplied without IP address and subnet.

(1 PROFINET - interface with

2 ports)

24
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21.2

Configuring the interface card

Configuring the interface card

Proceed as follows:
1. Start SIMOTION SCOUT.
2. Select the menu Tools > Set PG/PC interface.

SIMOTION SCOUT

The Set PG/PC Interface window opens.
Aocess Path | LLDP |

Access Paoint of the Application:

IS?DNLINE [STEP Y] -+ PC Adapter[PFROFIBUS) j
[Standard for STEP 7)

Interface Parameter Azzignment Used:
|F'E AdapterPROFIBUS)

Properties... |

B 150 Ind. Ethernet -> IntellF) 825650« |

PC Adaptersota) [

PC AdapterMF) Copy... |
e ST
1 | 3

[Parameter assighment of your PC adapter
far a PROFIBUS nebwark)

Interfaces
’V Add/Remove:

Select... |

Catcel | Help

Figure 2-1 Set PG/PC interface (example)

3. Select the access point of the application.
4. Click Select.

The Install/Uninstall Interfaces window appears.

x|

Selectior: Installed:

Module |

ER150 Ind. Etheret -» Intel[R] 325560M-2 Gig... £

CP5512 [PlugiPlay] Imztal - | PC Adapter E

CPEE11 [PlughPlay] B PC COM-Part (US5) E

150 Ind. Ethernet Serial cable[PFI) E

PC Adapter o Urirstall | TCPAP - IntellR] 825660M-2 Gig E

PC COM-Part [USS5) — TCPAP - Mdisiw anlp E

Senial cable[PF) ﬂ 4 | | ﬂ

|+ Display madules ready for operation only

IEPEB‘I‘I Communications processor [MPI/PROFIBUS) for programming devices/PCs [PCI)

Close

Help |

Figure 2-2

Installing / deinstalling interfaces

5. Select the module to be installed.
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2.1 System requirements

6.
7.
8.

Click Install.
Click Close to exit the dialog.
Confirm the settings by clicking OK.

Installing / deinstalling other interfaces
Proceed as follows to install or uninstall additional interfaces:

21.3

1.

In the Set PG/PC Interface window, select STONLINE as the access point of the
application.

2. Click Select under Add/remove interfaces.

3. In the left-hand field, select the interface that you want to install and click Install.

Or select the interface that you want to uninstall in the right-hand field and click Uninstall.

4. Click Close.

5. Select the interface to be used in the Used interface parameterization field.

The list of the used interface parameterization will be taken from SIMATIC STEP 7.

With the PC Adapter (Auto) setting, the interface to which the PG/PC is connected is
examined. This function automatically determines the current parameterization of the
respective interface.

Detailed information on the individual interfaces of the SIMOTION devices can be found
in the relevant commissioning manuals.

6. Click Properties to parameterize the interface.
7. Click OK to confirm.

Defining the interface

Defining the interface

26

The interface is defined uniquely when you insert a SIMOTION device. If you make changes
to the project so that the interface is no longer unique, you can modify the setting.

Note

SIMOTION devices have two PROFIBUS connections. Defining the associated PROFIBUS
connection speeds up online operation with the device.

Proceed as follows in offline mode:

1.
2.
3.

Open the project.
Select the SIMOTION device, e.g. C230-2, in the project navigator.

Right-click and select Target device > Online access... in the context menu.
The Properties - Program (Online) window opens.
If you have defined the interface uniquely, you cannot make any settings in this window.

Select Module Addresses on the tab. The IP address of the SIMOTION device is
displayed here.

Click OK to close the dialog.

SIMOTION SCOUT
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2.1 System requirements

214 Communication via PROFIBUS DP

PROFIBUS is a powerful, open, and robust bus system, which guarantees trouble-free
communication. The system is fully standardized, which enables trouble-free connection of
standardized components from a variety of manufacturers. Configuration, commissioning,
and troubleshooting can be carried out from any side. This results in user-defined
communication relationships that are very versatile, simple to implement, and easy to
change.

The high-speed, cyclic exchange of data with field devices (distributed 1/O) is carried out via
the PROFIBUS DP protocol. Expansion of the protocol to include isochronous mode also
integrates the drive components into communication via PROFIBUS DP. The individual
components can be connected via the integrated interfaces, connections, interface modules
or communications processors.

Important information on communication with PROFIBUS is contained in the following
catalog:

SIMOTION, SINAMICS S120 and Motors for Production Machines, PM 21 Catalog

The following PROFIBUS DP subnet applications are possible:
e PROFIBUS DP isochronous
Compatible extension to the standard PROFIBUS DP:

— Equidistance (constant synchronous bus cycle clock) enables synchronized time
slices for master/slave applications.

— Data exchange broadcast enables slave-to-slave communication.

Digital drives (e.g. SIMODRIVE 611U, MICROMASTER 4xx, SINAMICS) can be
connected via PROFIBUS DP.

In order to be able to operate the SIMOTION device with two isochronous

PROFIBUS DP subnets, isochronous mode and the same bus cycle must be set. The
cycle clock of the subnet of the second PROFIBUS interface is synchronized to the cycle
clock of the subnet of the first PROFIBUS interface.

If the bus cycle does not agree, the second PROFIBUS interface of the SIMOTION
device will be operated as a PROFIBUS DP subnet.

¢ PROFIBUS DP (MPI)
Standard PROFIBUS DP with DP-V0 and optional DP-V1 or DP-V2 functionality.

For the connection of distributed I/Os

For connection to a higher-level automation system

For the connection of HMI devices

For connection to the SCOUT engineering system

SIMOTION SCOUT
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2.1 System requirements

215 Ethernet communication

SIMOTION devices can also be connected to a PG/PC via Industrial Ethernet. Industrial
Ethernet is a communication network with a transmission rate of 100 Mbit/s.

For additional information, refer to the manual titled SIMATIC NET, Industrial Twisted Pair
and Fiber Optic Networks. See the list of references for the order number.

Examples for the use of Industrial Ethernet:

® For the connection of HMI devices

® For connection to the SCOUT engineering system

® For communication via UDP (User Datagram Protocol)
e TCP/IP

* |T DIAG

2.1.6 Communication via PROFINET

SIMOTION devices can be connected to a PROFINET subnet via interface modules. With
PROFINET IO IRT/RT, IT services can be performed in parallel to realtime communication
via an Ethernet cable. The PROFINET modules CBE20, CBE30 and MCI-PN-BOARD are
available. These PROFINET modules support the parallel operation of:

e |RT (isochronous realtime Ethernet)
® RT (realtime Ethernet)
e TCP/IP, UDP, http . . . (standard Ethernet services)

® For mixed operation of IRT and RT it has to be observed that the IRT-compatible devices
must form an IRT domain, i.e. there must not be any non-IRT devices on the data
transmission link between the IRT devices.

Additional references
Please refer to the following documents on this subject
e SIMOTION D4x5 Commissioning and Hardware Installation Manual
¢ SIMOTION D410 Commissioning Manual
e SIMOTION P, P350-3 and Panels Commissioning and Hardware Installation Manual
e SIMOTION C Operating Instructions
o System Manual: SIMOTION Communication

and the online help.

SIMOTION SCOUT
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2.2

Minimum requirements of the system

Table 2- 2

2.2 System requirements for SCOUT and SCOUT Standalone

System requirements for SCOUT and SCOUT Standalone

System requirements for SIMOTION SCOUT and SCOUT Standalone

Minimum requirement

Programming device or PC

Processor: Intel Pentium Il or compatible,

1 GHz (Windows XP)

512 MB RAM

Screen resolution: 1024 x 768 pixels

16-bit color depth

* Main memory with at least 1 GB is recommended

If you wish to process more comprehensive SIMOTION
projects with several modules, you should use a

programming device or PC with state-of-the-art
performance.

When installing WinCC flexible (ES), observe the
relevant system requirements and use a programming
device or a PC with state-of-the-art performance.

One of the following cards must be used as software
access point (CP5511, etc.):

- A CP5611 PROFIBUS card for a standard PC

— An integrated PROFIBUS card for a programming
device or

— An Ethernet connection

Operating system

Microsoft Windows XP Professional
with Service Pack 3

Microsoft Windows Vista Business SP1

Software required for
SIMOTION SCOUT

Microsoft Internet Explorer Version 6.0
SIMATIC STEP 7 Version 5.4 SP4 or SP5

For PROFINET connection SIMATIC STEP 7
Version 5.4 SP4

Software required for
SIMOTION SCOUT Standalone

Microsoft Internet Explorer Version 6.0
SIMATIC STEP 7 Version 5.4 SP5

Note

Simultaneous operation of SIMOTION SCOUT, Starter and SIMATIC S7-Technology on one
PC is not intended and is not possible.

SIMATIC S7-Technology is integrated in SIMOTION SCOUT V4.0 and higher.

SIMOTION SCOUT
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2.3 To install the software

2.3 To install the software

2.3.1 Installing SIMOTION SCOUT

Requirements:
e SIMATIC STEP 7 is installed.

® You are logged on to the operating system with administrator rights.

Note
Read the readme file and important information on the Add-On CD supplied with SCOUT.

To install SIMOTION SCOUT
1. Insert the DVD 1 with SIMOTION SCOUT into the CD-ROM drive.
Start Windows Explorer and select the CD-ROM drive.
Open the root directory on the DVD.
Double-click Setup.exe.

o M DN

Now follow the instructions in the installation program.

The installation program prompts you to insert or connect the supplied data medium
which contains the authorization. You can install the authorization as part of this setup. Or
install the authorization with the Automation License Manager after installing

SIMOTION SCOUT.

Information on this can be found in the section "To install the authorization".

6. If a restart of the PC is required during the installation, carry this out.
After the restart of the operating system, log on at least as main user.

7. After the installation:
Restart the PC and log on at least as main user.

All users who are logged on as main user are now able to start and operate
SIMOTION SCOUT.

Note

Simultaneous operation of SIMOTION SCOUT, STARTER and SIMATIC S7-Technology on
one PC is not intended and is not possible.

SIMOTION SCOUT
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Language setting of the SIMOTION SCOUT

SIMOTION SCOUT uses the language default setting in the SIMATIC Manager. You can
make changes to this setting in the SIMATIC Manager via the
Options > Settings... > Language menu.

German, English, French and Italian languages are currently available in SIMOTION
SCOUT. If a different language is set in the SIMATIC Manager, SIMOTION SCOUT uses the
English setting.

Note
Only those languages installed in STEP 7 are available.

2.3.2 Installing SIMOTION SCOUT Standalone

Requirements

No SIMATIC STEP7 must be installed or
a previous version of SIMOTION SCOUT Standalone is installed.

You are logged on to the operating system with administrator rights.

Note
Read the readme file and important information on the Add-On CD supplied with SCOUT.

To install SIMOTION SCOUT Standalone

1.

o DN

Insert DVD 1 with SIMOTION SCOUT Standalone into the CD-ROM drive.
Start Windows Explorer and select the CD-ROM drive.

Open the root directory on the DVD.

Double-click Setup.exe.

Now follow the instructions in the installation program.

The installation program prompts you to insert or connect the supplied data medium
which contains the authorization. You can install the authorization as part of this setup. Or
install the authorization with the Automation License Manager after installing

SIMOTION SCOUT.

Information on this can be found in the section titled "How to install the authorization".

A restart of the PC is required during the installation, carry this out. You are requested to
insert CD"/".
After the restart of the operating system, log on at least as main user.

. After the installation:

Restart the PC and log on at least as main user.

All users who are logged on as main user are now able to start and operate
SIMOTION SCOUT.

SIMOTION SCOUT
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24 To install the authorization

Installing the authorization for SIMOTION SCOUT

A data medium containing the authorization is supplied along with the product CD so that
you can use SIMOTION SCOUT. This contains the license key for the SIMOTION SCOUT
Engineering System.

To install the authorization for SIMOTION SCOUT
1. Connect or insert the data medium containing the authorization and the license key.
2. Start the Automation License Manager:

— Viathe start menu
Start > SIMATIC > License Management > Automation License Manager or

— Double-click the Automation License Manager icon

3. In the navigation area (left-hand window), select the drive where the data medium
containing the authorization is located. The license key is displayed in the right-hand
window.

4. Mark the license key and drag this with drag-and-drop to the target drive.
5. Exit the Automation License Manager.

6. Remove the data medium containing the authorization.

Note

Information on operating the Automation License Manager and transferring the
license key can be found in the online help for the Automation License Manager.

To install the authorization for SIMOTION SCOUT Standalone

Install the authorization for SIMOTION SCOUT Standalone as described in the Installing
authorization for SIMOTION SCOUT section.

To upgrade the authorization for SIMOTION SCOUT

As of Version 4.0, the authorization for SIMOTION SCOUT has been upgraded from
authorization (single license) to the licensing procedure involving a floating license. The
Automation License Manager program is used to manage the licenses.

1. Connect or insert the data medium containing the authorization and the upgrade license
key.

2. Start the Automation License Manager:

— Viathe start menu
Start > SIMATIC > License Management > Automation License Manager or

— Double-click on the Automation License Manager
icon. A new window will open.
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3. In the navigation area (left-hand window), select the drive where the authorization for the
old version of SIMOTION SCOUT is located. Generally the authorization will be installed
on a hard disk drive on the PC.

4. Transfer the authorization to the data medium containing the upgrade license key.
To do this, select the license in the right-hand window and select
License key > Transfer... via the menu.

5. In the Transfer license key dialog, select the connected data medium. Start the transfer
by clicking OK.
The authorization and upgrade license key will then be located on the data medium.

6. Select License key > Upgrade... in the menu.

The previous authorization will be deleted and a new floating license will be available
once the upgrade is complete.

Note

Do not interrupt the upgrade while it is in progress. Interrupting this process can lead to
the license key being lost.

7. Now transfer the new floating license onto the hard disk drive. To do this, follow the same
procedure as before: Via License key > Transfer... in the menu

8. After the transfer has completed successfully, remove the automation data medium.

9. Exit the Automation License Manager. SIMOTION SCOUT can now be operated without
restrictions.

2.5 Saving and moving the license key

Saving and moving the license key

You can transfer the license key to a removable disk. This is useful when you want to save
the license key when reinstalling a PC or when you want to use it on another PC. A copy of
the license key is not created during this operation, it is moved.

Note

More detailed information on the license keys can be found in the online help for the
Automation License Manager.
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2.6 To uninstall the software

2.6 To uninstall the software

Requirements:
You are logged on to the operating system with administrator rights.

Note
Note that the SIMATIC STEP7 must be uninstalled separately.

To uninstall SIMOTION SCOUT from the hard disk
1. Open the system control via Start > Settings > System control.
2. Double-click Software.

3. Select SIMOTION SCOUT x.x and click Change/Remove or Add/Remove. Follow the
instructions.

4. Once the above software has been uninstalled, restart the computer.

Uninstalling SIMOTION SCOUT Standalone

Uninstall SIMOTION SCOUT Standalone as described in the "How to uninstall
SIMOTION SCOUT from the hard disk" section.

2.7 Software upgrade

Note

Install a SIMOTION SCOUT upgrade as described in the How to install the software
(Page 30) section.
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Additional references

SIMOTION SCOUT

Please refer to the following documents on this subject
® Function Manual: SIMOTION Basic Functions

® Function Manual: SIMOTION Motion Control, TO Axis, Electric/Hydraulic, TO External
Encoder

® Function Manual: SIMOTION Motion Control, Synchronous Operation TO, TO Cam
® Function Manual: SIMOTION Motion Control, Supplementary Technology Objects

® Function Manual: SIMOTION Motion Control Output Cams and Measuring Inputs

® Function Manual: SIMOTION Motion Control, Path Interpolation TO

® Function Manual: SIMOTION Motion Control, Basic Functions for Modular Machines
and the SIMOTION SCOUT online help.

Note

We recommend that you run through Gefting Started with SIMOTION SCOUT in the online
help. This is a series of guided steps which teaches you how to work with SIMOTION
SCOUT. For example, how to create, compile and save a project, create a SIMOTION
device, add and configure a technology object and create a program.

When you have worked through all these steps, you will be able to create more complex
projects.

Note

It is not recommended that you open one SIMOTION SCOUT project twice. This application
case can result in malfunctions and is not supported by SIMOTION SCOUT. If you want to
open two different projects, you must open SIMOTION SCOUT twice.
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The SIMOTION workbench

36

The SCOUT workbench is the common framework for all other tools of the engineering
system. The workbench is also the navigation center for the individual engineering steps. It is
used to create and manage SIMOTION projects and provides a uniform and integrated view
of all data and programs.

The SCOUT workbench offers a basic display split into three views:

® Project navigator (left Workbench area)
The project navigator shows the technical tree structure of the project.

e Working area (right-hand area of the workbench)
All editing tools of the engineering system, e.g. parameterization dialog boxes, program
editors etc. are available in the working area as snap-ins.
A snap-in is a program that is automatically integrated in the working area of the
SIMOTION SCOUT workbench. Snap-ins provide functions for the editing of
SIMOTION SCOUT projects. Snap-ins are displayed in the working area of the
workbench as working windows. Several snap-ins can be opened in order to be able to
work in these. The opened snap-ins are displayed as tabs in the working area. The active
snap-in is visible in the foreground. Examples are:

Program editors:

Wizards for the configuration of technology objects

Device diagnostics

Drive navigator

® Detail view (lower area of the workbench)
The detail view displays data and messages that vary according to the situation.

SIMOTION SCOUT
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Figure 3-1 Workbench view

Workbench elements

The elements of the Workbench are:

e Menu bar:
You call the functions of SIMOTION SCOUT via the menus in the menu bar.

e Toolbars:
Frequently used menu commands are also available in toolbars, which can be activated
or deactivated as required. These provide quick access to the functions. The toolbars can
be undocked from the top and relocated to a different position (right, left, lower border or
as a window).

® Project navigator:
The project navigator provides an overview of the entire project. All defined elements,
such as devices, drives, axes, etc., are displayed here in a tree structure.

SIMOTION SCOUT
Configuration Manual, 05/2009

37



Functions

3.2 Menu structure

e Working area:

The task-specific windows are displayed in the working area. In these windows, you can
perform the configuration with wizards for the axis configuration and drive configuration.
You also create programs in the working area. Further information about the active
window in the working area is provided in the detail view.

Detail view

More detailed information about the element selected (marked) in the project navigator or
the active window in the working area is displayed in the detail view. For example,
variables of a program, system variables of a technology object or logs during the
compilation of program sources.

3.2 Menu structure

3.21 Main menus

The SIMOTION SCOUT menus are divided into different main menus.

® Main menus that are primarily used to control the workbench or a project are always

displayed. These main menus are also called static menus.

In addition, the Edit and Insert main menus are continually displayed if a project has
been loaded.

The main menu in the second position, between Project and Edit, is a dynamic menu.
Each snap-in supplies its own specific main menu to be displayed in this position. Always
the main menu that has been selected in the project navigator and therefore active in the
working area is displayed.

In addition, each snap-in can incorporate its own menu items in the static main menus,
primarily in the Edit and Insert main menus.

Table 3-1 Structure of the menu bar

Menu Comment

Project Static menu, always visible

(Dynamic menu) See Dynamic menus table

Edit Static menu, visible only when project has been loaded
Insert Static menu, visible only when project has been loaded

Target system

Static menu, always visible

View

Static menu, always visible

Options

Static menu, always visible

Window

Static menu, always visible

Help

Static menu, always visible

38
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Table 3- 2 Dynamic menus
Dynamic menu Comment
Axis Visible only when a project has been loaded and the associated
Output cam snhap-in is active in the working area.

Dynamic menus appear in the third position on the menu bar,

Measuring input ’
between Edit and Insert.

Synchronous operation

Cam

External encoder

Sensor

Controller object

Drive

Fixed gear

Formula object
Addition object
Drive control panel

Trace

ST source file

MCC unit Visible only when a project has been loaded and the associated
MCC chart snap-in is active in the working area.
LAD/FBD source Dynamic menus appear in the second position on the menu bar,

between Project and Edit.

LAD/FBD program

3.2.2 Keyboard action and shortcuts

Note

There are various keyboard assignments and shortcuts for the menu items to facilitate your
work in SIMOTION SCOUT.

The following table provides an overview of the keyboard assignments and shortcuts that
you can use for SIMOTION SCOUT.

Table 3- 3 Keyboard action

Keyboard action / shortcuts Meaning

Workbench: Change window...

ALT+0 Project navigator

ALT+1 Working area

ALT+2 Detail view

CTRL+F6 Next window in the working area

CTRL+F11 Minimize/maximize working area in relation to the whole
desktop

CTRL+F12 Minimize/maximize detail view in relation to the whole desktop
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3.2.3

40

Project navigator

Left mouse button

Selects the tree object at the cursor position;
detail view displays the associated details

Double-click with left mouse button

Selects the tree object at the cursor position;
detail view displays the associated details;
corresponding snap-in is opened

Right mouse button

Selects the tree object at the cursor position;
detail view displays the associated details;
context menu is opened

UP/DOWN arrow keys

Selects the tree object at the cursor position

"Return”

Snap-in for the selected tree object opens

"Context menu key"

Context menu for the selected tree object opens

Menu items

You can use the shortcuts listed in the table to call the menu items available in

SIMOTION SCOUT.

Table 3-4  Menu items in SIMOTION SCOUT

Shortcuts Menu item Reaction

Project...

CTRL+N New Creates a new project

CTRL+O Open Opens a project

Ctrl+S Save Saves a project

CTRL+ALT+K Check consistency Checks project consistency

CTRL+P Print Prints the selected window

ALT+F4 Exit Exits the SIMOTION SCOUT program

Shortcuts Menu item Reaction

Edit...

Ctrl+zZ Undo Undoes the last action

Ctrl+Y Redo Redoes the last action

Ctrl+X Cut Cuts the selection

Ctrl+C Copy Copies the selection

Ctrl+V Paste Inserts the clipboard contents

Del Delete Deletes the selection

F2 Rename Renames the selected tree object

ALT+Enter Object properties Displays the properties of an object in the
project tree

CTRL+ALT+O Open object Opens a new object of the selected tree object

Ctrl+A Select all Selects the entire contents in the ST and MCC
snap-ins

SIMOTION SCOUT
Configuration Manual, 05/2009



Functions

3.2 Menu structure

CTRL+F Find Opens the Find window

CTRL+SHIFT+F Searching in the project | Opens the Find window

CTRL+H Replace Opens the Replace window

CTRL+J Display next position

Shortcuts Menu item Reaction

Target system...

CTRL+L Download / target device | Downloads to individual target device

CTRL+D Device diagnostics Opens device diagnostics

Only possible in online

mode

CTRL+I Control operating mode | Opens the dialog box for control of the

Only possible in online operating mode

mode

Shortcuts Menu item Reaction

View...

CTRL+F11 Maximize working area Maximizes and minimizes the view of the
working area

CTRL+F12 Maximize detail view Maximizes and minimizes the view of the detail
view

CTRL+Num+ Zoom in Magnifies the diagram in MCC

(Plus key on the numeric

keypad)

CTRL+Num- Zoom out Reduces the diagram in MCC

(Minus key on the

numeric keypad)

F5 Refresh Refreshes the view

Shortcuts | Menu item | Reaction

Options...

CTRL+ALT+E | Settings ’ Opens the Properties window

Shortcuts | Menu item | Reaction

Window...

CTRL+SHIFT+F5 Arrange cascading Arranges the opened windows in the working

CTRL+SHIFT+F3 | Arrange vertically area

SIMOTION SCOUT
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Shortcuts Menu item Reaction

Snap-in menu...

CTRL+F4 Close Closes the selected window

CTRL+B Accept and compile Compiles the active object

CTRL+E Expert list Opens the expert list for the current technology
object

Shortcuts Menu item Reaction

ST source file

Ctrl+space Automatic completion

Ctrl+F2 Set and delete bookmarks

Ctrl+F4 ST source file > Close Close ST source file

Ctrl+F7 ST source file > Switches the program status function on or off

Program status on/off

Ctrl+Shift+F2 Delete all bookmarks in the ST source file

Ctrl+Shift+F3 Arrange windows, tile horizontally

Ctrl+Shift+F5 Arrange windows, tile vertically

Ctrl+Shift+F8 Format selected area

Ctrl+Shift+F9 Move cursor to the start of the current or
higher-level block

Ctrl+Shift+F10 Move cursor to the end of the current block

Ctrl+Shift+F11 Move cursor to the start of the higher-level
block, 1st level

Ctrl+Shift+F12 Move cursor to the start of the higher-level
block, 2nd level

Ctrl+Alt+B Display bracket pairs in the current ST source
file

Ctrl+Alt+C Folding: Hide all blocks of the current ST
source file

Ctrl+Alt+D Folding: Display all blocks of the current ST
source file

Ctrl+Alt+F Folding: Display or hide folding information in
the current ST source file

Ctri+Alt+l Display indentation level in the current ST
source file

CtrI+Alt+L Display or hide line numbers in the current ST
source file

Ctrl+Alt+R Folding: Display all subordinate blocks

Ctrl+Alt+T Folding: Show/hide block.

Ctrl+Alt+V Folding: Hide all subordinate blocks

Ctrl+Alt+W Display or hide spaces and tabs in the current

ST source file

Ctrl+ADD (numeric
keypad)

Increase font size in the current ST source file

42

SIMOTION SCOUT
Configuration Manual, 05/2009



Functions

3.2 Menu structure

Shortcuts | Menu item Reaction
ST source file
Ctrl+MINUS Decrease font size in the current ST source file
(numeric keypad)
Ctrl+DIV (numeric Increase font size in the current ST source file
keypad) to 100%
Alt+Shift+arrow key Select text by column
Alt+Shift+L Change selected text to upper case
Alt+Shift+U Change selected text to lower case
Shortcuts Menu item Reaction
MCC
CTRL+F4 Close Closes the MCC unit
ALT+Enter Properties Opens the MCC Unit Properties window
CTRL+R Insert MCC chart Insert a new MCC chart
CTRL+F7 Program status Switches monitoring on/off
CTRL+F8 Monitor
CTRL+F9 Single-step
CTRL+F10 Next step
Return - Opens the MCC configuration dialog
Arrow keys - Changes within the tab
Shortcuts | Menu item Reaction
LAD/FBD (source or program)
CTRL+F4 Close Closes the MCC unit
ALT+Enter Properties Opens the MCC Unit Properties window
CTRL+R LAD/FBD source: Insert | Inserts a new LAD/FBD program
LAD/FBD program
LAD/FBD program:
Insert network
CTRL+L Jump label On/Off Switches jump labels on and off

CTRL+SHIFT+K

Display/comment On/Off

Switches comments on and off

CTRL+SHIFT+B

All box parameters

Displays all box parameters

CTRL+T

update

Symbol check and type

Performs symbol check and type update

CTRL+F7

Program status

Switches monitoring on/off

F2 for LAD

F2 for FBD

make

box

Insert element / Insert

contact element / AND

Inserts a make contact

Inserts an AND box

F3 for LAD

F3 for FBD

break

box

Insert element / Insert

contact element / OR

Inserts a break contact

Inserts an OR box
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Shortcuts | Menu item Reaction
LAD/FBD (source or program)
F7 for LAD Add element/Add coil Adds a coil
Add element/Assignment
F7 for FBD Adds an assignment
F8 for LAD Insert element / Insert Inserts an Open branch
Open branch
element / Insert binary
F8 for FBD input Inserts a binary input
F9 for LAD Insert element / Insert Inserts a Close branch
Close branch
element / Invert binary
F9 for FBD input Inverts the binary input
ALT+F9 Insert element / empty
box
Ctrl + 3 Switch to FBD Switches the display
Ctrl +1 Switch to LAD
Shortcuts Menu item Reaction
Help...
SHIFT+F1 Context-sensitive help Opens the context-sensitive help function for
the selected object, parameter, etc.
Shortcuts Menu item Reaction
Hardware configuration...
CTRL+U Address overview Opens the Address Overview window
(In HW Config)
F4 Optimize layout
Shortcuts | Menu item | Reaction
Drive control panel
F8 Enable (bit 1 to bit 6) - Enables or disables controller
PC
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3.24 Using context menus

The tree elements of the project navigator have context menus. These provide quick access
to all major functions enabled for this tree element.

To call up a function for the tree element via context menus, proceed as follows:
1. Left-click the relevant tree element in the project navigator.

2. Right-click.

3. Left-click the appropriate menu item.

Open HW configuration

Cuk
Copy
Faste

Delete
Rename
Compare. ..

v Connect onling
Target device 3
Test mode. ..
Pebug task group
Debug table

Save vatiables ...
Restore variables ...

Confiqure execution system
Set system cycle clocks, .,

Select technology packages
Licenses

Load to file system

Object states. ..

FastIO »
Expert »
Reference data 3
Check consistency

Save and compile all
Save and recompile all

Properties. ..

Figure 3-2  Example of a context menu
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3.3 Project navigator

3.3.1 Using the project navigator

The project navigator in the SIMOTION SCOUT workbench
As standard, the project navigator has two tabs, the Project and Command library tabs.

The Project tab displays the entire project structure and is used for managing elements
within the projects.

The commands and functions required for the programming are displayed in the Command
library tab. You can search in the command library or set filters. You can use commands and
functions in the ST, LAD/FBD and MCC programming languages, e.g. for the creation of
conditions. In the MCC programming language, the functions are used, e.g. via the ST zoom
or the system function call command.

3.3.2 Creating elements

Elements in SIMOTION SCOUT
There are two different ways to insert elements in the project navigator tree:

Inserting hardware
Integrate hardware using:
e SIMOTION device element: Create new device
Alternatively, you can also call up the Insert > Hardware menu.

e Drive element: Insert single drive unit

Note

You can insert a standalone drive (e.g. SINAMICS S120) with the Insert single drive unit
element in the project navigator. It is commissioned using wizards in the working area of
the workbench that contains the Starter functionality.
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Elements within a SIMOTION device
Create the following elements within a SIMOTION device directly in the project navigator:

® Technology objects, e.g.:
Axes, external encoders, cams, measuring inputs, output cams, synchronous operation,
temperature channels, path objects

® Programs:
— Insert ST program
— Insert MCC unit
— Insert DCC charts
— Insert LAD/FBD unit
Other elements are created automatically, e.g.
® \When creating a project:
— LIBRARIES: Insert library/DCC library
— MONITOR: Insert watch table
® \When inserting a SIMOTION device:

— AXES, EXTERNAL ENCODERS, PATH OBJECTS, CAMS, TECHNOLOGY,
PROGRAMS folders

— EXECUTION SYSTEM, I/0, GLOBAL DEVICE VARIABLES elements
® \When creating an axis:

— MEASURING INPUTS, OUTPUT CAMS folders

— Access to the configuration views
® Additionally when creating a following axis:

— Synchronous operation element
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Displaying the station level of a SIMOTION device

The function provides a better transparency in large SIMOTION SCOUT projects. A project
with several SIMOTION devices and a large number of drives can be displayed in a
structure. The assignment in station levels, as is well known from SIMATIC STEP?7, is used.

Note

Optionally, the associated SIMATIC station of the SIMOTION device in the project navigator
can be displayed. In this way, all drive units that are assigned to a SIMATIC station are also
displayed in this structure.

Proceed as follows to activate or deactivate this function:
1. In the SIMOTION SCOUT, click the Options > Settings function.
2. Click the Workbench tab.

3. Activate/deactivate the Display station level function.
The project must be reopened for this to take effect.
When the function is activated, all drive units associated with a STEP7 station are also
displayed under this station.
When the function is deactivated, all drive units are displayed under the project.

4. Click OK to confirm the change.

Opening HW Config of a SIMOTION device
To call up the hardware configuration of a previously inserted SIMOTION device:

e Select the required SIMOTION device in the project navigator and select Insert >
Hardware in the menu, or

® |n the project navigator, double-click the SIMOTION device whose hardware
configuration you wish to open or

® Select the desired SIMOTION device in the project navigator, open the shortcut menu
and click Open HW configuration.

Inserting a single drive unit
To open the Insert single drive element (e.g. MM4):

® |n the project navigator, double-click Insert single drive unit.

Inserting elements within a SIMOTION device
To insert technology objects, source files, or watch tables:
1. Open the SIMOTION device under which the element is to be created.
2. Select the relevant folder (e.g. AXES, PROGRAMS).
3. Select the desired function, e.g.:
— Insert > Technology object > ... menu or
— Insert > Program > ... menu or

— Insert > Watch table menu
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3.3.3 Changing properties of the elements

You can change the properties of various elements as follows:

/\CAUTION

Changing a name can have far-reaching consequences. References to the axis, particularly
in programs, are lost. This can cause runtime errors in the program. Make sure that you
also change all name references.

1. In the project navigator, select the element to be edited, e.g. a specific axis or a specific
program.

2. Select the menu: Edit > Object properties.

Note
You define the hardware properties in the hardware configuration.

To rename an element:

1. Select the element you wish to rename in the project navigator.

2. Open the shortcut menu and select Rename.

3. Confirm the warning message.

4. Enter a new name and confirm the input by pressing the Enter key.

SIMOTION SCOUT
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3.3.4

3.4

Wizards for configuration support

Wizards are provided to assist you in configuring axes and external encoders. The wizards

guide you step-by-step through the configuration. Parameter interdependencies are taken
into account.

Axis configuration - Axis_1 - Drive assignment

‘which drive unit are pou using?

MASTERDRIVES_CEPZ 1
Log. Hw addiesses: Input: |25E Output: |25E
[CJEncoder aszighment
[ Complstion Which PROFIdrive message frame do you want to use for the data transfer?
IStandald message frame 5, PZ0-9/9 j Change PROF|drive message frame ... |

¥ Dynamic servo control [DSC)
[ Activate technology data black in the message frame

maximum motor speed IEUUU o pm

"T'ou can establish the connection to a diive an thiz page.For a diive on the PROFIBLS, the &
PROFIdrive message frame set in Hw' Config is used. Also for these dives, the rated speed

et here must also be set on the dive itself

If several data sets are used, the selection of the virtual axis is hidden. If pou want to set this

again, you must first remave all data sets apart fram the first ane. -

< Back I Mext > I Cancel | Help |

Figure 3-3  Axis configuration wizard - window for drive assignment

Using the working area

The workbench displays all of the snap-in working windows in the working area. Each snap-
in provides its own working window. You can open multiple instances of these windows. You
can, for example, open several programs at the same time for editing. For further
information, refer to the online help.

Using windows in the working area

50

You can change the size of the windows in the working area:

Click on the edge of the window, hold down the left mouse button, and drag the window to
the required size.

You can maximize or minimize each window using the shortcut CTRL+F11.

Each window opened in the working area can be accessed via a tab at the bottom edge of
the working area. To bring a window into the foreground:

® (Click on the relevant tab or

e Select the appropriate entry in the Window menu.
To close the window:

e Configuration dialog boxes: Click Close.

e Editors for MCC, ST and LAD/FBD:
Click the X button in the top right-hand corner.
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3.5 Detail view

3.5.1 Using the detail view

When you select an element in the project navigator, the associated detail view will appear in
the lower area of the workbench.

Various tabs are available depending on the element selected. The tabs available are
determined by the project mode (offline/online) and the active snap-ins.

x

Level | teszage

Information

Infarmation The automatically created communication configuration is up-to-date; create procedure skipped.
Infarmation Communications configuration successful

Infarmation D10 Create procedure of sounces successful

Infarmation Create procedure successful

|

= Symbol browser E Compiledcheck output |

Figure 3-4  Example of detail view

You can maximize or minimize each tab using the shortcut CTRL+F12.
Each tab is opened only once, i.e.:
® The active tab shows the details of the selected element.

® The contents of the tab change when you select a different element.

3.5.2 Using the symbol browser

The symbol browser in the detail view.

The symbol browser is a tab in the detail view. It displays status values of the variables for
the element selected in the project navigator.

To activate the symbol browser:
1. Select an element in the project navigator.

2. In the detail view, select the Symbol browser tab.

Continuous display of the symbol browser
To activate/deactivate the continuous display of the symbol browser:

Click the symbol at the top right of the the symbol browser (pin).
The active element is displayed continuously until this function is deactivated. To deactivate
this function, click the pin again.
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3.6 Adding add-ons to the workbench

Add-ons in SIMOTION SCOUT

SIMOTION provides you with the option of enhancing the functionality or accommodating
customer-specific requirements. You can integrate add-ons. The CamTool add-on is
currently available.

Note

More detailed information about the CamTool add-on is contained in the CamTool
configuration manual or the associated online help.

Add-ons are added to the workbench and are displayed as fully integrated:

® Menus and toolbars appear at the appropriate position in the workbench. After installation
of add-ons, the menus are visible and the toolbars are active.

® The working windows appear in the working area of the workbench and have tabs.

® The detail view of the workbench shows details about the currently active add-on. If the
associated details are distributed over several tabs, you can select the relevant tab and
place it in the foreground.
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3.7 Online help

3.71 Structure of the online help

SIMOTION SCOUT has a comprehensive context-sensitive help.
Examples of using the online help can be found under:
SIMOTION SCOUT > Help > Using help

_lo/x|
&= = i
Aushlenden Zurick “onwarts Aktualisisren Diucken Optionen PDF Documents  Using Dnline Help

Inhalt |Index I §uchan|

Gietfing Started with SIMOTION SCOUT
= m SIMOTION SCOUT
SIMOTION SCOUT
= ([ General
[2) Wworkbench Stucture

Praject M avigator Mote
?] Wworking Area
[2] Detail View

Using the Help

SIMOTION SCOUT and STARTER have a comprehensive context-sensitive help. The following is a description of
how to wark with the help system using a number of examples

In Wersion 4.1.1, problems may occur when calling PDFs from the help with Acrobat Reader 8.x. If the PDFs
are not apened, uninstall Acrobat Reader 8 and install anather wersion, e.q. Version 7.

o
Q warking with SIMOTION SCOUT
Cartrol Elements of the Workbench

;%Sm Help for help

0 ‘working with the SCOUT Workbench

@ SIMOTION Devices

@ Configuie Drives
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0 Configuring dxes

Structure of the anline help window

Help in the project navigator

Help far the cammand library {only SIMOTION)
Help far the detail view

@ Technology Objects # Help for the expert list
Q Programming # Help for the LAD/FDE editor (only SIMOTION)
Q Diagnnstics # Help for the link table
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Figure 3-5  Help for online help
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3.7.2 Types of online help

The following types of online help are available:
e Entire help
To open the entire help:

In the SIMOTION SCOUT menu bar, select Help > Help topics or press the F1 key. The
entire help is displayed.

e Getting Started with SIMOTION SCOUT
To open Getting Started:

In the menu bar, select Help > Getting Started.
All new functions for the current version are listed here in an overview. On the left-hand side,
on the Content tab, select Getting Started with SIMOTION SCOUT.

e Help button
To open the help:

Click the Help button in the respective dialog box or window.
The context-sensitive help for the dialog box is opened.

® Context-sensitive help
To open the context-sensitive help:

1. Press the SHIFT+F1 keys, click the button in the function bar or select
Help > Context-sensitive help in the menu bar.
The cursor changes to a question mark.

2. Use the mouse pointer to click on, e.g. dialogs, parameters, input fields, menu items,
command libraries, expert lists, symbol browsers or objects in the project navigator.
The context-sensitive help for the selected entry is displayed.

3.7.3 Searching in the online help

54

You can carry out a full-text search throughout the entire help in the Search tab.

With a full-text search, you have to consider certain points to ensure that the search is
successful. A simple search according to subject consists of the word or expression that you
want to find.

To refine your search, you can use wildcard expressions, nested expressions, Boolean
operators, similar word hits, the previous result list or subject titles.

To carry out a full-text search:
1. In the menu bar, select Help > Help topics or press key F1. The entire help is displayed.

2. Click the Search tab and enter the search term. You can add Boolean operators by
clicking the arrow next to the input field.

Note

If you enter the term Sysfem, this term is sought throughout the entire Help. Only the

Help pages that contain the word System are found. Compound words, e.g. Systemclock
are not found. Therefore it is usually more appropriate to search with wildcards if you are
not searching for a definite term, e.g. “sysfem*returns all the results that contain system.

SIMOTION SCOUT
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3. Click List subjects to start the search. The search returns a maximum of the first 500 hits.
If you want to sort the subject list, click Title, Position or Order.

4. Double-click the desired subject to display the Help page. The found terms are
highlighted on the page.

Note

If the terms are not highlighted or you want to switch the highlighting off, click the Options
button and select Activate/deactivate search term highlighting in the menu displayed.

You can also search just within the last result list, include similar word hits or only search the
subject titles in the table of contents.

In the case of multiple matches, a clearer overview can be obtained by sorting them with
Position , as the search results will then be arranged according to the associated topic.

Additional references
You can find more information about this subject in the online help.

3.74 Getting Started in SCOUT

Contents and settings in Getting Started with SIMOTION SCOUT
When SIMOTION SCOUT is opened, the online help offers a New to SIMOTION overview by

default.
il
hE <= = = - [9] @)
Ausblenden Zuriick onwEits Aklualisieren Diucken Optionen FDF Documents  Using Online Help
Inhalt Ilndek | ﬁucheml -
New Functions for SIMOTION 4.1 SP2 and SP3

= @ Getting Started with SIMOTION SCOUT
@ Mew Functions for SIMOTION 4.1 SP2 and SP:
[2] Overview of Geting Started with SIMOTION ST If you want to continue working with the Getting Started, see Overview of Getting Started.
@ General Information
@ Creats Project
0 SIMOTIOM Devices and Hardware Configuratic
@ Inzert Auis

The following new functions are available for SIMOTION W41 5P2 and SPa:

@ Save and Compile Functions for improved handling during c issioning and diag ics:
@ ONLINE and Download
@ Test with the Avis Control Panel » Project comparison: Quick and detailed detection and resolving of differences

@ working with Varisbles

Q Programming Languages

@ Execution Spstem

Q Compile Programs and Project
@ Monitoring Sequences

Q Ingerting and Configuring Drives
@ Test with the Drive Control Panel

Interconnection overview: Quickly finding relations in the object maodel
Simplification of upgrade: Upgrade, e.g. with USB stick

Extensions to download during RUN: E.g. technology objects, MotionTasks
Task trace: Effective troubleshooting/optimization in the user program
Diagnostics without SCOUT: Significant extensions for SIMOTION IT DIAG

MNew functions or hardware

o C240PN: Mew hardware, first supported with W4.1 SP2 HF2

» D445-1: Mew hardware, first supported with Wa.1 SP2 HF3

« New ST editor: Powerful editor

A large nurnber of function restrictions have been eliminated with SIMOTION w41 SP3.

Detailed information about the new functions can be found on the SCOUT Add-on CD at
M_ImportantEnglishtFeatures

4] | Bl

Figure 3-6  Online help
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In the Content tab, select Getting Started with SIMOTION SCOUT. You can deactivate this
function.

Getting Started provides a brief overview of how you can work with SIMOTION SCOUT. A
typical example is used to show you the different steps required to create a project and
introduces the configuration, programming, and diagnostic tools.

In addition, the right-hand window provides an overview of which new functionalities are
available in the latest version of SIMOTION.

Deactivating the Getting Started with SIMOTION SCOUT online help

To deactivate the default setting that automatically opens the online help when you launch
SIMOTION SCOUT:

1. In the menu bar, select Options > Settings...

2. Click the Workbench tab.

3. Uncheck the Display "Getting started" at start checkbox.
4. Click OK.

Opening the Getting Started online help
To reopen Getting Started at any time:
In the menu bar, select Help > Getting Started.

3.7.5 Error remedy

If error messages appear in the detail view in the SCOUT workbench, you can call up
detailed information in the online help. This is possible for technology objects, alarms and
alarms for drive units and 1/O devices. To do this, click the Help for event button.

Otherwise, additional information about the error text can be found using the complete text
search.
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3.8 Project comparison

You can use the SIMOTION SCOUT/Project comparison starter function to compare objects
within the same project and/or objects from different projects (online or offline) with one

another.

Objects are devices, programs, technology objects (TOs) or drive objects (DOs), and

libraries.

The project comparison is available with SIMOTION SCOUT and Starter. Comparing
projects is useful if you need to carry out service work on the system.

1. Start the project comparison by clicking the

[

Start object comparison button.

2. The Select Comparison Partners dialog is displayed. Select the projects to be compared.

Select Comparison Partners

IF'miekt_.-’-\ - chprogram fileghsiemenshetepyhe o

e SIMAMICS Integrated
il 0435

r— Comparison partner A: — Comparison partner B:
SINAMICS _Integrated

X

Device from the
opened project

= Device from a
zaved project

Device from the
target system [onling]

ISINAMIES_Integrated

IWS_Ubung - C:AProgram FileshSiemenshSte) @l

I SINAMICS Integiated

Start comparizon Cancel

Help |

Figure 3-7  Select comparison partner dialog

References

For detailed information, refer to:

® Function Manual: SIMOTION Project Comparison

e SIMOTION SCOUT Online Help
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Online multiuser mode

Thanks to the new project comparison, device upload and download with supplementary
data functions, several users can exchange project data that has been modified via the
target device, online. This allows them to synchronize the status of their own

SIMOTION project with that of another one, thereby updating it.

In online multiuser mode, it is possible for two people to work online on the same
SIMOTION device. The following functions can be performed:

e Reading and controlling of system variables and configuration data

® Execution of measuring functions and axis control panel

® Uploading of configuration data

e Uploading of programs or technology objects and other settings (e.g. execution system)
e Editing and downloading of programs (following prior alignment, if applicable)

The following graphic shows a schematic representation of online multiuser mode:

PG1 PG2
SIMOTION SCOUT project editor A SIMOTION SCOUT project editor B
Author = Editor A Author = Editor B
Project comparison Project comparison
2 3
[2] [2]
c c
Offline g Online Offline g Online
© ]
8 8
X / Wal
Uplpad Downlgad
Download Upload

Target device

Figure 3-8  Schematic representation of online multiuser mode

Editors A and B are working on one SIMOTION project at the same time. Changes made by
both editors are loaded to the target device. The project must be synchronized beforehand,
otherwise parts of it could be found to be inconsistent and subsequently overwritten when
the Load project to target device command is executed.

This means, for example, that Editor A must synchronize his project with Editor B's project
before loading it to the target device. This can be done via the synchronization mechanism in
the project comparison facility.
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3.10.1
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Figure 3-9

Basic steps

Overview

Synchronizing project data via the project comparison function

3.10 Basic steps

In order that the machine or plant can perform the desired tasks, you must carry out the
following steps with SIMOTION SCOUT:

Create a project:

The project is the generic term under which you store all of the relevant files.

Configure hardware:
Provide the SIMOTION system with information about the hardware.

Configure technology objects (TO):

Provide the SIMOTION system with information about the technologies used.

SIMOTION SCOUT provides wizards for comprehensive assistance.

Create and test open-loop and closed-loop control programs.

Commission and optimize drives and axes.

Test the system and utilize the diagnostic options.

SIMOTION SCOUT provides the workbench to enable you to perform these steps easily and
efficiently.

Configuration Manual, 05/2009
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3.10.2 Basic settings of SCOUT

In SCOUT, you have the possibility of predefining various basic settings via the Options >
Settings menu. Detailed information on the individual tabs and settings is provided in the
SIMOTION SCOUT online help.

1. Open SIMOTION SCOUT.

2. Click the Options > Settings... menu.
The Settings window is opened.

3. Select the desired tab.
4. Enter the settings.
5. Click OK.

3.10.3 SIMOTION SCOUT project

The project is the highest level in the data management hierarchy. SIMOTION SCOUT
saves all data which belongs, for example, to a production machine, in the project directory.
The project is therefore the sum of all data, programs, settings, etc.

The project encompasses all of the SIMOTION devices, drives, etc., that belong to a
machine. The axes, external encoders, path objects, cams, technology, and programs are
assigned hierarchically to the respective devices. This hierarchical structure is displayed in
the project navigator.
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3.104 Creating a new SCOUT project

Note
For further information, refer to the online help at: "Getting Started with SIMOTION SCOUT".

To create a new project:

SIMOTION SCOUT

1. Open SIMOTION SCOUT from the Start menu on the Windows desktop:

Start > SIMATIC > STEP 7 > SIMOTION SCOUT.
Or double-click the SIMOTION SCOUT icon on your PC desktop.

SIMOTION SCOUT starts the workbench and the HTMP help.
Getting Started with SIMOTION SCOUT is displayed.

. In the workbench menu bar, select Project > New.

The New Project window opens.

Note

SIMOTION SCOUT creates a directory with the selected name. All files relevant to the
project are stored in this directory.

Directory names and file names are shortened to 8 characters. If you assign longer
names, these are displayed in SCOUT. However, these names are only managed with 8
characters in the Explorer.

Special characters may not be used.

New Project x|

zer projects |
I ame | Storage path :I
% cz240 C:%Program FileshSiemenshStepMa7proiC240
% D410 C:%Program FileshSiemenshStepPefprofD 410
% 0445 praj C:%Program FileshSiemenshStep?a7proiD 445
@ DSC_MCP_3msz  C:A\Program FileshSiemenshStephe?profhDSC_:
% myProject C:\Program Filesh\Siemens\Step?a7projhmyPre
% Profinet_1 C:%Program FileshSiemenshStep a7 profsProfin
rraiaka 4 Derararn Filash Giarmaneh GhanTh = Frrnis nrnioh
il T

[™ &dd to current multipraject

M armne: Tivpe;
ISCDUT_pmi_'H IProiecl 'I
™ F Litrary

Storage location

IC:\ngram Filez\Siemensh\Step?ha7proj Browse... |
ol | e |

Figure 3-10 Creating a new project
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3. Enter the following data in the dialog box:

— Name:
Select a name for the project.

— Storage location (path):
The default storage location (path), where the new project is to be stored, is displayed
here.

4. Click OK to confirm.

The new project appears in the project navigator with an icon and its full name. The
associated tree is expanded.

HME SIMOTION SCOUT - SCOUT_proj_1 _lo|x]|

Project Edit Imsetk Targetsystem  View Options  Window Help
=

| Dics|@%| & & %] =] x| =] | 1%l | 2alf5 | -] ] | la)]| )
=] |

=-Ep sCoUT proj_t
M7 Create new device
- Insert single drive unit
(-] LIBRARIES
-] MONITOR

Praoject I Command library I

x

=== Symbol browser |

Press F1 ta open Help display. |pC AdapteriPROFIBUS) Offline mode [ o [
Figure 3-11  Workbench with new project

The following entries are located beneath the project name in the project navigator:

e Create new device element. Double-click on this symbol to select the required SIMOTION
device, create and configure a new subnet and insert the new device in the HW Config
program.

¢ |nsert single drive unit element. Double-click on this symbol to insert and commission a
stand-alone drive (e.g. MM4 Basic). Although this drive cannot be linked to or configured
in the master system of the project using a PROFIBUS DP connection, it appears in the
project navigator within the project.

® Folder labeled LIBRARIES
® Folder labeled MONITORING
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3.10.5 Opening an existing project

To open a project saved on the hard disk of the PC:
You can open projects that SIMOTION SCOUT has stored locally (e.g. on the hard disk).
1. Select the Project > Open menu.

2. In the User projects tab, select the desired project.
If the project you want is not stored according to the default path: Click Browse... and
follow the instructions on the screen.

3. Click OK to confirm.

If you want to open a project that was created in an older version, a message appears
asking whether the project should be converted to the newer version. This function is
available since SIMOTION SCOUT Version V3.1.

Note

The Save as function saves all previously made changes in either a new or in an existing
project.

This means when you change an existing project and save with a different name, you must
do this before you make any changes in the existing project.

x|
User projects | Sample projects I
Marme | Storage path :I

% D410 C:\Program Files\Siemens\Step?s7profh D410

% [Dd45_ proj C:%Program FileshSiemenstStepedprofD 445

% DSC_MCP_3ms  C:\Program Files\Siemenz\Step7\s7profDSC_

% riyProject C:%Pragram FileshSiemens\StepMe?prafmyPre

% Profinet_1 C:%Program FileshSiemenssStepy a7 profsProfi

% projeta C:%Program FileshSiemenshStep s 7profprajet

User Projects: 1
LLibraries:

Sample Projects:

tLilliprojects: Browse. .. |
ot | i |

Figure 3-12  Opening a project stored on the hard disk
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Note
The workbench displays one project at a time.

If you wish to display two projects at the same time, e.g. in order to copy/paste parts of a
project, start SIMOTION SCOUT a second time.

3.10.6 Using program editors

Editors in SIMOTION SCOUT
Three editors are available for creating programs:

Optional editors

Graphics-based editor for creating MCC charts.

You program by arranging symbolic program commands similar to a flow diagram and
assigning parameters to these commands.

Text-based editor for creating ST source files.

ST is a text-based programming language in compliance with IEC 1131-3, expanded to
include motion commands (system functions for the technology objects). An ST source
file can encompass several programs.

Graphics-based editor for creating ladder and function block diagrams. (LAD/FBD)

The ladder logic statement syntax corresponds to a circuit diagram. LAD statements
consist of elements and boxes, which are graphically connected to networks. The LAD
operations work according to the rules of Boolean logic.

FBD uses the logic boxes familiar from Boolean algebra to map logic. You can represent
complex functions (e.g. mathematical functions) directly in connection with the logical
boxes.

FBD provides all the elements required for the creation of a complete user program. FBD
features a powerful command set. This includes the various basic operations with a
comprehensive range of operands and how to address them. The design of the functions
and function blocks enables you to structure the FBD program clearly.

CamTool for the easy creation of cams using a graphical editor

DCC graphical editor based on CFC. SIMOTION controllers and SINAMICS drives can be
configured graphically.

Additional references
Please refer to the following documents on this subject

64

SIMOTION MCC Motion Control Chart Programming and Operating Manual
SIMOTION ST Structured Text Programming and Operating Manual

SIMOTION LAD/FBD Programming and Operating Manual

Programming and Operating Manual SINAMICS/SIMOTION Editor description DCC

and the SIMOTION SCOUT online help.
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Figure 3-13  Program editors

SIMOTION SCOUT
Configuration Manual, 05/2009

65



Functions
3.11 HW Config

3.11 HW Config

3.11.1 Inserting and configuring a SIMOTION device

Configure the hardware using the HW Config module. This informs the SIMOTION system
which hardware is present, e.g.:

® Type of SIMOTION device

e Type of the /O modules

® Type of the drives

In addition, you also specify which parameters the SIMOTION system should use, e.g.:
® Configuration of the SIMOTION device

e Configuration of PROFIBUS/PROFINET

e Assignment of the hardware to PROFIBUS/PROFINET

In this section, you learn how to use the HW Config tool:
® How to insert objects from the hardware catalog.
® How to edit objects.

® How to replace or delete objects.

3.11.2 Starting HW Config
HW Config can be started, e.g. to add a drive to the PROFIBUS.
To start HW Config:
® Double-click on the appropriate SIMOTION device in the project navigator or

® Select the appropriate device in the project navigator and confirm your selection in the
Open HW configuration shortcut menu or

e Select the appropriate device in the project navigator and select the Insert > Hardware
menu.

SIMOTION SCOUT
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3.11.3 The HW Config program
The HW Config program is displayed as follows:

e A hardware catalog window
® A working window that is split into two:

— In the upper half, you can see the rack or station frame with the CPU previously
automatically inserted in slot 2 (example for C2xx).
Insert the objects from the hardware catalog and edit them here.

— In the lower half, you can see detailed information about the selected objects.

[ Hw Config - [SIMOTION € (Configuration) -- DSC_MCP_3ms] | _ (Ol x|
EIHI] Station Edit Imsert PLC View Options ‘Window Help _ & ﬂ
DSs8 B S il M G =N
= o=l
=R
Find: H i
3 — Firn S
2 g} C230 Profile: Standard <
xg 04| oP7 ;
XD DRI PROFIBUS[1]: DP master spstern (1] T"E?' FROFIRLG OF
X7 £4 T !5’5! FPROFIBUS-PA
XT BEADA +] !5'5! FROFIMET 1O
X3 Anish_ | EIIMASTEI o SIMATIC 300
— ‘. CET +] SIMATIC 400
0% IIII o[l SMATIC PCEased Control 3004400

-8, SIMATIC PC Station
- [§ SIMOTION Drive-based

Order number Fimware | MPl address | | address 0 addiess Comment

BAUT 230-2AA01-0AAD

PROFIBUS-DF slaves for SIMATIC 57, ¢
7, and C7 [distributed rack) =

: = -

Press F1 to get Help,

Figure 3-14 HW Config with opened hardware catalog and the CPU previously inserted in the module

3.11.4 HW Config: Opening the hardware catalog
You can open the hardware catalog in the following ways:
e Select the Insert > Insert object menu.
® Select the View > Catalog menu.
For additional information, see

Chapter Inserting drives (Page 144)

SIMOTION SCOUT
Configuration Manual, 05/2009 67



Functions

3.11 HW Config

3.11.5 SIMOTION devices in the hardware catalog

You can find the SIMOTION devices in the corresponding directories of the
hardware catalog.

Table 3-5 SIMOTION device directories in the hardware catalog

SIMOTION SIMATIC station Subdirectory
device
C230-2 SIMATIC 300 CPU-300\CPU C2x0\6AU1 230-2AA00-0AA0\V3.0

CPU-300\CPU C2x0\6AU1 230-2AA00-0AA0\V3.1
CPU-300\CPU C2x0\6AU1 230-2AA00-0AA0\V3.2

C230-2.1 SIMATIC 300 CPU-300\CPU C2x0\6AU1 230-2AA01-0AAQ0\V3.2
CPU-300\CPU C2x0\6AU1 230-2AA01-0AA0\V4.0
CPU-300\CPU C2x0\6AU1 230-2AA01-0AA0\V4.1

C240 SIMATIC 300 CPU-300\CPU C2x0\6AU1 240-1AA00-0AAQ0\V4.0
CPU-300\CPU C2x0\6AU1 240-1AA00-0AA0\V4.1
CPU-300\CPU C2x0\6AU1 240-1AA00-0AAQ0\V4.1 - PN V2.2
P350 SIMATIC PC station SIMOTION P350\6AU1 350-XXXXX-XXX1\V3.0

SIMOTION P350\6AU1 350-XXXXX-XXX1\V3.1

SIMOTION P350\6AU1 350-XXXXX-XXX1\V3.2

SIMOTION P350\6AU1 350-XXXXX-XXX1\V4.0 - V2 box
P350-3 SIMATIC PC station SIMOTION P350\6AU1 350-XXXXX-XXX2\V4.0 - V3 box
SIMOTION P350\6AU1 350-XXXXX-XXX2\V4.1 - DP
SIMOTION P350\6AU1 350-XXXXX-XXX2\V4.1 - DP/PN V2.1
SIMOTION P350\6AU1 350-XXXXX-XXX2\V4.1 - DP/PN V2.2
SIMOTION P350\6AU1 350-XXXXX-XXX2\V4.1 - PN V2.1
SIMOTION P350\6AU1 350-XXXXX-XXX2\V4.1 - PN V2.2

D410 Drive-based SIMOTION | SIMOTION D410\6AU1 410-0AA00-0AA0\V4.1 - SINAMICS S120 V2.5
(PROFIBUS interface) V4.1 SP1

SIMOTION D410\6AU1 410-0AB00-0AAQ\V4.1 - PN V2.1
SINAMICS S120 V2.5(PROFINET interface) V4.1 SP1

SIMOTION D410\6AU1 410-0AB00-0AAQ\V4.1 - PN V2.2
SINAMICS S120 V2.5(PROFINET interface) V4.1 SP1

D425 Drive-based SIMOTION | SIMOTION D425\6AU1 425-0AA00-0AA0\ V3.2 SINAMICS S120 V2.2
SIMOTION D425\6AU1 425-0AA00-0AA0\ V3.2 SINAMICS S120 V2.3
SIMOTION D425\6AU1 425-0AA00-0AA0\ V4.0 SINAMICS S120 V2.4

SIMOTION D425\6AU1 425-0AA00-0AA0\ V4.1 - PN V2.1
SINAMICS S120 V2.5

SIMOTION D425\6AU1 425-0AA00-0AA0\ V4.1 - PN V2.2
SINAMICS §120 V2.5
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SIMOTION SIMATIC station Subdirectory
device
D435 Drive-based SIMOTION | SIMOTION D435\6AU1 435-0AA00-0AA0\ V3.1 SINAMICS S120 V2.1

SIMOTION D435\6AU1 435-0AA00-0AA0\ V3.2 SINAMICS S120 V2.2
SIMOTION D435\6AU1 435-0AA00-0AA1\ V3.2 SINAMICS S120 V2.2
SIMOTION D435\6AU1 435-0AA00-0AA1\ V3.2 SINAMICS S120 V2.3
SIMOTION D435\6AU1 435-0AA00-0AA1\ V4.0 SINAMICS S120 V2.4

SIMOTION D435\6AU1 435-0AA00-0AA1\ V4.1 - PN V2.1
SINAMICS S120 V2.5

SIMOTION D435\6AU1 435-0AA00-0AA0\ V4.1 - PN V2.2
SINAMICS S120 V2.5

D445 Drive-based SIMOTION | SIMOTION D445\6AU1 445-0AA00-0AA0\ V3.2 SINAMICS S120 V2.2

SIMOTION D445\6AU1 445-0AA00-0AA0\ V3.2 SINAMICS S120 V2.3
SIMOTION D445\6AU1 445-0AA00-0AA0\ V4.0 SINAMICS S120 V2.4
SIMOTION D445\6AU1 445-0AA00-0AAQ\ V4.0 SINAMICS SM150 V2.4

SIMOTION D445\6AU1 445-0AA00-0AAQ\ V4.1 - PN V2.1
SINAMICS S120 V2.5

SIMOTION D445\6AU1 445-0AA00-0AAQ\ V4.1 - PN V2.1
SINAMICS SM150 V2.5

SIMOTION D445\6AU1 445-0AA00-0AAQ\ V4.1 - PN V2.2
SINAMICS S120 V2.5

SIMOTION D445\6AU1 445-0AA00-0AAQ\ V4.1 - PN V2.2
SINAMICS SM150 V2.5

SIMOTION D445\6AU1 445-0AA00-0AAT\ V4.1 - PN V2.1
SINAMICS S120 V2.5

SIMOTION D445\6AU1 445-0AA00-0AAQ\ V4.1 - PN V2.1
SINAMICS SM150 V2.5

SIMOTION D445\6AU1 445-0AA00-0AA1\ V4.1 - PN V2.2
SINAMICS S120 V2.5

SIMOTION D445\6AU1 445-0AA00-0AA0\ V4.1 - PN V2.2
SINAMICS SM150 V2.5

Add interfaces

SIMOTION SCOUT

The version of the SIMOTION D4xx listed here must not be confused with the version of the
drive firmware contained in SINAMICS integrated.

The SIMOTION D4xx is supplied with a specific version of the drive firmware. If you insert a
SIMOTION D4xx into a project, this specific version is used as default version and displayed
in the "Properties". When the SINAMICS integrated firmware is updated, the firmware must
first be physically replaced and then the drive firmware version changed in the "Properties".

After inserting the SIMOTION device, the Properties - PROFIBUS DP Master Interface
(R0/S2.1) window appears. Create the PROFIBUS DP subnets and configure the SIMOTION
device interfaces in this window.

Note

The PCI integrated PROFIBUS subnet is created and configured automatically for the
SIMOTION D4xx. The user may neither configure nor select it!
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When the SIMOTION device is inserted into the rack, all interfaces and the PROFIBUS
subnets that you have created are displayed at the same time.

E{d‘ HW Config - [SIMOTION D {Configuration) -- D44 5proj] = |E| |5|
@) Station Edit Insert PLC View Options ‘Window Help =]

D@28 %@ = o dda BHE %8

= ol x|
1 [0 SIMOTION D45
& :I End | ﬂﬂ ﬂﬂ
PROFIBUS Integrated: DP master spstem (1] Profie: ISlandard j
1 =B PROFIBUS DP
7 SINAMI %% PROFIBUS P4
(-5 PROFINET IO
m & SIMATIC 300
) SIMATIC 400

SIMATIC PC Based Contral 300/400
-8, SIMATIC PC Station

= SIMOTION Drive-based

-7 SIMOTION D410

B SIMOTION D425

_l;l - SIMOTION D435
1l | L =0 SIMOTION D445

10 BALIT 445-08400-0440
:I:I FPROFIBLS Integrated: DF master spstemn (1] ;

B W32 SINAMICS 512022
PROFIBUS address Order number ... | Firmware Diagnostic ad... | Comment
E B SANAMICS Fnfegratec

B 4.1 SINAMICS SM1B0W2E

Bl 445-04A00-0440 £, |
D445 Mation Controller with CEE30 PN 10; Firmware 4.1
with SINAMICS 5120 V2.5

Press F1 ko get Help, [ [ A

Figure 3-15 Hardware configuration of a D4x5

Detailed information on the configuration of the SIMOTION device is contained in the
corresponding documentation for the SIMOTION devices.

3.11.6 Inserting a SIMOTION device in the rack

Example: How to insert the SIMOTION C240 in the rack:

1. Open the SIMATIC 300>CPU-300 > CPU C2x0 > 6AU1 240-1AA00-0AAQ > V4.1 folder
in the hardware catalog.

2. Use drag-and-drop to drag the required CPU version to rack slot 2.

Note

The slot rule is applied automatically. The SIMOTION C2xx can only be inserted into
slot 2.

SIMOTION D4xx can not be added to slot 2, but needs to be fitted to the module holder
(rack).

SIMOTION SCOUT
70 Configuration Manual, 05/2009



Functions

3.12 Licensing

3.11.7 Changing the SIMOTION device

Prerequisite

You will only need to perform this operation if you intend to upgrade a kernel or change a
platform within the same station type.

Swapping modules between SIMOTION families

A module replacement can be made within a device family (SIMOTION C2xx, P350, D4x5 or
D410 devices).

Changing between the SIMOTION C2xx, P350, D4x5 and D410 families is only possible
using an XML export.

For further information about replacing the device, see the section titled Replacing the
SIMOTION device (Page 79)

3.12 Licensing

3.12.1 Licensing of the runtime components

3.12.1.1  Overview for the licensing
Functions can be licensed using the following software options:

® Motion control technology functions
The licensing is performed axis-specifically for:

— POS - position; use of the technology functions for position axis
— GEAR; use of the technology functions for following axis
— CAM; use of the technology functions for cam axis

The GEAR technology function contains the POS technology function, while the CAM
technology function contains the POS and GEAR technology functions.

The MultiAxes package permits a simple licensing of the Motion Control technology
functions. It contains the license for the unlimited use of the CAM technology function on a
SIMOTION device, e.g. a C240, a D4x5, or a P350.
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TControl technology function
The TControl technology package is licensed channel-specifically, in packages of 8
temperature channels.

IT functions, IT-Diag and OPC XML-DA
The use of these functions is licensed for each SIMOTION device.

Note

Another option is to order SIMOTION memory cards (MMC and CF) and
SIMOTION P350-3 with pre-installed runtime licenses.

Additional references

Further important information for the licensing of the runtime software and the ordering data
can be found in:

Catalog: SIMOTION, SINAMICS S120 and Motors for Production Machines
PM 21 Catalog: Chapter 8 SIMOTION Runtime Software

Configurator for SIMOTION Runtime Licenses in the A&D Mall
(http://mall.automation.siemens.com)

3.121.2 Licenses and license key

Depending on the type and number of runtime components used in the project, licenses
must be acquired as part of the licensing procedure for SIMOTION. The licenses required for
a SIMOTION device are assigned to a license key. This license key is stored on the memory
medium of the SIMOTION device during the licensing procedure.

There are two ways of ordering the licenses:

Preinstalled licenses
The license key is already stored on the card.

Ordered licenses (Certificate of License)
These licenses must be assigned to the storage medium using the Web-License-
Manager. The determined license key is transferred to the hardware using SCOUT.

You require the following information to obtain the license key:

The serial number of the SIMOTION device memory medium
You can obtain the serial number from the memory medium or have it displayed online in
the SIMOTION SCOUT (licensing wizard).

The serial number of the CoL (Certificate of License)
You have this number on paper.

Table 3-6  The serial number on the SIMOTION hardware assigned to the SIMOTION device

SIMOTION device Hardware serial number of module
SIMOTION C2xx SIMOTION Micro Memory card
SIMOTION P350 SIMOTION IsoPROFIBUS-Board or

SIMOTION MCI-PN board

SIMOTION D4xx SIMOTION CompactFlash card
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License keys can be generated separately from the licensing.

Note

When the SIMOTION memory card is deleted or formatted, the licensing data is also
deleted. Archive the licensing data in order to be able to transfer it again to the memory
medium in such a case. If the data is not backed up, you have to perform the licensing again.
You can display the entered license key in the Web License Manager.

Additional information is available at:
Section License key is protected against deletion (as of kernel V4.1) (Page 76)

3.12.1.3  Determining licensing requirements

Note

Determine your license requirement only after you have completed the configuration! A
license that has been assigned a license key cannot be withdrawn.

Once you have completed your project configuration with SIMOTION SCOUT and before
you download it to the target device, you can determine the licenses required for the project.
You have three options for determining license requirements. Before you begin, the project
must have been saved and compiled. If you have not yet acquired any licenses,
underlicensing is displayed.

Options for determining license requirements are as follows:

e Offline mode with open project
The required licenses are displayed.

e Online mode with open project
A comparison of the required and actual licenses is displayed.

¢ Online mode without project
The actual licenses of the selected SIMOTION device are displayed.

Proceed as follows:
1. Select the SIMOTION device in the project navigator.

2. Select Licenses in the context menu.
The required licenses for the project or a comparison of required and actual licenses are
displayed.

3. You can close the window with X or continue with Perform licensing....
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The license check, i.e. the inspection of the license keys, is carried out in the target system.
Possible responses in the case of underlicensing are described in the Underlicensing
section.

Note

Memory cards can be purchased with integrated runtime licenses, which do not require
separate licensing.

3.12.1.4 Displaying existing licenses of the SIMOTION device

Displaying via accessible nodes

Requirements:

You can use the list of Accessible nodes to determine the specific licenses that have
already been assigned to the SIMOTION device. You can access the data of the SIMOTION
device directly.

Note

This step is not necessary if the required and actual licenses are displayed within a project.

e SIMOTION SCOUT is running
e SIMOTION SCOUT is in online mode

® No projects are open

Proceed as follows:

74

1. Select the Project > Accessible nodes menu.
The list of accessible nodes is displayed in the working area.

2. Select the relevant SIMOTION device.

3. Select Licenses in the shortcut menu.
The Licenses dialog box appears, showing the actual licenses for the selected
SIMOTION device.

4. You can close the window with X or continue with Perform licensing....

SIMOTION SCOUT
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3.12.1.5 Performing the licensing

To perform the licensing:

Once you have determined your actual license requirements, you can purchase the licenses
and then generate the required license key.

Requirements:

Proceed as follows:
1.
2.
3.

Configuration has been completed
The project has been saved and compiled
The required licenses have been determined

The license key has been determined or the serial numbers of the memory medium and
the CoL are available

SIMOTION SCOUT is in online mode

Select the relevant SIMOTION device in SIMOTION SCOUT.
Open the context menu and click Licensing.

In the Licenses dialog box, click Perform licensing...

If the Use wizard checkbox is activated, a wizard guides you through the licensing
procedure.

If the checkbox is not activated, the window for the expert licensing is opened. You can
enter the license key there without running through the wizard.

If you have not yet generated the license key, the wizard gives you the option to switch to
the Web tool to generate one. Then switch back to the wizard.

If you have an online connection, continue with item 5.
Otherwise, you can establish an online connection with Online in the Step 2 of 3 window.

5. Enter the license key in the Step 3 of 3 window.
6. Click Finish.

SIMOTION SCOUT

The wizard is closed. Licensing is complete.

Note

The license key is written to the retentive memory when the project data is transferred to
the target system.
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3.12.2 Changing the license key

The license key is influenced by changes to the project such as expanding the axis
technology from positioning to synchronous operation. This is why underlicensing is
displayed when the project is downloaded and the SF LED flashes at 0.5 Hz.

After you have determined the actual requirement and purchased the necessary licenses,
generate the license key again. Now replace the license key already entered with the newly
generated one.

Note
Transition from Version V3.0 to > Version V3.0

In a project as of Version V3.1, the license key is stored in a different location than in a
Version 3.0 project. You must re-enter the license key in order for Version V3.0 licenses to
be recognized in a project as of V3.1.

3.12.3 License key is protected from being deleted (as from Kernel V4.1)
The license key is stored in the "KEYS" directory on the SIMOTION Memory Card.

When the controller starts up for the first time, the license key will be saved in the boot sector
of the card and from this time is protected from being lost.

Operator actions cannot delete the license key in the boot sector. Also not by formatting the
card or with the "Write boot sector..." function.

If the license key is no longer present on the card, it will be written again during the startup
from the boot sector into the "KEYS" directory. This means that the system will repair any
deletion on the "Key" file.

The license key can be changed at any time, for example, by relicensing. At the next startup,
the license key will be saved again in the boot sector.

3.124 Licensing during hardware replacement

For the replacement of licensed SIMOTION components (MMC, CF, IsoPROFIBUS board or
PN board), the associated license key must be assigned to the new SIMOTION component.
In this case, contact the Customer Support for assistance.
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3.12.5 Underlicensing

If SIMOTION SCOUT detects the presence of underlicensing during license verification, an
entry is made in the diagnostics buffer. The verification is repeated every hour, and an entry
is made in the diagnostics buffer each time underlicensing is detected.

The following information can be read from the diagnostics buffer entry:
® Number of required licenses

® Number of actual licenses

® Operating mode

As an additional warning signal, the SF LED flashes at 0.5 Hz as long as underlicensing is
present on the system. Underlicensing will only be displayed if no acknowledgeable
technological event is pending, as the same SF LED is used to indicate this as well.

3.13 Write rights for boot sector

There are various reasons why it might prove necessary to write a boot loader. Use the
Options > Write boot sector menu in SIMOTION SCOUT to enable the boot sector on a
memory card to be rewritten.

Additional references
For additional information on this topic, refer to:
® The D4x5 Commissioning and Hardware Installation Manual
® The D410 Commissioning Manual
e SIMOTION SCOUT Online Help

SIMOTION SCOUT
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3.14 Searching in the project
In the open project, you can search all the project data for variables or any text.

If you select a variable search, you can also search within the ST sources. All global and
local variables at the declaration and use points are recognized.

Open the dialog using Edit > Search in project... on the menu bar or by using the shortcut
Ctrl + Shift + F.

The results are displayed in the search results tab of the detail view.

x|
Search for: I j Find I
Cancel |
Help |
[~ Match whale word only
[ tatch case ﬂl

™ Retain last s=arch result

Search filter: I\-"ariable anly [~
Object types to be : =
coarchod All object types J
; DCC chart [SIMOTION) -
r Search arly in DCC chart [SIMAMICS]
CPUlibrary Device
— GLOBAL DEVICE YARIABLES
IAt present, it i3 hot pos 140
LADAFBD unit

MCC Lt —
PROGRAMS

Figure 3-16  Searching in the project

Searching in CPU/Libraries only

If the "Search only in CPU/Library" checkbox is ticked, a selection list of all the CPUs and
user-defined libraries in the project appears. You can select one to search in this
CPU/Library only.

For more information regarding this topic, see the online help.

3.15 Replacing in the project
The Replace in project function is based on the Search in project function.
To open it, select Edit > Replace in the project... on the menu bar.

When you carry out a replacement, both the results found and the replacement term are
displayed in the "Search result" tab of the "detail view". The text can be edited again here.

Use the Replace button to replace all search results selected using the check box.
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Boundary conditions:
® Only text can be entered.

e Only texts in programs and script files are replaced (no variables in the 10 or global
device variables lists).

® Replaced texts cannot be undone.
More information on this topic is available in:

® Online help.

3.16 Changing a SIMOTION device

3.16.1 General information

In order that you can upgrade or replace a SIMOTION device and subsequently perform a
TP upgrade, you must decide which of the following upgrade variants is needed:

e Upgrade within a platform and a station type
e Station change: An old station is replaced by a new type of station.

e Platform change: The platform is changed within the same SIMOTION version. For
example, a SIMOTION C240 is replaced by a SIMOTION P350.

When the platform is changed, it may be necessary to change the station. In special cases, it
may also be necessary to change a station within a platform. This is the case, for example,
when upgrading from P350 V2.1 to P350 V3.0.

3.16.2 Changing a SIMOTION device followed by a TP upgrade

3.16.2.1  Upgrading within a platform and a station type

An upgrade is necessary when you want to replace the type or version of the SIMOTION
device in your existing project. Perform this replacement in HW Config.

To replace a SIMOTION device:

1. Double-click the SIMOTION device to be replaced in the project navigator in SIMOTION
SCOUT. HW Config is opened.

2. Open the appropriate folder structure in the hardware catalog:

Note

Ensure that the module/device (SIMOTION D) to be replaced does not get deleted. When
you change to the new module/device using Drag&Drop, the old module will be updated.

3. Confirm the displayed dialog box with Yes if you want to replace the SIMOTION device.
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4.
5.

Accept the changes made to the hardware configuration with Station > Save and compile.
Close the HW Config.

Note

The data for the SIMOTION device is immediately accepted in the SIMOTION SCOUT
project and the entire project is saved. In this way, the project also accepts all changes in
the project (e.g. axis configuration).

If you are using technology packages in your project, these will also need to be updated.

Upgrading technology packages

When modules are replaced or project data is imported, the versions of the technology
packages (TP) assigned to the individual technology objects (TO) are not automatically
upgraded to a version valid for the SIMOTION device. This upgrade requires a separate
step.

Adapting the technology packages version of the new SIMOTION device

80

1.
2.

Select the required SIMOTION device in the project navigator.

In the shortcut menu, select Select technology packages.

Note

If the last step you performed was to replace the SIMOTION device, the Unfamiliar
Technology Package Version dialog box appears. Confirm this by clicking OK in order to
delete the existing links to the technology packages (TPs) , enabling new technology
packages to be assigned. The Select Technology Packages dialog box will appear.

Activate the checkbox of the technology packages.

The technology packages must have the same version as the kernel. Consequently, in
SIMOTION SCOUT V3.0 and higher, the same version as the kernel is automatically
assigned to each technology package.

If TOs for your project indicating an incorrect version appear under Incorrect version, click
Update. If this is not the case, continue with step 8.

The Update Technology Packages dialog box appears.
Confirm this with OK.
A message appears.

6. Click OK to confirm the message.

7. If the update is successful, a message appears. Click OK to confirm.

8. Click OK to confirm the Select Technology Packages dialog box.

The upgrade of the TPs is completed.

Note

If you are using libraries in the project, these must also have the same version as the
SIMOTION device. You can only upgrade libraries that are not write-protected. Note also
the information in the SIMOTION SCOUT online help.

SIMOTION SCOUT
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When the version of a SIMOTION device and the technology packages changes, the
libraries created in SIMOTION SCOUT must also be adapted.

1.
2.

© N o o ko

Select a library in the project navigator.

Right-click and select Properties... in the context menu.
The Object Properties window opens.

Click in the TPs/TOs tab.

Select the appropriate device and the technology packages.

Click OK to confirm the changes.

Select the same library.

Right-click and select Save and compile in the context menu. The upgrade is completed.

Repeat the operations for all created libraries.

3.16.2.2 Changing a station

A station change is required if the station type changes.

This is the case, for example, if you want to change a platform between two of the following
SIMOTION devices:

SIMOTION C2xx
SIMOTION P350 V2.1 and higher
SIMOTION D4xx

Proceed as follows:

1.

© ® N o 0 &

SIMOTION SCOUT

Export the SIMOTION CPU data to be replaced via the
Expert > Save project and export object context menu.

Create a new SIMOTION device involving a different platform. This will be automatically
inserted in the project navigator.

Insert a new SIMOTION device or several master systems and configure them.

The HW Config is opened. The new station and the created master systems are already
inserted.

Also open the old station in the HW Config. Switch to the old station.
Copy the DP slaves.

Switch to the new station.

Insert the DP slaves in the new station.

Check the configuration of the elements of the new station.

Close the HW Config.
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10.Delete the old device in the project navigator.

11.Carry out an object import on the new device with the previously exported data.

Import object x|

f} Import into object "D435" with incompatible source
-
type

Target: Device of type "D435Y4.1"
#hL zource: Device of type "C230-2 41"

The import can place the project in an inconzsistent state.

Do pou really want to perform the import?

Tes Mo

Figure 3-17 Example of importing an object with a station change

3.17 Saving and restoring variables after a platform replacement or version
update

3.171 Saving and restoring variables from the device

Saving and restoring data with SCOUT

Using the SIMOTION SCOUT functions Save variables and Restore variables it is possible
to save and then restore data (which has been changed during operation and is only saved
in the SIMOTION device or on the memory card) to the hard disk. This can be used if a
SIMOTION platform is changed or a version updated, for example.

The following types of data can be backed up:

® Remanent global device variables and unit variables, as well as TO retain data (V4.1 and
higher) that are located in the SRAM/NVRAM of the control

e Data sets which have been backed up from the user program via _saveUnitDataSet or
_exportUnitDataSet and are located on the memory card, including

— Global unit variables of interface and implementation sections from program sources
(ST, MCC or LAD/FBD sources):

Remanent variables (VAR_GLOBAL_RETAIN)
Non-remanent variables (VAR_GLOBAL)

— Remanent and non-remanent global device variables (which have been backed up via
_saveUnitDataSet).

The _exportUnitDataSet function backs up unit variables in a version-independent format
(XML).

By contrast, data is backed up in a version-dependent format (binary) via the
_saveUnitDataSet function and can, therefore, only be read back in on a device/unit of the
same version (e.g. V3.2) via the _loadUnitDataSet function.
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Data sets saved via _saveUnitDataSet are automatically converted into XML format using
the Save variables function. The data sets are available in binary format for the new version
once the Restore variables function has been executed.

Data backed up using Save variables are saved as version-independent XML files in a user-
defined folder on the PC's hard disk.

In addition to the data backup functions provided by SIMOTION SCOUT, backup functions
are also available in the runtime system.

Note

When performing an update with a kernel version that is = V4.1, the above

SIMOTION SCOUT functions are only required for backing up and restoring unit data sets
that have been created using

_saveUnitDataSet.

Reason:
¢ Retain data remain valid after an update.
e Unit data backed up using _exportUnitDataSet also remain valid after an update.

¢ Retain data can also be backed up to a memory card without the use of
SIMOTION SCOUT:

— The _savePersistentMemoryData function saves all retain data from the
SRAM/NVRAM; these can be remanent global unit variables in the interface or
implementation sections of a source (VAR_GLOBAL_RETAIN) or remanent global
device variables (RETAIN) and
TO retain data

(For further information, see Parameter Manual: Device System Functions/Variables)

— The Back up diagnostic data function (triggered via an appliance switch or IT DIAG)
saves all retain data (as above, see _savePersistentMemoryData).

Subsequently executing the Restore non-volatile data function reactivates this backed
up data.

(For further information, see the SIMOTION D4x5 Commissioning Manual)

A directory structure is created in the selected path using the Save variables function. This
directory is assigned the name of the selected SIMOTION device or the selected unit,
depending on whether the variables should be saved or restored for the entire device or just
one unit.

The remanent global device variables are backed up in the file unitdata.xml. The number of
subdirectories corresponds to the number of sources in the SIMOTION project. The names
of the subdirectories correspond to the names of the sources. Every subdirectory contains a
file named unitdata.xml, where the remanent unit variables are backed up. If required,
another file is saved containing the non-remanent global variables for the source. This
DS*.xml file is assigned the data set number as its name, which is transferred by specifying
the parameter ID for the _saveUnitDataSet or _exportUnitDataSet function.

Additional references
Detailed information on this topic can be found in;
® Function Manual: SIMOTION Basic Functions, Data Backup from User Program
e SIMOTION SCOUT Online Help
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3.17 Saving and restoring variables after a platform replacement or version update

Example of a folder structure when backing up on the device:

The folder structure is as follows:

<Folder device>, e.g. D435
unitdataset.xml
DS000001.xml
<Folder device>, e.g. ST_UNIT1
Unitdataset.xml
DS000002.xml

3.17.2 Save variables function

Requirements:

Backed up data, see section: Saving and restoring variables from the device

The project has been downloaded to the target system.
SIMOTION SCOUT is in online mode.
Global unit variables and global device variables are backed up using system functions:

— The system function _saveUnitDataSet or _exportUnitDataSet must be executed for
every source, for example in the ST program, so that the global unit data is created as
a data set in the SIMOTION device.

— When executing the system function, the storage medium (RAM or memory card)
must match the selection in the Save variable dialog window.
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3.17 Saving and restoring variables after a platform replacement or version update

To save the variables:

SIMOTION SCOUT

1.

Switch the SIMOTION device to STOP mode. This ensures that all the variable values
have the same time stamp.

2. Select the SIMOTION device, e.g. C240, or the unit.

3. Right-click to open the shortcut menu.

4. Click Save variables.

® N o g

The Save Variables window appears.

Note
Options in the dialog:

Check the Retain variables checkbox if you want to save all remanent variables from the
non-volatile data memory (SRAM/NVRAM).

Check the Unit variables (ST)/global variables (MCC, LAD/FBD) saved via system
functions checkbox if you want to back up the previously saved or exported data sets.

Check the TO Retain data (variables) checkbox if you want to save these variables.

Select whether the data sets should be read from the memory card or from the RAM disk.
Ensure that this selection corresponds to the storage location where the data sets were
saved by the _saveUnitDataSet/_exportUnitDataSet function.

Detailed information can be found in
Function Manual: Basic Functions, Data Backup from User Program.

Make the required settings.
Click OK.
In the subsequent dialog, select the folder where the backup files are to be saved.

Select this folder.
Please note that these backed up variables can only be restored on this device.

Click OK to confirm.
The variables are saved.

Configuration Manual, 05/2009 85



Functions

3.17 Saving and restoring variables after a platform replacement or version update

3.17.3 Restore variables function

Requirements:

The variables have been saved via the Save variable function.
The project has been downloaded to the target system.

The SIMOTION device is in the STOP mode.

SIMOTION SCOUT is in online mode.

Note

Behavior when restoring tags if there are differences between the backup file and the

project:

o If the unit variable or the global device variable exists in the backup file and on the unit
or device and the data type is identical, then the contents of the variables from the
backup file is transferred to the unit variable of the unit or to the global device variable
on the device.

o |f the unit variable or the global device variable exists in the project, but not in the
backup file, then the contents of the unit variable in the unit or the global device
variable are retained unchanged.

o |f the unit variable or the global device variable exists in the backup file, but not in the
unit or on the device, then the variable is ignored.

o If the unit variable or the global device variable exists in the backup file and on the unit
or device, but is of a different data type, then a type conversion is performed between
ANY_INT <-> ANY_INT, ANY_INT <-> ANY_REAL, ANY_REAL <-> ANY_REAL. Ifa
type conversion is possible, then the value in the backup file must fit in the new value
range of the unit variable or global device variable, otherwise this is initialized. If a type
conversion is not possible (e.g. date, time), then the UNIT variable or global device
variable is initialized.

To restore variables:

86

1.
2.
3.

Select the SIMOTION device, e.g. C240, or the unit.
Select the Restore variables function in the context menu.

Select the desired settings in the Restore variables dialog and click OK.

Note
Options in the dialog:

¢ Check the Retain variables checkbox if you want to restore all previously saved
remanent variables in the non-volatile data memory (SRAM/NVRAM).

¢ Check the Unit variables (ST)/global variables (MCC, LAD/FBD) saved via system
functions checkbox if you want to restore the previously saved data sets.

e Check the TO retain data (variables) checkbox if you want to restore these variables.
e Select whether the data sets should be written to the memory card or to the RAM disk.
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4. In the subsequent dialog, select the folder where the backup files have been saved.

Note

Do not select the folder that contains the device name in its name. Instead, select the
folder one level higher, otherwise the restore will not work properly.

5. Click OK to confirm the following window.
6. Switch the SIMOTION device to RUN mode.

7. Execute the system function _loadUnitDataSet or _importUnitDataSet to initialize the
variables with the values from the backup files.

Global unit variables and global device variables are backed up using system functions:

— The _loadUnitDataSet or _importUnitDataSet system functions must be executed for
every source, for example in the ST program, so that the global unit data can be
loaded into the SIMOTION device (RAM or memory card).

— When executing the system function, the storage medium (RAM or memory card)
must match the selection in the Restore variable dialog window.

3.18 Exporting and importing projects

3.18.1 Exporting and importing a project in XML format

A log of the export or import is displayed in the XML export/import status display tab in the
detail view. The XML export log also contains a link to the exported file. Double-click on this
link to view the exported project data in the Internet browser.

Note

Projects are exported and imported version-neutral. However, if a project has version-
specific properties, related errors may occur following import into another SCOUT version,
e.g. when compiling of ST programs.

Exporting a project
Menu: Project > Save and export

The data format for exporting projects has been changed in SIMOTION SCOUT Version
V2.1. Activate the Use V2.0 export format checkbox to export a project in V2.1 or higher with
V2.0 format and re-import it with an older version of SIMOTION SCOUT (< V2.1). If you
activate this checkbox, an optimized XML export is not possible.

SIMOTION SCOUT V3.0 and higher features an additional function. Projects can be
exported more quickly using less memory. This is the default setting when you call the
export.

For this, activate the checkbox Use optimized export format.

If neither checkbox is activated, all data in the SCOUT project is exported, even data not
read back in during an import. This export is only required in exceptional cases.
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3. 18 Exporting and importing projects

Importing a project

Note

Projects can only be imported in offline mode and no projects should be open in SIMOTION
SCOUT.

o M Db

. Select Project > Import in the menu bar.

The Import Project window and the XML export/import status display tab appear.
Under Source path and Source name of the import, select the XML file to be imported.
Click Open to confirm.

Click OK.

Enter the project name in the newly opened window and select a project directory by
clicking Browse.

Click OK.

The import is started. On completion of the import, the successfully completed import, the
project name and the target path are displayed in the XML export/import status display
tab of the detail view. The new project is displayed in the project navigator.

Additional references
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Please refer to the online help on this subject

SIMOTION SCOUT
Configuration Manual, 05/2009



Product combination 4

4.1 Compatibility

411 General compatibility

Different hardware and software combinations as well as different Kernel and SIMOTION
SCOUT version combinations are possible when using SIMOTION.

These possible combinations can be found in the compatibility list on the SIMOTION SCOUT
add-on CD (under 1_Important) as well as on the Internet at:

http://support.automation.siemens.com/WW/view/de/18857317

41.2 Software compatibility

Technology packages with Kernel

The SIMOTION kernel and the technology packages must always have the same version.
Example: Only a TP Cam Version V3.2 technology package will run on a SIMOTION Kernel
Version V3.2.

Table 4- 1 SIMOTION SCOUT with SIMOTION Kernel

SCOUT version Kernel version
V2.1.x V3.0.x V3.1.x V3.2.x V4.0 V4.1

SCOUT V2.1.x X - - - - -
SCOUT V3.0/SP1 X X - - - -
SCOUT V3.1.x X X X - - -
SCOUT V3.2.x X X X X - -
SCOUT V4.0 - X X X X -
SCOUT V4.1 - X X X X X

X = supported; - = not supported

Project on memory card with SIMOTION Kernel

A project contains SIMOTION devices with a particular configured version. This exact
SIMOTION kernel version must be available on the relevant SIMOTION device.
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SIMOTION SCOUT with project version

A project with a version earlier than the installed version of SIMOTION SCOUT will be
converted to the current version when it is opened. Only the data content of the

SIMOTION project will be converted to the current version, but not the SIMOTION device
version.

Example: If you have installed SIMOTION SCOUT V4.1 and wish to open a project created
in SIMOTION SCOUT Version V4.0, the project is converted to V4.1 .

Table 4- 2 SIMOTION SCOUT with project version

SCOUT version Project created with SCOUT version
V2.1.x V3.0.x V3.1.x V3.2.x V4.0 V4.1

SCOUT V2.1.x X - - - - -
SCOUT V3.0/SP1 X X X X X X
SCOUT V3.1.x* X X X X X X
SCOUT V3.2.x* X X X X X X
SCOUT Vv4.0* X X X X X X
SCOUT V4.1* X X X X X X

X = supported; - = not supported

* As of SIMOTION SCOUT Version V3.1 SP1, a project can be saved in the project format of
an older version (up to Version V3.0), and therefore opened and worked on with an older
version of SIMOTION SCOUT.

To successfully convert a project to an older format, no devices or functions must be used
which are not implemented in the desired version./

Detailed statements on combining products can be found in the compatibility lists
(see section General compatibility (Page 89)).

4.2 Memory media of the SIMOTION devices

Storing on memory media

The online project comprising the technology package and the user data. It is stored on a
memory medium secure against power loss. The data medium used will vary depending on
the SIMOTION platform and SIMOTION version.

e SIMOTION C2xx: Micro memory card

e SIMOTION P350: Virtual memory card
Handling and functionality correspond to the micro memory card of the SIMOTION C2xx.

¢ SIMOTION D4xx: CompactFlash card

Note

The memory card must not be inserted or removed during operation. Removing the card
in RUN mode triggers an overall reset, which results in the loss of stored data.

SIMOTION SCOUT
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Additional references
More information on this topic is available in
e SIMOTION C Operating Instructions

e SIMOTION P350, SIMOTION P350-3 and Panels Commissioning and Hardware
Installation Manual

e SIMOTION D4x5 Commissioning and Hardware Installation Manual
e SIMOTION D410 Commissioning Manual
e SIMOTION SCOUT Online Help

Persistent data backup

Persistent data storage is executed using a non-volatile memory integrated in the SIMOTION
device, e.g. SRAM for D4xx. SuperCap and optionally a battery are used for buffering the
non-volatile memory.

You can save data from the non-volatile memory in order to avoid loss of data in the event of
a power failure. The following functions are possible:

e System function _savePersistentMemoryData for saving the non-volatile memory

® Restoration of the non-volatile memory during the ramp-up on detection of a power loss.

Additional references
More information on this topic is available in

® Function Manual: Basic Functions

4.3 STEP7

4.3.1 SIMATIC Manager

Open SIMOTION project

You can also open a project in the SIMATIC Manager and edit it with the tools provided.
However, you do not have any direct access there to specific SIMOTION components, such
as technology object and programs.

You can open the SIMOTION SCOUT from the CPU.

Note

You can use File > Manage... to show and hide the projects you have created in
SIMOTION SCOUT in the SIMATIC Manager.
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4.3.2 SIMATIC Logon

Overview

As of SIMOTION SCOUT V4.1, you have the option of assigning a project password to
provide access protection for projects. This functionality requires the previous installation of
the SIMATIC Logon STEP7 option.

This function makes it possible to restrict project creation to authorized personnel only and to
track changes in versions created with SIMATIC Logon. It also therefore provides support for
the validation process of a machine or system [as per FDA 21 CFR Part 11].

Installation / Prerequisites

The STEP7 V5.4 SP1 options SIMATIC Logon and Version Trail must be installed and
licensed in addition to SIMOTION SCOUT V4.1.

Features

When SIMATIC Logon is installed, password protection can be activated for any project. A
SCOUT project saved with SIMATIC Logon can only be opened and edited with password
protection.

e |f a project is opened in SCOUT that has an access protection set with SIMATIC Logon,
the access dialog appears in which the project password must be entered. This means
the correct password must be entered to open the project.

If an incorrect password is entered, an error message will be issued and the project
remains closed.

e Passwords are assigned in a separate administrator screen using a process configured
according to the guidelines under FDA 21 CFR Part 11.

® Every file open and every change is automatically recorded in a revision log.

® SCOUT projects created with SIMATIC Logon can be archived, managed and their
changes tracked in a clearly organized fashion using the SIMATIC Version Trail option.
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Activate SIMATIC logon
When SIMATIC Logon is installed, password protection can be activated for any project.

To do this, select Options > Access Protection > Activate in SIMATIC Manager.

| SIMATIC Manager - FOAD ]

amte [ =17 %A@ @M
Abtheren

Figure 4-1 Activate SIMATIC Manager access protection

When access protection is activated, the SIMATIC Logon Service window opens. The
administrator logs in here to assign a project password for this project.

Enable Access Protection

Aazzign project pazsward:

Confirm project password:

ok | Cancel | Help

Figure 4-2  Activate access protection

Then the users are entered in the user administration for this project using drag&drop.
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4.3 STEP7
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Figure 4-3  SIMATIC Logon AdminTool

Open protected project

When a protected project is opened, the following dialog box appears if SIMATIC Logon is
installed. Enter your user name and password here.

SIMATIC Logon Service - One-time logon

User name: |

Password: |

Log on bo: |AD013208PC {this computer) j

K | | Change password... | Cancel |

Figure 4-4  SIMATIC Logon service

If SIMATIC Logon is not installed, the project can also be set to open only with the project
password using STEP7 V5.4.

Enter Project Password

Project: 47_09 [d:\projektents7projhd?_09)

Enter project password: ||

Lancel | Help

Figure 4-5  Enter the project password.

For more details on this topic, see the following document:
e SIMATIC Logon; SIMATIC Electronic Signature, Manual
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4.3.3 SIMATIC Version Trail

Overview

SIMATIC Version Trail is a software option for SIMOTION engineering which, together with
the SIMATIC Logon central user administration, can assign a version history to libraries and
projects.

Installation / Prerequisites

SIMATIC Version Trail is an option in STEP7 V5.4 SP1 and must be installed and licensed in
addition to SIMOTION SCOUT V4.1. SIMATIC Version Trail can only be used and licensed
in a package together with SIMATIC Logon.

Function

When archiving, SIMATIC Version Trail creates a version history with the following
information in association with SIMATIC Logon:

® \ersion

® \ersion name
e Date and time
® Users

e Comments

This version history can be displayed and printed. Individual versions can be retrieved from
the version history, and used further. SIMATIC Logon organizes the access protection.

View of a SIMATIC Version Trail window, showing the project name, comments and
versioning data. The versions created with SIMATIC Logon can be documented and
managed in a clearly organized fashion after changes.
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4.4 NetPro

4.4

T SIMATIC Manager - [4_1_05 - d:\projektenls7proj\d_1_05]

Trail - [L:\Projekie\SIMOTION\Logon\aktueller Test mi 4711]

| 2 &8 BB1e
@9 akbaeller Test mi 4711 Eroiect
4711
= [dhprojektentsTprafid_1_0S
Comment
VT BT Test
Version Versionname __[Date User [eomment
&x] 47 05.00.00 122032007 144928 administrator | Stand fir Aufnahm
4 (SINLB
30 47 01.00 00 |07 022007 09:46:10 12345678
2.1 i 102022007 14:40:04 987654321 [ST_2 eingefigt
20 02.02 2007 14:31:50 abcdefgh |Anderer Mutzer
1.0 47.00.00.00 102022007 14:1257 12345678 VT Testmit 47 00
[Projekt 4_1_3_
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& &
Ready /4
Cancel Help

Press F1 ta get Help, (PROFIBLIS) " [1z345678

Figure 4-6  SIMATIC Version Trail - version data

Note

Please note that SIMATIC Version Trail cannot be used separately, but only in combination
with SIMATIC Logon.

NetPro

NetPro in STEP7
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NetPro is integrated in the STEP 7 basic package. NetPro is a supporting tool for STEP 7.
A time-controlled cyclical data transmission via MPI is possible with NetPro:
e Selection of the communication stations

® Entry of data source and data target in a table; the generation of all blocks (SDB) to be
loaded and their complete transfer to all CPUs is performed automatically.
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4.5 HMI

An event-driven data transmission is also possible with:
® Specification of the communication connections
e Selection of the communication/function blocks from the integrated function block library

® Parameter assignment of the selected communication/function blocks in the usual
programming language.

Application for SIMOTION

4.5

Overview

So that network nodes can communicate, configure networks and/or subnets in NetPro. In
NetPro, you create a graphic view of the networks and subnets and specify their properties
or parameters. You can also define the node properties.

You can open NetPro via SIMOTION SCOUT; the NetPro application then opens as a
separate window. Application cases for the SIMOTION project are, for example, the
connection of the engineering system via network nodes and the creation of routing
connections.

The Human Machine Interface (HMI) connects the world of automation with the individual
demands of the operator. As part of TIA, SIMATIC HMI supports uniform engineering under
Windows, accesses common data and communicates uniformly.

For efficient machine operation and monitoring in various performance classes, you can use
the following panels recommended for SIMOTION as well as PC-based panel systems with
membrane keyboards or touch screen operation:

® Panels
For efficient machine operation and monitoring in various performance classes, either
text-based or graphics-capable with membrane keyboards or touch screen operation.

e Multi-panels
These can be used for operator control and monitoring in the same way as the panels,
with operation by means of touch screens or membrane keyboards. Multi-panels (MP)
also permit the installation of additional applications and therefore provide typical PC
flexibility.

® Panel PCs
Are designed for demanding environmental conditions and provide the same degree of
robustness and suitability for industry.

SIMATIC ProTool/Pro, a modern visualization software under Windows, and the WinCC
flexible engineering software are available for the display of the user interface.

Additional references

SIMOTION SCOUT

Detailed information can be found in:
e (Catalog: SIMOTION, SINAMICS S120 and Motors for Production Machines
e PM 21 Catalog.
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4.5 HM/

SIMATIC ProTool/ ProTool/Pro

ProTool is the system-wide and uniform configuration software under Windows for all
SIMATIC HMI operator panels.

SIMATIC ProTool covers the applications of the machine-related area with PC-based control
and monitoring solutions for single-user systems based on ProTool/Pro through to the
SIMATIC HMI operator panels. For the configuration of the ProTool/Pro runtime for PCs as
well as SIMATIC HMI operator panels, the ProTool family has the uniform and scalable
configuration tools ProTool/Lite, ProTool and ProTool/Pro CS.

ProTool/Pro is the visualization software under Windows for the PC-based HMI in the
machine-related area. It allows quick response times and safe process control.

SIMATIC WinCC flexible

SIMATIC WinCC flexible is the innovative HMI software under Windows 2000/XP for all
applications in the machine-related area. The engineering software enables the uniform
configuration of all Windows-based SIMATIC HMI operator panels.

WinCC flexible Runtime provides basic HMI functionality on PCs, including messaging and
logging systems and can be expanded when required via options. The runtime functions
available on the SIMATIC HMI operator panels are dependent on the device class.
Existing ProTool projects can be accepted or converted. The WinCC flexible engineering
software can be integrated in the central programming software of the SIMATIC world,
SIMATIC STEP 7, and used for the configuration of all operator panels. The engineering
software of SIMATIC HMI also accesses variable lists and message lists of the controller and
uses their communication parameters.

OPC / OPC XML-DA

98

Open communications standard for automation components. The goal of the standard is to
ensure a problem-free and standardized data exchange between controllers, operator
control and monitoring systems, field devices and office applications from different
manufacturers.

The OPC abbreviation previously means "OLE for Process Control", because the
implementation is based on Microsoft's COM/DCOM technology.

Nowadays, one uses the term "Openness, Productivity and Collaboration". Today, a number
of standards defined by the OPC Foundation have evolved. The OPC Foundation is a
grouping of many manufacturers from the automation technology area.

SIMOTION supports the OPC DA (Data Access) and OPC AE (Alarm & Event) standards
with the SIMATIC NET Softnet package. This is based on the Windows COM technology.

SIMOTION also supports OPC XML-DA (Data Access based on XML). The OPC server is
located in the SIMOTION device and is accessed from a partner station no longer using
COM mechanisms but with Web services and their XML-coded function calls. This makes
the partner stations independent of hardware and operating systems.

The client application on the partner station works with the symbolic SIMOTION variable
names. There is no dependency on the SIMOTION SCOUT database, which means that no
consistency problems arise, even when there is a switch in versions.

SIMOTION SCOUT
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4.6 Drive ES

Drive ES engineering system

Drive ES is the engineering system used to integrate Siemens drive technology into the
SIMATIC automation world easily, efficiently and cost-effectively in terms of communication,
configuration and data management. The STEP 7 Manager user interface provides the basis
for this procedure.

Drive ES Basic is the basic software for the parameterization of all drives, online and offline.
With the Drive ES Basic software, the automation and the drives are edited on the user
interface of the SIMATIC Manager. Drive ES Basic is the starting point for common data
archiving from complete projects and for extending the use of the routing and SIMATIC
teleservice to drives. Drive ES Basic provides the engineering tools for the new motion
control functions - data exchange broadcast, equidistance and isochronous operation with
PROFIBUS DP.

The following commissioning tools are contained in Drive ES:

o STARTER Standalone for SINAMICS is not required and cannot be used in conjunction
with SIMOTION SCOUT because STARTER is integrated in SIMOTION SCOUT.

e SIMOCOM U for SIMODRIVE
® Drive Monitor for MASTERDRIVES

Note
Drive ES Basic is part of the delivery of SCOUT and SCOUT Standalone.

4.7 Commissioning drives (Starter)

The aim of STARTER is the simple and rapid commissioning, optimization and diagnostics of
all Siemens drives of the new drive generation with only one tool.

The STARTER drive/commissioning tool supports the following drives:
e SINAMICS

* MICROMASTER 420/430/440

* MICROMASTER 411/ COMBIMASTER 411

¢ COMBIMASTER

e ET200pro FC

e ET200S FC ICU24

The following variants are available:

e STARTER Standalone:
STARTER as commissioning tool for applications without SIMOTION, but with integration
of the new drives in SIMATIC S7. STARTER Standalone is not required in connection
with SIMOTION SCOUT and cannot be used.

® STARTER integrated in SIMOTION SCOUT:
For SIMOTION applications, SIMOTION SCOUT contains the entire functionality of
STARTER.
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4.8 CamTool

Performance characteristics:

e \Wizards support new users by providing solution-oriented dialog guidance, whereby the
uniform graphics-based display facilitates understanding.

® However, experts are also able to access the individual parameters quickly.

4.8 CamTool

Graphic creation of cams

Simple text-based editors are already integrated in the basic SIMOTION SCOUT package
for the creation of cams. The CamTool V2.2 option package expands SIMOTION SCOUT
with a powerful tool for the full graphical creation and optimization of cams. CamTool fully
integrates into the SIMOTION SCOUT user interface. In SIMOTION CamTool, you can
create, edit and optimize cams with the aid of a graphical user interface.

Additional references

Please refer to the following document on this subject
e Configuration Manual: SIMOTION CamTool

4.9 DCC programming system

Drive Control Chart

100

DCC enables SIMOTION and SINAMICS users to also implement and graphically configure
drive-related tasks employing continuous closed-loop and open-loop control.

A set of Drive Control Blocks (DCB) is available in a library for this purpose. These function
blocks can be graphically interconnected and configured in what are known as "charts" via a
configuration tool (DCC editor).

A large number of Drive Control Blocks (DCB) are available for both DCC-SIMOTION and
DCC-SINAMICS with identical functionality.

e Module library with administration, calculation, control, logic and complex modules.

e Graphical switching editor with various editing, macro, help, search, comparison and print
functions.

® Sequence environment for SIMOTION with selectable, mixable scanning times and
consistent data transfer between scanning periods.

® Sequence environment for SINAMICS with embedding of technology option in SINAMICS
using the BICO technique, with the applications set using configured parameters

e Diagnostics environment with signal display, diagnostics and trace functions.

e Scalability with different performance features and project data volumes for DCC-
SIMOTION and DCC-SINAMICS.
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4.9 DCC programming system

Additional references
More information on this topic is available in
® Programming and Operating Manual SINAMICS/SIMOTION Editor description DCC
e SINAMICS/SIMOTION DCC Module Description Function Manual
e SIMOTION SCOUT Online Help
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5.1 Controlling the target system

51.1 Overview
In online mode, you can control the SIMOTION device with SIMOTION SCOUT, e.g.:
® Change and compile program sources
® Download
® Control operating mode
e Set the internal clock of the SIMOTION device
e Change Configuration Data in RUN Mode
e Control variables in RUN
e Copy current data to RAM
® Copy RAM to ROM
® Delete the RAM of the SIMOTION device (overall reset)

® Archive project data

5.1.2 Controlling the operating mode with SIMOTION SCOUT

/\DANGER

Danger to personnel and machine can result from an uncontrolled change of the operating
mode.

Please note the safety regulations before you control a SIMOTION device via the mode
selector in SIMOTION SCOUT.

1. Select the SIMOTION device in the project navigator.
2. Select the Target system > Control operating mode menu.

A software switch is displayed. This represents the mode selector on the
SIMOTION device or the virtual hardware mode selector (SIMOTION P). The current
operating mode is displayed with symbolized switch setting and LEDs.

3. Select the desired operating mode.
Click the corresponding button.

The switching options are dependent on the position of the mode selector on the
SIMOTION device.

SIMOTION SCOUT
Configuration Manual, 05/2009 103



Diagnostics

5.1 Confrolling the target system

The operating mode can be monitored and switched with the device diagnostics.

Table 5- 1 Operating modes of a SIMOTION device

Operating mode Description

STOP e Technology objects inactive (enables deleted, no axis motion)

e User program is not executed

e Loading a user program is possible

e All system services are active (communication, etc.)

¢ All analog and digital outputs set to 0

e The I/O modules (signal modules) are in the safe state (SIMOTION D4xx)

STOP U e Technology objects are active
e Technology objects can execute jobs for testing and commissioning
functions.

e Otherwise identical to STOP operating mode
e STOP U means stop user program
e User program is not executed

RUN e Technology objects are active

e Execution of the user programs assigned to the execution system
e Loading a user program is possible

e Process image of the inputs and outputs is read or written

MRES Overall reset

e Switch setting for the overall reset of the SIMOTION C2xx, SIMOTION P350-
3 and the SIMOTION D4xx

SERVICE ¢ Mode selector on SIMOTION device (!) must be in the STOP U or RUN

position.

e The mode is assumed when the control priority is fetched using the axis
control panel.

Table 5-2  The switching possibilities of the software switch depending on the position of the mode
selector on the SIMOTION device (with regard to the SIMOTION D4xx, see the
SIMOTION D4x5 Manual; SIMOTION D410 Manual)

Mode selector position of the SIMOTION device | Switching options of software switch in
SIMOTION SCOUT

STOP STOP
STOP U
MRES
STOP U STOP U
STOP
RUN RUN
STOP U
STOP
MRES MRES
STOP
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Table 5- 3 LEDs of the mode selector

LED Description Color Meaning

5VDC Power OK Green Power supply 5 V
e Steady:

Power supply functioning correctly.
e Flashing:

Power supply defective

RUN RUN Green RUN mode

e Steady:
SIMOTION device is in RUN mode.

e Flashing:
RUN mode is selected (by SIMOTION SCOUT or
switch) and the SIMOTION device is on its way there.

¢ Flashing simultaneously with STOP U
SIMOTION device is in SERVICE mode.

o Off:
SIMOTION device is not in RUN mode.

STOP U | STOP User Orange STOP U mode
program e Steady:
SIMOTION device is in STOP U mode.
e Flashing:
STOP U mode is selected (by SIMOTION SCOUT or
switch) and the SIMOTION device is on its way there.
¢ Flashing simultaneously with RUN
SIMOTION device is in SERVICE mode.
o Off:
SIMOTION device is not in STOP U mode.

STOP STOP Orange STOP mode

e Steady:
SIMOTION device is in STOP mode.

e Flashing:
STOP mode is selected (by SIMOTION SCOUT or
switch) and the SIMOTION device is on its way there.
¢ Flickering (fast flashing):
Write access to the memory card
o Off:
SIMOTION device is not in STOP mode.

Note
The LED displays on SIMOTION devices are described in the associated Manuals.
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SIMOTION C2xx

C230 : Operating mode ... EHE

RN
DC 5y
RUN STDPU

STOPU /@6}
stop _STOP |
MRES |

Cloze |

[ o o o

Figure 5-1 Mode selector

On the SIMOTION C2xx, the operating mode can also be set via a rotary switch on the
device.

SIMOTION P350-3

Note

With SIMOTION P, the mode selector is displayed via the SIMOTION P Startup application.
You can call this via Start > Programs > SIMOTION P Startup.

For more information, see the SIMOTION P Manual.

#2 SIMDTION-P State [ (] =]
Show  Info
~NOK———————————— ~SIMDTION
Mot started @ sr
FEestart | & DCEY
Festart (el SHAH] | @ RUN STDPUl
: : & STOFU
: J STDP
STOP
Load Flash | :
BUSTF
IerminateSIMDTIDN-Pl MF‘ES
& BUSZF
Start SIMUTIIHE |

Figure 5-2  SIMOTION P state application

SIMOTION D4xx

Note

For the SIMOTION D4xx, it is recommended that the operating mode be switched with the
SIMOTION SCOUT.
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RUN
DCEY
RUN STOP U ~
STOPU
sTop _STOR | -
MRES

Schieten | Hir= |

Figure 5-3  D4xx mode selector

Additional references

Please refer to the following documents on this subject

Operating Instructions SIMOTION C2xx

SIMOTION P350-3 and Panels Commissioning and Hardware Installation Manual
SIMOTION D4x5 Commissioning and Hardware Installation Manual

SIMOTION D410 Commissioning Manual

and the SIMOTION SCOUT online help.

513 Overall reset

Proceed as follows:

1. Start the software mode selector.
2. ClickMRES.
3. Acknowledge the warning.

On the SIMOTION device, MRES automatically switches to the STOP mode once execution
is completed.

References

For more information, please refer to

SIMOTION SCOUT

SIMOTION C2xx Operating Instructions

SIMOTION P SIMOTION P350-2 Product Manual and Panels Manual
SIMOTION D4x5 Manual

SIMOTION D410 Product Manual

SIMOTION SCOUT Online Help
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5.1.4 Setting the time of day

Proceed as follows:
1. Select the SIMOTION device in the project navigator.
2. Select the Target system > Set time of day menu.

The current date and the time of day of the PG/PC and the SIMOTION device are
displayed.

3. Change the date and time of day of the SIMOTION device, if necessary:
If you want to accept the values from the PG/PC:
— Activate the Accept from PG/PC checkbox.
If you want to enter values:
— Deactivate the Accept from PG/PC checkbox.

— Enter the values in the corresponding fields (Module).

Set Time of Day E
Path: |proiect\SIMOTION CAC230_2
Date: Time of Day:
PiG/PL time: Joas12/03 |04:23: 42 pm ‘
Module time: |03 112 /03 |m 23 41 pm

¥ Take from PG/PC

Ertended >

Help |

Figure 5-4  Setting the time of day

5.1.5 Changing configuration data

You can also change the configuration data of a technology object offline and online in the
RUN mode.

You can change the configuration data in the configuration dialogs as well as in the expert
list of the respective technology object, e.g. axis.

Proceed as follows:
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108 Configuration Manual, 05/2009



Diagnostics

5.1 Controlling the target system

1. Select the relevant technology object in the project navigator.

2. Open Expert > Expert list in the shortcut menu.
The expert list opens in the working area.

3. In the expert list, open the Configuration data subtree and, if required, other subtrees.

Canfiguration data | Sustem varigbles |

Parameter Parameter text Unit |I]ata type Minimum |Maximum

Arrangement of the interpolator task lev
Leadscrewy pitch of a linear axis

Modulo settings of a rotary axis

Mode for the restart of the technology o
Conditions for the restart of the technolo
Process coupling

Axvis type-specific configuration

Actual scceleration monitoring
Activation of the actual acceleration mo (MO (917 ;l - '‘EnumY'esto’ = e
Maitnum walue of the permissible actual |0.0 mméz?  |LREAL -1E+012 |1 E+012
Actugl velocity monitoring
Activation of the actual velocity monitori (MO (917 ;l - '‘EnumY'esto’ = e
Maximum value of the permissible actual |0.0 mmiz  |LREAL ] |1 E+012
Guartification fiter

Activation of the gquantification fiter

| »

‘Enumeshio’ =

MO (913 |

Behavior at the end of the traversing pr '‘EnumEncdBeharvio
Cyclic cortinuation with position-relsted [MORE (107 - ‘EnumAxisCyclic

STOP_WHEN_PROFILE =]
=
Arrangement of sequential positioning ¢ (IMMEDIATELY (00 |- ‘EnumbecodeSeqy
-
=

Activation of the direction-dependert ac (MO (91) - '‘Enum'eshlo’ = e
Ahort of stopped mation commands afte | YES (173 - '‘Enum'eshlo’ = e
Maximum number of active commands |6 - DiIkT 5] 100
Maximum number of active command ID= 100 - DIrT 1] 1000
Maximum number of active commands |6 - DIrT ] 100

Limitation of the dynamic response para | COMMARD_DYIAMICS ¥ - ‘EnumProfilelyna
Resetting of the dynamic response valu MO (91) Jd '‘Enumy'esho’ = &
Local stop reactions vwith jerk limitation  |MO (91) Jhd [ '‘Enumyesho’ =
Reszet coordinate system for superimpo | TRAMSFER_STAMNDET! x|- '‘EnumTransfersu
Distributed mation contral =|

B Al |

Figure 5-5  View of the expert list

Additional references

Note
The detailed procedure for changing the configuration data is described in:
Function Manual: SIMOTION Basic Functions

For additional information, see
e SIMOTION Lists Manuals
e SIMOTION SCOUT Online Help
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5.1.6 Archive project data to memory card

The Target system > Archive project on card... function archives the complete SCOUT
project on the MMC/CompactFlash card or hard disk of the P350.

The Target system > Load project from card... function loads the archived SCOUT project
from the card or the hard disk.

A zip file is archived. This function is only possible in online mode. In addition to the zip file,
an info file is saved. This can be read with the Target system > Load project from card...
function. The following contents are written to the info file:

® The project name

® The size of the zipped project file
® The storage date

For additional information, see

® Handling Recommendations for Service with SCOUT V4.1 section

5.1.7 Loading data to the target system

You have to download the project data that you have created with SIMOTION SCOUT to the
target system. The target system can consist of several CPUs (SIMOTION controllers).

The project data contains the programs (ST, MCC, LAD/FBD, and DCC) that you have
created and compiled, the hardware configuration, and the technology packages that you
have created and parameterized.

Additional references
The exact download procedure is described in:
® Function Manual: SIMOTION Basic Functions
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5.2 Using diagnostic functions

5.21 Overview of the possible diagnostic functions

A wide range of diagnostic functions can be used for the operation of SIMOTION devices in
the online mode. These diagnostic options are summarized in the diagnostics overview:

® The diagnostics overview is a tab in the detail view and is available by default in online
mode. You can call up detail displays from here.

® An Alarms tab is also available in the detail view. This provides a tabular overview of
— Technological alarms (from technology objects)

— Alarm_S messages (from user programs)
The alarms can be acknowledged either individually or all together.

o Comprehensive diagnostic information ( e.g. diagnostics buffer, system utilization, and
task status, etc.) is accessible via Device Diagnostics as a window in the working area.

® You can record signal charts with the trace tool. The values of system variables can be
recorded during runtime for diagnostic purposes.

® Program testing and debugging, e.g. variable control, program status, breakpoints

Additional diagnostic functions are available with SIMOTION V4.1 SP2 and higher. On the
basis of simple operations (e.g. by setting the switch position) and without the need for the
SIMOTION SCOUT engineering system, you can:

® Back up diagnostic data including non-volatile data (retain data) to CompactFlash Card
(for SIMOTION D), MMC (for SIMOTION C) or hard disk (for SIMOTION P)

® Back up websites, including the most up-to-date content for diagnostic purposes, to the
CompactFlash Card, MMC, or hard disk

® Restore backed up non-volatile data (retain data)

Further information can be found in the FAQs on the Utilities & Applications CD under:
FAQs > Engineering > Backing up diagnostic data and non-volatile data

SIMOTION IT DIAG also offers comprehensive diagnostic options that can be easily
accessed via an Internet browser.

References
For more information, please refer to
e SIMOTION ST Structured Text Programming and Operating Manual
e SIMOTION MCC Motion Control Chart Programming and Operating Manual
e SIMOTION LAD/FBD Programming and Operating Manual
® Diagnostics Manual: SIMOTION IT Ethernet-based HMI and Diagnostic Function
e SIMOTION SCOUT Online Help
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5.2.2 Using the diagnostics overview

The diagnostics overview is available as a tab in the detail view when the project is in online
mode.

® |n the detail view, select the Diagnostics overview tab.

Device I Dperdi...l Ral disk occupied I R&M accuped | Mermory card occupied | Fetendive data ocoup.. I CFL uhlization
c230_2 SToP 70 KB M.0%) 765 KB (75 %) 9 ME [59.6 %) 520 Byte [4.2 %) nx

I 2aims | 2= Symbol beowser | [EE] Taget systemoutput | ] Conpilescheck output. %€ Diagnostics overview ]
Figure 5-6  Diagnostics overview in the detail view (online mode)

The following are displayed for each accessible SIMOTION device:
® Operating mode
® Memory used (absolute and percentage display)
RAM disk, RAM, memory card, retentive data
e CPU utilization (percentage display)

The drive devices specified in the hardware configuration are also displayed. To obtain a
detailed display of the individual devices, open the device diagnostics.

5.2.3 Device diagnostics

In online mode, the device diagnostics function enables you to obtain a comprehensive
display of diagnostics results of the individual SIMOTION devices.

Proceed as follows:

1. Select the desired SIMOTION device in the project navigator.
2. Select the Target system > Device diagnostics... menu.

or

1. Double-click the SIMOTION device in the Diagnostics overview tab in the detail view.

Note

You may open the device diagnostics for several SIMOTION devices simultaneously.
This allows you to compare different devices.

You can also access these device diagnostics via the Accessible nodes function.

The Device Diagnostics window appears in the working area of the workbench. This window
provides you with the following information:

® General information
® Diagnostics buffer
® Slaves

® Task runtimes

e System utilization
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e User log file

® Syslog file

® \/ersion overview

You have the following options:

® Print:
Select the Project > Print menu.

® Save it as a text file:
Click Save.

® Refresh:
Click Refresh or press the <F5> function key.

You can also monitor and change the operating mode:

e Click Control operating mode.

524 Device diagnostics: General
This provides general information on the SIMOTION device:
® Select the General tab in the Device Diagnostics window.
The following information will be displayed:
® Name and system ID of the SIMOTION device
® QOperating mode of the SIMOTION device
e MAC addresses
® |P addresses

® Subnet mask
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5.2.5

Standard gateway

Order numbers and names of the components used,
e.g. SIMOTION device, Motion Control technology package.

I tics - [D435]

(el Diagnostcs bufer | Slaves | Task manager | System wtiizaton | Usetog | Systog | content.tt | Alarms |

OpenT diagnostics

=lof/ x|

| _controloperating mode.._ |

Active MAC address:(1-2)

P addiess(1-2)
Subnet dialog bo(1-2 )
Standard gateway: (1-2)

D43
DVCUSE041
sTOP
08000673716

192168.016
265,255,256,

08000672717

183.254.11.22
26525500

Order no./ok

IIIIIIII

BAUT 43506500 0641
pr—
ttttt

CPU: Serial no: 51172018838 C
0S: Buidno: 47.630.0uncd7.6.. 4130
TP:Buldno. 47.6300umed76.. 4130

i no: 0000 0000
0S: Budne: 000.0 250480
Serial no.: Ddwy_BOOT_V02.07

Bios Seral no.: ¥00.00.03.00

SINAMICS integrates 4
Boot loacker

Cose | ReliehFs) | Savess. | Help

Figure 5-7

Display of general information in the device diagnostics

Device diagnostics: Diagnostics buffer

The diagnostics buffer is part of the system status list. It is possible to jump to the error
position from the diagnostics buffer (as of V3.2). It logs important events (e.g. changes in
module state) in the order in which they occur. These include the following:

Faults in a module

Faults in the process wiring

System errors in the CPU

CPU operating mode transitions

Drive alarms

Errors caused by the technology objects of SIMOTION

Errors in the user program that caused an operating state transition (a double-click on the
error message causes the cursor to jump to the error location in the program)

User-defined entries with the _writeAndSendMessage function
PMC error messages (SIMOTION D4x5)
Compeatibility errors, e.g. the drive software with SIMOTION (SIMOTION D4x5)

The SINAMICS Integrated diagnostics buffer is also displayed for the SIMOTION D4xx as of
SIMOTION version V4.1 SP2.

114

SIMOTION SCOUT
Configuration Manual, 05/2009



Diagnostics

5.2 Using diagnostic functions

To work with the diagnostics buffer:

1. In the Device Diagnostics window, select the diagnostics buffer tab.
The saved events are displayed in tabular form.

2. Select the event for which you want to obtain more information.

Detailed information for the selected event is displayed in the lower pane of the window.

=lalx|

Open!T diagnosics | Contiol operating mode... |

General  Diagnestios buffer | Slaves | Task manager | System utization | Useiog | Systog| content.ut | Alams |

Help ot evert: Display hes values only [~

03 0BDDZ5I0I 010132 User programm being laded, mode: 3

04 000015006 010132  Operating mode ansiion from INIT to STOP: Start

05 000015008 010132 Operating mode INIT reached

05 000000000 010182  SINAMICS and PROFIELS software loaded and started
07 000000000 010182 Device without battery modkie

02 000000000 010182  SINAMICS and PROFIELS software loaded and tarted

03 0ODDODOOD 010192  Iniialzation of persistent data - reasan: Commissioring made 1
10 000DODOOD 010182 Device wihout battery moduie

Event detals: 10f10 Event ID: 16 F360.8281

Gperating mode STOP reached =
incaring evert

L o
Fefiesh(FS) | Saveas. | He
Figure 5-8 = Example of the diagnostics buffer display in the device diagnostics

Close
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5.2.6

5.2.7

116

Device diagnostics: Slaves

The devices displayed in the Slaves tab of the device diagnostics are not identical to the
display in the Accessible Nodes window.

Note
When you open the Slaves tab, you must refresh the display.

Click the Update button or press F5 on the keyboard.

After refreshing the view, the following devices are displayed in the Slaves tab:
® Devices configured in HW Config

e All devices that are configured in the Slaves function

=lolx|

OpenT diagrostics | Contiol operating mode... |

General| Disgrostics buffer  Slaves | Task manager | System utiization | Useog | Sysiog | content it | Alams |

[Update with F5

Subnet [DP/IP addhess] Logical addh [ Slaves [State

Cose | RefeshFs) | Saveas | Help

Figure 5-9  Example of the Slaves tab display in the device diagnostics

Device diagnostics: Task Manager

You can display the task runtimes and the status of the tasks set up in the project if you are
connected online with the unit. The resolution of the displayed task runtimes is performed in
the servo cycle clock.

Note

The task runtimes are calculated to the ys and indicate the effective level runtime of the
respective task (including the interrupt times). These thus correspond to the values of the
effectiveTaskruntime device variables.

The following applies to SIMOTION Runtime versions < V4.1:

The display is calculated in the servo cycle clock and has only the resolution of the servo
cycle clock. As the task runtime can be less than the servo cycle clock, e.g., for the
ServoSynchronousTask or IPOSynchronousTask, the value 0 ms is displayed in this case.
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@/ De vice diagnostics - [0435] -lolx|
Open!T diagnosties | Contiol cperatingmodes.. |
Genera | Disgnostics uffer | Slaves Task manager | ystem utzation | Lsetag | Sysiog| content ot | alerms |
o Refieshrate: [Manual (5) = Task tiace
Please activate the debug mode under "CPL test mode' o contol the motion tasks Display | Create snapshot
Task [ Task status [sctusl min ma Mean val .
Backgound ask. STOPPED 0000ms  0000ms  000ms  0.00ms
2 STOPPED 0000ms  0000ms  0000ms  0000ms
STOPPED 0000ms  0000ms  0000ms  0000ms
STOPPED 0000ms  0000ms  0000ms  0000ms
o STOPPED 0000ms  0000ms  0000ms  0000ms
MotionT ask_1 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 2 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 3 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 1 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask & STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask & STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 7 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 8 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 9 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask_10 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask_11 STOPPED 0000ms  0000ms  0000ms  0000ms
MolionTask 12 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 13 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask_14 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask_15 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask_16 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 17 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 19 STOPPED 0000ms  0000ms  0000ms  0000ms
MotionTask 19 STOPPED 0000ms  0000ms  0000ms  0000ms
MolionTask 20 STOPPED 0000ms  0000ms  0000ms  0000ms
MolionT ask_21 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask 22 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask 23 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask_24 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask_25 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask 26 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask_27 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask 28 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask 29 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask_20 STOFPED 0000ms  0000ms  0000me  0.000ms
MolionT ask_31 STOFPED 0000me  0000ms  0000me  0.000ms
MolonT ask_22 STOFPED 0000me  0000ms  0000me  0.000ms
PerpheraF aulTask. STOFPED 0000me  0000ms  0000me  0.000ms
SewoSunchionousT ask STOFPED 0000me  0000ms  0000me  0.000ms
Sodout STOFFED DM DO 000 00 yn:';l
« >
Coss | RefeshiFs) | Saveas | Help

Figure 5-10 Example of the task runtimes display in the device diagnostics
The display is refreshed according to the refresh rate selected. The status and the following
values are then displayed:

® Current runtime (current):
Value of last polling

®  Minimum runtime (min.):
Minimum value since last transition from STOP to RUN

® Maximum runtime (max.):
Maximum value since last transition from STOP to RUN

® Mean runtime (mean value):
Value averaged from the last 10 cycles

The runtimes measured include the interruptions by higher-priority tasks.

Meaning of the various status displays:
® RUNNING (TASK_STATE_RUNNING)
Task running, e.g.:
— Via the _startTask function
— As an active cyclic task
¢ RUNNING_SCHEDULED (TASK_STATE_RUNNING_SCHEDULED) (as of V4.1)

Task interrupted by system.
If the task status RUNNING_SCHEDULED remains pending for a long time, it identifies a
long-runner in the user task, e.g., a programmed continuous loop.

o STOP_PENDING (TASK_STATE_STOP_PENDING)
Task has received signal to stop; it is in a state between RUNNING and STOPPED.

Actions may be performed until the task has stopped.
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e STOPPED (TASK_STATE_STOPPED)

Task stopped (e.g. via the _resetTask function), completed or not yet started.
e SUSPENDED (TASK_STATE_SUSPENDED)

Task suspended by function _suspendTask.

Use _resumeTask(name) to cancel this command. The task then resumes from the point
at which it was interrupted.

e WAITING (TASK_STATE_WAITING)
Task is waiting due to function _waitTime or WAITFORCONDITION.

o WAITING_FOR_NEXT_CYCLE (TASK_STATE_WAIT_NEXT_CYCLE)
TimerInterruptTask waiting for start trigger.

o WAITING_FOR_NEXT_INTERRUPT (TASK_STATE_WAIT_NEXT_INTERRUPT)

SysteminterruptTask or UserlnterruptTask is waiting for the triggering event to occur.
When an interrupt occurs, the SysteminterruptTasks are started and executed once. Up
to 8 incoming interrupts can be stored in the buffer. If another interrupt occurs, the buffer
overflows and the CPU goes into STOP mode.

e LOCKED (TASK_STATE_LOCKED)
Task locked by function _disableScheduler.

This status prevents the activation of all user tasks (except the IPOSynchronousTask and
IPOSynchronousTask_2) until command _enableScheduler is called. It does not,
however, affect system tasks. The time watchdog for cyclic tasks is not suspended.

Note
The also prevents the activation of the SysteminterruptTasks and UserlnterruptTasks.

Controlling MotionTasks

It is possible to control MotionTasks via SIMOTION SCOUT without a user program that has
been created by the user. Consequently, you can test programs and influence MotionTask
sequences in a very specific way.

Selected MotionTasks can be stopped, and locked or restarted for the sequence.

This means that programs in MotionTasks can be downloaded in RUN mode. If you have
made changes to sources and want to reload them in RUN mode, an active MotionTask can
prevent this. To avoid this problem, you can terminate specific MotionTasks with

SIMOTION SCOUT and then carry out the download in RUN mode.

Additional references
Further information on downloading in RUN mode can be found in:
® Function Manual: SIMOTION Basic Functions
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5.2.8 Device diagnostics: Checking the system utilization

To display the system utilization:

e Select the System utilization tab in the device diagnostics.

@/ Diagnostic de I'appareil - [D435]

CuiT Dsg__| ot dofrcion.. |

Général | Tampon de diagnostic |E claves | Gestionnaie des taches  Charge du ystéme | Userog | Syslog | contenttst| Alame |

[menueiFs) =]

23Ma | % Mo [488 Mo | 364 Ko

WW T

orn %
Efo [l [Ei [0 o 0%
01% | %53% | 74% e Tp decpoke /0: 6%

o

eeeeeeeeeeee

Femer | _Metwsaiou F5) | _Emegistersous... |

Aide
Figure 5-11  Example of the system utilization display in the device diagnostics

Additional references
Further information on this topic can be found in:

® Function Manual: SIMOTION Basic Functions, Chapter "Overview of Memory in Target
Device"

e SIMOTION SCOUT Online Help

Display on system utilization tab

The utilization of the following system resources is displayed:

RAM disk

After the download, the RAM disk contains the hardware and device configuration,
technology packages, configuration data of the technology objects, and the program units.
Use Copy RAM to ROM to copy the contents of the RAM disk to the memory card and
release the memory on the RAM disk. During subsequent downloads, only modified data is
loaded to the RAM disk.

The RAM disk or the memory card also contains the user data that was created from the

user program using file system functions. Copy RAM to ROM applies only to the project data
from the download.

SIMOTION SCOUT
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RAM

Memory card

Retentive files

After the controller powers up, the RAM contains the code and the data of the technology
objects (technology packages and data of the instanced technology objects) and the
executable program units.

Memory card (ROM) memory

Non-volatile memory of the SIMOTION device

CPU utilization due to system tasks

Here, the utilization due to system tasks (servo, IPO, IPO2, TControl, DCC) and due to
synchronous user tasks (ServoSynchronousTask, IPOsynchronousTask,
IPOsynchronoursTask_2).

Various problems arise with a CPU utilization of about 70% and higher, such as sporadic
connection terminations with the PG. A utilization of 80% or higher is considered critical, as it
can result in level overruns of important tasks (level overruns lead to CPU STOP with the
operating mode transition or "BZU" blocked).

Note

Do not operate the SIMOTION device at more than 60% utilization in order to maintain a
reserve for load fluctuations and peak loads.

The data listed above are displayed as:

e Diagram

® Absolute value for the maximum value
e Utilization (KB or bytes)

® Percentage value

Free cycle of the background level

120

The user cycle time for the background task is displayed in ms with the:
® Minimum value

® Maximum value

e Current value

The cycle time of the background task is a measure of one round of all active round-robin
tasks (communication, motion tasks).

SIMOTION SCOUT
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The display in the utilization area contains additional information on the system utilization:

SIMOTION SCOUT

1/0 controller:
For C2xx and P350:

Displays the processor utilization of the integrated I/O controllers due to the cyclical and
acyclical communication with the centralized and distributed peripherals as well as due to
the communication with IBN and B&B devices.

Values > 90% are critical and indicate problems, due to, for example,

— the data volume of the configured process peripherals (centralized and distributed)
— the types of modules on the central peripherals

— the cycle times on the isochronous PROFIBUS segment

— the dynamic load with acyclical orders from the user program (_read/writeRecord,
_read/writeDriveParameter, etc.)

— the dynamic load due to communication with IBN and B&B devices

For D4x5:
Displays the processor utilization of the integrated /O controller.
Values > 90% are critical and indicate problems, due to, for example,

— the dynamic load with acyclical orders from the user program (_read/writeRecord,
_read/writeDriveParameter, etc.)

— the dynamic load due to communication with IBN and B&B devices
— the drive regulation of the SINAMICS integrated (number of axes).

For D410:

Value has no relevance. The utilization due to cyclical and acyclical communication is
included in the CPU utilization.

Round robin:

Shows the computing time of the SIMOTION processor in the round robin level, in which
the background task, motion tasks and some system tasks run.

Values > 90% are critical and indicate continuous loops in motion tasks or computing-
intensive portions in the background task. As a result, communication and diagnostic
functions and the HMI connection become very slow.
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Solution:

MotionTasks, which run endlessly with a WHILE / REPEAT loop, and thus cyclically,
place a burden on the round robin level. Each MotionTask thus takes up the entire servo
cycle clock.

Alternatively, a _waitTime(Oms) should be inserted at the end of the loop. Then the
MotionTask releases the computing time after one loop cycle to the next MotionTask or
BackgroundTask and thus does not use it unnecessarily.

The control statement WAITFORCONDITION and the step enabling conditions for
"Delay program execution" likewise release the computing time to the next round robin
task.

The use of _waitTime (0 ms) can also be helpful with a computing-intensive background
task.

Communication:

The utilization of the communication buffer for the communication with IBN and B&B
devices is displayed here, e.g., for SCOUT or HMI. 90% should not be exceeded here.

SIMOTION SCOUT
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® |/O copying time:
For C2xx and P350:

Here, the time portion of the copying actions of the integrated I/O controller for the
cyclical communication (centralized and distributed) is displayed in relation to the
configured servo cycle clock.

The display value is calculated one time for each BZ transition and change in the
peripheral arrangement (e.g., station failure/restore). For a value > 65% in the RUN
operating mode or 55% in the STOP operating mode, a "cycle overload, reason n"
diagnostic buffer entry will be triggered (n=1: RUN, n=2: STOP). In these cases, the
system should be relieved by increasing the servo cycle clock.

For D4xx:

Value has no relevance.
® |/O cycle time:

For C2xx and P350:

The utilization of the I/O processor due to the cyclical communication is displayed and
thus also the proportion of time of the configured PROFIBUS cycle clock required for a
servo cycle clock cycle. This proportion of time includes the duration of the transfer of
cyclical data (data exchange) on the synchronous PROFIBUS DP, the subsequent
reading in of the input data, the runtime of the servo task in its regulating technology
portion as well as the output of the output data (target values) to the peripheral interface
and thus the preparation for the transport in the next DP cycle.

For D4xx:

The maximum utilization of a cycle is due to cyclical system tasks since activation is
displayed here. High values (e.g., > 90%) with low CPU utilization indicate only sporadic
loads due to system tasks. An IPO overrun should therefore be tolerated.

The following applies to all platforms:

If the I/O cycle time is greater than the cycle time of the isochronous PROFIBUS DP, then
a diagnostics buffer entry "Error in cyclical operation, reason 5, note n" is triggered.

The indicating parameter n can have the values 1, 10, 100 and 1000 and thus signals the
nth event of a cycle overrun. The frequency of the overruns can be calculated from the
time interval of the entries. Isolated overruns in larger time intervals can be tolerated as
long as they do not result in any negative effects on the technology.

In principle, however, the system should be relieved by increasing the DP cycle time.

SIMOTION SCOUT
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5.2.9

Device diagnostics: User log file

With the Userlog file, you can store your own text strings in the RT system. This is
necessary, for example, when changes, which are to be documented, are made in the
SIMOTION system on a plant which has already been commissioned.

Changes can be written in the SIMOTION SCOUT. These are loaded to the ROM of the
target device. When required, the text strings can be read out again. The text editor for the
Userlog file is integrated as a tab in the device diagnostics snap-in. This function is only
available in online mode.

@i Device diagnostics - [SIMOTION_1] ] 5

General | Diagnostios buffer | Sloves | Task manager | System utiization USEHDQISyﬂDgl Alams

Save in barget systen I

Open IT diagnostics Contral operating mode... |

val

Servicesnginesr

Serviceenginesr: Karl Maier
Date: 2008-12-06
Task: Errormessage encoder fault

Encoder at motor 13 replaced

Date: 2008-11-02
Task: Update runtime to version 4.1.2

Karl Maier

Close I

Riefresh (F] I Save as... I Help

Figure 5-12 Example of the Userlog file display in the device diagnostics

How to work in the Userlog file

124

e Select the Userlog tab in the device diagnostics.
The editor is in editing mode, i.e., you can immediately type or delete.
The system adds no further system contents, such as date/time.
You enter all of the necessary information.

® To save, click Save as... The Userlog file is stored as .txt.
All text entries can be changed or deleted at any time.
Access protection is not available.

® The Userlog file can also be read without a project.
The online mode is required for this.

® The Userlog file remains after user data are deleted.

SIMOTION SCOUT
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5.2 Using diagnostic functions

In addition to the user-defined Userlog file, the SIMOTION device also has a Syslog file. The
ROM actions entered therein facilitate a subsequent diagnosis. This function is only available
in online mode. The information of the Syslog file can also be read without a project.

The Syslog file logs the following actions:

* RAM2ROM

® Overall reset

® Formatting of the card from SIMOTION SCOUT

nostics - [SIMDTION_1]

General | Diagnostios buffer | Slaves | Task manager | System utiization | Userioa  545/0a | alams |

=10l x|

Open |T diagnostics Control operating mode. . |

112172008 16 .22 49 000 HINT: File system successfully mounted
11-21-2008 16.22.49. 000 HINT Starting control

11-21-2008 16.22.56.000 HINT File system successfully mounted
11-21-2008 16.22.56.000 HINT: Restarting control

11-21-2008 16.25.02.000 HINT: File systemn successfully mounted
11-21-2008 16.25.02.000 HINT: Restarting control

11212008 16.27.41.000 HINT: File systemn successfully mounted
11-21-2008 16.27.41.000 HINT: Restarting control

11-21-2008 16.28.52 486 HINT Starting RamToRom

11-21.-2008 16.29.40.720 HINT RamToRom successfully finished
11-21-2008 16.31.05.062 HINT: Starting RamToRom

11-21-2008 16.31.06.187 HINT: RamToRom successfully finished
11-21-2008 16.41.35.839 HINT: Starting RamToRom

11-21-2008 16.41.36.829 HINT: RamToRom successfully finished
11-21-2008 16.42.49.075 HINT: Starting RamToRom

11212008 16.42 .50.215 HINT: RanToRom successfully finished
11-21-2008 16.46.10.108 HINT Starting RamToRom

11-21-2008 16.46.11.095 HINT: RamToRom successfully finished
11-21-2008 17.36.10.639 HINT: GStarting RamToRom

11-21-2008 17.36.11.773 HINT: RamToRom successfully finished
11-21-2008 17.37.27.037 HINT: Starting RamToRom

11-21-2008 17.37.28.183 HINT: RamToRom successfully finished
11-21-2008 18.11.27 601 HINT: Starting RamToRon

11-21-2008 18.11.28 780 HINT RamToRom successfully finished I
11-21.-2008 18.12.24 826 HINT Starting RamToRom

11-21-2008 18.12.25.990 HINT: RamToRom successfully finished
11-21-2008 19.33.22.988 HINT: Starting RamToRom

11-21-2008 19.33.24.049 HINT: RamToRom successfully finished
11-21-2008 19.38.15.559 HINT: Starting RamToRom

11212008 19.38.17.233 HINT: RanToRom successfully finished
11-21-2008 19.39 .52 645 HINT Starting RamToRom

11-21.-2008 19.39.53 668 HINT RamToRom successfully finished
11-21-2008 19.43.41.134 HINT: Starting RamToRom

11-21-2008 19.49.42.277 HINT: RamToRom successfully finished
11-21-2008 20.03.39.739 HINT: Starting RamToRom

11-21-2008 20.03.41.494 HINT: RamToRom successfully finished
11282008 17 50 29 000 HINT: File system successfully mounted
11-28-2008 17 .50.29.000 HINT Starting control

11.-28.-2008 19.49.07.709 HINT Starting RamToRom

11-28-2008 19.49.09.614 HINT: RamToRom successfully finished
12-08-2008 11.58.05.000 HINT: File systemn successfully mounted
12-08-2008 11.58.05.000 HINT: Starting control

12-08-2008 12.21.28.958 HINT: Starting RamToRom

12-08-2008 12.21 30.989 HINT: RamToRom successfully finished
12-08-2008 12.25.18.716 HINT Starting RamToRom

]

|+

Close | Riefresh (F) | Save as... |

Help

Figure 5-13 Example of the Syslog file display in the device diagnostics

SIMOTION SCOUT
Configuration Manual, 05/2009

125



Diagnostics

5.2 Using diagnostic functions

5.2.11 Device diagnostics: Version overview

The version overview tab displays the SIMOTION version and the data of the SIMOTION
device stored in the CompactFlash card.

The following data are displayed:
e SIMOTION version
® BIOS version
e Components
Versions of the SINAMICS components
® Internal version / stamp
Internal components

This information is relevant for any questions to the hotline.

EEE

Open T diagrostios | Control opereting mode..._ |
General | Diagrostios buifer| Slaves | Task manager | System itization | Userog | Sysiog contertt | alams |
ompact Flash SIHOTION DAXX_PN21 V04 01 03.00 (intewnal Versiom 47 63 00 00) includes =
Konponente interne Version Stenpel
- SD_FY_Tools NAHICS SD_FW TOOLS 02 50 48.00
~  Tib Target ALL i 15 TARGET ALL_02 50 48,00
~  Tvaz Target ALL i TYAR_TARGET_ALT_02 50.48.00
- Tools i SD_FU 50
- 0_Target T N D410_TARGET 1_02.50.48.00
— D DIRECTORY THANICE TNFO_02.50 4800
- STHOTION DdxS FW MCHIN 47.63
- SIMOTION D410 FW 7 UMCHIN 4763
- EI0s 710 80 H EI0S 710 V02 02.00.00
- CEE3U_ENZL FV 4 CEE_K0200_3312
—  DAC_ABO2 Target 2 SINAHICS DAC_ABO2_TARGET 02.50.48.00
~  DACTABO Torget 02.50 4500 SINANICS_DAC_ABO_TARGET 02 50.48.00
—  DACTCUSTXI Target 02.50 4500 SINANICS DAC CUITXI_TARGET 02 50 48.00
—  DACCUA3IX Target 02.50 4500 SINANICS DAC_CUA31¥_TARGET 02 50 48 00
- DACCUA31 Target NAHICS DAC_CUA3I1 TARGET 02.50.48.0
DA CTA32 Target WAHTCS DAC_CUA32_TARGET 02 50 48.00
~  DACTDHC20 Target HAK C_DHCOII_TARCET 02 50 48, 00
—  DACTSHC30D_Target AN C_SHC3ND_TARGET 02 5048 .00
~  DACTHGIE Target Al C_THG4F_TARGET 1250 48,00
—  SACABOIDFI NAMICS SAC_ABO3ID_FW_07.50. 4
- SACCAROXFIl NAHTCS SAC_ABOIX_FW 02 50 4
- TABQ_Bootnaster NANTCS 5AC_ABO_BOOTHASTER 02 50 .20.00
- SACPSAF FW NANTCS 5AC_PSAF_FU 0250
- SaCESAIEW NANICS SAC_PSAL_FV_02.50.43,00
- Sacesa FW NAHICS SAC_PSA Fi_02.10
~  SACSHCTOR Bootmaster 022002100 SINANICS SAC_SHCTNE_BOOTMASTER_02 20.02.00
~  SACTSHCIOXF! 02.50 43100 SINANICS SACTSHC10¥_FW_02 50 43 .00
—  SACSHC20E Bomtmaster 02.20.02 SINANICS SAC_SHC20E_BOGTMASTER 02 20.02.00
- sacswcoox 4 NAHICS SAC_SHC20X FV_02 50 43 00
— sacaic WAHTCS SAC_SHC30E_BOOTHASTER 02 40.16.00 _
- sacaiC HAK C_SHCINY_FV_02.50 43 00
—  SacSKCa0 AN CTSHC3IN_FU 02 40 35.05
- saconr Al C_SHT10E_BOOTHASTER_02.20.02.00
- sacenr NANTCE SAC_SHILOX FV_| 3.00
- sacsur NAMTCS SAC_SWI205_BOOTHASTER 02.20.02.00
- sacsir NANTCS 5AC_SHIZ0Y_F. £.00
- eyt NANTCS SAC_THI5_FY_02.50 43 00
- sacr NAHICS SAC_TH17_FV_02.50 43 00
- sacCmHaID 02.50 43000 STNANICS SAC_TH31_FV_02 50 43 00
- sacTTHaiTEw 02.50 43000 SINANICS SAC_THA1_FW 02 50 43 00
- sacvaMEw 02.50 43000 SINAMICS SAC_VSM_FV_02.50.43.00
- SD_dppview 0250 4800 SINANICS APFVIEW 02 50 4800 -
K] _'l_‘

Cose | RetwhFs | saeas. | b |

Figure 5-14 Example of the version overview display in the device diagnostics
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5.2.12 Device diagnostics: Alarms

In the device diagnostics Alarms tab, pending alarms and configured messages are
displayed in the same way as in the Alarms tab in the detail view.

Detailed information can be found in the SIMOTION online help, in the Alarms output
window.

IV Displaynformaton Ackrowecige s Ackrondge | Helpfor evert |

Coss | RefieshlFs) | Saveas | Helo

Figure 5-15 Device diagnostics - Alarms

5.213 Interconnection overview

SIMOTION SCOUT

The interconnection overview allows you to display all motion input and output
interconnections of technology objects within the project. This overview is displayed in the
SIMOTION SCOUT working area in the form of an interconnection tree.

The tree display enables the synchronous operation interconnections to be displayed in
cascades. In the interconnection table below, you can see all the TOs interconnected on the
input and output sides for the technology object selected in the interconnection tree.
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- [435
—|-%%# Azze 1_SINCROMISMO
o= Interconnection tree on the input side
+-=0- |Interconnection tree on the output side
'—t'F Amiz_1
= '—t'F Asze_1
—|-o= Interconnection tree on the input side
ok fhoce 1 SIMCROMISKMO
-0 Interconnection tree on the output side
wam Tastatore_di_misura_1
i Tastatore_di_misura_2

Interconnections of: #% D435 Asse 1 _SINCROMNISMO

TO name - Input interfaces Output interfaces TO name
Follovwving axis D435 Azse 1

Figure 5-16 Example of an interconnection overview

Additional references
Further information on this topic can be found in:
® Function Manual: SIMOTION Basic Functions
e SIMOTION SCOUT Online Help

5.214 Service Overview

In online mode, the service overview shows a tabular complete overview of all configured
axes in the project. The current state (including values from system variables) is displayed
along with fault conditions.

The service overview is called up via the Target system > Service overview menu.

SIMOTION SCOUT
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(2) Service overview =10l x|
| SIMOTION_1
Achse_1a|Achse_1b |Achse_2 vil Achse_1
|-Pﬂsi(inn control status (] (] [ =]
Operational status (] (] (@] ) O
Technological alarm at the axis| () (@] (@] (@] "]
Cyclic drive interface active § § i § §
Actuator error (@] (@] (@]
Status of axis motion [=]
Actual velocity of the axis 0000000 | 0000000 |0.000000 | 0000000 | 0000000
0000000 | 0000000 |0.000000 | 0000000 | 200 0000
0000000 | 0000000 |0.000000 | 0.000000 | 0.000000
Velocity override 100.00000 | 100.00000 100.0000| 100000000 |100.0000
s
Extended Close: Help

Figure 5-17  Service Overview

5.2.15 Task Trace

Application area

The SIMOTION Task Trace supports you when troubleshooting in the SIMOTION
multitasking environment. The SIMOTION Task Trace records the sequence of individual
tasks, identifies user events that you can generate via a program command, and displays

these graphically.

Structure of the Task Trace
The SIMOTION Task Trace includes two main components:

® The SIMOTION Task Tracer, which writes the task change and events to a buffer on the
target device, and

® The SIMOTION Task Profiler, an application for displaying the recorded data

SIMOTION SCOUT
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Additional references
Further information on this topic can be found in:
® Function Manual: Task Trace
® Diagnostics Manual: SIMOTION IT Ethernet-based HMI and Diagnostic Function
e SIMOTION SCOUT Online Help

5.2.16 Accessible nodes

A list of the devices switched on and connected to the PG/PC is displayed via the Accessible
nodes function in the SIMOTION SCOUT working area. The display is related to the PG/PC
interface which is configured as the application access point in "Set PG/PC interface".

A SIMOTION project must not be open in order to use this function.
Proceed as follows:

1. Select the Project > Accessible nodes menu.

2. Select the corresponding node.

3. Right-click and select the following functions in the context menu.
e Operating mode ...

® Device diagnostics ...

® Copy from RAM to ROM ...

® Licenses

® | ogfiles

e Archived project

e SINAMICS Upload

Additional references
For additional information on this topic, refer to:
e SIMOTION SCOUT Online Help

SIMOTION SCOUT
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5.217 Program testing and debugging

Comprehensive program testing and debugging functions are available in
SIMOTION SCOUT. You can execute the following functions:

Control variable
Program status

Breakpoints

Additional references

Please refer to the following documents on this subject:

SIMOTION ST Structured Text Programming and Operating Manual

SIMOTION MCC Motion Control Chart Programming and Operating Manual
SIMOTION LAD/FBD Programming and Operating Manual

SINAMICS/SIMOTION DCC Editor Description, Programming and Operating Manual

and the SIMOTION SCOUT online help.

SIMOTION SCOUT
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6.1 Update device

Overview

SIMOTION offers a convenient solution for machine manufacturers and machine operators
to update SIMOTION devices or SIMOTION projects.

Updating does not simply refer to an update to a higher version of firmware; rather, in
general terms it refers to switching to a defined configuration, e.g. a project update. It is also
possible to return (restore) to a previous configuration. Update or restore procedures can
easily be performed on SIMOTION devices locally or remotely. The data can be imported to
a SIMOTION device via a convenient and handy storage medium or a communication
connection.

Update data and update media

SIMOTION SCOUT

The update data is created by SIMOTION SCOUT based on one or more
SIMOTION projects. All information required for the update is contained in the update data.
This includes:

SIMOTION project

® Technology packages

® Userdata
® Firmware

After the update data has been created, it can be handled flexibly depending on the
SIMOTION device in question (SIMOTION C, D, or P). The storage or update medium can
take the form of:

e CF/MMC card
e USB memory stick or
e SIMOTION IT DIAG file
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Update wizard and Device Update tool

Call up the update wizard via SIMOTION SCOUT. This will give you a step-by-step guide to
creating the requested update data, which are then either saved in an update archive or

134

imported directly to an update medium.

1. Select the Project > Start device update tool menu, either directly in SIMOTION SCOUT

or in an open SIMOTION project.

Project Edit Insert Targetsystem ‘iew Options Window Help

New... Y
Open... Chrl+
Close

Save oS
SavE A5

Save in ald project Farmat.. .

Conversion of old Starter projects. ..

Check consistency Chr+AlHE
Save and compile trl+AlE+E
Save and recompile all

Download ta target system

Properties...

Know-haow protection

Revake write pratection

Delete...

Connect to target system
Disconnect from barget system
Accessible nodes

Set PGIPC interface. ..

Assign PEIPC

Archive..,
Retrieve from archive...

Save and export. ..

Impork.. .

Language-dependent kexts

Messages 3
Open NetPro

Print... Chrl+P
Laheling Fields. ..

Prink preview, .

Prinker setup...

1 SCOUT_proj_L -- C:\Program FilesiSiemensiStep?|s7profisco. ..

Figure 6-1 SIMOTION SCOUT - Starting the SIMOTION Device Update tool

2. The update wizard opens with the start screen . Now you can select the data for updating
from the SIMOTION project to the SIMOTION device on a step-by-step basis, and specify

whether you want to update subsets or the entire project.

SIMOTION SCOUT
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4+ Welcome to the SIMOTION Device Update tool ¥4.1.4.0 x|

Thiz tool can be uged to create update data for
- a hewly selectable zet of SIMOTION Devices
- a formerly selected get of SIMOTION Devices

Altematively, you can create a restore tigger, which can be uzed to explicitly restore data
from applied update data.

Far further infarmation pleaze consult the onling documentation [keyword “upd_tool''] or
refer to the SIMOTION Documentation CO. chapter "Diagnosis".

' Create update data

[ zelect data which were farmerly stared in the file system |

{~ Create restore igger

Mest » I Cancel Help

Figure 6-2  Wizard start page: Device Update tool

Additional references

A detailed overview of the update process can be found in:

® Operating Manual: Upgrading SIMOTION Devices
e SIMOTION SCOUT Online Help

SIMOTION SCOUT
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FAQs 7

71 Handling Recommendations for Service with SCOUT V4.1

711 Selecting the right project with SCOUT V4.1

The observation of the following recommendations for the configuring simplifies maintenance
work.

Working with the right project

In order to ensure that you are always working with the right project, save the revised and
archived project as a zip file on the CF card.
Each time you work with the project, use only this zip file.

The project data can be archived on a memory card in SCOUT.

- l

P f Open HW configuration

g I cu

= Copy

B-Z 4 e

_l E

_| F Delete

10 Rename

B

-] F v Connect onling

: Target device Dovirload ..
#-_ ] LIER  Teskmade... Load comfiguration data bo P&, .

-1 MON|  Debug Eask graup q
Debug kable Load praject From card, ..

Figure 7-1 Archive SIMOTION project to card

The accessible nodes function can be used to determine on which CPU a Project.zip is
stored.

Load the project from the memory card.

The project data archived on the memory card can be transferred to "PROJEKT.ZIP" on the
hard disk of the PG/PC in the Accessible Nodes view via context menu (right mouse button).
Alternatively, the SCOUT function is also available in the context menu

Load project from card... on the device. Next, the archive project transferred to the hard disk
must be dearchived.

SIMOTION SCOUT
Configuration Manual, 05/2009 137



FAQs

7.1 Handling Recommendations for Service with SCOUT V4.1

Use routing

The Log Files as

138

The following must be considered in order to be able to use routing (e.g., for access to
SINAMICS_Integrated with SIMOTION D4x5):

e |[f the project should be generated on another computer, a

PG/PC assignment is necessary. The PG/PC has the unique "computer name" of the
creation system and this must be adapted to the current system.

This change can be made directly using the | @ Assign PG/PC toolbar button.

Further Help

The Syslog file and the Userlog file are also available to help verify the project (as

of Runtime V4.0). These files are stored on the memory card can can he read out, for
example, without a project on the PG/PC using the SCOUT function @
Accessible Nodes.

The log files on the memory card are directly accessible from the dialog box (via context
menu).

o

ndes - TCP/IP(Auto) - » Realisk RTLBY39/810x

2% ] s|alefe 20 BE

o] S

I MEO.TXT - Editor
[T Fo

ke
SubmetiD: (004-0008]

LI5S Uve unk_01 faddress = 31pe = SENAMICS 5120 Inte
Tede 1, Spata |

Figure 7-2  Log files via the context menu

® user\simotion\hmi\syslog\syslog.000
System logbook: The system makes an entry here when a RAM TO ROM, an overall

reset or a reformatting of the memory card is carried out.

user\simotion\hmi\prjlog\userlog.txt

Machine logbook: It is possible here to document the tasks carried out and the SCOUT
version used for the next service worker. Call for editing from the SCOUT dialog box
Device diagnostics.

Below are other data, which are stored on the memory card and can be accessed from this
dialog box:

e USER/SIMOTION/HMI/PRJLOG/info.txt
is created with the archived ES project and contains the name, variable, save date.

o USER/SIMOTION/HMI/PRJLOG/project.zip
archived ES project. Max. 1 archived project can be archived on the memory card using
SCOUT.

The above-named files visible in the dialog box also remain on the memory card after
Delete user data.
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7.1 Handling Recommendations for Service with SCOUT V4.1

For a detailed description, please refer to:
® SCOUT Online Help -> Device diagnosis: Syslog / Userlog
® Device Diagnosis section: User log file

® Device Diagnosis section: Syslog file

71.2 Project was created in Version V3.2 SP1/V4.0

If the project was created in Version V3.2 SP1 / V4.0, remember the following points:

® \When opening a project created in an older version of SCOUT using SCOUT V4.1, a
conversion of the project to SCOUT's current internal data format is automatically
requested.

Only the data content of the SCOUT project is converted to V4.1, not the SIMOTION
device version.

e After the project conversion, the system asks whether the project should be opened write-
protected.
If the project needs to be changed, the write protection can also be revoked later.

— Select Project > Revoke write protection from the menu bar.

71.3 Project V3.2 SP1 / V4.0 was edited with SCOUT V4.1

If the project of versions V3.2 SP1/ V4.0 was edited with SCOUT V4.1, remember the
following points:

® The project can be saved back in the original project version when closing the projects,
exiting SCOUT or by selecting the SCOUT function Save in old project format.... This
makes it possible to edit the project later using the corresponding SCOUT version again.

Note

In case of a back-conversion to the V3.2 SP1 / V4.0 project format, the internal V4.1
conversion results of the changed sources are deleted!

This means that after the project has been opened again and the online connection
made, the changed sources are inconsistent (shown in red).

Only after the compilation and download are completed are the sources consistent again
(shown in green).

This is due to the editing with different SCOUT versions, which contain different compiler
versions.

e |f the project was opened write-protected for diagnostic purposes or if no changes were
made in non-write protected mode, then it need not be saved.
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Recommendation

After editing an old project version using SCOUT V4.1, the engineering project should
remain in Version V4.1. This eliminates the need to back-saving in the old project format so
that the project remains consistent at all times.

The engineering project is then no longer available in the old project version.

After the project changes are completed, they should be documented in the Userlog file.
The Userlog file is edited in the device diagnostics dialog box.

®/ Device diagnostics - [SIMOTION_1] =10l x|

Open IT diagnostics Contiol operating mode... |

General | Diagnostics huffell S\avesl Task managerl System utlization  Userog I Syslogl Alalmsl

Save in target system I

Servicesenginesr: Harl Haier
Date: 2008-12-06
Task: Errormessage encoder fault

Encoder at motor 13 replaced
va

Servicesenginesr: Harl Haier
Date: 2008-11-02
Task: Update runtime to version 4.1 2

Close I Refresh [F5] I Save az... I Help

Figure 7-3  Example of the User log file display

714 Introduction of versioning with standard library and software components

It is possible to introduce versioning for any standard library and any software component
during configuration, i.e., each component then has its own version identifier.

® For every unit and every library the version, author and a brief description in the
comments field (offline version identifier) in the Properties dialog box in
SIMOTION SCOUT.

® Each library and each software component can disclose its version identifier during
runtime (online version identifier identical to offline version identifier).

— Version identifier as constant(s) or
— Version identifier as function return value, e.g. FCGetVersion.
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® The version identifiers can be displayed separately on the available HMI systems, i.e.,
self-identification of all involved system components.

e A simple variant for applying versioning is in a date identifier as a constant in the format
yyyy-mm-dd. This can be assigned to a variable, which is then, for example, passed on to
HMI systems for the version display.

Example, date identifier:

VAR_GLOBAL CONSTANT
APP_VERSION : UDINT :=20060612; // 12.06.2006

END_VAR
VAR_GLOBAL
G_uAppVersion : UDINT := APP_VERSION;
END_VAR
7.2 Rules for the arrangement of the modules

Slot rules
Modules must be inserted in the rack without gaps.

Exception:
Slot 3 remains empty in the configuration table. This slot is reserved.

Note

The actual arrangement has no gaps, as otherwise the bus on the backplane would be
interrupted.

Table 7- 1 Slot rule for SIMOTION rack 0

Slot 1: Power supply only PS 307 xA
(valid only for SIMOTION C2xx)

Slot 2: CPU only (e.g. SIMOTION C2xx)

Slot 3: Empty or interface module

Slots 4 to 11: I/0 modules or empty
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SIMOTION SCOUT provides the following support when you configure a station:
® A message will appear if, for example, a module cannot be inserted into the desired slot.
® Address areas are also checked to prevent dual allocation of addresses.

® The status bar or messages displayed provide feedback, which you should pay attention
to. Important information can also be found in the help.

® Temporary rules, that is, rules that apply only to a specific version, are not considered
(such as restriction of the useable slots due to a functional restriction for individual
modules).

Consult the documentation or the current product information for the modules.

Note

Modules that are installed but not configured are repeatedly addressed via the PROFIBUS.
This requires additional computing time.

7.3 Routing

7.31 Operation of cross-subnet connections

Introduction

With SCOUT and STEP 7, it is possible to access SIMOTION, drives and S7 stations online
via a PG/PC beyond the subnet boundaries, in order to, for example, load user programs or
a hardware configuration or to perform test and diagnostics functions. You can connect this
PG/PC to any position in the network and establish an online connection to all stations that

can be reached via gateways.

For more details on this topic, see the following document:
¢ SIMOTION Communication, System Manual

SIMOTION SCOUT
142 Configuration Manual, 05/2009



FAQs

7.3 Routing

7.3.2 Human Machine Interface system (HMI)

SIMOTION SCOUT

SIMOTION allows the end user to communicate with operating devices (Human Machine
Interface systems) such as operator panels.

The following configuration is possible, for example, with the SIMOTION C240:
o HMI device is connected to the non-isochronous PROFIBUS of SIMOTION device 1.

® Four other SIMOTION devices are connected to the PROFIBUS DP (isochronous) of
SIMOTION device1.

SIMOTION automatically also establishes connections between the HMI device and
SIMOTION devices 2 to 5 (routing). Therefore, the HMI device can also display variables,
messages, and alarms for these devices.

Note

The number of routed connections depends on the device. Between 4 and 10 routed
connections are possible. For more detailed information, see Data volume.

A maximum of two gateways are possible.

For more information, please contact your local Siemens representative.

HMI

PROFIBUS DP VO

SIMOTION 1

Isochronous PROFIBUS DP

SIMOTION 2 SIMOTION 3 SIMOTION 4 SIMOTION 5

Figure 7-4  Example for the connection of an HMI device to a group of SIMOTION devices

Note

Routing via a controller, e.g. C2xx, P350 or D4x5, is only possible if the controller has been
configured as active I-slave. However, please note that with an active I-slave, the
PROFIBUS connection can no longer be operated isochronously.
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7.3.3 Higher-level automation systems

A SIMOTION device can be connected to a higher-level automation system. Communication
takes place via the MPI interface of the SIMATIC STEP 7 device or the non-isochronous
PROFIBUS interface of the SIMOTION device.

SIMATIC S7 400

MPI - PROFIBUS DP VO

SIMOTION 1

Isochronous PROFIBUS DP

Drive 1 Drive 2 Drive 3 Drive 4

Figure 7-5  Higher-level automation system with SIMOTION device

74 Inserting drives

7.4.1 Drives with SIMOTION

Note the following:
Drives must be differentiated between:
® Drives that are connected to PROFIBUS/PROFINET
® Drives that are connected directly to the SIMOTION device
The following applies to drives connected to PROFIBUS/PROFINET:
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® Only drives that meet the requirements of PROFIdrive profile V3.0 can be connected:

SINAMICS

MICROMASTER (PROFIBUS only)

COMBIMASTER 411 (PROFIBUS only)
MASTERDRIVES (MC, VC) (PROFIBUS only)
SIMODRIVE 611U (PROFIBUS only)

SIMODRIVE POSMO (CA, CD, Sl) (PROFIBUS only)
ADI4 (analog drive interface for 4 axes)

IM 174 (Interface Module for 4 axes)

® These drives are taken into the hardware configuration.

® The drives of the SINAMICS and MICROMASTER drive families can be configured,
assigned parameters, and commissioned with SIMOTION SCOUT.

All analog drives can be connected via one of the four analog interfaces on the
SIMOTION C2xx or via the ADI4 PROFIBUS module.

® These drives are not taken into the hardware configuration.

® The SIMOTION device requires only the actual values from the encoder at the input and
issues the setpoints at the analog output.

® The drives must be configured, assigned parameters, and commissioned directly on the
corresponding device.

74.2 Inserting a SINAMICS drive on PROFIBUS DP

Starting point

® The SIMOTION device is created in SIMOTION SCOUT
e A PROFIBUS subnet has been configured, for example, as PROFIBUS DP isochronous.

® The subnet interface is the master on this subnet of the SIMOTION device
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Follow the steps outlined below:
1. Open the PROFIBUS DP folder in the hardware catalog.
2. Open the SINAMICS subfolder.

3. Use drag-and-drop to drag an entry to the isochronous PROFIBUS subnet of the
SIMOTION device.

@5‘ HW Config - [SIMOTION C {Configuration) -- SCOUT_proj_3] = IEII!I

Wl Ststion  Edit Insert PLC Wiew  Options  Window  Help _l=l x|
D@ e" &&= e dhallHo 2w

= ol =l

End | ﬁ:l: n=!|

PROFIBUS([2): DP master system 1] Profile: IStandard j

- SIMODRIVE |

l |

st

:I:I FPROFIBUS|2): DP master system (1]

PROFIBUS address I Module

I Order nurnber

| Flrmwarel Diaghostic addressl Comment I

Press F1 ko get Help.

SINAMICS_5120_CU320 (651 3040-0xA00-Dxxx [5120)

-0 SIMOREG

B0 SIMOVERT

-3 SINAMICS

g SIMOTION Cx32

g SIMOTION <32 SM150
- SINAMICS DCMASTER
- SINAMICS G120
- SINAMICS G130
- SINAMICS G150
- SINAMICS GL15D
- SINAMICS GM150
- SINAMICS 5110

B0 SINAMICS 5150
B0 SINAMICS SL150
@ SINUMERIK Mx10

SINAMICS 5120 CU320 DP Slave. Drive ES /
SIMOTION Interface, Cyclical and Acyclical
Communication, |sochronous Mode, Data Exchange LI

BSL3040-0400-0xx (5120) ﬂ

=l
3

4

Figure 7-6

743

Starting point

Inserting a SINAMICS drive

Inserting a SINAMICS drive on PROFINET 10

e SIMATIC STEP 7 V5.4 SP2 is installed

® The SIMOTION D4x5 device with Ethernet IE2/NET (X130) interface selection has been

created in SIMOTION SCOUT
e A PROFINET IO has been configured
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Follow the steps outlined below:

1. Open the HW Config of the SIMOTION D4x5 device.

2. Open the PROFINET IO/Drives/SINAMICS folder in the hardware catalog.
3. Select the SINAMICS S120 CBE20 drive.
4

Use drag-and-drop to drag the drive to the PROFINET 10 subnet of the
SIMOTION device.

E{#‘ HW Config - [SIMOTION D {Configuration) -- Profinet_1] = |E| il
E"] Station Edit Insert PLC  Wiew Options ‘Window Help — |E| il
D@9 § S0 e dbdal@Ho) 8]
- olx|
End | .n.ﬂ ar!|
ERGIE PROFIELS Integrated: DF-Masterspstem 1] Erofie: [Standard |
b ]ﬁ? PROFIBUS DP

B2 PROFIBUS-PA
=2 PROFINET 1D

E|{:I Drives
-0 SINAMICS

Ethemet[2]: PROFINET-10-System [100]

g SIMAMICS 5150 CEE20

-] Gateway
(-] General
=7 140
=2 -0 Sensars
< | _>|_I G- SIMATIC 300
- SIMATIC 400
= SIMATIC PC Based Cantral 3007400
ﬂil (0] SHETIONDA -8, SIMATIC PC Station
Order nurmber Firmware | MPl address | | address | O addresz | Comment [ SIMOTION Drive-based
EAET SI5-LAAGF-BAN SIS0 Ve & #-{_] PROFIEUS-DP
DTN
MRS
HEENET
CBE30-PM_ |BFCE531 2-0FADD-04AD 4.0
Aot
S 65L3055-04400-2EB0 (5120 ﬂ 3
Far 7 SIMAMICS, die durchgangige Antriebs-Familie mit =
Frd skalierbarer _Pgrfor_mance,_vom Einbaggerél bis hin 2um
S chrankgerat in einem Leistungsbereich won 120 bis LI

Press F1 ko get Help, [ [ 4

Figure 7-7  Inserting a SINAMICS drive with PROFINET
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7.4.4

Initial situation:

Inserting a MICROMASTER drive

® The rack with the SIMOTION device has been inserted.
e A PROFIBUS subnet has been configured, for example, as PROFIBUS DP isochronous.

® The subnet interface is the master on this subnet of the SIMOTION device

Follow the steps outlined below:
1. Open the PROFIBUS DP folder in the hardware catalog.
2. Open the SIMOVERT subfolder and then the MICROMASTER 4 subfolder.

3. Use drag-and-drop to drag an entry (e.g. MICROMASTER 420) to the isochronous
PROFIBUS subnet.

E.m HW Config - [SIMOTION C {Configuration) -- Micromaster] -0 ﬂ
|I||||] Station  Edit  Imsert PLC  View Options ‘Window Help == ﬂ
D &8 & & s g ||| %8 w2
= Blxl
= Find: | ant] il
1 - PROFIEUS[1): DP master spstem (1] Prafile: |Standard ﬂ
2 §3 C230
X8 DA K] #-_] Metwork Components j
X304 ] DR +-_] Sensor system
X7 0 | +-_] SIMADYN
X PEROMT -] SIMATIC
X3 Toie +-_] SIMODRIVE
X4 Diive +-_] SIMOREG
x5 Diiva =-_1 SIMOVERT
x5 [ oo = +-_] LARGE DRIVES CBP2
+-[_1 MASTERDRIVES CBP
+-_1 MASTERDRIVES CBP2
+-_1 MICRO-/MIDI-/COMBIMASTER CB15/CE155
=1-_1 MICROMASTER 4
B COMBIMASTER 411
B MICROMASTER 420
B MICROMASTER 430
- B MICROMASTER 440
2| > + g MASTERDRIVES CB1
+-g@ MASTERDRIVES/DC MASTER CEPx
.J [1] MICROMASTER_ 420 +-g MASTERDRIVES/DC MASTER CBP2 DPV1
— +-gg MICROMASTER 4
Slat 3 Module .| laddress | O address | Comment ‘ 4 % MICRO/MIDIMASTER OPHP j
7 e D 3| 5 L WAICDO AN EARADIAACTED CD1E HER
- e —| | |ESEE400-1PEO0-04A0 (MM4B] -l £,
& Dz Dafy EEL P MICROMASTER 420 with PROFIBUS Interface (see Order J’
£ L D32 S < Mo.]. Drive ES / SIMOTION Intertace, Cclical and Acyclical
7 Communication, D ata Exchange Broadeast, OP -
Press F1 to get Help. Chg

Figure 7-8
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Inserting a MICROMASTER 4 drive

A window appears in which you can configure the PROFIBUS interface of the drive.

Note

Although the MICROMASTER 420 does not support isochronous operation, it can be
operated on the isochronous PROFIBUS subnet. Note that the drives of all synchronous
axes have to be connected to the same PROFIBUS subnet.
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745 Inserting a MASTERDRIVES drive

Initial situation:
® The rack with the SIMOTION device has been inserted.
¢ A PROFIBUS subnet is configured as PROFIBUS DP isochronous.
® The PROFIBUS interface is the master on this subnet of the SIMOTION device.

Follow the steps outlined below:
1. Open the PROFIBUS DP folder in the hardware catalog.
2. Open the SIMOVERT subfolder.

3. Use drag-and-drop to drag an entry to the isochronous PROFIBUS subnet of the
SIMOTION device.

[ Hw Config - [SIMOTION C (Configuration) -- Masterdrives] o] x|
@y station Edit Insert PLC Wiew Options Window Help == %]

Dlslel8 %) &) mle| la| @) 2 x|

- 8=
End | nﬂ ﬁ=!|
EZT] Profils: | Standard [~
PROFIBUS[1): DP mazter spstem (1 -
DR 1 Ll T L 0 D IDENT ;l
EH {:I IPC
BEROMT 11 MASTEI {:l NC
Anfriah — P oo [+ Metwork Compaorents
Ariniah m HH! D Senzor spstem
Aniried £ {:I SIMADTM
Anfried {:I SIMATIC
LI D SIMODRIVE
-1 SIMOREG
=1 SIMOVERT
=1 LARGE DRIVES CBPZ
=103 MASTERDRIVES CBF
----- E Active Front End
bt 1| T E Frequency Control
4 | | L2 | N S ﬁ totion Control
----- B Motion Cartral Plus
!I:I SMOTION G e E Riectifier/Regenerative Unit
----- E Servo Control
Designaon e e B Veotor Cortral CU2
----- E Yector Control CLWC
----- E Yector Control Plus
FROFIBUS[): |DP master system (1) -] MASTERDRIVES CBP2 -
4| - | o]
DF slave CBP in SIMOVERT MASTERDRIVES. Drive ES 3
interface, cyclic and acyclic communication =

Press F1 to get Help, lﬁ o
Figure 7-9 Inserting a MASTERDRIVES drive
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74.6 Inserting a SIMODRIVE drive

Initial situation:
® The rack with the SIMOTION device has been inserted.
¢ A PROFIBUS subnet is configured as PROFIBUS DP isochronous.
o The PROFIBUS interface is the master on this subnet of the SIMOTION device.

Follow the steps outlined below:
1. Open the PROFIBUS DP folder in the hardware catalog.
2. Open the SIMODRIVE subfolder.

3. Use drag-and-drop to drag an entry to the isochronous PROFIBUS subnet of the
SIMOTION device:

— SIMODRIVE 611 universal
— SIMODRIVE POSMO xx

[ Hw Config - [SIMOTION C (Configuration) — DSC_SIMODRIYE] ol x|
@l station Edit Insert PLC Wiew Options ‘Window Help _ =] x|
D= B & ain alin ||[fh B3| 58 | w2
j olx
=
End | it
1 o PROFIEUS[1]: DP master system (1] J—|
2 %} C230 Profile: Standard 4
XE 0] DRt 4 T | J
x3 0[] oromer R — +- 1 IPC -l
X¥ £ 2 +-_] NC
X BERAAT  — 5}; +-{_] Metwork Components
X3 Anfmah = +-{_] Senzor system
xd Arted = +1-_] SIMADYN
X5 Aniiah +-_] SIMATIC
XG A mfriad j =I-_1 SIMODRIVE
= @ SIMODRIVE 617 universal
- @ SIMODRME B17 universal HR
] | | L’J @ SIMODRMNE POSMO &
@ SIMODRMNE POSMO &, C1/C2
@ SMODRIVE POSMO CA
4m )| (31 SIMODRIVE_611U_DP2_DP3 & SIMODRIVE POSMO CD
@ SIMODRIVE POSMD 51
Slat 3 Module o | | address 0 address Comment | . @ SIMODRIVE 611U MC.POSMO SI/CA/CD
4 pmp‘j'"‘j — = + @ SIMODRME senzar isochron
& ﬁmz’?._w‘.i LU — | | .1 SIMOREG
£ W ove Dats AR +- (1 SIMOVERT
- gﬁgﬁ +.11 SINBMICS ~
£ Lie Db SRR BSM1115N00-Dddx (E111) LY,
Hd Hatve Dotz SRS Drive ES interface -
11 ﬂ
Press F1 to get Help.

Figure 7-10 Inserting a SIMODRIVE 611U drive

A window appears in which you can configure the PROFIBUS interface of the drive.
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74.7 Configuring an inserted drive as a slave on the PROFIBUS

Follow the steps outlined below:
Once you have inserted the drive, the following
DP interface configuration window appears:
1. Specify the address.

Properties - PROFIBUS interface SIMODRIVE 611U DP2. DP3 E

General  Parameters |

Address: i

Trangmizzion rate: 12 Mbps

Subnet:

--- hiot networked - e[

FROFIBUS(2) 1.5Mbps Fraperties... |

[elete |
Coed | _teb_|
Figure 7-11

Configuring the PROFIBUS interface on the drive

2. Confirm with OK.
A further window for configuring the drive as a DP slave appears.
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3. Make the necessary settings.

4. Click OK to confirm.

DP Slave Properties [ %]
General Configuration | Clock Synchronization I Internode communication - overview I
Default
Slat In local slave PROFIBUS partner
Type Addr ... Type DP . |MD-a... Pro.. |L..| Unit |Consiste..|C
4 no PR
& Actual value PCD 1 |Input 2 260 10 |Ward | Entire len...
5] Setpoint PCD 1 |Cutput 2 260 6 |Word | Entire len...
7
| | |
Irsert rovy | Welete rov |
— Master-Slave configuration 1
Master: [2]1 DF1
Statior: SIMOTION C
Comment: I ﬂ
Coce | beb |

Figure 7-12  Configuring the SIMODRIVE 611U as a PROFIBUS slave

W Canfig - [SIMDTION C [Configuiation) — SCOUT_proi__3]

Stalion EdR [nset ELC View Opbons Window Help

Dlle (% & e ikl [@o) 2 el

Prolile ]SIandald =l

|1 DP VO slaves
{1 DP/ASH
DP/PA Link
] ENCODER
(1 ET 2008

11 ET 200C
|1 ET 200eco
1 ET 20085

ET 2000

)

(1 ET 200M
1 ET 200R

(21 ET 2005

(] ET 2000

{23 ET 200¢

Funclion Modules
(21 IDENT

& Irc

(I NC

(] Metwerk Components
1 SIMADYN

SIMATIC

w1 SIMODRIVE

& SIMOREG

1 SIMDVERT <]

PROFIBLIS[1E DP masher system (1]

1 1 1

& 5 MICRO

PROFIBUS(Z) DP mastes

shem [2)

1-[[] LARGE DRIVES CBP2

{Z1 MASTERDRIVES CBP

_] MASTERDRIVES CBP2

[Z1 MICRO-MIDI-/COMBIMASTER CB
=[] MICROMASTER 4
COMBIMASTER 411
MICROMASTER 420
MICROMASTER 430
MICROMASTER 440

Fanware | MPI address | addiess | O address

|¥3.0

Pl

e

“ MASTERDRIVES C81

BT 55

S 85 =

4

128753

# MASTERDRIVES/DC Mi'-\STEH CB "I

T8 7S

IWm}mmm
MICROMASTER 420 with PR
interface (s2e MLFB]. Dlme ESJ'SIHCITION

j“

o 203

2.

interface, cpclical and
Press F1 to gat Helo.

Figure 7-13 Example of a hardware configuration with 4 drives
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7.5 Commissioning the drives

Drives that can be commissioned with SIMOTION SCOUT
You can use SIMOTION SCOUT to assign parameters to the following drives:
e SINAMICS
* MICROMASTER
e COMBIMASTER 411

For all other drives or for third-party drives, the appropriate commissioning program for the
specific drive must be used (e.g. the SIMOCOM U program for SIMODRIVE 611U). If
required, you must commission these drives directly on the drive.

Table 7- 2 Commissioning of various drives

Drive Connection Commissioning
SINAMICS S120, S150, PROFIBUS DP or analog | With SIMOTION SCOUT or
G110 CPM100, G120, G130, | interface STARTER
G150, GM150
SINAMICS S120 PROFINET With SIMOTION SCOUT or
STARTER
MICROMASTER 410 Analog interface With SIMOTION SCOUT or
DRIVE ES Basic or
STARTER
MICROMASTER PROFIBUS DP or With SIMOTION SCOUT or
420/430/440 analog interface DRIVE ES Basic or
STARTER
COMBIMASTER 411 PROFIBUS DP or With SIMOTION SCOUT or
analog interface DRIVE ES Basic or
STARTER
SIMODRIVE 611U PROFIBUS DP or analog | With SIMOCOM U or
interface DRIVE ES Basic
MASTERDRIVES MC, VC PROFIBUS DP or analog | With SIMOVIS or
interface DRIVE ES Basic
SIMODRIVE POSMO PROFIBUS DP With SIMOCOM U or
CA; CD, Sl DRIVE ES Basic
Third-party drives Analog interface or With commissioning tool supplied by the
PROFIBUS DP manufacturer
according to PROFIdrive
profile V3.02
Note

If the Drive-ES Basic commissioning program is installed, it can be called by SIMOTION
SCOUT in the project navigator via Commissioning.
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7.6 SINAMICS on SIMOTION

7.6.1 SINAMICS S120 on SIMOTION

STARTER functionality in SIMOTION SCOUT

It is possible to parameterize drives directly with SIMOTION SCOUT. As an example, the
following is a description of how a SINAMICS_Integrated drive is inserted in
SIMOTION SCOUT.

Prerequisites:

SIMOTION SCOUT has been installed on the PC/PG
A SIMOTION SCOUT has been created

Note
You can create the SINAMICS drive with PROFIBUS or PROFINET.

You must execute the following steps:

Insert SIMOTION device D4x5 or SIMOTION device D410
Configure SINAMICS_integrated

Commissioning in SIMOTION SCOUT

154

8.
9.

N o o ks~ e bdb =

Open the SIMOTION project in SIMOTION SCOUT.
Double-click Create new device.

Select a SIMOTION D4xx device.

Select the variant.

Deactivate the Open HW Config box.

Confirm withOK.

Select the PROFIBUS interface or Ethernet.
If you have selected Ethernet, select the interface parameterization of the PG/PC.

Confirm withOK.
Open the structure tree of the SIMOTION D4xx device in the project navigator.

10.0pen the structure tree of the SINAMICS_Integrated drive in the project navigator.

11.Double-click Configure drive unit.

The Configuration - SINAMICS_Integrated - Option Module window opens.

The STARTER functionality now starts in SIMOTION SCOUT.
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How to configure the SINAMICS_Integrated drive is described in detail in the following
documents:

e SIMOTION D4x5 Commissioning Manual
e SIMOTION D4x5 Product Manual
e SIMOTION D410, Commissioning Manual

7.7 MICROMASTER on SIMOTION

7.71 Commissioning a MICROMASTER

STARTER functionality in the SIMOTION SCOUT

Drive parameters can be assigned directly using SIMOTION SCOUT (starter functionality in

SIMOTION SCOUT). The commissioning of the MICROMASTER 420 is described as an
example.

Requirements:
e SIMOTION SCOUT installed on PC/PG.
o PC/PG is connected to drive.
e SIMOTION SCOUT is in online mode.

/\CAUTION

You can only commission the drive in online mode!

All configuration data is stored in the drive RAM and is lost when the drive is switched
off. You must therefore save this data to the drive ROM with Copy RAM to ROM. The
appropriate drive must be selected.

SIMOTION SCOUT
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7.7.2 Commissioning in SIMOTION SCOUT

7.7.21 Drive navigator

The drive navigator appears in the project navigator tree directly below the drive. It is
designed as a snap-in. You can use the drive navigator for:

e (Configuration

® Terminals/bus

® Limits

Proceed as follows:

1. Open the structure tree of the MICROMASTER_420 device in the project navigator.

2. Double-click drive navigator.
The snap-in opens in the working area of SIMOTION SCOUT.

3. Maximize the window view in the working area.

Note

The content displayed for the individual drive versions is the same in offline and online
mode. Any options not available in a certain mode are grayed out. This function is then
not active in that mode. This means that you have a complete overview of the possible
functions at all times.

4. Configure the drive.
7.7.2.2 Configuring a drive

Configuring a drive

/\ CAUTION

Use the drive configuration wizard to directly edit the drive data.

When you exit a window, the data is transferred to the drive immediately. A Cancel function
is not available!

Requirement:

® You have inserted a drive into the project.

SIMOTION SCOUT
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Proceed as follows:
1. Open the element (folder) for the drive unit in the project navigator.

2. Open the drive element below the folder.

3. Double-click the Configuration element.
The most important configuration data is displayed in the window.

4. Click Reconfigure drive.
A prompt appears asking you to confirm that you wish to reconfigure the drive.

5. Confirm the prompt with Yes.
The wizard for configuring the drive is started.

B SIMOTION SCOUT - SCOUT_proj_3 - [MICROMASTER_420 - Configuration] - o] x|
@ Projeck Drive Edit Insert Target system View Options Window Help .= ﬂ

) = = = = e e 24 == Xl = [% | | 28| BRIES|| | 25| | [<no fter = T =

=& 5COUT proji_3
® Create new device
- Insert single drive unit
=B 230
EXECUTION SYSTEM
B 10
8— GLOBAL DEYICE WARIABLES Mame: |MIEF|DMASTEH_4ZU Operating mode: |V with inear charac. (0]
=] AHES
® ) Insert axis
#-_] EXTERMAL ENCODERS
#-_] CAMS
#-_] TECHNOLOGY
-] PROGRAMS
= ﬂﬁ MICROMASTER 420
= @ MICROMASTER _420
.& Drrive navigakor
> Configuration
> Terminals | bus
> Limits
» Diagnostics
> larm histary
» Control panel
# ¥ Extended
-] MONITOR
+-_] LIBRARIES

Beconfigure drive |

Configuration ]

Dirivve type: tdotor:
- Unknowri- Agynchronous matar (1] 230 080 A
Firmusare - 012Ky B000Hz  Omint

Communication module [CB] |

-l

Cloze Help

Praject | Command library @ MICROMASTER_420

* === Symbaol browser
Press F1 ko open Help display, Offline mode

Figure 7-14  Configuring the MICROMASTER 420

You are now in the Drive Configuration - MICROMASTER 420 - Standard window:

6. Select the appropriate standard.
Default setting: Europe [kW], standard frequency 50 Hz (0).
A message appears.

7. Read this message and click OK to confirm.
8. Click Next >.

You are now in the Drive Configuration - MICROMASTER_420 - Motor window:
9. Select the appropriate data.

SIMOTION SCOUT
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7.7.2.3
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10.1f required, activate the Additional motor data function.
11.Click Next >.

You are now in the Drive Configuration - MICROMASTER_420 - Motor Data window:
12.Enter the appropriate data.
13.Click Next >.

You are now in the Drive Configuration - MICROMASTER_420 - Operating Mode window:
14.Select the appropriate operating mode.
15.Click Next >.

You are now in the Drive Configuration - MICROMASTER_420 - Command/Setpoint
Source window:

Several sources may be offered simultaneously for selection of the speed setpoint. The
meaning of the entries is as follows:

— First entry: Main setpoint
— Second entry: Additional setpoint
16.Select the appropriate data.

17.Click Next >.
A message appears.

18.Read this message and click OK to confirm.

You are now in the Drive Configuration - MICROMASTER_420 - Most Important
Parameters window:

19.Enter the appropriate data.
20.Click Next >.

You are now in the Drive Configuration - MICROMASTER 420 window for completing the
drive configuration:

21.Check the data entered.

22 .Click Finish.
The drive configuration is completed.

23.Click Close.

Configuring the drive terminals/bus

Here you define the following:
® The assignment of the input and output terminals to the parameters of the drive.
® The calibration of the analog-digital converter and the digital-analog converter.

¢ When BICO parameter assignment is enabled, the Digital inputs tab is only used to
display the connections. The interconnection itself is made with the appropriate function.

® In the Signal interconnection tab, assign the input parameters to the signal sources.

SIMOTION SCOUT
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Proceed as follows:

1. Open the element (folder) for the drive unit in the project navigator.
Open the drive element below the folder.

Double-click Terminals/Bus.

Configure the inputs and outputs.

Configure the USS/PROFIBUS interface

/\ CAUTION

The signal interconnection input window is intended only for use by experts who are
familiar with BICO technology and the MM4 parameter assignment options.

o > 0N

Parameter changes are not checked for plausibility. Incorrect entries may affect the
functioning of the drive.

6. Change the signal interconnection, if required.

@MIERDMASTER;!ZD - Terminals / bus | ﬂ
Digital inputs] Digital outputs  Analog inputs lAnalog outputs] USS / PROFIBUS ] Signal interconnection

g in = Smoothing time Analog-digital converter
L+
®3 o #— | Unipolar voltage input (0 to +10°) [0 ~ |
n e | nipolar wolkage input [0 to + 1100 J
x4 9
Actual value ; =
0.00 v 000 % g
H 8 Dead band [+/-]
|D.DD v |‘ID.DD W 4l |D.DD "
Output iz interconnected to...
p1070, CI: Main setpaint +
factialbialio p2264, CI- PID fesdback Actval T .
1] Dec 0.00 ’70 relative to reference walue
Table of reference values
Pno.| Parameter text |Ualue Unit|
p2000 |Reference frequency [S0.00 |Hz
p2001 |Reference voltage 1000 |%
p2002 |Reference current 010 |A
Signal loss
Drelay time 10 - Signal losz at AD converter
KN — i

ﬁ Close | Help

Figure 7-15 Configuring the drive interfaces
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7724 Configuring the USS and PROFIBUS interfaces

Use this tab to configure the interfaces only. You do not define whether they are used for
communication.

Procedure for changing station addresses or baud rates.

If you have changed the station address or the baud rate of the interface used for
communicating, test the communications.

Proceed as follows:
Disconnect the SIMOTION SCOUT from the target system.
2. If you:

1.

Have changed the station address:

Change the station address of the drive in the Properties dialog box of the drive unit or
in the hardware configuration.

Have changed the baud rate:

Select menu Options > Set PG/PC interface and configure the interface of your PC
accordingly.

If you want to use the USS interface, you must install this.

In the PG/PC Interface window, click Select and install the PC COM-Port (USS)
module.

3. Reconnect SIMOTION SCOUT to the target system.

7.7.2.5 Parameterizing setpoints and limits

The following submenus are used for the complete parameterization of setpoints and limits:

Limits
Extended

Parameterizing limits

Deactivate the PID controller before parameterizing the ramp function generator. Otherwise
this has no effect.

160

Motor potentiometer (MOP)
Fixed frequencies

PID controller

Setpoints

Shutdown functions

Start functions

Functions (slip compensation, programmable V/f characteristic)

SIMOTION SCOUT
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7.7.3 Controlling drives
You can use SIMOTION SCOUT to control the configured drive. Use the control panel for

this purpose. This is displayed as a detail view tab. Drives can only be controlled in online
mode.

/\DANGER

Before the motor turns for the first time, pay special attention to the following potential
hazards:

Make sure that the motor is connected correctly!
Secure the surrounding area:

Secure the motors! Do not release the magnetic motor brake of vertical axes without a
safeguard!

Set the limit values! Bring the axes to neutral position! Choose low velocities and speeds!
Observe general accident prevention guidelines!

The function is released exclusively for commissioning and service purposes. The safety
shutdowns from the higher-level control have no effect.

The function should only be used by authorized technicians.

The "Emergency stop with space bar" function is not guaranteed in all operating modes.
Therefore, there must be an EMERGENCY STOP circuit in the hardware. The appropriate
measures must be taken by the user.

Follow the steps outlined below:
1. Open the element (folder) for the drive unit in the project navigator.
2. Open the drive element below the folder.

3. Double-click the Control panel element.
The control panel is displayed in the detail view.

SIMOTION SCOUT
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4. Select the drive that you want to control.
5. Select the relevant checkbox:

— Control:
You switch the drive and control its speed.

— Enables and actual value:
You monitor setpoints and actual values as well as enables and alarms.

— Links to status info:
You can switch to the drive diagnostics.

|MICROMASTER_440 = [¥ Contiol [V Enables and act, valuss [2 Links to stalus info
— 100%
Assurne control priority | ﬂ . Firef) = | 50.00 10Hz 0% N L 't 200%
I= | Enaties (it BitE] Stop w. space bar - always = B
Comenizsioning mode: (FO0101=0) Setl Actual = CO: Act. frequency setpoint | ™
(0N /OFF 1 Output frequency: 0.00 0.00 Hz 0.00 Hz
(CJON /OFF 2 Torque | 0.00 0.00 N
(0N /OFF 3 Themal capacity:| Motor cument: 0004 |CO:Act. frequency |
;. Pulze enable . . . 000 Hz
() Rampfunction generator enable Drive data set: 0 Commanddataset: 0
() Start/stop ramp-function gen. .
'. Setpoint enable Commands=BICO parameter Setpoint=BICO parameter
Drive diagnostics |
. Alams 'é Diive contral panel 'E o] ining the lfe list output |E Target system output | %% Disgnosti

Figure 7-16  Controlling drives with SIMOTION SCOUT

Switching the drive and controlling its speed

162

Follow the steps outlined below:

Activate the Control checkbox.

Click Assume control priority.

Move the slider to the left.

Activate the Enables (bit 1 to bit 6) checkbox.
Switch on the drive: Click the | button.

Use the slider to control the speed.

2B S o

To switch off the drive:
e (Click the O button.

® Press the space bar.

/\ CAUTION

Make sure that all windows in the working area are closed. Otherwise, delays may occur
between the entry of the control command on the PC and its execution by the drive!

SIMOTION SCOUT
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Monitoring enables and actual values

The speed setpoint and actual speed value are displayed constantly.

Select two additional parameters for display. These parameters are displayed below the
selection box.

The enables and alarms are displayed.

7.74 Using the drive diagnostics

Diagnostics in SIMOTION SCOUT

You can use the drive diagnostics to check the communication connection between
SIMOTION SCOUT and the drive and to display individual control words and status words as
well as the operating mode.

You cannot change any system parameters. The display is only used for the diagnostics.

Proceed as follows:

1.

2.
3.
4

SIMOTION SCOUT

Open the element (folder) for the drive unit in the project navigator.
Open the drive element below the folder.
Double-click Diagnostics.

Select the relevant tab.

| MICROMASTER_4_PROFIB_1_.MICROMASTER_420 - Diagnostics [diive)

Control word 1 Conrol word 2 Status word 1 Status word 2

o |0 OW/OFFT = p | O Fised frequency Bit 0 2] g |0 Drivercady = p | O DCbiake acive 24
1=YES O=NO ~ | 1=YESO=NO 1=YES D= NO ~ | 1=YESO=NO

0 1 OFFZ; Electrical stop o 1 Fied frequency Bit 1 o 1 Diive ready bo un o 1 Act freq 0024 > PZ
1=H0D=YES 1="ES 0=NO 1=YES D=NO 1=%ES 0=HO

0 2 OFF3: Faststop 0 2 Fiwed hequency Bit 2 0 2 Diive tunning 0 2 Act freq (0024 > P1
1=HO 0=YES 1="ES O=NO 1=YES O=HO 1="ES O=NO

g | 3 Puseensble e g | 3 Drive lauk sctive g | 3 At curent (027 2= F
1=YES D=NO 1=YES D=HNO 1=YES 0=HNO

0 4 FAFG enable 0 4 0 4 OFF2 achive 0 4 Act freq 0024 » PZ
1=%ES D=HD 1=HO0=YES 1=YES 0=HD

g |5 FFGstat o |3 g |5 OFF3actve g |5 Actfeq 0024 =P
1=YES D=NO 1=H0 0=YES 1=YES D=NO

0 B Setpoint enable 0 E 0 B DM inhibit active 0 B Act freq 0024 5= et
1=YES D=ND 1=YES D=NO 1=YES 0=HO

0 7 Faul acknowledge 0 7 0 T Diive veaming achive 0 7 Act Vde 0026 < P21
1=YES O=HNO 1=YES O=HO — 1=YES O=NO

0 8 JOG right o & PID enabled 0 8 Devialion selp, / act y 0 8 Act Vde 0026 > P21
1="ES D=NO 1="ES 0=HO 1=H0 0=%ES 1=%ES 0=HO

0 9 JOG leh 0 3 DC brake enabled 0 9 PZD control 0 3 Rampirg firished
1=%ES O0=HOD 1=4ES D=NO 1=%ES O0=HO 1=%ES D=NO

g | 10 Corbrol from FLC o |19 g | 10 Masirum frequency ie p | 10PID output 2234 < P
1=YES D=NO 1=YES D=HNO 1=YES O=HNO

o | 1 Reverse [setpaint e o | M o | 11 Waming Metor cunen” p | 17 PID output 2234 s=F
1=%ES D=HD 1 1=HO00=YES 1=%ES D=HD

12 12 12 Moter holdng brake ac 12
’ ’ % | T1-vesoano ’
0 13 Moter patentiometer M _ 0 13 Extesnal fauk 1 0 13 Motee overload = o 13 =
! e e LIJ C1-NOD=VES oyl g < ;,J 5 | L,-,

Cloze Help... |
Figure 7-17  Drive diagnostics with SIMOTION SCOUT - Control/status word tab
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Table 7- 3 Drive diagnostics tabs

Tab Meaning
Control/status word Bit allocation of:
e Control word 1
e Control word 2
e Status word 1
e Status word 2

Operating conditions

Important parameters and operating modes of the drive

Status parameters

Important system variables of the drive

USS/PROFIBUS

Define the communications interface in this tab; you can also monitor
the values for the individual control words and status words.

| MICROMASTER_4_PROFIB_1_.MICROMASTER_420 - Diagnostics (diive)
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Control/status word | 0) 1| Status paraemeter | LSS / PROFIBUS |

The following precondtions must be satisfied for the mobos to

wehere the i Irom on the drive | -» Enables and
ual values. If the fres interconnection [BICD] is active. you wil find the source of the
signalz under “Shutdown funchions" and “Limits".

Bits 1 10,6 of control werd 1 O Evor pending!! (See alam outpul)

must be zet o 1 and O Drive cannot ramp-up as the cusent is
subsequently Bit 0 must be ) aready too high
bl O Molor helding brake aciive
0 OM/OFF1 i|
1=YES O=HNO
N Spead setpoint must be »0:
1 OFFZ Electrical . ) )
IE 1=HD 0=YES Mmmmmalsemtlllw
2 OFF3: Fast stop Altes ditection moritoring: |0L00
1= HO 0=YES
Ramp-function generator input Illl]]

3 Puke enahle_lll
u L Famg-function generator output: Illw

Corirel via PZD: Control word1, bt
10 must be 1 Mote:

o | 10 Controlhom FLCA] The selpaint s displayedin the configuration
i=YESD.ND;| dsplays at diferent paints of the sefpont
channel

Motor dentification must be O

[o Ma frequency mustbe >0 [0

Stabuz must be “Ready™

[-J0G

8 JOG right -
DEE-E
[ o |9 JOG leit =l

Setpoint: 0.00

With JOG, motor alzo bums wio
contiol word 1, bit 0 "ONAOFF 1",

Fiiad spesds

0 Fieed frequency Btﬂ
1=%ES D=NOD

[ | 1 Ficeditequency B x
4 I I »
Setpaint a00

Depending on the selection
method. ONADFFT can be set
automatically! Read the
information for “Fived speeds™

[~ Motor potentiometer [MOP)

13 Motor Dolcnllom-:tt:l
1«YESO=NO

4 »

Setpoinl: .00

Figure 7-18  Drive diagnostics with SIMOTION SCOUT - Operating conditions tab
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7.75 Using the expert list

Expert list for experienced users

/\ CAUTION

The expert mode is intended for experienced users. Incorrect entries may affect the
functioning of the drive.

The system does not carry out any plausibility checks.

The expert list for drives is different from the expert list for technology objects.
1. Open the element (folder) for the drive unit in the project navigator.

2. Open the drive element below the folder.

3. Select Expert > Expert list in the shortcut menu.

4. Enter the required values.

-[olx]
| clia]|| ¥ -] e | ==

Expert list |

Parameter | + | + |Parameter text alue ROMA R Unit  |Cl Acces Minil i ;I
pa49 Bl 2. OFF3 1 - Ready to run |3

pas2 Bl Pulse enahle 1 - Ready to run |3

[k B address 3 - Ready to run |2 1] 65535
paz2y + |Parameter changeahle via FH - Cperation 2 oH FFFFH
r347[0] + Last fault code, Recent fault trip |0 2

r94a[0] + Fault time, Recent fault trip --, fa |0 3

pas2 Total numker of faukts 0 Ready to run |3 1] 3
ra64[0] + Firmywvare version data, Compan [0 3

r9es Profibus profile 3

967 + | Control word 1 oH 3

965 + | Status word 1 oH 3

pava Factory reset Dizahled (0) - Commissionin |1 J
paTl Transfer data from RAM to EEPR|Disabled (0) - Operation 3

pl000 Selection of frequency setpoint | Analog setpoirt (2) Jhd Ready to run |1

Pl 001 Fixed frequency 1 0.00 Hz Operation 2 -650 650
P00z Fixed frequency 2 5.00 Hz Operation 2 -650 650
pl003 Fixed frequency 3 10.00 Hz Operation 2 -650 650
pi004 Fixed frequency 4 15.00 Hz Operation 2 -650 650
pl00s Fixed frequency 5 20.00 Hz Operation 2 -650 650
p1 006 Fixed frequency B 25.00 Hz Operation 2 -B50 650
1007 Fixed frequency 7 30.00 Hz Operation 2 -B50 650
p1016 Fixed frequency mode - Bit O Direct selection (1) - Reacy to run |3

p1017 Fixed frequency mods - Bit 1 Direct selection (1) - Reacy to run |3

p1018 Fixed frequency mode - Bit 2 Direct selection (1) - Reacy to run |3

1020 Bl Fixed freq. selection Bit 0 a - Reacly to run |3

1021 Bl Fixed freq. selection Bit 1 a - Reacly to run |3

p1022 Bl: Fized fred. selection Bit 2 1] - Reacy to run |3

r1024 COn Act. fixed frequency 0.00 Hz 3

p1031 Setpoint memory of the MOP MOP setpoint will not be store | - Operation 2

p1032 Inhibit reverse direction of MOP  Reserve direction inhibited (1 j;l - Reacy to run |2 LI

Figure 7-19  Expert list for drive commissioning - display of an array

Additional references
Please refer to the following document on this subject
® Function Manual: SIMOTION Basic Functions
® The SIMOTION SCOUT online help

SIMOTION SCOUT
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7.8 MICROMASTER in Conjunction with a Positioning Axis

Introduction

This section describes how to integrate the MICROMASTER MM4 as a drive in
SIMOTION SCOUT.

In the following example, the MICROMASTER MM4 is controlled via standard message
frame 1.

Communication from SIMOTION:
e Word 1, Control word

e Word 2, Speed setpoint
Communication to SIMOTION:

e Word 1, Status word

e Word 2, Actual speed value

7.8.1 Parameterization steps

This section describes how to integrate the MICROMASTER MM4 as a drive in
SIMOTION SCOUT.

In the following example, the MICROMASTER MM4 is controlled via standard message
frame 1.

Communication from SIMOTION:
e Word 1, Control word

® Word 2, Speed setpoint
Communication to SIMOTION:

e Word 1, Status word

e Word 2, Actual speed value

Integrating MICROMASTER MM4 in HW Config
1. Select the SIMOTION device in the project navigator.
Open HW Config.
Insert a MICROMASTER MM4 into a PROFIBUS subnet.
Once you have inserted the drive, select Standard message frame 1, PZD-2/2.
Save and compile the hardware configuration.
Download the hardware configuration to the SIMOTION device.
Create a TO axis in SIMOTION SCOUT.

N o o~ Db

SIMOTION SCOUT
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Inserting a virtual axis

Insert a virtual axis into the project navigator of SIMOTION SCOUT. This will be
converted to a real axis via the expert list when the axis wizard is completed.

1.

Changes in the expert list

1.
2.
3.

Select the virtual axis in the project navigator.
Open the expert list via the shortcut menu.

Open the following directory in the expert list:
ConfigurationData\TypeOfAxis

Make the following setting:
TypeOfAxis = REAL_AXIS (0)

[ c230.Axis_1 - Expert list I

=Iolx]|

@ J - ‘Lmearaxis (standard/pressure)

|

Configuration data ] Spstem variables ]

Parameter Parameter text Unit |Data type

LesdScrew Leadscrewy pitch of a linear axis

Modulo Modulo settings of a rotary axis

Restart Mode for the restart of the technology obje
RestartConclition  Conditions for the restart of the technolog
Simulation Process coupling

[ Typedfaxis Axiz type-specific configuration

ActuslAccelersti | Actual acceleration monitoring
DecodingConfig  Command execLtion
Distributedrdotion  Distributed motion contral
Extrapalstion Actusl walue smoothing
MaxAccelerstion Msaximum accelerstion
Maxderk Maximurm jerk

Maxelocity Maximum velocity
PathSyncaAxisPo  Setpoint difference monitoring of the sync
StandStillSignsl  Standstil signal

SaneLimit Software limit switch
‘elocityPositionP | Settings for the v(=) profile

LtypeOfixis Axiztype ‘EnumAxisicdent

Ll

Minimum Maximum ~

o

Figure 7-20  Axis setting in the expert list

Assigning encoders

SIMOTION SCOUT

NumberOfEncoders/Encoder_1/encoderidentification = ONBOARD (1), set EncoderType,

EncoderMode and EncoderSystem according to the

encoder

NumberOfEncoders/Encoder_1/Driverinfo/LogAddressin = 128 (or 160, 192, 224)
NumberOfEncoders/Encoder_1/Driverinfo/LogAddressOut = 128 (or 160, 192, 224)
NumberOfEncoders/Encoder_1/Driverinfo/TelegramType = NO_TELEGRAM (0)

NumberOfEncoders/Encoder_1/IncEncoder/incResolution = 1024 (or number of

increments without pulse multiplication)

Configuration Manual, 05/2009
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[ cz30.axis_1 - Expert list

| &l

[ —T

J |Linearams (standardipressure) j |

Configuralion deta | Systsm variables |

Parameter

Parameter text

Incremental measuring system homing

T -

Minimum |Max = |

Count direction inversion

Distance per revalution

Toleration of encoder errors

Sl

Encoder idertification ONBOARD (1)

|'Enuma xisEncoderldentification’ = enumDINT

Encioder mode

‘EnumAzisEncoderiode’ = enumDINT

‘Enum xisEncader Type' = enum/DINT

POSITION (0] =l-

‘EnumAzisEncoderyalueType' = enumiINT

1

UDINT

Number of encoders 1

LIDINT

Setpairt differsnce monfioring of the sync

Posilion monitaring

Activate contral loop manftoring wih acti

Drive interface

Actusl value smoothing

ManipLlated varizble limitation

Standstill monitoring

Standstil sigrial

Software limit switch

System-related dead times

Drive interface for specific parameters

Settings for the v(s) profils

Lvis tune

[RFAI IS (M =1

[Frumisirentifinatinn’ = AnomDIRT T

Figure 7-21

Expert list: Assigning encoders

Assigning the setpoint output
SetPointDriverinfo/mode = DPMASTER (2)
SetPointDriverinfo/logAddressin = 256 (or | address of DP slave)

SetPointDriverinfo/logAddressOut = 256 (or O address of DP slave)

SetPointDriverinfo/TelegramType = DP_TEL1_STANDARD (1) for 2 PZD words in input
and output direction

168

[ c230.4xis_1 - Expert list

| Gl

[ — T

J ILlnearaxls (standardipressure)

=l

=ofx]

Conlfiguralion data | System variables |

Parameter

Setpaint difference mantoring of the synchr

|Data type

Minimum <]

Fosttion manftoring

Activate control laop monitoring wih active

Drive interface

Drive characteristic valugs for standard mat

Direction of rotation adjustment

Crive type NO_TYFE (0)

EnumxisDioActarType' = enum/DINT

Activation of the life-sign monitaring VES (173)

Logical aderess for output data arsa 256

Enum¥esno’ = enumDINT

UDINT

Standerd voltage for meximum crive speed |10.0

W LREAL

‘Enumd disDriverode’ = enum/DINT

Crive interface type PPMASTER (2
STANDARD_MOTORTYFE (0)

‘Enuméxishiator Type' = enumDINT

UDINT

0
Message frame type DP_TEL1_STANDARD (1)

‘EnumxisTelegramType' = enumDINT

Actual value smoathing

ManipLiated varizble [mitation

Standistil monitaring

Standistil signal

Software limit switch

System-related dead times

Crive interface for specific parameters

Figure 7-22  Expert list: Assigning the setpoint output

1. Commission the MICROMASTER MM4.

Note

The drive can now be addressed via SIMOTION SCOUT in conjunction with a positioning

axis.

SIMOTION SCOUT
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7.9 SIMOVERT MASTERDRIVES MC on SIMOTION

7.9.1 Connecting the SIMOVERT MASTERDRIVES MC

Converter requirements

Note

Derating has to be taken into account for compact devices as of 75 kW. This means that if a
converter is operated with a pulse frequency greater than 5 kHz, the permissible rated
current is reduced and the device can no longer be operated at its maximum rated power.

Software requirements
Personal computer minimum requirements
e Windows 2000 Professional Service Pack 3 or Windows XP Professional Service Pack 2
SIMATIC STEP 7 V5.4 SP1
® Drive Monitor V5.4 HF1 or Drive ES V5.4 SP1
SIMOTION SCOUT V4.1
Converter
Motion Control / Motion Control Compact PLUS (Standard / Performance?2):
® Version V1.60 or higher; readable in the parameters r69.1 and r828.1

You can find a description of how to upgrade the converter firmware in the Motion Control
compendium (Section 7.4 in the AC Edition)

PROFIBUS communication board (CBP2):

® Version V2.23 or higher; readable in the parameters r69.x and r828.x

PROFIBUS communication board (CBP2):

A CBP2 communication board must be inserted. This can be read out on the converter in the
monitoring parameter r826.x:

If a CBP2 is connected, value 148 is output.

If a CBP1 is connected, value 143 is output.

Index x designates the slot in which the communication board is inserted:
Index 1 means the basic unit module,

Index 2, the module in slot A etc.

Further information is available in the parameter list in the Motion Control compendium.
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7.9.2 Upgrading option cards firmware

Requirement

Note

A bootstrap file, e.g. CBP2_DL.hex and a program file CBP2_V223.hex of Version 2.23 or

higher is required for the upgrade.

The Drive Monitor or Drive ES may access only the converter RAM for the upgrade of the

firmware.

To upgrade the firmware of the option card:

The upgrade with the Drive Monitor software is described as an example.

1. Open the Drive Monitor

o T
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Figure 7-23  Drive Monitor accesses the RAM of the MC

2. Click File > Download > Option card firmware.

[3 Driverion - [MASTERDRIVES MC Plus — MASTERDRIVES MC Phs & (EEPROM)| am =l=lx
igFle Vew Paametsrz Operste Dugnostics Took Window Hep =%
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Figure 7-24  Opening the Option Card Download window
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3. Enter the path for the bootstrap file, the program file and the slot in which the CBP2 is
installed.

4. Activate the Activate diagnostics checkbox.

i

|

fiih

gggnnnn
¥
i

Nl

Figure 7-25 Settings in the Option Cards Download window

5. Right-click a free area of the screen. The following window opens:

Figure 7-26  Additional settings for the download

6. Enter a program length of 128 KB and 8 EEPROM blocks.
7. Click the Check button.
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7.9.3

7.9.3.1

172

8. Click the Start download button.
The following window opens:

CASiemens\Step"F7VRYISHPROJECTS\DRIVESYWASTERDRIVES M Flus\MDMPLOT6.S5C

Cancel Beje) s |

Figure 7-27  Start of the script file download

9. Click the Start button.
The download is started.

After the download, you can read out the new firmware version of the CBP2 from parameters
r69.x and r828.x.

Commissioning MASTERDRIVES MC

Commissioning procedure

Note

This guide only describes how to set up the connection between the SIMOVERT
MASTERDRIVES Motion Control converter/inverter and SIMOTION. The guide does not
describe how to optimize the controller; it is assumed that this has already been carried out.

The commissioning procedure is divided into two parts:

® |n the first part, a SIMOTION project is created and the SIMOTION SCOUT program and
the hardware manager HW Config are used to enter the settings for the SIMOTION
system. Settings which have to be made both in SIMOTION and in MASTERDRIVES MC
are highlighted.

® In the second part of the commissioning procedure, the MASTERDRIVES MC is
parameterized. The guided basic unit commissioning procedure and a preprogrammed
script file for connection to SIMOTION are used for this purpose. After the commissioning
of SIMOTION and MASTERDRIVES MC, a sample program is set up for an axis
positioning.

Various parameter settings for MASTERDRIVES MC are derived from the SIMOTION
settings. The following table contains an overview of the functions and settings which have to
be entered in both SIMOTION and MASTERDRIVES MC. These settings are described
separately in the following sections for the SIMOTION and MASTERDRIVES MC.

SIMOTION SCOUT
Configuration Manual, 05/2009



FAQs

7.9 SIMOVERT MASTERDRIVES MC on SIMOTION

Table 7-4  Settings required in SIMOTION and MASTERDRIVES MC
Required setting Value
DP cycle 3 ms
Pulse frequency 5.3 kHz
Encoder type Select
(incremental encoder / absolute encoder)
Homing mode Select
Measurement Set
(yes/no)
Select encoder resolution In bits
Enter rated motor speed 6000 rpm
Ratio of
position control cycle clock: DP cycle | 1:2:2
clock
Note

The script file for the connection of SIMOVERT MASTERDRIVES Motion Control to
SIMOTION with standard message frame 5 is provided at no cost. It may be copied,
modified and used or passed on to third-parties. However, in the case of it being passed on
to a third party, it must be in its full and unmodified form, and all copyright conditions must be
observed. The commercial distribution to a third party, for example, in share/freeware
distribution is only permitted with the previous written agreement of the Siemens AG.

As this script file is provided free-of-charge, the authors and copyright holders cannot accept
any liability for this file. Its use is the sole risk and responsibility of the user. The liability of
the authors and copyright holders is restricted to damages arising from gross negligence or
intent. All other claims are excluded. In particular, the authors and copyright holders cannot
accept liability from any damages arising from defects or consequences arising from such

defects.
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7.9.3.2

Creating a SIMOTION project

Hardware configuration

174

In this step, the SIMOTION device, the bus system and the MASTERDRIVES MC are
created and parameterized via SIMOTION SCOUT and HW Config.

1. Start SIMOTION SCOUT.
2. Click Project > New.
3. Enter a name, e.g. DSC_MCP_3ms.

4. Click OK.
A project is created.

BIX SIMOTION SCOUT - DSC_MCP_3ms

Project Edit Inmsert Target system View Options ‘Window Help
| D|=1Q|8 Sl [5=(2] <[] X
ol |

& DSC_MCP_3ms
i) Create new device
%) Insert single drive unit
1 LIBRARIES
1] MONITOR

EEE R e =

x

Figure 7-28 Creating a project

5. Double-click Create new device.
x

wihich SIMOTION device do you want to create in Hw Config?
V¥ Open Hw Corlfig

CPU type

W ariant I j

ak. I Cancel |
Figure 7-29 Open HW Config (example)

6. Select the desired SIMOTION device.
7. Click OK.
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8. Select the interface at the C230-2 V4.1 in the PG/PC for a connection between the

PG/PC and the C230-2.

Interface selection for PG/PC connection:

PROFIBLS DP2/

Interface parameterizationz in the PG/FPC:

PC Adapter(PROFIBLIS)

ar. I Canicel

Figure 7-30  Selecting the interface

9. Click OK in the Selection of the Interface - C230 window.

The HW Config application starts.
The rack with the SIMOTION C230 device is displayed.

E{d‘ HW Config - [SIMOTION C {Configuration} -- DSC_MCP_3ms]

ol x|
Eﬂ] Station Edit Insert PLC  Wiew Options ‘Window Help - |ﬁ'|£|
D@28 §/a & e da DD %8
= ol x|
jod
FEind: I it i
| ] -
Prafile: I Standard j
PROFIBUS(1): DP master systemn (1] PROFIBUS DP
B2 PROFIBUS-PA
B2 PROFINET 1D
SIMATIC 300
SIMATIC 400
SIMATIC PC Based Contral 300,400
-J8, SIMATIC PC Station
SIMOTION Drive-based
Order nurnber Firmware | MPI address | | address 0 address Comment
C230 BAUT 230-2AA01-0AAD
257 SR
LFEAE SRUES
Lt B &7 [ PROFIEUS-DP slaves for SIMATIC 57, M7, and C7 Ll
BEROMT [0 [distributed rack) -
Dz LR IR | MR AR |

Press F1 to get Help. [

Icha 4

Figure 7-31 Rack with PROFIBUS DP Mastersystem

To create a PROFIBUS chain in the rack, proceed as follows:

SIMOTION SCOUT
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10.Double-click X8_DP1.

11.Click the Properties button in the Properties -DP1 - (R0/S2.1) window in the General tab.
12.Click the New button in the Parameters tab.

13.Select the Network Settings tab.

14.Set 2 as the highest PROFIBUS address.

15.Select a transmission rate of 12 Mbit/s on the bus and DP as profile.

%
Gereral  Metwork Settings I
. Options... |
Highest PROFIELIS
Address: |2 'I ¥ Change
Tranzmission B ate: 500 Kbps ;I
1.5 Mbps
IMbpz
5 MbEs ‘
Proie:
Standard
User-Defined
Bus Parameters... |
Cancel | Help |

Figure 7-32  Configuration of PROFIBUS lines

16.Click the Options button.

17.Activate the Activate isochronous bus cycle checkbox in the Isochronous mode tab.

18.Enter the desired cycle time, e.g. 3 ms in the Equidistant DP cycle field.
The possible times can be taken from the DP cycle time table.

19.Confirm the settings by clicking OK four times.
All property windows are closed A PROFIBUS DP master system has been created.

The other described settings are all shown for a DP cycle of 3 ms.

For 1.5 ms or 2 ms, the setting must be modified according to the DP cycle and setting
DP cycle time, pulse frequency, task tables.

Note

The X9-DP2 interface in the rack is not networked for this example. It is set by default for
PROFIBUS communication at 1.5 Mbaud.

20.0pen the PROFIBUS DP \ SIMOVERT \ MASTERDRIVES CBP2 directories in the
hardware catalog.

21.Click the PROFIBUS line. This is displayed in black.

SIMOTION SCOUT
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22.Double-click the type: Motion Control Plus.
The Properties - PROFIBUS Interface MASTERDRIVES CBP2 window appears.

[ Hw Config - [SIMOTION C (C _ o] x|
E"] Station  Edit  Insert PLC  Wiew Options  Window Help — |5|5|

Ds(E-® %] s sinlnl [ 38 we|
E— = ol
= ([0]UR :I End | ot

Puofile:  [Standard |

D Metwork Components ;I
(- Sensor system
(1 SIMADYN

_| PROFIBS(1]): DF master system [1]

-] SIMATIC
+-{_] SIMOREG
General  Parameters | : SIMOVERT

[ LARGE DRIVES CBP2
{1 MASTERDRIVES CBP
=-[_] MASTERDRIVES CBP2
@@ Active Front End
: E Frequency Control
B Motion Cantral
B Mation Cantral Flus
E Rectifier/Regenerative Unit
B Servo Contral
E Wector Control CL2
B “ector Contral CUWC
E Wector Control Flus
-] MICRO-/MIDI-/COMBIMASTER CB
-1 MICROMASTER 4
£
E

Address: h

4]

B

Transmission rate: 12 Mbps

:I:I PROFIBUS1): DP master syst Subnet

FROFIBUS addiess | [ Modul - notnetworked Hew. .
|

Froperties...
Delete

I

+-gg MASTERDRIVES CB1
+-#a MASTERDRIVES/DC M?STEH Ti:l
3

4|

EBSE70390-0-<84-0FFS (MDMP] - £,
DP slave CBP2 in SIMOVERT -
Cancel | Heln MASTERDRIVES ME Flus. Drive ES interface,
cyclic and acyclic communication, peer-ta-peer j
Press F1 to get Help, ,7,@ Y

Figure 7-33  Attaching a MASTERDRIVES Motion Control Plus to the PROFIBUS

23.Click OK.
The Properties - Drive window appears.

24 Click OK.
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25.In the Configuration tab of the DP Slave Properties window, select the Standard message
frame 5 PZD-9/9 as default.

26.In the Clock Synchronization tab, activate the Synchronize drive with equidistant DP cycle
setting.

DP slave properties ﬁl

General | Configuration  l¥ochronous Operation | [rata Exchange Broadcast - Overview I

¥ Synchronize drive to equidistant DP cycle

MHetwork, settings in m:

|Equidistant buz cycle activated

Equidistarnt DF cycle: |3'DDD Data_Exchange_Time comp. Tdx: IU-'I B4

Pulze freq. [P340] [kHz]: |5.3 Task: I.-_1 vl

Factor Frame / baze time [mz]

DP cycle Tdp [ms]: |3.019 = |1 j H |3.ma [2.974...3.065]

ak | Cancel Help

Figure 7-34  Selecting isochronous operation

Table 7- 5 DP cycle time

DP cycle time Motion Control Motion Control Performance 2
1.5 ms - Possible setting
2ms Possible setting Possible setting
3ms Possible setting Possible setting

The DP cycle must be set in SIMOTION and in the MASTERDRIVES MC.

Special settings: SIMOTION
27.Enter the value 5.3 in the Pulse frequency (P340) field.

28.Click the Alignment button.
A message appears.

29.Click Yes.

30.In the DP cycle > Time frame/time base field, enter the value 3.0.
31.Click the Alignment button.

32.Click OK to confirm the changes.
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Special settings: SIMOVERT MASTERDRIVES MC

Parameters:

Meaning:

SIMOTION SCOUT

P340 (pulse frequency)

The pulse frequency must be matched to the DP cycle so that the converter/inverter can be
synchronized with this. Frequencies from 5 to 8 kHz can be set.

The following relationships between DP cycle time, pulse frequency and task result:

Table 7- 6 Settings of DP cycle time, pulse frequency, task

DP cycle time Pulse frequency Task

1.5 ms 5.3 kHz 3 (only possible with Motion Control
Performance 2)

2ms 8 kHz 4

3 ms 5.3 kHz 4

33.Save and compile the project with Station > Save and compile.
34.Click Station > Check consistency.
35.Click OK to confirm the message.

36.Click Target system > Load to module.
The hardware configuration is completed.

37.Close HW Config.

Note

After loading the hardware configuration, the red BUS1F LED on the C230 may still flash.
The toggle switch is in the STOP position. This bus error occurs if the PROFIBUS
address and pulse frequency configured in the HW Config have not yet been set on the
MASTERDRIVES MC.

If communication between the two devices is to be tested at this point, the basic functions
of the MASTERDRIVES MC should be commissioned and the connection to
MASTERDRIVES MC established.

If the settings in SIMOTION and MASTERDRIVES MC match, the BUS2F error does not
occur and the LEDs on the PROFIBUS module of the MASTERDRIVES MC flash in
synchronism.
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7.9.3.3 Creating an axis in SIMOTION SCOUT

1. Open the Axes folder in the project navigator under C230.

2. Double click Insert axis.
The axis assistant opens and guides you through the configuration of the axis.

MY STMOTION SCOUT - DSC_MCP_3ms (=] 3

Project Edit Insert Target system View Options Window Help
| |J L B

| D132 ) % ) ] M| == | 5160 | S | ot ] ] 2] 0|
Jl j|J|<Noﬁner> =] ||

B8P DSC_MCP_3ms
W Create new device
™) Insert single drive unit
Bl STMOTION ©
= C230
-] EXECUTION SYSTEM
&= [j0
S GLOBAL DEVICE VARIABLES
B AXES

x

P_] Insert axis
[-1 EXTERMAL ENCODERS
[+ PATH OBJECTS
-] CAMS

[+ TECHNOLOGY

-] PROGRAMS

#-flla MASTERDRIVES_CBP2
LIERARIES

MCNITOR:

Project I Command library I

Figure 7-35 Inserting an axis

3. Enter a name for the axis.

4. Select the technology.
Speed regulation and positioning are already preset.

5. Click OK.
The Axis configuration - Axis Name - Axis type window is opened.

Axis configuration - Axis_1 - Axis type 5'
Agis type: | % Linear & Elechical
 Rotay = Hydravlic
 Vittual
[C1Drive assignment |+
L3
Mode: IStandald j
_’
I otor bype: ISlandald mator j
‘t'ou can select the awiz type on thiz page. ;I
Caution!

Changing thiz entry can cause loss of already set data as the
stiucture of the configuiation data changes.

< Back I Contine » I Cancel Help
Figure 7-36  Axis configuration: Axis type
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. Specify the axis type.

In the example, the set linear axis remains selected.
Set mode and motor type are also transferred.

. Click Continue.

The Axis configuration - Axis name - Units window is opened.

. Click Continue.

The Axis configuration - Ax/is name - Modulo window is opened.

. Click Continue.

The HW Config data is read out. The Axis configuration - Axis name - Drive assignment
window is opened.

Axis configuration - Axis_1 - Drive assignment J

‘whhich drive unit are vou using? Dirive:
MASTERDRIVES_CBP2 ﬂ 1

Log. Hyw addresses: Input: Output; {296

Dirive assignment

‘whhich message frame type do you want ta use for data transfer?

| standard message frame 5, FZD- ¥ | Message frame wizard... |

¥ Dynamic servo contral (DSC)
™ Activate technology data block in the message frame

Maximum speed: (6000 1pm

"r'ou can establish the connection to a dive on this page.For a diive il
on the PROFIBUS, the message frame et in HW Config is used.

Az for these drives, the rated speed set here must alzo be zet on

the drive itzelf. 1If several data sets are used, the selection of the -

< Back | Eontinue>| Cancel | Help |

Figure 7-37  Axis configuration: Drive assignment

10.Select the MASTERDRIVES CBP2 as drive unit. The standard message frame 5 is set

automatically. If this is not the case, select standard message frame 5 in the field for the
message frame type.

11.Enter the value 6000 in the Rated speed field.
12.Click Continue.

The Axis - Drive Relationship window is opened.

13.Read the note and click OK.

The online help is opened.
The Axis configuration - Axis name - Encoder assignment window is opened.

14.Select the appropriate properties.

In the example, Incremental encoder in the Encoder type field and SINE in the Encoder
mode field are selected.

The encoder data settings required for SIMOTION are listed in the encoder settings table.
Only the input values listed in the tables are evaluated for the respective encoder.

The encoder and resolution must be specified in SIMOTION and in
MASTERDRIVES MC.

15.Click Continue.

The Axis configuration - Axis name - Encoder - Data window is opened.

Configuration Manual, 05/2009 181



FAQs
7.9 SIMOVERT MASTERDRIVES MC on SIMOTION

You can find the encoder settings tables:
® in the online help or
e on the CD Utilities&Application under 2_FAQ\ENCODER_PARAMETERIZATION

Axis configuration - Axis_1 - Encoder assignmenkt il

] Drive assighment ‘where iz the position encoder connected?
|M&STERDRIVES_CBP2 - Encader 1 =l

Log. Hw addresses: Input: |255 Olutput: |255

‘which meszage frame type da vou want ta use for data transfer?

IStandard message frame 5, PZ0-349 j
Encoder type: IAbsqute encoder, cyclic absolute j
Encoder noce: [ - |
Measuring system: IHotary encoder system j

't'ou can get the encoder uzed far this ariz on this page. You can AI
alio select special connection types of the encader.
vI

< Back I Continue>| Cancel | Help |

Figure 7-38 Example: Axis configuration - selecting the encoder type for an absolute encoder

Axis configuration - Axis_1 - Encoder - data x]

Encoder pulses per revolution: -1IZIHE -

ultiplication factor of the cyclic 0
actual value [Gn_XIST1):

ultiplication factor of the absolute l—
actual value [Gn_XIST2): 0
Mumber of data bits: |24

[w]Cirivve assignment J

Encoder assignmer:

Encoder monitoring active: W

Enter the special data of the zelected encoder on this page. ;l

[

< Back I Continue>| Cancel | Help |

Figure 7-39 Example: Axis configuration - input of the resolution for an absolute encoder

Pulse encoders, resolvers and encoders must be configured according to the encoder
settings tables. This results in the following settings, for example, for the encoder.
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Axis configuration - Axis_1 - Encoder assignmenkt Ll

Wi Cirive assignment “w'here is the position encoder connected?

Log. Hw addresses Input: |25E Output: |25E

‘which meszage frame type do pou want ta use for data transfer?

Standard message frame 5, FZ0-9/9 j
Encoder type: |incremental encoder j
Encoder mode: |Sine d
Measuring sustem: |Fotary encoder system j

'f'ou can sef the encoder wsed for this axis on this page. Y'ou can
also select special connection ypes of the encoder.

L« [

< Back I Eontinue>l Cancel | Help |

Figure 7-40 Example: Axis configuration - selecting the encoder type for an incremental encoder

Axis configuration - Axis_1 - Inc. encoder data I x|

Encoder pulses per revalution; |2048 -

Mgdulo . ultiplication factor of the ceclic
Drive assignment J act. val. [Grn_#IST1):
[WIE ncoder assignmer.

< Back I Eontinue>l Cancel | Help |

Figure 7-41  Example: Axis configuration - input of the resolution for an incremental encoder
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Special settings: SIMOTION

The settings in SIMOTION are specified with the name of the configuration data and can be
shown using the expert list. The following assignments apply to the axis configuration
windows:

Encoder type

TypeOfAxis.NumberOfEncoders.Encoder_1.encoderType

Encoder mode

TypeOfAxis.NumberOfEncoders.Encoder_1.encoderMode

Resolution

TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution
TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution

Data width of absolute value without fine resolution
o TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsDatalength

Fine resolution
e TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution
e MultiplierCyclic
® TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution
® MultiplierCyclic

Fine resolution for absolute value in Gn_XIST2
o TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution
e MultiplierAbsolute

Special settings: SIMOVERT MASTERDRIVES MC
The required settings of the parameters can be found in the following tables.

Parameters:
U922 index 1 (encoder actual values)

SIMOTION SCOUT
184 Configuration Manual, 05/2009



FAQs

Meaning:

Parameters:

Meaning:

Parameters:

Meaning:

7.9 SIMOVERT MASTERDRIVES MC on SIMOTION

The actual position value is connected to the encoder interface via U922.i001. With an
absolute encoder, the absolute value from the encoder is specified as the actual position
value. Please note that it takes a moment to read this value after initialization of the Motion
Control system.

Note

If a resolver or encoder is used, the connector KK120 (actual

position value) is set in U922.i001(actual position value of the encoder interface).

If, however, a multiturn encoder is used, the connector KK100

(absolute position) is set in U922.i001(actual position value of the encoder interface).

P183 index 1 (position measurement configuration)

The configuration of the position measurement is entered via this parameter.
The last digit enables the position measurement.

xxx1 = resolver/encoder enabled

xxx2 = multiturn encoder enabled (x means not relevant)

P171 (position resolution)

In MASTERDRIVES, the position resolution, including a fine resolution (multiplication factor),
is specified. The resolution is specified with a power of two.

The position resolution must be set as follows:

2P171 = number of increments * multiplication factor of the cyclic encoder actual value

i.e. for incremental encoders: IncResolution * IncResolutionMultiplierCyclic

i.e. for absolute encoders: AbsResolution * AbsResolutionMultiplierCyclic

Differences between ABS and CYCLE_ABS:

SIMOTION SCOUT

® In the case of ABS, the absolute actual position of the encoder is assumed after switching
on the C230 or following an encoder error.

® |n the case of CYCL_ABS, overflows of the encoder areas are carried over in the NVRAM
and taken into account when the cycle is resumed. With this setting, an overall reset must
be carried out on the controller prior to initial loading of the project. Then, the encoder
must be readjusted. If the settings for the absolute encoder are modified, the encoder
must likewise be
readjusted.
With the controller switched off, the encoder may only be moved a maximum
distance < "half the encoder range" in both traversing directions in order to still be able to
detect the exact position.
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Completing the axis configuration
1. Click Next. The set data is displayed.

Axis configuration - Axis_1 - Completion i __]

All the necessamy data for configuration has been entered

v
v
v Configuration of this axis: ;]
v Name:
7 -Anis 1
Technology
v, - Position axis
v Ais type;
- Dinve: axis
- Mo modulo selected
Dirive:
- Name of drive: "MASTERDRIVES_CBF2'.
Output:
+ Dirive on PROFIBUS.
- Message frame type: "DP_TELS_STANDARD"
\ - Logical HW addresses |

[~ Do not display infarmation anymore

< Back I Finish Cancel Help

Figure 7-42  Last window of the axis configuration

2. Click Finish.

The settings are saved. An information window opens; read the information and confirm
the window.

After creating the axis, several settings must still be made in order to optimize the
interaction between SIMOTION and MASTERDRIVES MC.

7934 Deactivating following error monitoring in SIMOTION SCOUT

To prevent the following error monitoring interrupting an axis motion, it can be set to a higher
value or deactivated.

A high following error can occur, for example, as a result of a missing drive optimization.
1. In the project navigator, open the folder of the created axis.

Double-click Monitoring.

Click the Following error monitoring tab in the working area.

Deactivate the Dynamic following error monitoring active checkbox.

Click Close.

The following error monitoring must be matched to the requirements and mechanical system
of the plant when commissioning an application.

o~ wDbd

AWARN ING

If the following error monitoring is increased or deactivated, larger incorrect motions can
also occur on the axis in the case of an error (e.g. incorrect position control direction). This
is particularly important, for example, when the axis only has a limited traversing range.
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m2 C230.AHis_1 - Monitoring

Figure 7-43  Deactivating the following error monitoring
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7.9.3.5 Setting the position control configuration in SIMOTION SCOUT

1. In the project navigator, double-click Control under Axis.

2. Set the following data in the working area:

Kv factor: Enter
Speed precontrol: Activate

Fine interpolator: Select constant velocity interpolation

Dynamic drive control (DSC): Leave activated

BX SIMOTION SCOUT - DSC_MCP_3ms - [C230.Axis_1 - Closed-loop contral]
&5 Project Edit Insert Targetsystem View Options Window Help

=[oix|
=121%]

Dl (@2 &1 s =1 -] -] 2l x| falsf 2o 2| mEE | cow = 3| o

- 8P D5C_MCP_ams ¥ Expert mods
®) Create new device
) Insert single drive unit

Static controller data | Dynamic controller data | Friction compensation ]

=8 230 o
] EXECUTION SYSTEM Manipulated var. limitation
S=1/0 [ Limitation On
- GLOBAL DEVICE ARIA

=] AEES

# ) Insert axis
= auis_L Serva gain factor
> Configuration 145
> Mechanics Contraller setting ,mn—
> Default
> Limits
> Actval,
> Closed-aop col Selpt.
> Haoming
> Maritoring
> Profiles
> Control panel
> Interconnection
#-_] MEASURING Ih,
#-__] OUTPUT CAM

Diive
Max. speed

0000 o

Maw. et voltage
100 I

E

a1 Man var

U V connechion

+ 2 ExTERmAL EncoDers | | T He‘gcﬁf\i‘:w
#1-__] PATH OBIECTS o
#1_] CAMS
-] TECHNOLOGY ;ﬁh;;‘
#1-_] PROGRAMS
#1-ffl MASTERDRIVES_DC_M
# () LIBRARIES Fine interpolatar:
#1-{__] MONITOR
o Constant-speed interpolation =l I Dynamic responss fiker On
Precontrol
I~ Precontiol On
Close: Help
4 [

Project | Command library g5 Aisl

Press F1 ko open Help display.

Offline mode LM

Figure 7-44  Position control configuration

3. Click Close.
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7.9.3.6 Setting system cycle clocks in SIMOTION SCOUT

1. In the project navigator, right-click Execution system and select Expert > Set system
cycle clocks.

2. Set the values.

3. Click OK.
A message appears, read the information and confirm with OK.
T T E—— x|
Cycle clock ratios
Bus cycle clock | 3 ms
Servo 1 j x Bus cycle clock = 3 ms
Ipo 3 j X Servo = 9ms
lpo_2 2 j % lpo = 18 mz
ﬂ TCantral
Metwiork settings PROFIBLS[T]
||SUCh[UI’]UuS buz cycle activated Isachronous DP cycle: 3000 ms
Cancel | Help

Figure 7-45 Set system cycle clocks

Specifying the system cycle clocks

The system cycle clock settings in SIMOTION affects the position setpoint adaptation in
MASTERDRIVES MC.

Special settings: SIMOTION

The ratio of DP cycle clock to position control cycle clock and to interpolator cycle clock is
set to 1:2:2, for example. This represents a DP cycle clock of 3 ms, a position controller
cycle clock of 6 ms and an interpolator cycle clock of 12 ms.

For instructions on how to activate and use interpolator cycle clock 2, see the online
documentation in SIMOTION SCOUT.

Special settings: SIMOVERT MASTERDRIVES MC

Parameters:
P770 (time slice interpolator)
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Meaning:

7.9.3.7

190

The transition from the position control cycle clock (SIMOTION) to the sampling time of the
position controller (Motion Control) is controlled by an interpolator which compensates for the
transformation ratio.

e Up to MASTERDRIVES software Version V2.2

The transformation ratio can only be specified in the form position control cycle clock / DP

cycle = 2(P770-1),

l.e. if the DP cycle and the position control cycle clock are the same, then you must enter
the value 1 in P770. If the position control cycle is double the DP cycle, you must set the

value to 2.

o As of MASTERDRIVES software Version V2.2

The transformation ratio can only be specified in the form position control cycle clock / DP

Cyc|e = 2(P770-3),

l.e. if the DP cycle and the position control cycle clock are the same, then you must enter
the value 3 in P770. If the position control cycle is double the DP cycle, you must set the

value to 4.

Correction of system-related dead times in SIMOTION SCOUT

1. Right-click the axis.

2. Right-click and select Expert > Expert List.
The expert list opens in the working area.

3. Click the Configuration data tab.
4. Open the structure under typeOfAxis > SystemDeadTimeData.

5. Enter the appropriate value in additionalTime.
In our example, the value 0.002625.

6. Confirm the input by pressing the Enter key.

Table 7-7 Values of system-related dead times

DP cycle time Motion control up to SW V2.2 Motion control as of SW V2.2
1.5ms 0.003 s (only possible with Motion 0.001875 s
Control
Performance 2)
2ms 0.002 s 0.001750 s
3ms 0.003 s 0.002625 s
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B SIMOTION SCOUT - DSC_MCP_3ms - [C230.Axis_1 - Expert list] ol x|
m Project  Axis Edit Insert Target system Wiew Options Window Help ;Iilﬂ
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———————————— k4
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- Tnsert axis Emergency stop ramp generator
El% Axis_1 Actual value smoothing

- ¥ Configuration Fire interpalstor

- » Mechanics Friction compenzation
-y Default Hardware limit switch
- Limiks Haming
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» Homing hldimum jerk
- % Monitoring Merimum velocity
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Configured encadets
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- » Control panel
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[]'"_‘l MEASURING INPUTS

[]..._‘| OUTPLUT CAM Posttion monftoring
[¥]-__] EXTERMAL EMCODERS Activate control loop monitoring with acti
-1 CAMS Drive interface
[l TECHNOLOGY Actual walug smoothing
-] PROGRAMS Manipulated varishle limitation

[+ ffla MASTERDRIVES_CEP2 Standstil monforing
[ MOMITOR Standstill signal
(-] LIBRARIES Software limit switch
System-refsted dead times

0.002625

Drive interface for specific parameters
Settings for the w(s) profile
s type REAL_&HS (0) =- | Enumisidentiti =

Project | Command Ilbralyl E Bz 1

Figure 7-46  Input window for correction of the system-related dead time

7.9.3.8 Specify Homing Mode

Note

The statements with respect to the homing modes in this section and the screenshots only
refer to the homing settings for axes on a C2xx in connection with a SIMOVERT
MASTERDRIVES MC. The homing options depend on the respective drive.

If the connected axis is to be homed, the homing mode must be specified in both SIMOTION
and SIMOVERT MASTERDRIVES MC.

1. In the project navigator, double-click Homing under Axis.
2. Enter the required homing mode and the appropriate data.
3. Click Close.

Additional references
Please refer to the following document on this subject

® Function Manual: SIMOTION Motion Control, TO Axis, Electric/Hydraulic, TO External
Encoder
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Homing mode "External zero mark only"
When a defined edge of the external zero mark is crossed, the position is accepted.

MASTERDRIVES MC
Encoder
SIMOTION C230-2 ———— & M B>
E B External zero mark
HD L Input S-F
» terminal X101/2 |
I:| I:| — Reference potential
|:| HU terminal X101/2
_ L- L+
PROFIBUS DP 24VDC

Figure 7-47 Hardware configuration: Homing (External zero mark only)

Special settings: SIMOTION

If External zero mark only is selected as the homing mode, the approach direction can be
selected by means of homing direction.

Signal control and BERO edge are not significant, as the positive edge is always evaluated
in Motion Control with the parameterization of the script file (e.g. "STDTLG5_T4_V21.ssc").

The homing external zero mark for Motion Control must be connected to digital input 4
(interrupt-capable inputs / terminal X101/6).

With the script file, the digital inputs 4 or 5 are configured as measuring input 1 and
measuring input 2 and can be addressed via SIMOTION.

Digital input 4 can be used as external zero mark and as measuring input.

Digital input 5 can be used as measuring input.

The parameterization of U922.i005 and U923.i001 in Motion Control should be set to KK122
and B212 for SIMOVERT MASTERDRIVES MC in accordance with the description below.
As the zero position is of no significance here, the parameterization of the 2nd position of
P183.i001 has no effect.
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B8 c230.Axis_1 - Homing =10] x|

Active homing | Passive haming

Encoder_1 - Incremental encoder - Sine —

Homing required: |z

Harming mode: |Extemal zero mark only j
Homing with

Signal tranzition:  Low -» High [positive)

On the extemal zero mark side: |Left

L L

Start of homing procedure: |F'Dsitive direction

[~ Max. distance ta ext. zera mark
Approach velocity: ‘

50.0 mmds

Entry welocity:
200 mmes

Feduced velocity:

0o mm/'s

Home position coordinate: Home position offzet:

00 mm oo mm

-
4 | »

Cloze | Help |

Figure 7-48 Axis homing in SIMOTION (homing mode External zero mark only)

Homing mode "Encoder zero mark only"

An external zero mark signal is not necessary. The position is accepted at the next zero

mark of the encoder.

Special settings: SIMOTION

If encoder zero mark only is selected as the homing mode, the approach direction can be

selected by means of homing direction.

This must be compatible with the parameterization of the 2nd digit of P183.i001 in the Motion

Control.

If Zero mark in negative direction ... is selected in the window, P183.i001=xx2x must be

entered in the Motion Control.

If Zero mark in positive direction ... is selected, P183.i001 = xx1x must be set in the Motion

Control.
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E2)c230.A4is_1 - Homing =lof x|

Active haming | Passive homing

|»

| Encoder_1 - Incremental encoder - Sine

Homing required: IYes 'l

Horming mode: Encoder zera mark only

Start of homing procedure; | Negative direction d

[ Max dist. to encoder zero mark

Entry velocity:
|2U.U mmds 77—\ IUU— mm

Reduced velocity:

|1 oo mnds \. *
Home pogition coordinate: Home pogition offset:
0o mm [00 mm
< | _>l_I

Cloze | Help |

Figure 7-49  Axis homing in SIMOTION (homing mode Encoder zero mark only)

Homing mode "Homing output cam and encoder zero mark"

The axis traverses in the specified homing direction. Once the BERO signal is reached, the
velocity of the axis switches from the homing approach velocity to the homing reduced
velocity. Once the BERO is left, the axis is homed at the next detected zero mark of the
encoder.

The homing BERO is connected to an unassigned SIMOTION 1/O input.

External zero mark
MASTERDRIVES MC

SIMOTION C230-2 + Encoder
m| M /=

i BN
omplUUEH, || |

L- L+
24 VDC —

Input module

PROFIBUS DP

Figure 7-50 Hardware configuration: Homing (Homing output cam and encoder zero mark)
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If Homing output cam and encoder zero mark is selected as the homing mode, the
evaluation position of the zero mark and the approach direction as the homing direction can
be selected via zero mark.

These must be compatible with the parameterization of the 2nd digit of P183.i001 in the
Motion Control.

This means: If the negative direction is chosen as the homing direction in the window and
the zero mark is "behind the home position switch", the setting P183.i001=xx2x must be
configured in the Motion Control; if negative direction is selected and zero mark is "before
the home position switch", the setting P183.i001=xx1x must be configured in the Motion
Control.

If, however, the positive direction is chosen as the homing direction in the window and the
zero mark is "behind the home position switch", the setting P183.i001=xx1x must be
configured in the Motion Control; if positive direction is selected and zero mark is "before the
home position switch", the setting P183.i001=xx2x must be configured in the Motion Control.

The homing external zero mark must be connected to a freely selectable digital input of
SIMOTION which has been configured in the Home Axis window. When the external zero
mark is reached, homing is enabled in the drive.

B8 £230.Axis_1 - Homing | =Iof x|

Active homing | Passive homing

|»

Encoder_1 - Incremental encoder - Sine

Haming required: |Yes <

Haming mode: Harning output cam and encader zera mark. ﬂ
Haming with
Encoder zero mark: | e R ]
Log. addiess of 55535
homing output canm;
Start of haming procedure: |Poswt|va direction ﬂ Bit number: {0 -
[ Max distance to homing output cam
Approach velocity: ‘ |
50.0 mmds 0.0 mm
X [ Max dist. to encoder zero mark
Entry welocity:
20.0 s \ ,007 mm
Reduced velocity:
10.0 mmis o i +
Hame position coordinate: Home position offset:
0.0 i ‘U.U mm
-
4 | 3
Cloge Help

Figure 7-51  Axis homing in SIMOTION (homing mode Homing output cam and encoder zero mark)
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Special settings: SIMOVERT MASTERDRIVES MC

Parameters:

Meaning:

Parameters:

Meaning:

Parameters:

Meaning:

196

U922 index 5 (encoder actual values)

The homing value is connected to the encoder interface via U922.i005. If Homing output cam
and encoder zero mark or Zero mark only are used for homing, the homing procedure is
performed via the home position detection in the Motion Control. However, if External zero
mark only is used for homing, the position measured value memory in Motion Control is used
for the homing procedure.

If Homing output cam and encoder zero mark or Encoder zero mark only are used for
homing, connector KK124 (home position measured value) should be set in U922.i1005
(encoder interface homing value).

If External zero mark only is used for homing, connector KK122 (position measured value
memory) should be set in U922.i005 (encoder interface homing value).

U923 index 1 (encoder checkback signal)

The "Reference point detected" feedback signal (acknowledgement) is connected to the
encoder interface via U923.i001. If Homing output cam and encoder zero mark or Zero mark
only are used for homing, the homing procedure is performed via the home position
detection in the Motion Control. However, if External zero mark only is used for homing, the
position measured value memory in Motion Control is used for the homing procedure.

If Home position switch and zero mark or Encoder zero mark only are used for homing,
binector B210 (home position detected acknowledgement) should be set in U923.i001
(homing value detected checkback signal, encoder interface).

If, however, External zero mark only is used for homing, binector B212 (measured value
valid acknowledgement) should be set in U923.i001 (homing value detected checkback
signal, encoder interface).

P183 index 1 (position measurement configuration)

The position detection configuration is entered in this parameter.

xx1x=The 1st zero position to the right of the coarse pulse (external zero mark) is evaluated
xx2x=The 1st zero position to the left of the coarse pulse (external zero mark) is evaluated
(x means not relevant)

The SIMOTION project is now configured. The MASTERDRIVES MC is set in the next step.
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7.9.3.9 "Measuring" function

The "Measuring" function can be used to determine the actual position of an axis at any time.
A typical application is the acquisition of a print mark for the purpose of synchronizing the
axis to this mark.

The measuring input must be connected to fast input X101/6 or X101/7. The input is isolated.
This enables more than one input to be switched in parallel, whereby the reference potential
of the 24 V supply of the measuring input (for example, from the network supply) must also
be wired.

MASTERDRIVES MC

Encoder
SIMOTION C230-2 ———— 1 M B

Measuring Measuring

H ] input 2 input 1
Input r- + r -+
terminal X101/7

Input — ||
terminal X101/6
Reference potential
|:| I:“] terminal X101/2

- L- L+
24 VDC

] [aee ] |

PROFIBUS DP

Figure 7-52 Hardware configuration: Measurement

Inserting a measuring input in SIMOTION SCOUT
1. Open the Measuring inputs folder in the project navigator.
Double-click Insert measuring input.
Enter a name for the measuring input.
Click OK.
Click Close.
Two measuring inputs can be connected to the MASTERDRIVES:
® Measuring input 1 to X101/6

o > 0N

® Measuring input 2 to X101/7

Only one measuring input can be activated at any time. For example, before you activate
Measuring input 2, you must make sure that Measuring input 1 is not active.
The measuring input number is assigned as follows:

® Measuring input 1 = "1"

® Measuring input 2 = "2"
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SIMOVERT MASTERDRIVES Motion Control
Settings in the Edge field (SIMOTION; calling the measuring function in the user program):
® Rising edge or
e Falling edge
If you select another setting, the last valid value is taken over (rising or falling).

Response times for the measuring function

In SIMOTION, measuring can be used in various configurations. Depending on the
connection of the axis (via PROFIBUS DP) and the processing level (position control cycle
clock or IPO cycle clock), you must take different response times for the measuring function
into account in the application.

In the user program, measuring is started with the function call

_enableMeasuringlnput. You can specify when the measuring function is to be active during
the call:

® |mmediately (without measuring window)
MeasuringRangeMode = WITHOUT_SPECIFIC_AREA

e Within a position-dependent measuring window
MeasuringRangeMode = WITH_SPECIFIC_AREA

When measuring without measuring window, the measuring input is immediately activated
with _enableMeasuringlnput.

Before the measuring edge is evaluated at the hardware input, there is a
configuration-dependent runtime. To be certain to detect the measuring edge, you must
ensure that _enableMeasuringlnput is executed earlier by this amount of runtime in the user
program.

When measuring with measuring window, the job is first only registered in the system with
_enableMeasuringlnput. Only when the axis has reached the start of the measuring window
is the measuring input activated.

From the time of reaching the start position of the measuring window on the axis
(mechanical) until the evaluation of the measuring edge at the hardware input, there is a
configuration-dependent runtime. In order that the measuring input is active when the start
position of the measuring window on the axis is reached, you must move the start of the
measuring window forward depending on the axis velocity and the response time during the
function call.

This is also valid for the end of the measuring window. It is important that the measuring
input is no longer active when the end of the measuring window on the axis (mechanical) is
passed.

These runtimes can be compensated with the MeasuringRange.activationTime configuration
data item.

Note
The runtimes are only compensated without error for constant axis velocity.

The offset of the measuring window only functions reliably when the axis velocity
e within the measuring window is constant and

e known before the function call.
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You can determine the response times for your configuration using the following tables. The

SIMOTION SCOUT
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values in the tables refer to set system cycle clocks. By using the actual times, you can

calculate the response time in milliseconds.
The following abbreviations are used in the tables:

® (IS) IPO cycle clock or position control cycle clock

(is dependent on whether the measuring input is processed in the IPO or position control
cycle clock; can be selected during the configuration of the measuring input)

e (DP) Cycle time on the PROFIBUS DP

e (DR) Cycle time in the drive (time slice in which the measuring function is evaluated)

Tool calculates the anticipated response and rate times when using measuring inputs on

different hardware More at:
e 4 TOOLS\MEASURING_INPUT_CALCULATION

Table 7- 8 Measuring without measuring window

MASTERDRIVES MC

_enableMeasuringlinput
Ready to detect the measuring edge

2(IS) + 3 (DP) + 3 (DR)

Detection of the measuring edge
Result in SIMOTION for further processing

2 (IS) + 8 (DP)

Total

Minimum time between two measurements

In addition, the restrictions of the respective system must be taken into
account.

5(IS) + 11 (DP) + 2 (DR)

Table 7- 9

Measuring with measuring window: Measuring edge is detected in the window

MASTERDRIVES MC

_enableMeasuringlnput
Ready for the evaluation of the measuring range (start of the measuring
window)

2 (1)

Start of the measuring window on the axis (mechanical) reached
Ready to detect the measuring edge

2 (IS) + 3 (DP) + 2 (DR)

Detection of the measuring edge
Result in SIMOTION for further processing

2 (IS) + 8 (DP)

Total

Minimum time between two measurements

In addition, the restrictions of the respective system must be taken into
account.

5(IS) + 11 (DP) + 2 (DR)

Table 7- 10 Measuring with measuring window: No measuring edge in the window

MASTERDRIVES MC

_enableMeasuringlnput
Ready for the evaluation of the measuring range (start of the measuring
window)

2 (IS)

Start of the measuring window on the axis (mechanical) reached
Ready to detect the measuring edge

2(IS) + 3 (DP) + 2 (DR)
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MASTERDRIVES MC
Start of the measuring window on the axis (mechanical) reached 2 (I1S) + 3 (DP) + 2 (DR)
Reset: "Ready to detect the measuring edge"
Resetting of the ready to measure 2 (IS) + 8 (DP)
Checkback signal in SIMOTION for further processing
Total 7 (I1S) + 14 (DP) + 4 (DR)
Minimum time between two measurements
In addition, the restrictions of the respective system must be taken into
account.

794 Basic commissioning of MASTERDRIVES MC

What has to be observed?

One of the commissioning tools, Drive Monitor or Drive ES, is used to commission the
Masterdrives MC. If the connection is made via the serial interface USS, the bus address in
Parameter P700 and the baud rate in Parameter P701

® 6 - 9600 baud
® 7 - 19200 baud
® 8- 38400 baud

must match the settings in the commissioning tool used.
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Setting the basic functions

The initial step in a guided commissioning procedure is to configure the hardware (used
power unit, motor, encoder, etc.), the interfaces, etc. This is performed with one of the
commissioning tools, Drive Monitor or Drive ES, by calling up the Parameter > Guided
commissioning > Basic functions menu item.

1. Open the Configuration window.
2. Select for

— Motion Control devices, the power unit according to the order no. of the converter and
enter the supply voltage.

— Motion Control Compact Plus devices, the supply voltage. The power unit of this
device cannot be changed, it is automatically detected and displayed with a gray
background (like the individual slot assignments).

E§ DriveMon - [MASTERDRIVES MC Plus -- MASTERDRIVES MC Plus : (EEPROM)] I _|=] x|
5’1 Fhe View Parameters Operate Diagnostics Took Window Help == ﬁl
DI0|%| ||| 5|5 o |fsfre Bl EIMWIER| olb| %tel*|*| BI0] 2
Configuration
Motar =
Motor encoder
Machine encoder
Control mode [
Inputs{outputs
Communication
=
Supply voltage oc I 540 W
SlotA [cerer El
=== SiotB nat =l
0 SlotC YT ——r—— =
Il = Matar encoder E K
i ]
| Mext > |
4 4

!i EFF Setpoint[2]: [0.00 Act val [%]: ﬁ.ﬂﬂ Device status: Muming from device pending ’W Adr: 0

For Help, press F1

Figure 7-53  Guided commissioning of the basic device: Configuration window

3. Click Next.
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4. Select the connected motor in the Motor window.

F_5 DriveMon - [MASTERDRIVES MC Plus -- MASTERDRIVES MC Plus : (EEPROM)] = IE Iil
25 Fle View Parameters Operate Diagnostics Took Window Help - =%
o 5 g == s Y o = e A
Canfiguration
IMotar
Motor encoder
Maching encodar ISIE MENS-Matar LI |&'m:hror|au5 mator ﬂ
Control mode
Inputs fautputs p que | Roted curent | 4|
Communication 0 o matar —
1 TFEB032-6AK7 E000 1/min 0.8 Hm 154
5 FRE0ADBAR?
3 TFRE042-64F7 3000 1/min 26MNm
4 TFEE0E0-6AFT 3000 1 fmin 40 Mm ITA
5 TFEB0EI-6AFT 3000 1/min 6.0 Mm 494
B TFEE0B0-6AFT 3000 1/min 6.6 Nm 53A
7 TFEB0BI-6AFT 3000 1/min 10.5 Nm TEA j
Mexdrnum forward speed 6300 1fmin

Madmum reverse speed I-E]DD 1{min

ot

< Back | MNext > |

4

w[E foFF Setpoint[%]: [0.00 Act val[2]: [700 Device stetus: [Warming from device panding [w  adg: [0

For Help, press F1
Figure 7-54  Guided commissioning of the basic device: Motor window

5. Click Next.
6. Select the connected motor encoder in the Motor Encoder window.

F_E DriveMon - [MASTERDRIVES MC Plus -- MASTERDRIVES MC Plus : (EEPROM]]
25 Fle View Parameters Operate Diagnostics Took Window Help

I

EIES
=1s|x|

EIn[e| 15| o[saffe Bl ElmiE fol%) %l (] Eloy 2]

Canfiguration
Motar

Motor encoder
Machine encoder

Control mode
Inputs{outputs
Communication

EQMN1325 EnDat +A/B
ECHN133 20464 1 EnDat +4/8
EnDat_autom Automatisch Automatisch  EnDat +AB
EQI1325 324 4096 EnDat +4/8

< Back | MNext > |

4

!ﬁ foFF Setpain]: [3 00 Act val [%]: [0.00 Device stetus: [Warming from device panding [w

For Help, press F1
Figure 7-55 Guided commissioning of the basic device: Motor Encoder window
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I

SIMOTION SCOUT

202 Configuration Manual, 05/2009



FAQs
7.9 SIMOVERT MASTERDRIVES MC on SIMOTION

7. Click Next.
8. In the Setpoints, Control Type window, select the setting PROFIBUS DP and terminal
strip.
Configuration
Mator
Motor encader Anelogue input end terminal stip ;I Speed control -
Maching encodar Analogue input and terminal strip
Control mode hntor pnmn}mrmler and tarminal strip
Inputs/outputs.

Communication

:1 : Z ramp generator speed controller
with limitations with limitations
to current
’* n[set] \i, \L controller
— —_—— —_—

< Back et >

| | o]
Figure 7-56  Guided commissioning of the basic device: Setpoints and Control Type window

9. Click Next.

10.In the Closed-loop Control window, enter the optimized speed controller parameters
(Kp and Tr), torque limits, etc.

11.Click Next.
Do not make any settings in the following window.

12.Click Next.
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13.Set the bus address in the Communication window.

FlewewPaamemoperaﬂeDlagmmsTods\&mHeb

EIES
=l5x]

515] o [pafFn 1] IRIER] "ol %itel,[*] =i 2

Bus adress

Telegram off time

Canfiguration

Motar

Motor encoder ‘Word 1 ‘Word 2
Machine encoder |Control word 1 |Main setpoint
Control mode

Inputs{outputs
Communication

mE FF Setpoinz1 o0 Actvel] 00

For Help, press F1

Word 1 Word 2
[Etans word 1 [Main actusl value
<Back | Net> |
1| ’I

Device status: Faming from device pending W Adr 0

Figure 7-57  Guided commissioning of the basic device: Communication window

14.Click Next.
At the end of the guided commissioning, a

Parameters Operate Diagnostics Took  Window  Help

summary of the parameterization is displayed.

EIES
=l5x]

515] o [pafFn 1] IRIER] "ol %itel,[*] =i 2

Canfiguration
Motar

Machine encoder

Motor encoder Drive type: BSE7014-0TPS0

Control mode Option boards: Slot A CcerP2 Slot B: naot occupied Slot C: SBME
Inputs{outputs
Fommunicafion Motor 1FKEDA0-6AKT

Motor encoder. Absolute value encoder

Machine encoder. not available

Confral mode: Speed control

Setpoint source: PROFIBUS-DP and terminal strip

The drive is being operated in closed-oop cument control mode. We recommend that automatic motor

204

- identification is carmed out prior to start up. To do this, setP115 = 2 and switch the unit on within 20 sec.
== ==
, Caution: The motor shaft can align itself during the (Seethe insection 6.2.4
E for more information)

<Back | Mext> | accept configuration | Frint

4

mE FF Setpoinz1 o0 Actvel] 00

Device status: Faming from device pending W Adr 0

For Help, press F1

Figure 7-58 Guided commissioning of the basic device: Summary
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15.When you click Accept configuration and confirm your entries with OK and Next, the
parameterization is loaded to the converter.
A message window confirms that the parameterization has been successfully loaded.

16.Click OK to confirm the message.

The guided commissioning of the basic device is completed. You must now connect
MASTERDRIVES MC to SIMOTION.

Connecting MASTERDRIVES MC to SIMOTION

In this step, the parameterization is performed for the connection of the Motion Control to
SIMOTION for standard message frame type 5. This is performed with a script file in
accordance with the DP cycle time. The script files are stored on the Add-On CD in folder
4_Accessories.

Table 7- 11 DP cycle times and associated script files

DP cycle time Script file
1.5ms STDTLG5_T3_V21.ssc
(only possible with Motion Control Performance 2)
2ms STDTLG5_T4_V21.ssc
3 ms

The appropriate script file implements the following parameter assignments / functionalities
on the Motion Control converter/inverter:

e All digital outputs and speed setpoint interconnections are reset.

® [nstructions for setting application-dependent parameters are provided initially in a
message box. The settings are configured in the next dialog box that is displayed.
All application-dependent parameters have already been described in the "Creating a
SIMOTION project" section. Examples are parameters U922 and U923 (encoder
interface), which have to be modified etc. depending on the application (e.g. homing with
zero mark or with External zero mark only).

® Errors occurring after Power On are acknowledged automatically.
o The SST1 interface is located in the T6 time slice.

® Motor potentiometer functionality is excluded from the time slice.
® The DSC kernel function is implemented with free blocks.

® Interconnection of free modules for the implementation of the functionalities homing with
External zero mark only and measuring.

® Wiring of the standard message frame 5 process data in the converter/inverter.

e Wiring of the motor encoder interface. A wiring of the external encoder interface is not
implemented.

The following section describes the procedure for the execution of script file
STDTLG5_T4_V21.ssc. The procedure is the same for script file STDTLG5_T3_V21.ssc:

1. Open the Drive Monitor or Drive ES commissioning tool.

2. Click File > Execute script file... in the menu bar.

SIMOTION SCOUT
Configuration Manual, 05/2009 205



FAQs

7.9 SIMOVERT MASTERDRIVES MC on SIMOTION

3. Select the STDTLG5_T4_V21.ssc script file for the standard message frame 5 and open
it.

Note

The 6SE70MC converter/inverter must not be in the "RUN" mode (r001=14).

The settings for the sources of the digital outputs which are possible via the menu
Parameters > Guided commissioning > Basic functions are reset at the next Execute
script file...!

You are now guided online via Windows windows.
4. Click the Start button.

LI
FASTDTLGS_V14a sse
Concel E

Figure 7-59  Starting the script file STDTLG5_T4_V21.ssc

5. Accept the exclusion of liability.

6. Confirm the connection of the Motion Control to SIMOTION for the standard message
frame 5.

Note
You can stop the execution of the script file by clicking the Cancel button.

7. Read the contents of the message box with the setting information for the application-
dependent parameter P340 (pulse frequency).

8. Click OK to confirm the message.

x|

.é“) Enter the pulse rate of the converter in the dialog box (P340). Set Up the following value
for the pulse rate:  ///P340 = 16/DP cycle time (SIMOTION)///. Then for a DP cycle of
2ms, for example, the pulse rate is P340 = 8.0kHz. Follow instructions about the restriction

concerning pulse rates higher than 5.0 kHz,

| QK | Cancel

Figure 7-60 Message box with setting information for P340

SIMOTION SCOUT
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9. Set the required value for the application-dependent parameter P340 (pulse frequency).

P340 Pulse Frequency 3 ﬁ
Currentvalue: New value:
|5'3 KHz
Lower limit: 50
Upper limit: 100

oK Accept | Cancel |
Figure 7-61

Dialog box for setting P340

10.Read the contents of the message box with the setting information for the application-
dependent parameter U922.i001 (actual position value of the encoder interface).

11.Click OK to confirm the message.

x|

@ Enter the source for the actual position value in the dialog box (U922.1001). If an absolute
valuie encoder is not being used, confirm orily the default value (KK 120). However, if an
absolute value encoder is being used, enter the walue KK100 (jin U922,i001).

o]

Cancel

Figure 7-62 Message box with setting information for U922.i001

12.Set the required value for the application-dependent parameter U922.i001 (actual

position value of the encoder interface).

x|
Number | Name | FB name ‘
KK 73 n(set RgenOut) SetpProc. 2 ﬂ
KK 74: n(setsumz) SetpProc. 2
KK 75: nisetlimiir) SetpProc. 2 |
KK 76: dn/dt (RoenOuf) SetpProc. 2
K 77: Torgue(PRE) SetpProc. 2
KK 88: ZeroPDevExtTot Encoder Mach
KK 84 ZeroPtDeyv Encoder Motor
KK 90: Mech. Angle PulseEnc Motor
KK 91: niact) Actual Values
KK 94: SBP SetpChl Setpoint Enc
KK 95: SBP SetpCh2 SetpointEnc
KK 96: Resalver Angle Resolver Motor
KK 89: n Mix Actual Values
KK 100 Posdbs Abs Enc Motar
KK 101 nExtEncoder Actual Values
KK 102 n.Difference Actual Values
KK 104: AngleEncExt Encoder Mach
KK 105: PulseCntMachEn Pos Machine Enc
KK 106 PositionAbshach Abs Enc Mach
K115 Diagnostword 1 Diagnostic vals
K116 D D als

stivord 2

Connectomumber.  |120

Figure 7-63 Dialog box for setting U922.i001

13.Read the contents of the message box with the setting information for the application-
dependent parameter U922.i005 (homing value of the encoder interface).
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14.Click OK to confirm the message.

x|

@ Enter the sourrce for the reference value in the dialog box (U922.i005). If it is intended for
referencing to take place with BERC and reset pulse or with reset pulse only, confirm only
the default value (Kk124), However, if it is intended for referencing to take place with BERC
only, enter the value KK122 (jn U222.i005),

| OK | Cancel

Figure 7-64 Message box with setting information for U922.i005

15.Set the required value for the application-dependent parameter U922.i005 (homing value
of the encoder interface).

x

Number | Name I FB name I

K 77 Torque(PRE) SetpProc. 2 ﬂ
KK 88; ZeroPDevExtTot Encoder Mach

KK 89 ZeroFtDev Encoder Motar =
KK 30 Mech. Angle FulseEnc Motor

KK 91 naci) Actual Values

KK 34 SBP SetpCht Setpoint Enc

KK 95 SBP SetpCh2 Setpoint Enc

KK 36 Resolver Angle Resolver Motor

KK 99; n.ix Actual Values

KK100: PosAbs Abs Enc Mator

KK101: n ExiEncoder Actual Values

KK 102: n.Difference Actual Values

KK 104: AngleEncExt Encoder Mach

KK 105: PulseCnttdachEn Pos Machine Enc

KK 106: PositionAbskach Abs Enc Mach

K115; Diagnostord 1 Diagnosticvals

K116: Diagnosfword 2 Diagnosticvals

KK120: Pos Actv' Pos MotarEnc

KK121: Pos Test Pos MatarEnc

KK 122: Pas (Memong) Pos MatorEnc

KK 123 PoshiVE0ffset Pos MatorEnc

Posh efP Pos MotorEnc

Connectomumber. 124

Figure 7-65 Dialog box for setting U922.i005

16.Read the contents of the message box with the setting information for the application-
dependent parameter U923.i001 (home position checkback signal of the encoder
interface).

17.Click OK to confirm the message.

DriveMon x|
—_— The acknowledgement for the homing procedure is entered in the following dialog box (U923.i001).
'\lr) If the homing is to be performed with External zero mark and zero pulse, the default value (B210)
only has to be confirmed. If, however, the homing is to be performed with External zero mark only,
the value B212 (in U923.i001) mus

Cancel |

Figure 7-66 Message box with setting information for U923.i001
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tion-dependent parameter U923.i001 (home position

checkback signal of the encoder interface).

x|
Nurnber ‘ MName [ FB name |
'-E 145: No Ovlcharn D Status Word?2 j
B 146: Trnp Flt Drive Status Word2
B147: No Tmp Fit Dre Status Word?2
B 148 TrapWarn Drive Status Waord2 —
B14%; Mo TmpiWarn Dne Status Ward2
B150: TmpWarnhator Status Word2
B151 No TmpWarnhotor Status Word?
B152: TrmpFlttotar Status Word2
B153: No TmpFltMotor Status Word2
B156: Motor PullOut Status Waord?2
B157: No MotarPullOut Status Word2
B 158: ChrgRelay close Status Word?2
B159: ChrgPelay open Status Word2
B162: Prechrg active Status YWord2
B163 Prechrg n.act, Status Word2
B 200; No SpdDir Sel SetpProc. 1
B201: Accel active SetpProc. 2
B 202: Decel active SetpProc. 2
B 203: Limitr FwwD act. SetpProc. 2
B 204; Limitr REV act. SetpProc. 2
FelPosContrByps SetpProc. 2

Pos MotorEnc

RefPoint sensed

Binectormumber. 210

Cancel

Figure 7-67 Dialog box for setting U923.i001

19.Read the contents of the message box with the setting information for the application-

dependent parameter P171 (position

20.Click OK to confirm the message.

DriveMon

Enter the position resolution in the

H#{27P171=Resolution (SIMOTION configuration) x 211/,

[ o< |

resolution).

X

dialog box (P171). Set up the following value

Cancel

Figure 7-68 Message box with setting information for P171

21.Set the required value for the applica
resolution).

tion-dependent parameter P171 (position

X

P171 Pos Resolution i
Currentvalue: MNew value
22
Lower limit: 9
Upper limit: 30
oK I Accept I Cancel I

Figure 7-69 Dialog box for setting P171

SIMOTION SCOUT
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22.Read the contents of the message box with the setting information for the application-
dependent parameter P183.i001 (position measurement configuration).

23.Click OK to confirm the message.

prvsvion x|

@ Enter the position acquisition configLiration in the dialog box (P183.1001). Position
acquisition for the resolver or the encoder is released via xxx 1, Position acquisition for the
absolute value encoder is released via xxx2, Reference point acquisition is configured as
follows: xo¢1x the first zero position right of the coarse pulse is evaluated. xx2x the first
zero position left of the coarse pulse is evaluated. (where x means don 't care)

oK l Cancel

Figure 7-70 Message box with setting information for P183.i001

24.Set the required value in the dialog box for the application-dependent parameter
P183.i001 (position measurement configuration):

P183.1 ConfPos Sensing i,
Current value: Mew value:
I[lx]] 011
Lower limit 0x0
Upper limit: Oxcfitf

oK | Accept I Cancel I
Figure 7-71 Dialog box for setting P183.i001

25.Read the contents of the message box with the setting information for the application-
dependent parameter P205 (rated velocity).

26.Click OK to confirm the message.

x|

Enter the nominal speed of the motor in the dislog box (P205). Calculate the valLe to be
set Up in P205 according to the following formula: ///P205 = nominal speed[rpm(P353) x
27P171 { 1000/f/. For example if a motor has a nominal speed of 6000 rpm, enter a value

of 25165824,
| oK | Cancel

Figure 7-72 Message box with setting information for P205

Lo
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27.Set the required value for the application-dependent parameter P205 (rated velocity).

P205 Vrat E x|
Current value: New value:
[pEteseza 25165524

Lower limit 1
Upper limit 2000000000

OK | Accept | Cancel [

Figure 7-73 Dialog box for setting P205

28.Read the contents of the message box with the setting information for the application-

dependent parameter P770 (interpolator).

29.Click OK to confirm the message.

x|

.'\i:) Enter the ratio of the position confroller cycle and DP cycle (SIMOTION) in the dialog box

{P770). The gear ratio can only be specified in the form position controller cycle/OP
cycle=2~(P770-1), i.e. if for example the OP cycle is the same as the position controller
cycle, enter 1in P770.

QK | Cancel

Figure 7-74 Message box with setting information for P770

30.Set the required value for the application-dependent parameter P770 (interpolator).

31

SIMOTION SCOUT

P770 PosRegIntpRatio 8 ﬁ
Current value New value:
f 4
Lower limit -8
Upper limit &

OK | Accept | Cancel [
Figure 7-75 Dialog box for setting P770

.Click OK.

A message appears after the successful commissioning. Confirm this with OK.

Note

If an "Error"message is also to appear, then open the associated LOG file (name the
same as the script file but with the extension .LOG) either with the Log button or an editor
for the troubleshooting. You can find the LOG file in the commissioning tool in the same
directory as the script file.

After configuration, the green 5 VDC LED and the yellow STOP LED light up on the
SIMOTION. The keyswitch is in the STOP position.
The 3 LEDs of the PROFIBUS module flash in synchronism on the MASTERDRIVES MC.
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7.9.5

Commissioning tool

MASTERDRIVES MC commissioning tool

This section explains how to establish a connection to the MASTERDRIVES MC via a serial
interface using the Drive Monitor or Drive ES commissioning tools.

The serial interface of the MASTERDRIVES MC is set to 9600 baud and the bus address is
set to 0 at the factory. The bus address can be read out via parameter P700 on the PMU
operator panel of the converter.

The baud rate is in parameter P701, whereby:

6 — means 9600 baud
7 - means 19200 baud
8 - means 38400 baud.

Communication via DRIVE ES

1.

© N o

9.

o > DN

Open the SIMATIC Manager.

Insert a drive in the project directory via Insert > Drive.

Insert a MASTERDRIVES MC Plus with Version 01.6 and bus address O.
Click OK.

Right-click the inserted drive and select Target system > Drive > Overview in the context
menu.

Select Options > Interface settings.

Select USSin the Bus type tab.

Set 9600 baud in the COM interface used in the Interface tab.
Close the window.

10.In the menu bar, click Target systems > Drive > Parameterization.

11.Parameterize the drive.

Communication via Drive Monitor

212

1.

Start the Drive Monitor.

2. Create a parameter set via the menu File > New > Empty parameter set.
3.
4. Click OK.

Insert a MASTERDRIVES MC with Version 01.6 and bus address 0.

The file is saved and the parameter set is opened offline.

In the menu bar, click View > Online (EEPROM).
The connection to the drive is established. If a connection cannot be established, you
must set the interface via Options > ONLINE settings.

SIMOTION SCOUT
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7.9.6 MASTERDRIVES VC in connection with an axis

Introduction

This section describes how to integrate the MASTERDRIVES Vector Control converter unit
as a drive in the SIMOTION SCOUT program. This description is valid for the

MASTERDRIVES VC connection to a drive axis or a position axis. With a position axis, you
must also assign the encoders. This is noted at the appropriate position in this description.

In the following example, the converter unit is controlled via standard message frame 1.

Inserting a MASTERDRIVES VC in HW Config

1.

2

In the project navigator, double-click the SIMOTION device.
HW Config opens.

Insert the converter unit used from the HW catalog into the PROFIBUS subnet. To do
this, use the following components from the HW catalog:

Note

The SIMOVERT/MASTERDRIVES CBP2/Vector Control CUVC has a front panel that can
be swung open and behind this there is a plug-in card drawer unit with at least one plug-
in card.

— SIMOVERT/MASTERDRIVES CBP2/Vector Control CUVC or
— SIMOVERT/MASTERDRIVES CBP2/Vector Control Plus
Select the standard message frame 1, PZD-2/2.

Click the Save and compile button.

Click the Load to module button.

Close HW Config.

Inserting and modifying a virtual axis in SIMOTION SCOUT

SIMOTION SCOUT

1. Insert a virtual axis into the project navigator of SIMOTION SCOUT.
2. Call the expert list.

3. Convert the virtual axis into a real axis.

4.
5
6
7

Select the virtual axis in the project navigator.

. Open the expert list via the shortcut menu.
. Open the following directory in the expert list: ConfigurationData\TypeOfAxis.
. Make the following setting:
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e typeOfAxis = REAL_AXIS (0)

Ativate I Linear axiz [standard/pressure] B
 Restart 4 Auis_1:Configuration data:Type0faxiz. S etPaintDriver nfo J
- RestartCondition - —
o Simulation Hame Comment Start value (RAM) Unit Data type Minimum [
- Typetsis typeOfixis  |Axistype  |REAL_AXIS (D) (e e
- Actualhocelerationt anitarir INumberOfEncoders
- Actual/elocityt onitoring '—'WEndF_‘DS_
. DecadingCanfi StandtilSignal
- Distributedbation Sl e ing
.. Drift {|Positionkdonitoring
- EmergencyR ampGeneratar ID'Str'bmeaMPt'Dn _
.- Finelnterpalatar IAduaIVeIocrtyMonrtorlng
... Friction [[Maoxcvelocity
- Homing [[Maxxa.coeleration
- HWEndPos IM?XJEFK
- Manhcceleration il . S
o M amlerk ActualAccelerationhonitoring
- Mavelacity WelocityPositionProfile
. MeutralBand |NPTut.raIEland
[ MumberDfD ataSets IF”d'D_n :
- MumberDfE ncoders ISEﬂ:‘_O"-'ﬂ:)r'\"'3”“fD
- Pasitiont anitaring IHomlng :
- SetPaintDrivernfo ID.ecodlngConﬂg
.. DriveData IFlneInterpoIator
o InvertSetPaoint | IEmergencyRampGenera{or
- SmocthingFiler LonbeBilaiasels
- StandStilMonitaring _ [[EmesthingFitet
e | _>|-I | | -

Figure 7-76  TypeOfAxis configuration data

Assigning encoders

o NumberOfEncoders/Encoder_1/encoderldentification = ONBOARD (1), set EncoderType,
EncoderMode and EncoderSystem according to the encoder installed

¢ NumberOfEncoders/Encoder_1/Driverinfo/logAddressin = 128 (or 160, 192, 224)
® NumberOfEncoders/Encoder_1/Driverinfo/logAddressOut = 128 (or 160, 192, 224)

214
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® NumberOfEncoders/Encoder_1/Driverinfo/telegramType = NO_TELEGRAM (0)

o NumberOfEncoders/Encoder_1/IncEncoder/incResolution = 1024 (or number of
increments without pulse multiplication)

P Axis_1 - Expert list

Assigning the setpoint output

SIMOTION SCOUT

[ Collect changes Agtivate “ Linear axiz [standard/pressure] 'l
- Drift B Awiz_T:Configuration data: Type0fdsis MumberDfE ncoders Encader_1 J
E;::ﬁ:;:igiaor[npﬁenerator Hame Comment Start value (RAM) Unit Data type i ]
.- Frickion encoderldentific| Encoder identifi | DPMASTER (21 - ‘Enuma.xisEnco
- Horming encoderType  |Encoder type  |SENSOR_IMCREMENTAL (1) |- 'EnumAxisEnco
- HwWEndPas encoderbode  |Encoder mode | @ E_TTL (1) ;I- 'EnumaxisEnco
- Mastcceleration encodersystem|Encoder syste |ROTATORY _SYSTEM (0) - ‘Enuma.xisEnco
- Mamlerk {|'ncEncader
- Masvelocity IIncHomingEncoder
- NeutralBand IFrequencyLimﬂ

- NumberDfD ataSets IIn\fersCoumDiredion
- NumberOfEncoders |Dr|verlnf.0
B- Encoder_1 PRI
- AdaptDrive el
- BdaptEsterm Al.:!aptExtern
- Bdaptload e
- BzzemblyB ase I meEEE L
. Diiverlnfa [[PathPerRevalution
.- Filter IAssemnyElase
- FrequencyLimit [FliEr
- IncBackLash
- IncEncoder
- IncHamingE ncoder
- ImversCountDirectio
- PathPerR evalution
- Slippage
; - S | _'_I ) | i
Figure 7-77 Encoder configuration data
e SetPointDriverinfo/mode = DP MASTER (2)
® SetPointDriverinfo/logAddressin = 256 (or | address of DP slave)
e SetPointDriverinfo/logAddressOut = 256 (or O address of DP slave)
® SetPointDriverinfo/telegramType = standard message frame 1 (1)
T3 Agis_1 - Expert list
I Collect changes Setivate || Linear avis [ztandard/pre ssure) 'l
: _
- Restart Al Auis_1:Configuration data:TypeOfasiz SetPaointDrivernfo j
- RiestartCondition - —
 Gimulation Hame Comment Start value (RAM) Unit Data type Minimum )
E| TypeQtésis miode Drive interface t DPMASTER (2] - 'EnurmAxizDrive
- ActualbcoelerationManitorr | [|StrTYRE e e MO_TPE (0) = EnumAxisDiod
-~ ArtuahelncityMonitoring utouthlmbenolResepied 0 B DINT 2147483648 |21:
D ecodingCarfig [[heoAddressin  Logical sddress| 256 - LDIMT n 428
. DistributedMation I\ogAddrassOut Logical sddress 256 - UDINT 1] 420
- Drift ItelegramType Message frame ;I - 'Enum&xisTeleg
- ErmergeneyFampBenerstar l\ifeSignCheck Activation of th | YES (173) - ‘Enurm*eshlo’ =
- Firelrkerpolatar maxSetPoirt ol Standarcd voltag) 10.000000 N LREAL 1] 10
Friction motor Type Iotar type STANDARD_MOTORTYPE (D) |- ‘Enum&xishiotor
Hoarring |[Crivelata
- HwWEndPos IrvertSetPoint
- M ardcceleration
- M anlerk.
- M axielocity
- NeutralB and
- NumbemiD atadets
[+ M umbenfE nooders
- Prositionibd onitaring
[=1- SetPaintDriverlnfo
- DiiveDiata
- InvertSetPaint e
- EmoothingFiker
- StandStillkdanitaring
‘ .- | | .
Figure 7-78  Setpoint output configuration data
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Commissioning the MASTERDRIVES VC

The converter unit is commissioned with the Drive Monitor or Drive ES Basic program.

1. Establish an online connection to the converter unit.

2. Start the guided basic device commissioning via the menu item Parameter > Basic device
commissioning.

With the guided basic device commissioning, you should have selected the following
settings:

PROFIBUS DP and terminal strip selection, parameterize all digital inputs without
function

Without motor encoder:
Speed control without tachometer (F control)

With motor encoder connected to the Vector Control:
Speed control with tachometer (n control)

Setting the PROFIBUS address

Set the ramp-function generator according to the dynamic requirements (please make
sure you have the correct units)

3. Adapt the following parameters. You can then address MASTERDRIVES Vector Control
from SIMOTION via a PROFIBUS connection:

P571 = P572 = 1 (pos. and neg. direction of rotation)
P573 = P574 = 0 (motor potentiometer higher/lower)

P575 = 1 (external error, low-active)

7.10 SIMODRIVE 611U to SIMOTION

7.10.1 Connecting SIMODRIVE 611U to SIMOTION

Standard options when using the SIMODRIVE 611U

This section describes the most important standard options when using the
SIMODRIVE 611U on SIMOTION. Although additional functions can be executed with the
SIMODRIVE 611U, these must be examined on an individual basis.

This description does not replace the device documentation for the SIMODRIVE 611U. A
complete functional description of the SIMODRIVE 611U can be found in the Description of
Functions for SIMODRIVE 611 Universal "Closed-Loop Control Components for Closed-
Loop Speed Control and Positioning".

POSMO C and POSMO S

POSMO C and POSMO S drives can also be used on SIMOTION. These drives belong to
the SIMODRIVE 611U family and are parameterized with the same commissioning tools.
The adaptation to SIMOTION is comparable to the approach described for the

216
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SIMODRIVE 611U. However, the functional scope is different and is contained in the
corresponding device description.

Note

The following sections refer only to the SIMODRIVE 611U. The described approach also
applies to POSMO S and POSMO C.

The data exchange broadcast function of the SIMODRIVE 611U cannot yet be used in
connection with SIMOTION.

If a double-axis module is used, either both axes must be created as a technology object
(TO) or both axes must be addressed from the user program via the PZD interface. A mixed
operation, in which one axis is operated as a TO axis and the other axis from the user
program via the process data interface, is not possible.

Requirements of the 611U converter

SIMOTION SCOUT

¢ SIMODRIVE 611U closed-loop control module
e PROFIBUS DP3 option module for isochronous PROFIBUS DP
Closed-loop control module options:

2-axis for encoder sin/cos 1 Vpp n-set 6SN1 118-O0NHO_-0AA_
2-axis for encoder sin/cos 1 Vpp positioning 6SN1 118-1NHO_-0AA_
2-axis for resolver n-set 6SN1 118-0NKO_-0AA_

2-axis for resolver positioning 6SN1 118-1NKO0_-0AA_

1-axis for resolver n-set 6SN1 118-0NJO_-0AA_

1-axis for resolver positioning 6SN1 118-1NJO_-0AA_

PROFIBUS DP3 option module 6SN1 114-0NB01-0AAQ

Note

As a general principle, a closed-loop control card for speed setpoint operation is sufficient for
operation with SIMOTION. This is also the case when DSC is used.

If you want to use an external encoder on the axis, you must select a 2-axis closed-loop
control module, whereby the second axis cannot be used to control a motor.
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Software requirements

Personal computer minimum requirements

Minimum converter

Windows 2000 Professional Service Pack 3 or Windows XP Professional Service Pack 2
SIMATIC STEP 7 V5.3 Service Pack 3

SimoCom U V4.x
(depends on the firmware version of the SIMODRIVE 611U)

SIMOTION SCOUT V3.0

requirements
SIMODRIVE 611U firmware Version V4.x; can be read out in parameter P1799
PROFIBUS V4.x option module; can be read out in parameter P1795

7.10.2 Upgrading the firmware

Proceed as follows:
1.

2.

218

Connect SimoCom U to the drive via the RS-232-C.

Note
SimoCom U may not be connected via PROFIBUS DP!

Do not cancel the downloading operation or interrupt the online connection to the
SIMODRIVE 611U under any circumstances.

- Ak program start, initially |
[/ ok | % cancel |

$  Goonne | T Hep |

~ For 'Go online’ connect via-

* RS232 /RS485 |EEIM1 'I

—PROFIEUS

' direct connection Setthe PC / PG interface
C routed via S7.CPU @ [~ Set PROFIBUS address

Fleset routing information |

" Expert mode

Figure 7-79  Firmware upgrade: Interface window

Open the commissioning tool.

SIMOTION SCOUT
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3. In the menu bar, click Options >Service > . ..
If you want to upgrade the drive, select Firmware upgrade.

If you want to upgrade the PROFIBUS module, select Firmware upgrade of PROFIBUS
option module.

You are guided through the upgrade.

Note
This example shows the procedure for upgrading the firmware of the drive.

& SimoCom U - Drive A

Fie Edt Stadup Operatorcontiol Diggnostics ilRael Help
[o@s @ e o @ isn sl Tk @A T BN
Oriine with Diive A = data ate changed drect B Calculator.. |
[T FROFEUS e ot e ot onlercor [ ot contoler dta.
?anm}'j B e e R S
[Contiguraton] .

Analog inputs

Mechanics

Lirnit stions:

Digital inputs

Dighal oulputs

Anslog culputs

Monitorng

Cortioder

Trawetsing blocks

Angular encodet intedace

PROFIBUS pameterization

Spindle pessitioning

Filter setlings, cunent setpoin

Filtes setlings, speed setpoint

Metor data optimization I
+ @ Drive B - BSN1182-0EAD0-2P00 |

PROFIBUS nc o
smon;r; ‘St defaul vahues for cument diive configuration
E11U Delste ditve configuration
Iniiskze module
Option mo,

o I
MotionC i de FROFIE i ule AksCibeShlt+H

Be-configuie dive... I

1 | |
P _Pa [ = Opcont] B Disg

| Seport!  Achual=
g Pulse enable module tesm. 663 Speed: 00 0.0rpm LI

Torque: oo Nm

8 Fulze ensble NE teim B3/48 .
Cortr. enable NE term. 64/63  Capacaty utiz Motor current: | 001 A

Overviewstatis  [A B |

Opere: irdesactive mode via which a femwate upgrade of the connected dive can be intisted. o

Figure 7-80 SimoCom U firmware upgrade

4. Confirm the information message with OK.

Firmware upgrade

‘When upgrading the firmware, the user data can be lost!
9 Please save the diive parameters in a file!

Firmware uparade Drive & + Drive B ?

Abbrechen |

Figure 7-81 Firmware upgrade: Message window
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5. Select the file with the desired firmware and confirm your input with Open.

Firmware upgrade [ 2]

Suchen in: I_\l 05_01_04 El gl

Dateiname:  [611u.ufw | Offnen I
Dateityp: IFirmware Files [*. ufw;* c) L] Abbrechen |

[ Mit Schreibschutz Gffnen

Figure 7-82 Firmware upgrade: Select file

Firmware upgrade

Load firmware ..

8% of 628 KB, time remaining: 4:04

Figure 7-83 Firmware upgrade: Load window

SimoCom U

63 The firmware has been uparaded successfully.
\'.) The downloaded firmware will be active only after RESET.

Perform a Reset Drive & + Drive B now?

Nein |

Figure 7-84 Firmware upgrade: SimoCom U window

6. Confirm the prompt with Yes. The drive executes a RESET.

7. The firmware upgrade for the drive is completed. If required, you can now perform the
firmware upgrade for the PROFIBUS module.

SIMOTION SCOUT
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7.10.3.1

Introduction

7.10 SIMODRIVE 611U to SIMOTION

Commissioning SIMODRIVE 611U

Commissioning procedure

This section describes the standard commissioning procedure using a sample configuration.
The settings required in SIMOTION and in the SIMODRIVE 611U are explained. The sample
configuration is based on the control of two position-controlled axes with DSC. Control is via
PROFIBUS message frame 105, and a SIMODRIVE611U double-axis module is used as
drive.

If you use another axis or message frame type or another SIMODRIVE 611U closed-loop
control module, the structure of the input windows may differ from those described below.
However, the principle approach remains the same.

Moreover, you can use additional functions of the SIMODRIVE 611U in the user program (for
example, reading of operating modes, etc.). Information on this can be found in the "Expert
functions" section

Note

These instructions ensure only the connection of the SIMODRIVE 611U converter to
SIMOTION. The guide does not describe how to optimize the controller; it is assumed that
this has already been carried out.

Commissioning procedure

SIMOTION SCOUT

The commissioning procedure is divided into two parts:

® |n the first part, a SIMOTION project is created and the SIMOTION SCOUT program and
the hardware manager HW Config are used to enter the settings for the SIMOTION
system. The settings that have to be made both in SIMOTION and in the
SIMODRIVE 611U are given special attention.

® In the second part, the SIMODRIVE 611U is parameterized. The basic device
commissioning for connection to SIMOTION is used for this.

After commissioning SIMOTION and the SIMODRIVE 611U, a sample program is set up for
axis positioning.

Various parameter settings for the SIMODRIVE 611U are derived from the SIMOTION
settings. The following table contains an overview of the functions and settings which have to
be entered in both SIMOTION and in the SIMODRIVE 611U. These settings are described
separately in the following sections for SIMOTION and the SIMODRIVE 611U.

Table 7- 12 Settings required in SIMOTION and SIMODRIVE 611U

Required setting Sample values

DP cycle 2ms

Pulse frequency 5.3 kHz

Select encoder type Incremental encoder
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Required setting

Sample values

Select homing mode

Homing output cam and encoder zero mark
Encoder zero mark only
External zero mark only

position control cycle clock

Measurement Yes

No
Rated motor speed / 6000 rpm
max. axis speed
Master application cycle / Factor 1

Message frame type
see selection table

2 axes, message frame 105, PZD-10/10

PROFIBUS address

By default, the SIMODRIVE 611U is connected to SIMOTION via PROFIBUS DP.

Depending on the desired axis functionality, this connection can be made using various
device-specific message frames. The following selection table shows the options for the
individual message frame types:

Table 7- 13 Selection table

Sign-of-life | 1. 2. Dynamic Torque Required
monitoring | encoder | Encoders | Servo reduction message
Control (DSC) | (Mred) frame
Measure
ment
Speed- 1
coptrolled X 2
axis
X X 101
Position- X X 3
corltrolled X X X 4
axis /
following X X X °
axis X X X X 6
X X X 102
X X X X 103
X X X X 105
X X X X X 106
Note

The message frame types < 100 are standard message frames. These are standardized via
the PROFIdrive V3 profile. The message frame types > 100 are device-specific message
frame types for the SIMODRIVE 611U.
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7.10.3.2 Creating a SIMOTION project

Hardware configuration

In this step, the SIMOTION device, the bus system and the SIMODRIVE 611U are created
and parameterized via SIMOTION SCOUT and HW Config.

1.
2. Click Project > New.
3.

4. Click OK.

Start SIMOTION SCOUT.

Enter a name, e.g. DSC_S/IMODRIVE.

A project is created.

#Y STMOTION SCOUT - DSC_SIMODRIYE

Project Edit Insert Target swstem Yiew Options ‘Window Help

| Dics|@] = (@) o)) el 28l | Xl | sl | 5]

=P DSC_SIMODRIVE
o B9 Create new device
*._] Insert single drive unit
-] MONITOR
[#-_] LIBRARIES

Figure 7-85 Project: Creating DSC_SIMODRIVE

Double-click Create new device.

createnem device

Wwhich SIMOTION device do you want to create in Hw Config?
V¥ Open Hw Corfig

CPU type

W ariant I j
1] I Cancel |

Figure 7-86 Open HW Config (example)

Select the desired SIMOTION device.

7. Click OK.
8. Click Cancel twice.

SIMOTION SCOUT

The scanning of the PROFIBUS interface properties can be skipped first of all as these
are described in the following.
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9. Click OK in the Selection of the Interface - C230 window.
The HW Config application starts. The rack with the SIMOTION C230 device is displayed.

E{d‘ HW Config - [SIMOTION C {Configuration) - DSC_MCP_3ms] = |E| |5|

@) Station Edit Insert PLC View Options ‘Window Help =]
D@28 %@ = o dda BHE %8

= ol x|

End | | i

| ] :
Profile: ISlandard j
PROFIBUS(1): DP master systemn [1] FROFIBUS DP

SIMATIC 400
SIMATIC PC Based Contral 300,400

&[] SIMOTION Drive-based

=
I | 3

|0 v
Module .. | Order number Firmware | MPI address | | address O address Comment

C230 GALUT 230-2AA01-0AAD
257 SR
LA SRE
Lt £E. &7 & PROFIEUS-DP slaves for SIMATIC 57, M7, and C7 £<|
EEROMT [ [distributed rack] -
Dz LR IS | LR AR |

Press F1 ko get Help. [ cha 4

Figure 7-87 Rack
10.Double-click X8_DP.
The PROFIBUS line is created in the rack.

11.Click the Properties button in the Properties -DP- (R0/S2.1) window.
12.Click New.

13.Then select the Network settings tab.

SIMOTION SCOUT
224 Configuration Manual, 05/2009



FAQs
7.10 SIMODRIVE 611U fto SIMOTION

14.Set a transmission rate of 12 Mbit/s on the bus and DP as profile.

Properties - New subnet PROFIBUS il

General  Metwork Settings I

Highest PROFIBUS Optians... |

Address: |2 'I ¥ Change
Transmizsion B ate: 500 Kbps ;I
1.5 Mbpz

Prafile:
Standard
User-Defined
Bus Parameters. .. |
Cancel | Help |

Figure 7-88 Configuration of PROFIBUS lines

15.Click the Options button.
16.Activate the Activate isochronous bus cycle checkbox in the Isochronous mode tab.
17.Enter the desired cycle time, e.g. 2 ms in the Isochronous DP cycle field.

18.Confirm the settings by clicking OK four times.
All property windows are closed. A PROFIBUS master system has been created.

Note

The X9-DP interface in the rack is not networked for this example. It is set by default for
PROFIBUS communication at 1.5 Mbaud.

19.0pen the PROFIBUS DP / SIMODRIVE directory in the hardware catalog.
20.Click the PROFIBUS line. This is displayed in black.
21.Double-click the type: SIMODRIVE 611 universal.
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22 .Enter the address = 3.

o (=]
@) Station Edit Insert PLC View Options Window =81 x|
D[(5-[2 %] & || bl [@e) %8 e
I — jg..,ﬁ.e e F|
i]. [ = O ET 2008 Al
= x|
DR General  Parameters I
0
BEROMT Address: l3 v '
Drive
Drive Modules
Drive Transmission rate: 12 Mbps
Drive
Subnet:
- not networked - New,. Fomponents
PROFIBUSIT] 1.5 Mbps
4|
4= = | PROFIBUS(2) Delete VE
DRIVE B11 universa™
__PROFIBUS address DRIVE B11 universa
| DRIVE 611 universa
DRIVE POSMO &
DRIVE POSMO 4, C
DRIVE POSMOD Ca
DRIVE POSMO CD =
I NRIVE PACKN &I
0K Cancel Help | ]: _"J
BSN1118-»NO0-0&8% (B11U) E
Drive ES interface —~
Press F1 to get Help. [ [cha 4

Figure 7-89  Attaching a SIMODRIVE 611U to the PROFIBUS
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23.Click OK.

24.In the Configuration tab of the DP Slave Properties window, select the required
PROFIBUS message frame for the connection. In this example, a 611U double-axis
module connected via message frame 105 is selected. The subsequent axis motion will
be position-controlled.

DP Slave Properties i x|

General Configuration | Clack Synchronization I Internade communication - overview [

Default
Slat In local slave PROFIBUS partner =
Type Addr... Type DP ..\lfO-a... Pro.. L., Unit |Consiste...
4 no PHW
5 Actual value  PCD1  |Input 1 256 10 Word |Ertire len...
6 Setpoirt PCD1 | Output il 256 10 Word  Ertire len...
7 Axis disconn...
8 no PHW
9 Actual value  PCD1  |Input 1 276 10 Word  Ertire len...—
10  Setpoirt PCD1 | Output 1 276 10 |word |Ertire len...
14 2
< | _>J_'

|nsert slot | Delete slot |

- Master-Slave configuration 2

Master: (1)DP1

Station: SIMOTION C

Comment: | =
=l

Cancel | Help |

Figure 7-90  Setting standard message frame 105 on the slave

Special settings: SIMOTION

The message frame selected here is specified again when the axis is subsequently created.
The setting is automatically taken over from the hardware configuration when the axis is
created.
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Special settings: SIMODRIVE 611U

The PROFIBUS address must be set in the 611U in parameter P918. The message frame
selected here must be specified in parameter P922 in the SIMODRIVE 611U. With
SimoCom U, the entry can be made in the PROFIBUS Parameterization window.

228

1. Click the Isochronous operation tab.

2. Activate Synchronize drive with equidistant DP cycle.

3. Enter the following settings.

DP Slave Propetties ! ﬁ.’

General | Configuration  Clock Synchranization I Internode communication - averview |
[V Synchronize drive with equidistant DP cycle
MNetwork Settings [ms]

IEquidistant bus cycle activated

E quidistant DP cycle: 2.000 Data_Exchange_Time Tds: 0.304

o Factor Time frame/timebase [ms]
Necoodealon . [T 2], [oow
Factor Time frame/timebase [ms]
DP cycle Tdp [ms]; [2.000 = [18 = I CAES
Time Time] Factor Time frame/timebase [ms]
ime Ti [ms _ == |
[Actual value acquisition): ID’125 - I1 = | ® IU'125
RE o] Factor Time frame/timebase [ms]
[Setpoint transfer]: IU-SUU = I“ j % |G-125

Alignment |

Cancel Help

Figure 7-91 Selecting isochronous operation for SIMODRIVE 611U

Master application cycle:

Here, you specify the cycle clock in which the master is to supply new values to the
SIMODRIVE 611U. For SIMOTION, this is the position control cycle clock (servo). You
must note this value and enter it later when configuring the execution system as
position control cycle clock in SIMOTION SCOUT.

Note

It is mandatory that the master application cycle match the position control cycle clock
of the CPU!

DP cycle:

Bus cycle clock: It depends on the number of slaves
(minimum of 1 ms for P350 and 1.5 ms for C230).

Actual value acquisition:

Measured value is latched in the SIMODRIVE 611U as soon as possible before the
DP cycle clock (Input 1: - 0.125 ms before the next DP cycle clock).
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— Setpoint acceptance:

Setpoint is output in the SIMODRIVE 611U as soon as possible after the DP clock
cycle. The time depends on the number of isochronous slaves. It must be ensured
that the last slave has also received the setpoint values in the current DP cycle.
Otherwise, the drive signals it is "not isochronous with the master".

— With several axis modules on the PROFIBUS, click Align.
Click OK to confirm the changes.

Save and compile the project with Station > Save and compile.
Click Station > Check consistency.

Click OK to confirm the message.

Click Target system > Load to module.
The hardware configuration is completed.

Close HW Config.

Note

After loading the hardware configuration, the red BUS1F LED on the C230 may still flash.
The toggle switch is in the STOP position. The bus error occurs if the PROFIBUS address
configured in HW Config and the selected message frame type have not yet been set in
the SIMODRIVE 611U.

If communication between the two devices is to be checked at this point, then the basic
functions of the SIMODRIVE 611U must have been commissioned.

If the settings in SIMOTION and the SIMODRIVE 611U match, the BUS1F error does not
occur and the LED on the PROFIBUS module of the SIMODRIVE 611U is green.
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7.10.3.3 Creating an axis in SIMOTION SCOUT

Creating an axis in SIMOTION SCOUT

1. Open the Axes folder in the project navigator under C230.
The axis wizard opens when you create an axis. This guides you through the
configuration of the axis and cannot be aborted.

MY STMOTION SCOUT - DSC_MCP_3ms (=] 3

Project Edit Insert Target system View Options Window Help
| |J L B

“ D=5 =] 2B =] M Jﬂ"JﬁlﬁI"JM| fe[uka ﬁ|'3|||J§|gl|
[ e o 7

x

B8P DSC_MCP_3ms
® ) Create new device
™) Insert single drive unit
=Bl SMOTION ¢
- €230
EXECUTION SYSTEM
&= [j0
8— GLOBAL DEVICE WARIABLES

[-1 EXTERMAL ENCODERS
[+ PATH OBJECTS
-] CAMS

[+ TECHNOLOGY

-] PROGRAMS

#-flla MASTERDRIVES_CBP2
LIERARIES

MCNITOR:

Project I Command library I

Figure 7-92 Inserting an axis

Double-click Insert axis.
Enter a name for the axis.

4. Click OK.
The Axis configuration - Axis name - Axis type window is opened.

Axis configuration - Axis_1 - Axis type 5'

Agis type: | % Linear & Elechical
 Rotay = Hydravlic
 Vittual
[C1Drive assignment |+
L3
Mode: IStandald j
_’
I otor bype: ISlandald mator j
‘t'ou can select the awiz type on thiz page. ;I

Caution!
Changing thiz entry can cause loss of already set data as the
stiucture of the configuiation data changes.

< Back I Contine » I Cancel Help
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Figure 7-93  Axis configuration: Axis type

. Specify the axis type.

In the example, the linear axis setting is retained.

. Click Continue.

The Axis configuration - Axis name - Units window is opened.

. Click Continue.

The Axis configuration - Axis name - Modulo window is opened.

. Click Continue.

The HW Config data is read out. The Axis configuration - Axis name - Drive assignment
window is opened.

Axis configuration - Axis_1 - Drive assignment J

‘which drive unit are vou using? Drive:
MASTERDRIVES_CBPZ ﬂ 1

Log. Hw addresses: Input: Output; (256

Dirive assignment

‘wihich meszage frame type do pou want ta use for data transfer?

|Standard message frame 5, F'ZD-ﬂ Message frame wizard... |

¥ Dynamic servo control (DSC)
[T Activate technology data block in the message frame

M aximum speed: (6000 1pm

'f'ou can establish the connection to a drive on this page.Far & diive il
on the PROFIBUS, the message frame setin HwW Config is used.

&lso for these drives, the rated speed set here must also be set on

the drive itself. 1If several data sels are used, the selection of the =

< Back | Eontinue>| Cancel | Help |

Figure 7-94  Axis configuration: Drive assignment

. Select the SIMODRIVE_611U_DP2_DP3 as drive unit. The message frame 105 should

be set automatically. If this is not the case, select message frame 105 in the field for the
message frame type.

10.Enter the value 6000 in the Rated speed field.
11.Click Continue.

The Axis - Drive Relationship window is opened.

12.Read the note and click OK.

The online help is opened.
The Axis configuration - Axis name - Encoder assignment window is opened.

13.Select the appropriate properties.

In the example, Incremental encoder in the Encoder type field and Endat in the Encoder
mode field.

The encoder data settings required for SIMOTION are listed in the following table. Only
the input values listed in the tables are evaluated for the respective encoder.

— The encoder and resolution must be specified in SIMOTION and in
MASTERDRIVES MC.
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The encoder settings tables can be found
® in the online help or
e on the CD Utilities&Application under 2_FAQ\ENCODER_PARAMETERIZATION

Axis configuration - Axis_1 - Encoder assignmenkt il

] Drive assighment ‘where iz the position encoder connected?
|M&STERDRIVES_CBP2 - Encader 1 =l

Log. Hw addresses: Input: |255 Olutput: |255

‘which meszage frame type da vou want ta use for data transfer?

IStandard message frame 5, PZ0-349 j
Encoder type: IAbsqute encoder, cyclic absolute j
Encoder noce: [ - |
Measuring system: IHotary encoder system j

't'ou can get the encoder uzed far this ariz on this page. You can AI
alio select special connection types of the encader.
vI

< Back I Continue>| Cancel | Help |

Figure 7-95 Example: Axis configuration - selecting the encoder type for an absolute encoder

Axis configuration - Axis_1 - Encoder - data x]

Encoder pulses per revolution: -1IZIHE -

ultiplication factor of the cyclic 0
actual value [Gn_XIST1):

ultiplication factor of the absolute l—
actual value [Gn_XIST2): 0
Mumber of data bits: |24

[w]Cirivve assignment J

Encoder assignmer:

Encoder monitoring active: W

Enter the special data of the zelected encoder on this page. ;l

[

< Back I Continue>| Cancel | Help |

Figure 7-96 Example: Axis configuration - input of the resolution for an absolute encoder

Pulse encoders, resolvers and encoders must be configured according to the tables under
"Encoder settings". This results in the following settings, for example, for the encoder.
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Axis configuration - Axis_1 - Encoder assignmenkt

Log. Hw addresses Input: |25E Output: |25E

‘which meszage frame type do pou want ta use for data transfer?

Standard message frame 5, FZ0-9/9 j
Encoder type: |incremental encoder j
Encoder mode: |Sine d
Measuring sustem: |Fotary encoder system j

'f'ou can sef the encoder wsed for this axis on this page. Y'ou can ;I
also select special connection ypes of the encoder. _I
-

7.10 SIMODRIVE 611U to SIMOTION

< Back I Cantinue » I

Cancel | Help

Figure 7-97 Example: Axis configuration - selecting the encoder type for an incremental encoder

Axis configuration - Axis_1 - Inc. encoder data

Encoder pulses per revalution; |2048 -

Multiplization factor of the cyclic [FyE
act. wal [GroxIST) 1=

Dirive assignment J
[WIE ncoder assignmer.

=
=]
< Back I Cortinue > I Cancel | Help

Figure 7-98 Example: Axis configuration - input of the resolution for an incremental encoder

The settings in SIMOTION are specified with the name of the configuration data and can be

shown using the expert list.

The following assignments apply to the axis configuration windows:

Encoder type

TypeOfAxis.NumberOfEncoders.Encoder_1.encoderType

Encoder mode

TypeOfAxis.NumberOfEncoders.Encoder_1.encoderMode

Resolution

TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution
TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution

Configuration Manual, 05/2009

233



FAQs

7.10 SIMODRIVE 611U to SIMOTION

Number of data bits
TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsDataLength

Multiplication factor of the cyclical encoder actual value
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution
MultiplierCyclic
TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution
MultiplierCyclic

Multiplication factor of the absolute encoder actual value
TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution
MultiplierAbsolute

SIMODRIVE parameter bit P1011.2=0

Table 7- 14  SIMOTION settings

TypeOfAxis.NumberOfEncoders.Encoder_1.encoderType=INC
TypeOfAxis.NumberOfEncoders.Encoder_1.encoderMode=RESOLVER
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution =1024 (Resolver 2p)
=2048 (Resolver 4p)

=3072 (Resolver 6p)

=4096 (Resolver 8p)
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolutionMultiplierCyclic=2048 (0)

SIMODRIVE parameter bit P1011.2 = 1

Table 7- 15 SIMOTION settings

TypeOfAxis.NumberOfEncoders.Encoder_1.encoderType=INC
TypeOfAxis.NumberOfEncoders.Encoder_1.encoderMode=RESOLVER
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution =4096 (Resolver 2p)
=8192 (Resolver 4p)

=12288 (Resolver 6p)

=16384 (Resolver 8p)
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolutionMultiplierCyclic=2048 (0)

Comment:
For the encoders, a fine resolution of 0 (default value)

® in parameter TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.
IncResolutionMultiplierCyclic means a fine resolution of 211 = 2048

® in parameter TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.
IncResolutionMultiplierAbsolute means a fine resolution of 29 = 512
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Differences between ABS and CYCLE_ABS:

® |n the case of ABS, the absolute actual position of the encoder is assumed after switching
on the C230 or following an encoder error.

7.10 SIMODRIVE 611U to SIMOTION

® |n the case of CYCL_ABS, overflows of the encoder areas are carried over in the NVRAM
and taken into account when the cycle is resumed. With this setting, an overall reset must
be carried out on the controller prior to initial loading of the project. Then, the encoder
must be readjusted. If changes are made to the settings of the absolute encoder, the
encoder must also be adjusted.
With the controller switched off, the encoder may only be moved a maximum distance

a%ox "half the encoder range" in both traversing directions in order to still be able to

detect the exact position.

Completing the axis configuration

14. Click Next .
The set data is displayed.

Axis configuration - Axis_1 - Completion

v
v
v
4
v
v
v

Al the necessan data for configuration has been entered

Configuration of this axis:
Mame:
- Ans_1
Technology:
- Position axis
i type;
- Dirive anis
- Mo modulo selected
Dirive:
- Name of diive: "MASTERDRIVES_CBP2".
- Dutput:
+ Drive on PROFIBUS
- Message frame type: "DP_TELS_STANDARD"
- Logical HW addiesses:

[~ Do not display information anymore

< Back | Firish Cancel |

[»]

Help

15. Click Finish.
The settings are saved. A message appears, read the information and confirm this window.
After the axis is created, a few more settings have to be made to optimize the interaction

between SIMOTION and SIMODRIVE 611U.

Figure 7-99 Last window of the axis configuration

SIMOTION SCOUT
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7.10.3.4 Deactivating following error monitoring in SIMOTION SCOUT

To prevent the following error monitoring interrupting an axis motion, it can be set to a higher
value or deactivated.

A high following error can occur, for example, as a result of a missing drive optimization.
1. In the project navigator, open the folder of the created axis.

Double-click Monitoring.

Click the Following error monitoring tab in the working area.

Deactivate the Dynamic following error monitoring active checkbox.
Click Close.

O~ Db

The following error monitoring must be matched to the requirements and mechanical system
of the plant when commissioning an application.

AWARN ING

If the following error monitoring is increased or deactivated, larger incorrect motions can
also occur on the axis in the case of an error (e.g. incorrect position control direction). This
is particularly important, for example, when the axis only has a limited traversing range.

Eflc230.4xis_1 - Monitoring =10l x|

Positioning and standshll - Fallowing error | Standstill signal | Welocity error

[ Dynamic following ermror monitoring active; -~

-
“| | »

- LCloze | Help |

Figure 7-100 Deactivating the following error monitoring

SIMOTION SCOUT
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7.10.3.5 Setting the position control configuration in SIMOTION SCOUT
1. In the project navigator, double-click Control under Axis.

2. Set the following data in the working area:

Kv factor: Enter

Speed precontrol: Activate

Fine interpolator: Select constant velocity interpolation
Dynamic drive control (DSC): Leave activated

X SIMOTION SCOUT - DSC_MCP_3ms - [C230.Ais_1 - Closed-loop control] [ —loj x|
5 Project Edit Insert Targetsystem View Options Window Help —=| x|

D% S &%\ 2 < ]c-] X | Xi]%l|| G f5 | | da| ] ||| 38]]]| 2] £l Fewomeo =] =] || il

- @ DSC_MCP_sms Iv Expert mode
) Create new device
1 Insert single drive unit
=8 230
6] ExECUTION SYSTEM
S= 1o [ Limitation On
[EF GLOBAL DEVICE ARIA, Gl el

=] ARES 3000.0 1pm

® ) Insert axis

Static contoller data | Dynamic controller data | Friction compensation }

Manipulated var. limitatian
Drive

- d Axis_L Servo gain factor
> Configuration /s r ‘r:;,:'éuh,ad
> Mechanics EA  Contioller ssiting 100 P 00
> Defadt
> Limits
> actval.
> Closed-loop cai Setpt.
> Homing
> Monitaring
> Brofiles
3 Contral panel
> Interconnectiol
] MEASURING If
F- ] OUTRUT CAM

Maw. set voltage

E

= Man var
U V connechion

-] EXTERNAL ENCODERS r He‘gcutfv‘i':EC'
A-__] PATH OBJECTS i
- CAMS
#-_] TECHNOLOGY Act. val
conhect.
&1 PROGRAMS
- ffl MASTERDRIVES DC_M
#-_] LIBRARIES Fine interpolator: Dynamic respanse filter
#-{_] MONITOR ) )
- Constant-speed interpalation j [ Dynamic response fiter On
Precontrol
I Frecontiol On

1l B -

Froject | C ik
i ommand library a5 Ais 1
Press F1 ko open Help display. Offline mode UM

Figure 7-101 Position control configuration

3. Click Close.
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7.10.3.6  Setting system cycle clocks in SIMOTION SCOUT

1. In the project navigator, right-click Execution system and select Expert > Set system
cycle clocks.

2. Set the values.

3. Click OK.
A message appears, read the information and confirm with OK.
x|
Cycle clock ratios
Bus cycle clock - 2ms
Serva 1 v| * Bus cycle clock = 2ms
|po ¥ | x Servo = 4ms
lpo_2 2 | xlpo= G ms
ﬂ TControl
Metwork setings PROFIEUS(T)
|\suchrunuus buz cycle activated Aguidistanter Zpklus: 2000 ms
Cancel | Help

Figure 7-102 Setting system cycle clocks - SIMODRIVE 611U

Specifying the system cycle clocks

The specifications for system cycle clocks in SIMOTION affect the position setpoint
adjustment in the SIMODRIVE 611U.

Special settings: SIMOTION

The ratio of DP cycle clock to position control cycle clock and to interpolator cycle clock is
set to 1:2:2, for example. This represents a DP cycle clock of 2 ms, a position controller
cycle clock of 4 ms and an interpolator cycle clock of 8 ms.

Note

Important: The position control cycle clock entered here must match the master application
cycle in the HW Config!

For instructions on how to activate and use interpolator cycle clock 2, see the online
documentation in SIMOTION SCOUT.

SIMOTION SCOUT
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7.10.3.7  Specify Homing Mode

Note

The statements with respect to the homing modes in this section and the screenshots only
refer to the homing settings for axes on a C2xx in connection with a SIMODRIVE 611U. The
homing options depend on the respective drive.

If the connected axis is to be homed, the homing mode must be specified in
SIMOTION SCOUT. Depending on the mode selected, settings may also be necessary in
the SIMODRIVE 611U.

Additional references

Please refer to the following document on this subject

e SIMOTION Motion Control, TO axis, TO externalEncoder, Description of Functions
Follow the steps outlined below:

1. In the project navigator, double-click Homing under Axis.

2. Enter the required homing mode and the appropriate data.

3. Click Close.

Homing mode "External zero mark only"

SIMOTION SCOUT

When a defined edge of the external zero mark is crossed, the position is accepted.

SIMODRIVE 611U

Encoder
—n M &
SIMOTION C230-2

E |] H H External zero mark
r- +
Input
terminal 10.x
|:| HD Reference

potential
terminal 19

PROFIBUS DP

L- L+
24 VDC

Figure 7-103 Homing (External zero mark only)
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Special settings: SIMOTION

If External zero mark only is selected as the homing mode, the approach direction can be
selected by means of Homing direction.

E21 c230.4xis_1 - Homing =10 x|

Active homing | Passive homing

Encoder_1 - Incremental encoder - Sine

Haming required: |3

Homing mode: |Extemal zero mark arily ﬂ
Harming with
Signal tranzition:  Low - High [positive)

On the external zero mark side: |Left j

Start of homing procedure: |F’ositive direction ﬂ
[ Max. distance to ext. zero mark

0o i

Approach velocity: |
50.0 mms

Entry welocity:
200 mm's

Reduced velacity:

10.0 s

Home pozition coordinate: Home position affset:

0.0 mm oo mm
4 | »

Close | Help ‘

Figure 7-104 Axis homing in SIMOTION (homing mode External zero mark only)

Special settings: SIMODRIVE 611U

The homing external zero mark must be connected to input 10.x (x: Drive A or B) on the
SIMODRIVE 611U.

Parameterize input 10.x with the Equivalent zero mark function. You must enable the
equivalent zero mark via parameter P879 Bit 13.

Follow the procedure outlined in the section below on "Standard commissioning of
SIMODRIVE 611U" for the parameterization of input 10.x.

Comment on the internal 611U edge detection:

For travel in the positive direction, only the signal change 1 - 0 is recognized as an
equivalent zero mark. For travel in the negative direction, only the 0 - 1 edge is recognized
as an equivalent zero mark. As a result, not all of the approach directions that can be
selected in SIMOTION in combination with SIMODRIVE 611U can be used.

Homing mode "Encoder zero mark only"

240

An external zero mark signal is not necessary. The position is accepted at the next zero
mark of the encoder.

SIMOTION SCOUT
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SIMOTION

If the encoder zero mark only is selected as the homing mode, the approach direction can be
selected by means of the homing direction.

E¥1c230.A%is_1 - Homing =l 3

Active homing | Passive haming

-
Encoder_1 - Incremental encoder - Sine —
Homing required: |ves =
Homing mode: Encoder zero mark. only
Start of horing procedure: | Megative direction j
- [T Max dist to encoder zero mark
Entry welocity:
200
mme's 0.0 -
Reduced velocity:
100 mmis *
Home position coordinate: Harme position affset:
iRi] o |U.U mrm
-
4 | »

Cloze | Help |

Figure 7-105 Axis homing in SIMOTION (homing mode Encoder zero mark only)

Special settings: SIMODRIVE 611U

With this mode, a motor with an incremental encoder or resolver must be connected on the
SIMODRIVE 611U. Otherwise, no additional settings are necessary.

Homing mode "Homing output cam and encoder zero mark"

The axis traverses in the specified homing direction. Once the external zero mark signal is
reached, the velocity of the axis switches from the homing approach velocity to the homing
reduced velocity. Once the external zero mark is left, the axis is homed at the next detected
zero mark of the encoder.

The homing external zero mark is connected to an unassigned SIMOTION 1/O input.

SIMOTION SCOUT
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SIMODRIVE 611U
Input module External zero mark
Encoder
SIMOTION C230-2 . |:|~4|:n M

-

H 10.0 | [|

BRI HH|I||I w
L- L+
24 VDC

PROFIBUS DP

Figure 7-106 Homing (Homing output cam and encoder zero mark)

Special settings: SIMOTION

If "Homing output cam and encoder zero mark” is selected as the homing mode, the
evaluation position of the zero mark can be selected via zero mark and the approach
direction via homing direction.

The homing external zero mark must be connected to a freely selectable digital input of
SIMOTION which has been configured in the Home Axis window. When the external zero
mark is reached, homing is enabled in the drive.

B33 c230.4%is_1 - Homing =lofx|

Active haming | Passive homingl

| v

| Encoder_1 - Incremental encoder - Sine

Homing required: IYBS 'l

Homing mode: Homing output cam and encoder zero mark. j
Homing with

Encoder zero mark: [ i ==~
Log. address of [gEe35
homing output canm:
Start of homing procedure: IF‘osihve direction j Eit number: Ig vl

1 Max. distance to homing output cam

Approach velocit | | \
|50.u s I—D 2 -

Enliy velocity: ™ Maw. dist. to encoder zero mark
IZD a mmds

T ——
Fleduced velocity:
100 mds
1 ¢ ] —
Home position coordinate: Home position offset;
|n.n i |n.0 o
| | _’I—I
Clase | Help |

Figure 7-107 Axis homing in SIMOTION (homing mode Homing output cam and encoder zero mark)
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Special settings: SIMODRIVE 611U

With this mode, a motor with an incremental encoder or resolver must be connected on the
SIMODRIVE 611U. Otherwise, no additional settings are necessary.

7.10.3.8 "Measuring" function

You can use the "measuring" function to record the actual position of an axis at any time. A
typical application is the acquisition of a print mark for the purpose of synchronizing the axis
to this mark.

The measuring input must be connected to the fast input 10.x. The input is isolated. This
enables more than one input to be switched in parallel, whereby the reference potential of
the 24 V supply of the measuring input (for example, from the network supply) must also be
wired.

SIMODRIVE 611U

Encoder v
—|.n. —
SIMOTION C230-2 D
! ﬂ H H Measuring input
r -+
Input
terminal 10.x
|:| HI] Reference
potential
terminal 19
PROFIBUS DP L- L+
24 VDC

Figure 7-108 Measurement

Inserting a measuring input in SIMOTION SCOUT

1.

SIMOTION SCOUT

Open the Measuring inputs folder in the project navigator.

2. Double-click Insert measuring input.
3. Enter a name for the measuring input.
4.

5. Click Close.

Click OK.

Configuration Manual, 05/2009
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SIMODRIVE 611U

Parameterize the SIMODRIVE 611U with SimoCom U so that input 10.x addresses the
measuring input.

Comment on 611U-internal edge detection in HW versions up to 6SN 118-xxxxx--xxx1:

For travel in the positive direction, only the 1 - 0 signal change is detected as a measuring
signal.

For travel in the negative direction, only the 0 — 1 edge is recognized as a measuring signal.
You must take this into account when activating the measuring input.

Settings in the Edge field (-~ SIMOTION; calling the measuring function in the user program):
® Rising edge or
e Falling edge

If you select another setting, the last valid value is taken over (rising or falling).

Response times for the measuring function

In SIMOTION, measuring can be used in various configurations. Depending on the
connection of the axis (via PROFIBUS DP) and the processing level (position control cycle
clock or IPO cycle clock), you must take different response times for the measuring function
into account in the application.

In the user program, measuring is started with the function call

_enableMeasuringlnput. You can specify when the measuring function is to be active during
the call:

® |mmediately (without measuring window)
MeasuringRangeMode = WITHOUT_SPECIFIC_AREA

e Within a position-dependent measuring window
MeasuringRangeMode = WITH_SPECIFIC_AREA

When measuring without measuring window, the measuring input is immediately activated
with _enableMeasuringlnput.

Before the measuring edge is evaluated at the hardware input, there is a configuration-
dependent runtime. To be certain to detect the measuring edge, you must ensure that
_enableMeasuringlnput is executed earlier by this amount of runtime in the user program.

When measuring with measuring window, the job is first only registered in the system with
_enableMeasuringlnput. Only when the axis has reached the start of the measuring window
is the measuring input activated.

From the time of reaching the start position of the measuring window on the axis
(mechanical) until the evaluation of the measuring edge at the hardware input, there is a
configuration-dependent runtime. In order that the measuring input is active when the start
position of the measuring window on the axis is reached, you must move the start of the
measuring window forward depending on the axis velocity and the response time during the
function call.

This is also valid for the end of the measuring window. It is important that the measuring
input is no longer active when the end of the measuring window on the axis (mechanical) is
passed.
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These runtimes can be compensated with the MeasuringRange.activation
Time configuration data item.

Note
The runtimes are only compensated without error for constant axis velocity.

The offset of the measuring window only functions reliably when the axis velocity
e within the measuring window is constant and
® known before the function call.

You can determine the response times for your configuration using the following tables. The
values in the tables refer to set system cycle clocks. By using the actual times, you can
calculate the response time in milliseconds.

The following abbreviations are used in the tables:

® (IS) IPO cycle clock or position control cycle clock
(is dependent on whether the measuring input is processed in the IPO or position control
cycle clock; can be selected during the configuration of the measuring input)

e (DP) Cycle time on the PROFIBUS DP

Tool calculates the anticipated response and rate times when using measuring inputs on
different hardware More at:

e 4 TOOLS\MEASURING_INPUT_CALCULATION

Table 7- 16  Activate measuring immediately

SIMODRIVE 611U
_enableMeasuringlinput 3 (I1S) + 7 (DP)
— Ready to detect the measuring edge
Detection of the measuring edge 2 (I1S) + 10 (DP)
— Result in SIMOTION for further processing
Total 5(IS) + 17 (DP)
Minimum time between two measurements *)

Table 7- 17 Measuring in the measuring window: Measuring edge is detected in the window

SIMODRIVE 611U
_enableMeasuringlnput 2 (IS)
- Ready for the evaluation of the measuring range (start of the
measuring window)
Start of the measuring window on the axis (mechanical) reached 2(1S) + 7 (DP)
— Ready to detect the measuring edge
Detection of the measuring edge 2 (I1S) + 10 (DP)
— Result in SIMOTION for further processing
Total 5(IS) + 17 (DP)
Minimum time between two measurements *)
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Table 7- 18 Measuring in the measuring window: No measuring edge in the window

SIMODRIVE 611U
_enableMeasuringlnput 2 (IS)
- Ready for the evaluation of the measuring range (start of the
measuring window)
Start of the measuring window on the axis (mechanical) reached 2 (IS) +7 (DP)
— Ready to detect the measuring edge
Start of the measuring window on the axis (mechanical) reached 2 (IS) +7 (DP)
— Reset: "Ready to detect the measuring edge"
Resetting of the ready to measure 2 (IS) + 10 (DP)
- Checkback signal in SIMOTION for further processing
Total 7 (IS) + 24 (DP)
Minimum time between two measurements *)

*) In addition, the restrictions of the respective system must be taken into account.

7.10.3.9  Drive configuration for SIMODRIVE 611U

The commissioning tool SimoCom U is used for commissioning the SIMODRIVE 611U. This
SimoCom U commissioning tool is intuitive for the most part. You are guided through the
individual steps.

The connection to the drive can either be made via a serial interface or PROFIBUS DP.
1. Start SimoCom U.

2. A window appears in which you are asked whether you want to change the data for the
drive.

3. Establish a serial connection (PROFIBUS DP) between SimoCom U and the drive.

SIMOTION SCOUT
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4. Select Find online drives....
The advantage of this is that you do not have to enter the data for the controller card and
the PROFIBUS module. This data is read out and displayed by SimoCom U.

A data set has not selected. Do you wish

to...
3| Generate new offine file...
&

5

Dpen an existing file...

Search for online drives...

|

Mone of these

Figure 7-109 Drive configuration for SIMODRIVE 611U

#¥ SimoCom U - Drive A
Eile Edit Statup Operator contol  Diggnostics  Options  Help
|0 o W o | 5050 i <t 8 ¥ Re (R MA|T & @2
Online with Drive & =» data are changed diect in the drivel
|C31 FROFIBUS iz nat in the data ransfer condition [Warning) |ﬂ Feset fault memary I Help I Alarms. .
-] x| -
=i Mame: P\ntrieb A EI Operating mode: | Speed/torque setpaint
=t @ Drive A - Antrieb A -
- T I~ PROFIBLS node ddess: | 5[]
Analog inputs SIMODRIME 5110: _Mohur:
Mechanics BSM1118-1NHO0-Qéudix TFTEO31 -RAKT -k
Limitations B11U 2 axiz Positioning made | B000pm 1.0 Mm 1.45 Afrms)
Digital inputs : Sin/Cos Vpp O Encoder:
Digital outputs Dption madule: 1Pt -sotmci-HE
Ainalog outputs BSM1114-0MB01 0240 2048 lines/rev EnDat Sin/Cos voltage signal
Monitoring Matian Control with PROFIEUS-DP
Contraller Power section: @) second encader:
Traversing backs BSM1T 231 8000-0H Ax Mo encoder
Angular encoder interface BAlpk]
FROFIBUS parmeterizatio
Spindle positioning
Filter settings, cusrent st
Filter zettings, speed selp
Jq totor data optlmzauon. = II Be-configue dive... |
P Pa | = Opcont E Diag
P ral> B0 |, _ | 3
'k_?l - R fﬂwint ! 5| Actual = 0 Torque-generating cuirer I
Pulse enable module term. 663 =p= . Tpm b5
e % [ 000 Al
& | D Contralles enable tem. 65 .
S | @ Ramp-function generator enable ez au i —
. Patameter set: 0 Utilization, mator vI
g 8 Pulse enable ME term. 63/48
Conlr. enable NE lemn 64/63  Capacityutiz| | Motarcunent | 0014 [ oox
Overview status ’Tﬂ
Press F1 to display Help. [ | [250902 (033454

Figure 7-110 Drive configuration for SIMODRIVE 611U with SimoCom U
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5. Click Configuration under Drive A.
6. Click the Reconfigure drive button in the working area.

Note

If you use a double axis module, you must perform the following procedure twice, for
Drive A and Drive B. You must make sure that the PROFIBUS address setting is
applicable to both drives. The same PROFIBUS message frame must be used for both
drives.

247



FAQs

7.10 SIMODRIVE 611U to SIMOTION

248

7. Enter a name for the drive.

Drive configuration

Dirive configuration - Drive &

“ou will be prompted to select the hardware (dependent on the drive
type, e.q. type of Simodive, Motor, encoder etc.] and define the
SIMODRIVE operating mode.

A3 the final step, the controller data will be calculated and - if

necessary - a Power-on Reset performed

Drive name:

easier identify dives in the system. This name is saved in the
diive, and is read out again anline.

< 2tk I Weiter > I Abbrechenl Hilfe

Figure 7-111 SimoCom U: Drive Configuration window

8. Click Next.

In the Select SIMODRIVE window, the order numbers of the controller module and the
PROFIBUS module are displayed with a gray background, as you are connected online
with the SIMODRIVE 611U. These input values cannot be changed.

Select SIMODRIVE

Which version of SIMODRIVE do vou wish ta commission [if the hardware
configuration was automatically recognized, only the status is displaved here.) 7
|ESN1118-1NHO0-04Ax 611U 2 asis Posiioning mode Sin/Cos 1¥pp =l
Firrweare wersion : II.F. 01.04 ¥ |
Are pou using an option module?

|ESN1114-0NBO1-0440 Mation Contral with PROFIBUS-DP =l
\wihich PROFIBUS address shall this diive have? B 3

Only encoder systems with 1% peak to peak can be used with this control type.

The optional PROFIBUS module acts as the interface between the SIMODRIVE
E11 universal and & Profibus network. It is inserted in the control module [See
sketch on left).

<Zuiick [ Weiter> | Abbrechen | Hilfe

Figure 7-112 SimoCom U: SIMODRIVE Selection window
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9. Enter the PROFIBUS address.
The address must agree with the bus address specified in the SIMOTION hardware
configuration.

Motor selection

Motor: IStandard matar vI Mator type: I‘IFTB, 1FKE, 1FET [syn 'l

Nm 15.00 A{ra|

1FEG064-TAHTx-xxxx 4500 rpm 12,

o
1FK6080-6AFTu=xxxx 3000 rpm 8.0 Nm 5.80 Afr
1FEG0532-TAFTx-xxxx 3000 rpm 14.0 Nm 10.60 Afr
IFE6083-6AFTx-xxxx 3000 rpm 16.0 Nm 10.40 A(r
1FE6085-TAFTw-xxxx 3000 rpm 22.0 Nm 22.50 Alr
1FK6100-8AF7x-xxxx 3000 rpm 18.0 Nm 12.20 su—l
IFEE101-8AF7x-xxxx 3000 rpm 27.0 Nm 17.50 A(r
1FE6103-8AFTx-xxxx 3000 rpm 36.0 Nm 23.50 A(r
IFTE0Z1-6AKTx-xxxx 6000 rpn 0.4 Nm 1.25 A(r

.8

lF'I'6024—SAK?x—xxxx 6000 rpm
{LFTE03 1 - AK T xx 6000 rpm
1 FTAN R d—w AR T —vww ﬁnrn ram
4

.25 Afr

1
L0 Nm 1.45 Af
M 9ﬁnn:ld
»

o

Lok for: |

< Zuriick. I Weiter > I Abbrechen Hilfe

Figure 7-113 SimoCom U: Motor Selection window

10.Select the connected motor. You can find the data on the type plate of the motor.
11.Click Next.

Measuring system / encoder

‘Which motor measuring spstem are pou using? IStandard encoder j

The following measuring systems can be used for the selected
module-motor combination:

2048 linesfrey
2048 lines/rev

<Zuiick [ Weiter> | Abbrechen | Hire |

Figure 7-114 SimoCom U: Measuring System / Encoder window

12.Select the measuring system.
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13.Click Next.

You require this data in SIMOTION to adjust the encoder when you commission the axis.
Use this number to find the corresponding input values for the SIMOTION axis
configuration in the "List of encoder data".

— In the Operating Mode window, you must select the speed/torque setpoint. This option
is only available for the 611U closed-loop control modules that are also capable of
positioning operation.

Operating mode

In what made do pou wish to operate this dive?

Speed/torque setpoint

Speedftorque setpoint;

I this mode, you can enter a speed/torgque setpoint via analog
inputs (+-10%) or PROFIBUS, which is used to control the mator.

*You can toggle between open-loop torque controlled operation
and closed-loop speed contralled operation during operation via a
parameterizable teminal [terminal <461 or <462,

<zwiick [ weier> | Abbrechen | Hilfe

Figure 7-115 SimoCom U: Operating Mode window

14.Select the operating mode.
15.Click Next.

el meaziming syclom / encodsi

Which tiect mesmaing sysfem ar= peu usng? [ - |

<guick [ Wetes | Abmechen | Hile |

Figure 7-116 SimoCom U: Direct Measuring System / Encoder window
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16.1f desired, select the direct measuring system.

7.10 SIMODRIVE 611U to SIMOTION

This encoder can only be measured on a double-axis module via the measuring input for
Axis B. As a result, Axis B is no longer available for controlling an axis.

If you use the direct measuring system, you must select a PROFIBUS message frame
that contains a second encoder. In SIMOTION, you can assign this encoder for the
position control or create an external encoder that accesses this actual value.

17.Click Next.

Completion of drive configuration

Al data required to configure the dive have been entered:

Drive name:

Power section
Mator

Encoder
second encoder
(Opetating mode

2l

Closed-loop ctil plug-in module

: B5N1182-0EA00-2P00 Drive

1 BEN112¢-14x0:-0HA: 8 Alpk]

pk]
: TFTE031 28K e-waee 000 rpm 1.0 Mm 1.4%
- 1FsBix-susn-+E e 2048 linesfrey EnDat Sins

: No encoder
: Speed/tarque setpoint

After "Calculate controller data, save, reset"" this
configuration iz saved in the FEPROM
- power-on RESET executed on the module
- all of the parameters re-azsigned.

Calculate controller data, save, reset

: BSN1118-1NHO0-0bAR

=

|

S EiEn > | Abbrechenl

Hire |

Figure 7-117 SimoCom U: Completion of the Drive Configuration window

The Completion of the Drive Configuration window displays a summary of the inputs.

18.Click Calculate controller data, save, reset.

19.Select the PROFIBUS Parameterization window. Here you can select the PROFIBUS
address of the drive, 3 in this example, and the message frame, 105 in this example.

In SIMOTION, specify this data during the hardware configuration to adjust the drive.

Note

Error message for the drive enable.
If a TO alarm appears for the axis enable with absolute encoder, the encoder data is not yet
valid on the drive interface. The status of the encoder system must be queried before calling
the enable command. The enable command can be issued when the axis system variable

sensordata[1].state displays the status VALID.

SIMOTION SCOUT
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Figure 7-118 SimoCom U - Drive A
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e Optional: Select the Digital Inputs window. Here you can define the function of input 10.x.

If you want to use the "measuring function" in SIMOTION, you must select the "Flying
measurement / length measurement” function here.

If you want to use the "External zero mark only homing" function in SIMOTION, you must
select the "Equivalent zero mark" function here. In addition, you must enable the
equivalent zero mark function via parameter P879 Bit 13.

Note

You cannot have "measuring" and "equivalent zero mark" active on a drive at the same
time, because you may only select the functions on input 10.x. If you need both functions
on a drive, you must switch the function. The section on "Expert functions" describes how
you can write (switch) parameters in the drive from the user program.

&% SimoCom U - Drive A

File Edit Statup DOperatorcontiol Diagnostics Options  Help
(D@ B * o @ as]ie s AR QR AA T BN
Online with Drive & => data are changed direct in the drivel
[E31- PROFIBUS is not in the data transler condition (warning) 1~] Resetfaulmemoy | Hep |  Alams. |

22l inputs: Wiing... L

Description of Functions...
104 Flyrg measurement / length measuleme;l Help I

E Q Drive A - B5N1182-0EADD-2

Configuration
Analog inputs
Mechanics
Limnitations
Digital inputs
Diigital outputs
Analog oulputs
Moritating
Cantroller
Traversing blocks
Angulas encoder interface
FROFIBUS parmeterization
Spindle posilioning
Filter zettings, curent setpain
Filter zetlings, speed setpoint
Motor data optimization

[+ ép Diive B - BSN1182-0E400-2P00 |

o A » 134 Inactive = Hee | |
P Pal =+ Op cont Diag
17

i?] Setpaini | Aclual=
§ Oﬁjseenablemodklelm 663 Spesd [ [ 00 mpm

Controller enable term. 65
@ Ramp-function generator enable UL r 0'2 b

| Fidis enthio NE Stnt B3/ NN e A ek
} Contr. enable NE tetm. 64/63 Capawutiﬂ Mator cument: | 0.01 A

Overviewstatus  [A B |

Press F1 to display Help. I | [250902 [pas042

Figure 7-119 SimoCom U - Drive A digital inputs

114 Inactive | Hep |

124 Inactive J= | M

Not all of the parameters for the SIMODRIVE 611U can be specified by means of technology
screen forms. To enter parameters directly (e.g. parameter P879), open the expert list. Here
you can select and modify the relevant parameters.

SIMOTION SCOUT
Configuration Manual, 05/2009 253



FAQs

7.10 SIMODRIVE 611U to SIMOTION

4% SimoCom U - Drive A

File List QEIEUNEN Operator contiol  Diggnostics  Dptions Help
|I3§_ PaameteizingViews  * | <5 5 ([3p | rc? £8 #3 Ro | Qe ok? @ A (Tga.‘?|
Onl  Wiing... bed direct in the drivel
5 et i dves et conditon [Warning) T~] Resetfaulmemory | Help Alaims...
- %] Disconnect Humbes | Text Walue Unit Active -
Vo 1 851  |Brake release time 600 | ms immed.
il il 852 | Speed, close holding brake 500 | rpm immed.
o 400 | ms immed.
Linnitations P Jani = 500} me e
N 9 force.. 010z Read only
Drigital inputs Torque reducti
Digital autputs 0002k Read only
Analog oulputs 872 | Option modude type 4 Read anly
Menitceing 873 | Option module version 0000k Read only
Conhal.e' 875 | Espected oplion module ulpe 4 Power On
Traversing blacks FROFIBUS coni 0000k Bits->F4
Angular encoder inteiface higriration 00006 Bits-»F
PROFIEUS izt 880 |Spesd evaluation, PROFIELIS 16324 | pm immed.
Spindle posilioning 88 Evalusation torque/power reduction PROFIBL 16384.00| % immed.
Fiter setlings. cunent selpoin 882 | Evaluation, torque sefpont PROFIBUS 800.00| % immed.
Fiter seltings, speed setpoirt | | ™ gag | Funclion, distiibuted input [FROFIBLIS) 0 immed
Motor data optimi = =
@ Diive B - ESN1182.0EA0D 2F‘Eﬂl 890 [Activate angular encoder/encoder interface 1] Power On
il Source, extenal posibon reference value -1 Power On
892 |Mo. of angular encoder marks / no. of encod 1] Power On
4 N 2 893 | Angular encoder zer pulse offset 0.00| Degres Power On
P Pa I -+ Op cont Diag [ 894 |Angular encoder input signal waveform 1] Power On I -
4 |
k] Setpoint | Aclual=
§ O Pulse enable module term, 663 Speed [ o0 | 00 mpm 3 |
Controller enable berm. B5 0.0
Q) Ramp-function generator enable ;m::w o r '0 iy
@ Pulse enale N tem. €343 =
Canty. enable NE term. B4/63  Capacity ubliz [ Mator cument: | 0.01 4
Ovwerview status l__l
Opens the expert list. v

Figure 7-120 SimoCom U - Drive A expert list

Parameters to be entered directly:

e P879 Bit 13:
Enabling of the equivalent zero mark function. This setting is necessary if you use the
"External zero mark only homing" function. In addition, you must select the Equivalent
zero mark function for input 10.x.

® P880:
The scaling of the PROFIBUS speed value is specified here. For the maximum motor
speed, a setpoint NSET = 4000 0000hex is transferred to the drive via the PROFIBUS.
The P880 parameter is used to inform the SIMODRIVE 611U which speed should be set
when NSET = 4000 0000 hex. This speed must agree with the "maximum motor speed"
value specified when the axis was created (SIMOTION SCOUT: Axis Configuration -
Drive window).

This concludes the drive configuration. If there are no errors, the green 5 VDC LED and the
yellow STOP LED are now illuminated on the SIMOTION. The keyswitch is in the STOP
position. The LED on the PROFIBUS module of the SIMODRIVE 611U is illuminated green.

The standard commissioning is now completed. You can continue with the section Creating
a sample program for positioning in SIMOTION SCOUT.

If you would like to use special functions of the SIMODRIVE 611U from the user program,
you should also read the Expert functions section.
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7104 Expert functions

This section explains functions that can be used in conjunction with the SIMODRIVE 611U
and that go beyond the standard connection.

These functions primarily involve evaluating or influencing data (parameters) of the
SIMODRIVE 611U in the user program. Several options are available for this:

® |[f the desired value is already contained in the message frame used for the axis
connection, you can poll the value directly (cyclically).

e |f the desired value is not contained in the used message frame, but can be provided
cyclically by the SIMODRIVE 611U, it is possible to lengthen the message frame.

e |f the value is not available cyclically, you can expand the message frame to include the
parameter identifier value (PIV) mechanism and access the parameters of the
SIMODRIVE 611U acyclically.

Furthermore, you can make certain operational settings on the SIMODRIVE 611U such as
control of just one axis with the double-axis module, or utilize functions such as using
unassigned analog inputs and outputs in the user program.

Note

This section assumes that you are well-acquainted with the functions of the SIMODRIVE
611U. The function options are only briefly presented. For more information, refer to the
Description of Functions for SIMODRIVE 611 universal "Closed-Loop Control Components
for Closed-Loop Speed Control and Positioning".

Important parameters on the SIMODRIVE 611U

SIMOTION SCOUT

The table lists the parameters of the SIMODRIVE 611U that are evaluated in connection with
SIMOTION or must be taken into account during adaptation to SIMOTION.

Some of the listed parameters are entered during the standard commissioning.

Table 7- 19  Selection of some parameters and their meaning

Parameter | Meaning

P 660 Function selection for input 10.x

79 Equivalent zero mark

If the zero mark of the encoder cannot be evaluated during homing, a signal
supplied by an appropriately mounted encoder can be fed in as

"equivalent zero mark" via this input.

80 Measuring input

Maximum number of measuring inputs for SIMODRIVE 611U = 1;
Caution: Measuring can only be performed via this input (10.x).

P 700 Operating mode
For 2-axis module only: Axis B can be deselected.

P 875 Expected optional module type
PROFIBUS communication for Drive B can be deactivated here, if only one axis is
operated on the 2-axis module.
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256

Parameter

Meaning

P 879

Sign-of-life monitoring in the drive is active

Bit 0,1,2: Permissible sign-of-life errors

Bit 8: Deselect sign-of-life monitoring

Bit 12: Activate direct measuring system

Bit 13: Use incremental measuring system with equivalent zero mark

P 880 Specifies scaling of the speed for motion with PROFIBUS DP. Here you specify the
maximum speed of the motor. You must also specify this speed when creating the axis
in SIMOTION SCOUT.

P 881 Specifies scaling of torque reduction for motion with PROFIBUS DP.

P 915 PZD setpoint assignment for PROFIBUS

P 916 PZD actual value assignment for PROFIBUS

P 918 DP slave address as specified in the project with HW Config.

P 922 Message frame type as specified in the project on the axis.

P 1001 Speed controller cycle clock
Input value 4 -~ 4 x 31.25 «s = 125 «s for sin/cos 1 Vpp drives
Input value 16 - 16 x 31.25 «s = 500 «s for resolver drives

P 1042 Fine resolution of absolute track G1_XIST1 - fixed input value: 11

P 1044 Fine resolution of absolute track G2_XIST1 - fixed input value: 11

P 1043 Fine resolution of absolute track G1_XIST2 - fixed input value: 9

P 1045 Fine resolution of absolute track G2_XIST2 - fixed input value: 9

P 1795 Firmware for option module

P 1799 Firmware for closed-loop controller

SIMOTION SCOUT
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PROFIBUS message frame

Your application may require that certain drive data be evaluated in the user program. Using
the message frame structure, you can see which data are available by default for evaluation
with the respective message frame. You may read, but not modify the data in the user
program as this data is supplied by the axis.
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PzZzD |PzD | PzD | PzD | PzD | PzD | PZD | PzZzD | PzD | PzD | PzD | PzD | PzD | PzD | PzZD | PZD
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

MF_1 STW | NSE

set 1 TA

MF_1 ZSW | NACT]

act 1 _A

MF_2 STW | NSET_B STW

set 1 2

MF_2 | ZSW | NACT_B ZSW

act 1 2

MF_3 STW | NSET_B STW | G1_

set 1 2 STW

MF_3 ZSW | NACT_B ZSW | G1_ | Eg. E.g.

act 1 2 ZSW | G1_XIST1 G1_XIST2

MF_4 STW | NSET_B STW| G1_ | G2_

set 1 2 STW| STW

MF_4 ZSW | NACT_B ZSW | G1_ | Eg. E.g. G2_| Eg. E.g.

act 1 2 ZSW | G1_XIST1 G1_XIST2 ZSW| G2_XIST1 G2_XIST2

MF_5 STW | NSET_B STW | G1_ | XERR KPC

set 1 2 STW

MF_5 ZSW | NACT_B ZSW| G1_ E.g. E.g.

act 1 2 ZSW| G1_XIST1 G1_XIST2

MF_6 STW | NSET_B STW] G1_ | G2_ | XERR KPC

set 1 2 STW| STW

MF_6 ZSW | NACT_B ZSW | G1_ | Eg. E.g. G2_| Eg. E.g.

act 1 2 ZSW | G1_XIST1 G1_XIST2 ZSW| G2_XIST1 G2_XIST2

MF10 STW | NSET_B STW | M_R | DAC | DAC

1 set 1 2 ed 1 2

MF10 ZSW | NACT_B ZSW | Meld

1 act 1 2 w

MF10 STW | NSET_B STW| M_R| G1_

2 set 1 2 ed STW

MF10 ZSW | NACT_B ZSW | Meld | G1_ | E.g. E.g.

2 act 1 2 w ZSW | G1_XIST1 G1_XIST2

MF10 STW | NSET_B STW| M_R | G1_ G2_

3 set 1 2 ed STW|] STW

MF10 |ZSW | NACT_B ZSW | Meld | G1_ E.g. E.g. G2_ E.g. E.g.

3 act 1 2 W ZSW | G1_XIST1 G1_XIST2 ZSW | G2_XIST1 G2_XIST2

MF10 STW | NSET_B STW | M_.R | G1_

5 set 1 2 ed STW XERR KPC

MF10 |zSw | NACT_B ZSw | Meld | G1_ E.g. E.g.

5 act 1 2 w ZSW | G1_XIST1 G1_XIST2

MF10 |STW | NSET_B STW | M_R | GI_ | G2_ XERR KPC

6set |1 2 ed STW | STW

MF10 |ZSW | NACT_B ZSW | Meld | G1_ | E.g. E.g. G2_ | Eg. E.g.

6 act 1 2 wW ZSW | G1_XIST1 G1_XIST2 ZSW | G2_XIST1 G2_XIST2

Figure 7-121 Message frame structure
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Table 7-20  Signal list assignment

SIMODRIVE 611U signal Designation Short designation Signal length

number

50001 Control word 1 STW1 16 bit

50003 Control word 2 STW2 16 bit

50005 Speed setpoint A NSET_A 16 bit
(nset-h)

50007 Speed setpoint B NSET_B 32 bit
(n-set (h +1))

50009 Encoder 1 control word G1_STW 16 bit

50013 Encoder 2 control word G2_STW 16 bit

50017 Encoder 3 control word G3_STW 16 bit

50025 System deviation (DSC) XERR 32 bit

50026 Position controller gain factor | KPC 32 bit
(DSC)

50002 Status word 1 ZSW1 16 bit

50004 Status word 2 ZSW2 16 bit

50006 Actual speed value A NACT_A 16 bit
(nact-h)

50008 Actual speed value B NACT_B 32 bit
(n-act (h +1))

50010 Encoder 1 status word G1_ZSW 16 bit

50011 Encoder 1 actual position G1_XIST1 32 bit
value 1

50012 Encoder 1 actual position G1_XIST2 32 bit
value 2

50014 Encoder 2 status word G2_ZSW 16 bit

Device-specific signals for "SIMODRIVE 611 universal":

50015 Encoder 2 actual position G2_XIST1 32 bit
value 1

50016 Encoder 2 actual position G2_XIST2 32 bit
value 2

50101 Torque reduction MomRed 16 bit

50103 Analog output DAC1 16 bit
Terminal 75.x/15

50105 Analog output DAC2 16 bit
Terminal 16.x/15

50107 Digital outputs DIG_OUT 16 bit
Terminals O0.x to O3.x

50111 Distributed inputs DezEing 16 bit

50113 Torque setpoint MsetExt 16 bit
external

50102 Message word MeldW 16 bit

50104 Analog input ADCH1 16 bit

Terminal 56.x/14
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SIMODRIVE 611U signal Designation Short designation Signal length

number

50106 Analog input ADC2 16 bit
Terminal 24.x/20

50108 Digital inputs DIG_IN 16 bit
Terminals 10.x to 13.x

50110 Utilization Ausl 16 bit

50112 Active power Pactive 16 bit

50114 Smoothed torque setpoint Mset 16 bit

50116 Smoothed torque-producing | I1qGl 16 bit
current Iq

Adapting message frames individually

The drive may require additional functions, beyond the predefined message frames, for an
application. It is possible to expand the predefined message frame for this purpose. These
additional words can be addressed via the 1/O interface of SIMOTION. The technology object
does not access this data.

To adapt a message frame individually:

1. Find the message frame type required for your axis type from the table above.

2. In HW Config, append the desired number of additional words after the last word of the
selected message frame.
Note: As the message frame structure no longer corresponds to the selected message
frame type, another message frame or "no message frame" is displayed.

3. When creating the TO in SIMOTION, you must specify the originally selected message
frame type. The TO evaluates only the number of words corresponding to the specified
message frame type. The additional words can be processed in the user program.

4. In the SIMODRIVE 611U, you must generate the desired message frame structure
manually using the signal numbers. To do this, set parameter P922 to 0. You can use
parameter P915 Index 1 to 16 and parameter P916 Index 1 to 16 to enter the signal
numbers corresponding to the message frame.

A maximum of 16 PZD words can be read or written.

Furthermore, an expansion to include the PIV area is possible. This enables parameter

contents to be read or written by means of a job mechanism.

The following procedure must be followed:

1. Find the message frame type required for your axis type in the table.

2. In HW Config, select the PIV area.

Comment: As the message frame structure no longer corresponds to the selected
message frame type, another message frame or "no message frame" is displayed.

The step-by-step procedure for the expansion of the message frame is described using two
examples.
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Example 1: Expanding the process data area

The signals of the process data area are updated in the PROFIBUS cycle clock. The
evaluation takes place on the SIMODRIVE 611U in the speed control cycle clock (default
125 0O s).

Task
Based on the desired axis functionality, message frame 102 is to be used to connect the
SIMODRIVE 611U.
Both of the analog inputs of the SIMODRIVE 611U are to be read in the user program.
An analog value of 0 to 10 V is to be output via the two analog outputs.
The actual torque value of the drive is to be evaluated in the user program.
Note
The analog channels on the SIMODRIVE 611U are not required for the PROFIBUS
connection, and the user can make use of these as desired.
In order to utilize the functions, message frame 102 must be expanded as follows:

PzD | PzD | PzD | PzD | PzD | PzD | PzD | PzD | PzD | PzD | PzD | PzD | PZD | PzD
1 2 3 4 5 6 7 8 9 10 11 12 13 14-16

MF STW1 |NSET_B STW2 |M_Red| G1_S | DAC1 | DAC2

set W

P915 50001 | 50007 | 5007 |50003 | 50101 | 50009 | 50103 | 50105

(6110)

MF ZSW1 | NACT_B ZSW2 | Meld | G1_Z | G1_XIST1 G1_XIST2 ADC1 | ADC2 | Mset

act W SwW

P916 | 50002 | 50008 | 50008 | 50004 | 50102 | 50010 | 50011 | 50011 | 50012 | 50012 [|50104 | 50106 | 50114

(611U)

Message frame 102 Additional functions Not assigned

Figure 7-122 Message frame 102

SIMOTION SCOUT
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Adaptations for SIMODRIVE 611U with SimoCom U
Settings differ from those described in the section on "Commissioning" as follows:

1. Call up the Analog outputs menu item in the SimoCom U.

2. Parameterize
the function Signal DAC1 from PROFIBUS PPO for the first output,
the function Signal DAC2 from PROFIBUS PPO for the second output.

3. Expand the PROFIBUS message frame via the expert list as follows.
Approach:

- P922 =102
This results in a standard assignment of the P915 and P916 parameters
corresponding to message frame 102.

- P922=0
This setting enables you to freely set up the message frame using the P915 and P916
parameters. The standard assignment (step 1) is still available, i.e. you only have to
enter the additional signals.

P915:1 to P915:6 — standard assignment corresponding to message frame 102 setpoints
P915:7 = 50103 - analog output 1 (DAC1)

P915:8 = 50105 - analog output 2 (DAC2)

P916:1 to P916:10 — standard assignment corresponding to message frame 102 actual
values

P916:11 = 50104 - analog input 1 (ADC1)

P916:12 = 50106 — analog input 2 (ADC2)

P916:13 = 50114 - smoothed torque setpoint (Mset)

Settings via SIMOTION SCOUT

Settings differ from those described in the section on "Commissioning" as follows:

Configuring the hardware:

® Message frame selection:
Select message frame 102.

® Change the length from 6 to 8 in the Setpoint line
(2 additional words DAC1 and DAC2)

® Change the length from 10 to 13 in the Actual value line
(3 additional words ADC1, ADC2 and Mset)

Note the I/O start address for both areas, for example, 256.

Note

Due to this change, the message frame structure no longer corresponds to message frame
102. For this reason, either "No message frame" or another message frame type is displayed
after the change, which you can ignore. You address the drive using the originally intended
message frame type, 102 in our example.
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Creating the TO axis

® Axis configuration:

The drives created in the HW configuration can be selected here. Select the required
drive.

® Message frame:
Specify message frame type 102. The part of the message frame relevant for the
TO axis, corresponds to message frame 102.

Creating the I/O area

Create two 1/O output words and three I/O input words for the additional functions in the 1/0O
container. The addresses are calculated are follows:

® Address = message frame start address + (PZD number - 1) x 2
® Example for ADC2:

Message frame start address: 256

ADC2 is on PZD12: 12

I/O input address for ADC2 = 256 + (12 - 1) x 2= 278

Activating the PIV area

You can perform the following tasks via the PIV area (PIV = parameter identifier value):
® Request parameter value (reading of parameters)
® (Change parameter value (writing of parameters)

The PIV area consists of 8 bytes.

Table 7-21 PIV area

Bit 0-10 = PNU Reserved IND PWE
Bit 12-15 = AK
Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 Byte 8

PNU: parameter number

AK: request or response ID

IND: subindex, subparameter number, array index
PWE: parameter value

The exact structure and handling of the area is contained in the Description of Functions for
SIMODRIVE 611U.

Task in example 2

SIMOTION SCOUT

e Based on the desired axis functionality, message frame 102 is to be used to connect the
SIMODRIVE 611U.

® The motor temperature is to be read out from parameter P603 in the user program.
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Adaptations for SIMODRIVE 611U with SimoCom U

Settings differ from those described in the section on "Commissioning” as follows: None

Settings via SIMOTION SCOUT
Settings differ from those described in the section on "Commissioning" as follows:

Configuring the hardware
® Message frame selection: Select message frame 102
e Click the "No PIV area" cell and select the "PIV area" setting.

Note the 1/O start address for the PIV area, for example, 256.

Note

Due to this change, the message frame structure no longer corresponds to message frame
102. For this reason, either "No message frame" or another message frame type is displayed
after the change, which you can ignore. You address the drive using the originally intended
message frame type (102 in our example).

Creating the TO axis

® Axis configuration;
The drives created in the HW configuration can be selected here. Select the required
drive.

® Message frame:
Specify message frame type 102. The message frame structure relevant for the TO axis,
corresponds to message frame 102.

Creating the 1/0 area

Create one I/O input byte array for the response area and one I/O output byte array for the
request area in the 1/0O container, with each array having a length of 8 bytes. The start is on
the 1/0 address you noted for the PIV area (hardware configuration).

Example for requesting the P603 parameter (motor temperature):
Request ID: 6 — (request parameter value (array); refer to SIMODRIVE 611U - Description)
Parameter number: 603 = 16#25B

Index: O

SIMOTION SCOUT
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Table 7-22 PIV area

7.10 SIMODRIVE 611U to SIMOTION

Bit 0-10 = PNU Reserved IND PWE

Bit 12-15 = AK

Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 Byte 8
Request | 16#62 16#5B 0 0 0 0 0 0
area
Respons | 16#42 16#5B 0 0 Data 4 Data 3 Data 2 Data 1
e area

Note

The entered response identifier (4) corresponds to the positive request transaction.

Deactivating the sign-of-life monitoring

The PROFIBUS connection between SIMOTION and the SIMODRIVE 611U is monitored
using the sign-of-life. As a general principle, sign-of-life monitoring must be active during
operation. Sign-of-life monitoring is automatically selected when the axis is created. In case
of problems (for example, alarm 832 on the SIMODRIVE 611U), the sign-of-life monitoring
can be deactivated temporarily for diagnostic purposes.

In SIMOTION, parameters for the sign-of-life monitoring can be selected or deselected on
the TO axis via Expert list > Configuration data ....lifeSignCheck.

The sign-of-life monitoring can be deactivated in the SIMODRIVE 611U via parameter
P879 Bit 8.

2. Activating the second encoder

SIMOTION SCOUT
Configuration Manual, 05/2009 265

In SIMOTION, you can use the second encoder input on the SIMODRIVE 611U double-axis
module for the actual value acquisition. Axis B of the SIMODRIVE 611U cannot then be used
to control a motor.

A PROFIBUS message frame must be used for the second encoder in SIMOTION.

When creating Axis A in the SIMODRIVE 611U:

Create the second encoder by specifying Which direct measuring system are you using? >
Enter data. Then enter the required encoder type. Depending on the configuration of the
SIMODRIVE 611U, it is necessary to adapt the following parameters:

Parameter P879 Bit 12 = 1 -~ Enable direct measuring system (Axis A)
Parameter P922 -~ PROFIBUS message frame type (Axis A)
Parameter P700 = 0 — Deselect Axis B (Axis B)

Parameter P875 = 0 - Expected option module type (Axis B)
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7.10.5 Commissioning the 611U with DSC

To operate SIMOTION with DSC (dynamic servo control) on the SIMODRIVE 611U via the
PROFIBUS, you must enter special settings in three places when you assign parameters.

Hardware configuration

For SIMODRIVE 611U, you must select a PROFIBUS message frame type that supports
DSC. Here they are the message frames 5, 6, 105 and 106.

i
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Figure 7-123 Message frame type in the HW Config

Activating DSC in SIMOTION SCOUT

You must activate a parameter in SIMOTION SCOUT in order to use the DSC function. DSC
can be activated individually for each axis. This means that mixed operation is also possible.

DSC is activated via:

SIMOTION SCOUT
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o Axis/Expert/Expert list/Configuration
data/TypeOfAxis/NumberOfDataSets/DataSet_1/ControllerStruct/PV_Controller/enableD

SC=YES

“HSIMOTION SCOUT - SCOUT_poi__3 - [Axis_1 - Expest list]

7.10 SIMODRIVE 611U to SIMOTION
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Figure 7-124 Activating DSC in SIMOTION SCOUT

Setting in the SIMODRIVE 611U

In the SIMODRIVE 611U, DSC is automatically activated when the PROFIBUS message
frame type is set, i.e. the drive internal position controller is active as soon as Xerr (following
error) and Kpc (position controller gain) are sent to the drive.

SIMOTION SCOUT

You should set the same message frame type selected in HW Config under PROFIBUS
parameterization / message frame selection (corresponds to P922 in the expert list).
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7.11 Creating a sample program for positioning in SIMOTION SCOUT
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Figure 7-125 Setting during operation

7.11 Creating a sample program for positioning in SIMOTION SCOUT

Program overview

In this section, a program for positioning the connected axis is created in the MCC (Motion
Control Chart) editor.

Inserting the programs
Set four programs with MCC.
e motion_1
® backgr
e perfault

e tecfault

SIMOTION SCOUT
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7. 11 Creating a sample program for positioning in SIMOTION SCOUT

Creating a program with MCC

1.

© N o ok~ DN

9.

Open the Programs folder under the created SIMOTION device in the project navigator.
Double-click Insert MCC unit.

Enter the name motion_1 for the MCC unit.

Click the Compiler tab.

Activate the required settings.

Click OK. An MCC unit is created in the project navigator.

Double-click the MCC unit motion_1 in the project navigator.

Double-click Insert MCC chart.

Enter the name motion_1 for the MCC.

10.Click OK. The MCC is opened.

11.Click the Single-axis commands > Switch axis enable icon.

The command is inserted.

12.Click the Single-axis commands > Position axis icon.

SIMOTION SCOUT

The command is inserted.
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13.Click the Single-axis commands > Remove axis enable icon. The command is inserted.

B SIMOTION SCOUT - DSC_MCP_3ms - [MCC - [C230.motion_1][mation_1 *]] =lol=|
& Project Edit Insert Targetsystem View Options Window Help == x|

HD‘@m&ea\@II%EII:I&HEIIJ&I&IJEIM\*-‘-&'B%IIJE@IHJ@IIJ T T e 57 |
|

Parametersivariables | 10 symbols | Structures | Enumerations |

=8P DSC_MCP_3ms = =
) Create new device || wame | Variable type Data type | Arraylength | initial value | Comment |
[

) Insert single: drive unit 1

=] 230 N 1

1S 1/O
{E GLOBAL DEVICE YARIA
[=l-_] A¥ES
| Insert axis
[ Axis_1 stant
EXTERMAL ENCODERS
] PATH OBIECTS
1 cAmMs
] TECHNOLOGY Ende
=] PROGRAMS
----- | Insert ST program
] Inserk MCC unit
----- # | Insert DCC charts
®) Insert LAD/FED uni
=2 motion_
-~ Insert MCC che
L é mation_1()
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-] LIBRARIES
[#-_] MONITOR

< | El
Project | Cammand library s 1| 5 motion_ 1 & molion_1
x

Level | Message -]
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Infarmation DP Canfig: Start of the communication configuration
Information DP Config: Deletion of the old configuration
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Figure 7-126 Menu bar of the single-axis commands

I * Aude [fis_1 I

Parameter | Dynamicsl Expelll
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Direction I From position j
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Figure 7-127 Opened command: Position axis

14.Double-click the Switch axis enable command.
15.Click OK.
16.Double-click the Position axis command.

SIMOTION SCOUT
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7. 11 Creating a sample program for positioning in SIMOTION SCOUT

17 .Enter the value 2000 at Position.
18.Select Relative in the Type field.

MCC - [C230.motion_1][motion_1 *] I =101 x|
Parametersfvariables IIIO symbols | Siructuresl Enumerations |
}' [ Hame I Variable type I Data type I Array length I
i ‘ | | l
‘ I 2l

3

I
[

Achse_1 2]

* Achse_1

4 X

4

P Achse_1 (l

Figure 7-128 Arrangement of the single-axis commands in MCC motion_1

19.Click OK.
20.Double-click the Remove axis enable command.
21.Click OK.
22.Compile using the menu command MCC chart > Apply and compile.

Creating the backgr program
1. Double-click Insert MCC unit.

© ©® N o g kDN

SIMOTION SCOUT
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Enter the name backgr for the MCC unit.

Click the Compiler tab.

Activate the required settings.

Click OK. An MCC unit is created in the project navigator.
Double-click the MCC unit backgr in the project navigator.
Double-click Insert MCC chart.

Enter the name backgr for the MCC.

Click OK. The MCC is opened.
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10.Enter the following variable data in the MCC unit backgr.
In the Name field: Run

As the variable type, select: VAR_GLOBAL

As the data type, select: BOOL

In the Initial value field: False

=P DSC_MCP_3ms -
#) Create new device
| Insert single drive unit
= C230
] ExECUTION SYSTEM
&= 10
B GLOBAL DEVICE VARIABLE:
£l A%ES
® ) Insert axis
d Ais_L
-] EXTERNAL ENCODERS
-] PATH OBJECTS
#-] CAMS
-] TECHNOLOGY
=] PROGRAMS
=) Insert ST program
| Insert MCC unit
® Insert DCC charts
= Insert LAD/FED unit
g é backar
% Insert MCC chart
& backgr()
=] ;E? mition_1
# ) Insert MCC chart
& motion_1{)

INTERFACE [exported declaration]
Parameter 1 IO symbals I Structures I Enumerations I Connections I

| Hame Variable type | Data type

| Arraylength | initial value |

Comment

AR _GLOBAL BOCL

T |Leur
E

1l

Ealse

IMPLEMENTATION [source-internal declaration]
Parameter 1 I¥0 symbols I Structures I Enurerations I Connections I

| Hame | Variable type | Data type

| Arraylength | Initial valus

Comment

|

# flla MASTERDRIVES_DT_MAiF

< »

4

{ Praject | Command library

£ motion_1 &5 backar | & motion_1 J & backgr

Figure 7-129 Entering a global variable

11.Switch to the MCC Chart backgr tab.

12.In the Program structures command bar, click on the
IF program branch icon.

Parametersivariables I I¥O symbols I Structures I Enumerations }

=8 DSC_MCF_ams -
Variable type | Data type

® Creats new device = | Hame | Array length | Initial value Comment

1 Insert single drive unit 1

g 10 IR sl o Al kel &
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® ) Insert 5T program TRUE

# Insert MCC unit
® Insert DCC charts
= Insert LAD/FED unit
=2 backar
# Insert MCC chart
= backgr()
= é mation_1
) Insert MCC chart
=
A motion_1()
| i fla MASTERDRIVES_ch_MAirF
4 »

Project | Command library

Figure 7-130 IF program branch under basic commands

Ende

&5 motion_1 | & backg | & motion 1 & backg |

13.Double-click the IF program branch command.

SIMOTION SCOUT
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14 .Select Formula and enter the condition Run=true.

IF: Program branching [backarl x]
|‘B Farmda I
If Lauf=trid]
Cormands | “arichles |
JE I Canel | Avcepl | Help |

Figure 7-131 Configuration of the IF program branch

15.Confirm the input with OK.

16.In the Task commands command bar, select the command Start task.
This inserts the command.

17.In the Important commands command bar, select the command Variable assignment.
This inserts the command.

18.Double-click the Start task command.
19.Click OK to confirm.
20.Double-click the Variable assignment command.

21.Enter the statement Run:=false.

Variable assignment [backgr] =]
Formula I
Variable  [:=| E |
1 |Lauf -=|talze |
[~ Uninterruptible assignments Corenands I Variables I
0K | Cancel | | Accept | Hep |

Figure 7-132 Configuration of the variable assignment
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22.Click OK to confirm.

X SIMOTION SCOUT - DSC_MCP_3ms - [MCC - [C230.backgr][backgr]] -[of =]
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Information Code generation: backgr - 0 enorfs), 0 warning(s)
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Fress F1 to open Help display. UM
Figure 7-133 Completed program of the BackgroundTask

23.Select MCC Chart > Accept and compile from the menu bar.
The detail display in the Compile/Check output tab indicates how compilation is
progressing and when it is complete.

Creating the perfault program
1. Double-click Insert MCC unit.
Enter the name perfault for the MCC unit.
Click the Compiler tab.
. Activate the required settings.

Click OK. An MCC unit is created in the project navigator.

Double-click Insert MCC chart.
Enter the name perfault for the MCC.
Click OK. The MCC is opened.

2
3
4
5
6. Double-click the MCC unit perfault in the project navigator.
7
8
9.
10.Select from the menu bar MCC chart > Apply and compile.
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Creating the tecfault program

The procedure for creating the tecfault program is exactly the same as for the perfault
program.

In the MCC unit and MCC chart, enter tecfault as the name.

Assigning programs to the execution system

1.

o > N

SIMOTION SCOUT
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In the project navigator, double-click Execution system under the SIMOTION device. The
execution system is opened in the working area.

=[oix]
=l=1x]
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Figure 7-134 Execution system of the SIMOTION device

Click the MotionTasks button.

Assign the motion_1 program to MotionTask_1.

Assign the backgr program to the BackgroundTask.
Assign the perfault program to the PeripheralFaultTask.
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Assign the tecfault program to the TechnologicalFaultTask.
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Figure 7-135 Assignment of the tasks in the task system

Click the Save project and compile all button.

Loading the programs to the SIMOTION device and switching to RUN
The C230 toggle switch is still set to STOP.

1.
2.

Establish an online connection. Click the Connect to target system button.

Click the Download project to target system button.
This can take several minutes.

Switch the SIMOTION device to RUN via the keyswitch after the project has been
downloaded to the target system. Two LEDs, the green 5 VDC and the RUN LED, light

up.

Monitoring and controlling in SIMOTION SCOUT
Click the Connect to target system button.
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Select the backgr program.

Select the Symbol browser tab.

As control value, enter the variable Run "TRUE".

Activate the setting in Status value.
Click Start status. The value FALSE is displayed.

Activate the setting in Control value.
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7. 11 Creating a sample program for positioning in SIMOTION SCOUT

8. Click Control immediately.

T SIMOTION SCOUT - DSC_MCP_3ms - [MCC - [backgr *]]

& Project Edit Insert Targetsystem View Options Window Help =8| x|
== e Y T 3 B
I | o iver> g A T T E T P AT

= 8P DSC_MCP_3ms
#) Corfigure hardware
) Insen individual dive
= 230
] EXECUTION SYSTEM
&= 110
& L AXES
) Insert axis
W A1
@ £ EXTERNAL ENCODEF
# ) CAMS
= (] PROGRAMS
® Insest ST program
5 Insest MCE chast

Start task

Wanable
assignment

4]
4] motion_1
I3 peifault
4] tecfault
#- @ MASTERDRIVES_CEF
% (L] MONITOR
+ 1 LIBR&RY
1 | »
Project | Comemand ib. & fuis_1 M
x
backgr: Refresh rate:  [500 ms Stop status Immed. stafus iate control
Name Data Status value | Display format]| Control value
1 Tunner BOOL 7 FALSE [BOOL [P TRUE
B i 5 Sywbel o [T v conlusshon it | [5] Conpis/check o] 5] Tatpet syt o | S Disrosics ovenven

Online mode |
Figure 7-136 Monitoring and controlling the variable in the BackgroundTask

The motor now rotates at 6000 rpm and approaches the position 2000 mm. You can
check this by selecting Axis_1 under Axes, opening positioningstate in the symbol
browser, and noting the actualposition.
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9. Select the variable to be monitored.
10.Click Start status.

W SIMOTION SCOUT - DSC_MCP_3ms - [MCC - [backgr *]]

& Project Edit Inset Torgstsystem View Options Window Help

18] %
| Dlslei & »wle| -l e [ o)) =1z 2] | )]
”| =l “|<~Dnner, e E = EE TR
————1 =
= & DSC_MCP_3m: A =
) Configure hardware
*) Insert indhvidual difve
= 0230
] EXECUTION SYST
&= 110
&5 AXES R
) Iripet iz _
# ) EXTERNAL ENCOI
® 2] CAMS —
=] PROGRAMS as:‘:‘rr'::: runner = false 7|
% et 5T progre g
% Irpert MCC cha =
1 G backgyr -
L L] nd I 1 =
Fuoea Dt @ oo [Swen 1]
Axis_1 Refrach rate:  [F0 s [Siopeane ] Immed. status Immediete control |
[ F Name | Plain text Data type | Unit Status value__| Display format| Control value B
2 =] Jefaulipositio User defaults for ispositio
30 | positioni |§musdmhrp ispositio
31 i Actual position o LREAL mm. 39997290 |DEC
32 d| if i positi LREAL mm r DEC
33 perimp Command positi LREAL mm r DEC
34 rdifferencecomma |Difference betwe LREAL mim I DEC
35 rhomed Axis homing sta|'enumyesno’ o TEXT
3B t it Home position ¢ LREAL mm [l DEC J
7 By Execution statu |! i |
£ ] haming d|Execution statu |
a o —— ; m T ¥
B s 5 ymbel romes [ ] v conlprsion dta | [] Compie/check cuout ] [ Tatge syt ot | R Disrosics overven
Press F1 toa open Help display. Online mode —

Figure 7-137 Checking the positioning motion in the symbol browser of Axis_1

When the axis has finished positioning, a value of 2000 mm appears here. If the positioning
is restarted, the actual position value increases by 2000 mm for each motion.
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7. 12 Advanced Diagnostics on SCOUT crash

7.12 Advanced Diagnostics on SCOUT crash

In the rare event of a SCOUT crash, important diagnostics data can be stored. This data is

important for the reproducibility of the error in order to determine the cause. Contact the
hotline straightaway and forward the diagnostics data.

The following dialog "Siemens Automation Diagnostics" would open:

Siemens Automation Di X

u7wwbfax has encountered a problem and needs to close. We are
sorry for the inconvenience

‘We apologize For the inconvenience. IF wou are in the middle of something,
some infarmation riaht be lost,

Please tell Siemens about this problem

Al information will be treated as confidential and anonymous,

Creake repork :

Cancel

Figure 7-138 Siemens Automation Diagnostics

Please note the following:
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1. Click on the Create report button to generate the diagnostics data.
Another dialog opens.

Note

If you close the dialog by pressing Cancel, the diagnostics data is not saved!

Siemens Automation Diagnostics

‘Welcome to Siemens Automation Diagnostics. You can now create a report containing general
information about your systern and installed software components of Siemens. The report may help us
solving problems on your system.

Discard I Details 55 I Privacy Policy

Save fis... I

Figure 7-139 Generate Diagnostics Data

2. Click Detailsbutton. Another "Siemens Automation Diagnostics" dialog is displayed.

Siemens Automation Diagnostics

Welcome to Siermens Automation Diagnostics. You can now create a report containing general
information about vour system and installed software components of Siemens. The report may help us

solving problems on your system.

Cloze 1 Save fz.. I Dijgzard << Detailz

x|

Frivacy Policy

Details I Commion Datai

Dumnp File Generatar
Process Information
Wi Reader
=l File Copy
- [#] % hestaatwarehexp bink U Fumchdatatwirkbrich W UE S user. dat
- ><:\es‘ssoftware‘se:-:p\bin\u?umc\.data'\wrkhnch'\UESpersi.dat
- [#] 5 heshzaftwarehenp bink U Fumchbrcoutyracedmp. tat
- [#] = heshaattwarehexp bink U Fumcibroouthoetre007 . bt
2 X:\es‘ssoftware\e:-:pkbinku?umc'\trcnut’\switches.TSW'

Add Filefs] I

Size of attachments: 18043 KB

Yiew Report I

Figure 7-140 Siemens Automation Diagnostics - Details

In this window, there is more detailed information in the Details and Common data tabs.
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7. 12 Advanced Diagnostics on SCOUT crash

Add File(s) button

Here, you can add more user-specific files to the diagnostics directory.

View Report button

The problem details are displayed in plain text.

Close button

The dialog closes. The diagnostics data is saved in the following default directory:
— U7umc/data/AdvancedDiagnostic/<files>

Save As button

You can select a user-defined directory to save the diagnostics data to.

Discard button

Corresponds to 'Cancel’, the diagnostics data is not saved.
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8.1 Quantity framework

Technical data

Note

See also the function overview in Chapter 8 of the PM 21 Catalog.

Table 8- 1 Quantity framework for SIMOTION devices

SIMOTION devices

C2xx; P350-3; D4xx

Execution system

- task structure / program
execution

BackgroundTask

1
(adjustable monitoring time)

TimerlnterruptTasks (as of 1 ms)

5

MotionTasks

32
(for C2xx = 20)

ServoSynchronousTasks

(synchronous with the position control

cycle clock)

1

IPOSynchronousTasks

(synchronous with the interpolation

cycle clock)

InterruptTasks (for user)

TControlTasks

StartupTask

ShutdownTask

Execution system

- task structure / error
processing
(SysteminterruptTasks)

ExecutionFaultTask

SN

TechnologicalFaultTask

PeripheralFaultTask

TimeFaultTask

TimeFaultBackgroundTask

Communication

Guaranteed engineering system
connections

Alalalala

Guaranteed HMI connections

Number of connection points

SIMOTION SCOUT
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8.1 Quantity framework

SIMOTION devices C2xx; P350-3; D4xx
Number of routed connections 10

PROFIBUS DP Equidistance Possible
Baud rates 1.5; 3; 6; 12 Mbaud
Number of slaves 64 max. per DP line

PROFINET Number of devices Max. 64

(not C2xx)

Diagnostics and alarms

Diagnostics buffer

200 entries (100 entries for D410);

an additional 200 entries for SINAMICS Integrated on
the SIMOTION D4x5;

an additional 100 entries for SINAMICS Integrated on
the SIMOTION D410/CX32;

Technological alarms

160 entries

Alarm_S (buffer)

40 entries

Cycle clocks and times

Ratio of position control cycle clock to
DP cycle clock

1:1 to 1:4 (for C2xx = 1:1, 2:1)

Ratio of position control cycle clock to | 1:1 ... 16:1
PN cycle clock
Ratio of IPO1 cycle clock to position 1:1...1:6
control cycle clock
Ratio of IPO2 cycle clock to IPO1 2:1t0 64:1
cycle clock
Table 8- 2 Quantity framework for SIMOTION C2xx
SIMOTION device C230-2 C240
User memory RAM disk for user data 22 MB 22 MB
Main memory (user RAM) 20 MB 35 MB
Retentive user variables 12 KB 100 KB
(retain variables)
Memory medium for retentive user data on the MMC 32 MB 64 MB
(Micro Memory Card)
Memory space available to the user on the memory medium 26 MB 58 MB
(persistent memory)
Address space Permanent process image for 64 bytes
BackgroundTask (I/O variables)
Additional configurable process image for | Yes
cyclic task (I/O variables)
Logical I/0 address space 2 KB 4 KB
Physical I/O address space for 1KB
PROFIBUS
(max. per line for inputs and outputs
respectively)
Address space for each PROFIBUS DP 244 bytes
station
Technology objects Maximum number of axes 32
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8.1 Quantity framework

SIMOTION device C230-2 C240

Number of measuring inputs 2 2+4

(measurement on onboard encoder)

Onboard outputs for output cams 8 max. (140 pus) 8 max. (70 us)
Cycle clocks and PROFIBUS DP cycle clock 1,5...8ms 1..8ms
times

Minimum position control cycle clock 1.5 ms 1ms

Table 8- 3 Quantity framework for SIMOTION P350

SIMOTION device P350-3

User memory RAM disk for user data 18 MB
Main memory (user RAM) 24 MB up to max. 100 MB (adjustable

via SIMOTION P control manager )

Retentive user variables 15 KB
(retain variables) (up to 256 KB with UPS)

Memory medium for retentive user data: File on hard disk

Memory space available to the user on the memory medium Any

(persistent memory)

Address space Permanent process image for 64 bytes
BackgroundTask (I/O variables)

Additional configurable process image for | Yes
cyclic task (I/O variables)

Logical I/0 address space 4 KB
Physical I/O address space for 1 KB
PROFIBUS

(max. per line for inputs and outputs

respectively)

Physical I/0 address space for PROFINET | 4 KB
(max. per line for inputs and outputs

respectively)

Address space for each PROFIBUS DP 244 bytes
station

Address space for each PROFINET 1400 bytes

device station

Technology objects Maximum number of axes 64

Number of measuring inputs -

Onboard outputs for output cams -

Cycle clocks and PROFIBUS DP cycle clock 1..8ms

times
PROFINET cycle clock in 0.125 ms steps: 0.25 ... 4 ms
Minimum position control cycle clock 0.25 ms
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8.1 Quantity framework

Table 8- 4 Quantity framework for SIMOTION D4xx
SIMOTION device D410 D425/D435 D445/D445-1
User memory RAM disk for user data 17 MB 22 MB 45 MB
Main memory (user RAM) 1 25 MB 35 MB 70 MB
Retentive user variables 7 KB 320 KB

(retain variables)

Memory medium for remanent user data:
CompactFlash Card (CF card)

512 MB and 1 GB (1 GB is recommended)

Memory space available to the user on the memory medium 300 MB
(persistent memory)
Address space Permanent process image for 64 bytes
BackgroundTask (I/O variables)
Additional configurable process image for | Yes
cyclic task (I/O variables)
Logical I/0 address space 16 KB
Physical I/O address space for PROFIBUS | 1 KB
(max. per ext. line for inputs and outputs
respectively)
Physical I/O address space for PROFINET | 4 KB
(max. per line for inputs and outputs
respectively)
Address space for each PROFIBUS DP 244 bytes
station
Address space per 512 bytes
SINAMICS Integrated/CX32
(DP Integrated)
Address space for each PROFINET device | 1400 bytes

station

Technology objects Maximum number of axes 1 D425 =16 64
D435 = 32
Integrated drive control (in combination 1 1...6 (servo)
with SINAMICS S120); 1 ... 4 (vector)
further axes are possible via CX32 for (Servo, vector or | 1 ... 8 (U/f)
D435 and D445 U/
Number of measuring inputs (onboard 3 6
measuring inputs - for integrated drives)
Onboard outputs for output cams 8
Cycle clocks and PROFIBUS DP cycle clock 2..8ms D425=2..8 1..8ms
times D435=1..8
PROFINET cycle clock in 0.125 ms steps: 0.5 ... 4 ms
Minimum position control cycle clock 2ms D425 =2 ms 0.5ms
D435=1ms

1) A dedicated 20 MB main memory is available for Java applications
- on the D4x5 as of V4.1 SP1 HF6
- on the D410 as of V4.1 SP2 (a Java Virtual Machine will only be provided on the D410 as of V4.1 SP2)
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8.2 Memory requirement

8.2 Memory requirement

Memory requirement
Table 8- 5 Memory requirement for each instance of a technology object

Technology object Memory requirement / KB
Drive axis 180

Position axis 200

Following axis with following object 350

External encoder 150

Output cam 100

Measuring input 100

Cam 100

In addition for each interpolation point pair 1

TController: Heating controller 85

TController: Cooling controller 70

TController: Heating/cooling controller 100

Position axis path interpolation 250

Path object (for 4 axes, 1 cam) 200

Cam track 450

Addition object 50

Formula object 150

Fixed gear 100

Controller 100

Sensor 100
Table 8- 6 Memory requirement of technology packages

Technology package Memory requirement / KB
TP TControl 1.700

TP CAM 7.700

TP PATH 8.500

TP CAM_EXT 9.500
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A

Access protection for projects
SIMATIC Logon, 92
Accessible nodes, 130
Add-ons, 52
Alarms
Device diagnostics, 127
Archiving, 110
Authorization

Installing, SIMOTION SCOUT Standalone, 32

Authorization
Installing, 32
Available nodes, 74

C

CamTool, 100
Change
Change, 13

Checking the system utilization, 119

Commissioning
MICROMASTER 420, 155
Communication
Industrial Ethernet, 28
PROFIBUS DP, 27
PROFINET, 28
CompactFlash card
Data backup, 91
Compatibility
Software, 89
Compatibility list
SIMOTION SCOUT, 89
Compile, 13
Configuration data
Changing online, 108
Configuring
Interface card, 25
MICROMASTER 420, 156, 158
MM420 expert list, 165
PROFIBUS interface, 160
Time of day, 108
USS interface, 160
Configuring SCOUT V4.1
Recommended actions, 137
Context menu, 45
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Data backup
Persistent, 91
DCC
Drive Control Chart, 100
Deleting
Overall reset, 107
Detail view, 38
Symbol browser, 51
Using, 51
Device diagnostics, 112
Accessible nodes, 130
Alarms, 127
Diagnostics buffer, 112, 114
General, 112
General information, 113
Slaves, 112, 116
Syslog file, 113, 125
System utilization, 112, 119
Task Manager, 116
Task runtime, 112
User log file, 113, 124
Version overview, 113, 126
Diagnostic functions
Overview, 111
Diagnostics, 111
Accessible nodes, 130
Device diagnostics, 112
Diagnostics buffer, 114
Diagnostics overview, 112
General information, 113
System utilization, 119
Diagnostics buffer, 114
Diagnostics of the drive, 163

Displaying symbol browser continuously, 51

Drive

Configuring PROFIBUS interface, 151

Controlling, 161
Controlling speed, 162
Insert, 169, 216
Inserting, 144, 153
Monitoring actual values, 163
Monitoring enables, 163
Switching, 162
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DCC, 100
Drive diagnostics, 163
Drive ES, 99

E

Error remedy, 56
Expert list, 165
Exporting
Optimized export format, 87

G
Getting Started, 55

H

Hardware catalog, 67
Hardware configuration
SIMODRIVE 611 U, 266
Starting, 66
Help in the event of a SIMOTION SCOUT crash
Siemens Automation Diagnostics, 279
HMI, 97
ProTool, 98
WinCC flexible, 98
HW Config, 66

Inserting drive

SINAMICS on PROFIBUS, 145

SINAMICS on PROFINET, 146
Installing

Interface card, 23

SIMOTION SCOUT Standalone, 31
Interconnection overview, 127
Interface, 26
Interface assignment

SIMOTION devices, 23
Interface card

Configuring, 25

Installing, 23

K
Keyboard action, 39
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LAD/FBD, 19
Ladder Logic/Function Block Diagram, 19
Libraries
Upgrade, 81
License key, 72
Changing, 76
Entering, 75
Saving, 33
Transferring, 33
Licenses
Determining, 73
Displaying, 74
Licensing, 71
Accessible nodes, 74
Hardware replacement, 76
Performing, 75
Underlicensing, 77
Limits, 160

M

Main menu, 38
MCC, 18
Memory media, 90
Memory requirement
Technology object, 287
Technology packages, 287
Menu
Context menu, 45
Main menu, 38
Menu structure, 38
Menu bar, 37
Menu items, 40
MICROMASTER 420
Commissioning, 155
Configuring, 156
Expert list, 165
Insert, 148
Parameterizing limits, 160
Parameterizing setpoints, 160
Signal interconnection, 158
Terminals/bus, 158
MICROMASTER MM4
Parameterization steps, 166
Module
Slot rule, 141
Motion Control Chart, 18
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NetPro, 96

New
Drive, 144, 153, 169, 216
MICROMASTER 420, 148
Project, 61
Project navigator, element, 46
SIMODRIVE 611U, 149, 150
SINAMICS, 145, 146

O

Online help, 53
Searching, 54
Online multiuser mode, 58
OPC, 98
OPC XML DA, 98
Open, 13
Open protected project
SIMATIC Logon, 94
Open SIMOTION project
Older version, 139
Opening
Hardware catalog, 67
Project, 63
Operating mode, 104
MRES, 104
RUN, 104
SERVICE, 104
STOP, 104
STOP U, 104
Optimized export format, 87
Overall reset, 107
Overview
Diagnostic functions, 111

P

Platform change, 79
PROFIBUS interface
Configuring DP slave, 151
Drive, 151
Program editors, 64
Programming language
DCC, 18, 100
LAD/FBD, 17, 19
MCC, 17, 18
ST, 17, 20
Programming languages, 17
Project
Creating, 61
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Exporting, 87
Importing, 88
Opening, 63
Project data
Archiving, 110
Project navigator, 37, 46
Changing elements, 49
Creating elements, 46
Display station level, 48
Project versioning
SIMATIC Version Trail, 95
Properties
Elements in the project navigator, 49
ProTool, 98

Q
Quantity framework, 283

R

Recommended actions, configuration with SCOUT
V4.1
Log files, 138
Selecting the correct project, 137
Use routing, 138
References, 4
Remove write protection
SIMOTION project, 139
Routing, 142
HMI, 143

S

Saving
License key, 33
Setpoints, 160
Shortcuts, 39
Siemens Automation Diagnostics
Help in the event of a SIMOTION SCOUT
crash, 279
SIMATIC Logon, 92
Open protected project, 94
SIMATIC Manager, 91
SIMATIC station level, 48
SIMATIC Version Trail, 95
SIMODRIVE 611U
Activating DSC, 266
Hardware configuration, 266
Inserting, 149, 150
Setting, 267
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SIMOTION C230-2
Slot rule, 141
SIMOTION device
Changing, 79
Configuring, 66
Inserting, 66
SIMOTION devices
Interface assignment, 23
SIMOTION project
Remove write protection, 139
SIMOTION SCOUT
Compatibility list, 89
Installing authorization, 32
Installing the authorization, 32
Uninstall, 34
Upgrade, 34
Upgrade authorization, 32
SIMOTION SCOUT Standalone
Installing, 31
SINAMICS
Inserting, 145, 146
Slaves
Device diagnostics, 116
Slot rule
SIMOTION C2xx, 141
Snap-in, 36
ST, 20
STARTER, 99
Starting
Hardware configuration, 66
Station change, 79, 81
STEP7, 91
Structured Text, 20
Symbol browser, 51
Syslog file
Device diagnostics, 125
System overview, 14
System requirements, 23, 29

T

Target system
Controlling, 103
Operating mode, 104
Overall reset, 107
Time of day, 108

Task Manager
Device diagnostics, 116

Task Profiler, 129

Task Trace, 129

Task Tracer, 129

Technology object, 16
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Memory requirement, 287
Technology package, 16
Memory requirement, 287
Upgrade, 80
Time of day
Setting, 108
Toolbar, 37
Transferring
License key, 33

V)

Underlicensing, 77

Responses, 77
Uninstalling

SIMOTION SCOUT, 34
Upgrade, 79

Libraries, 81

SIMOTION SCOUT, 34

Technology package, 80

Within a platform, 79

Without station change, 79
Upgrade authorization, 32
Use routing, 138
User log file

Device diagnostics, 124
Using

Detail view, 51

Working area, 50

\Y

Version overview

Device diagnostics, 126
Versioning with standard library and software
components, 140

w

WinCC flexible, 98

Wizards, 50

Workbench, 15, 36
Detail view, 38
Elements, 37
Menu bar, 37
Project navigator, 37
Toolbar, 37
Working area, 38

Working area, 38
Snap-in, 36
Using, 50
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